Publication Information

© 2017 Imagine Communications Corp.
Proprietary and Confidential.

Imagine Communications considers this document and its contents to be proprietary and confidential. Except for making a reasonable number of copies for your own internal use, you may not reproduce this publication, or any part thereof, in any form, by any method, for any purpose, or in any language other than English without the written consent of Imagine Communications. All other uses are illegal.

This publication is designed to assist in the use of the product as it exists on the date of publication of this manual, and may not reflect the product at the current time or an unknown time in the future. This publication does not in any way warrant description accuracy or guarantee the use for the product to which it refers. Imagine Communications reserves the right, without notice to make such changes in equipment, design, specifications, components, or documentation as progress may warrant to improve the performance of the product.

Trademarks

Product names and other appropriate trademarks, e.g. D-Series™, Invenio®, PowerSmart®, Versio™ are trademarks or trade names of Imagine Communications or its subsidiaries.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation. All other trademarks and trade names are the property of their respective companies.

Contact Information

Imagine Communications has office locations around the world. For domestic and international location and contact information, visit our Contact page (http://www.imaginecommunications.com/how-buy/contact-us).

Support Contact Information

For domestic and international support contact information see:

- Support Contacts (http://www.imaginecommunications.com/how-buy/contact-us)
- Worldwide Support e-mail (mailto: service@imaginecommunications.com)
- Customer Community Portal (http://app.imaginecommunications.com/customercommunity)
- Warranty & Contract Information (http://www.imagincommunications.com/services/customer-care)
- MyImagine Academy Training (http://www.imagincommunications-academy.com)
- Product Manuals (http://www.imagincommunications.com/services/product-manuals)
# Contents

## Device Server Overview

- About the Device Server ................................................................. 9
- Clarification of Nomenclature ......................................................... 9
- About Internet Protocol Version 6 (IPV6) ........................................ 10
- Minimum System Requirements ..................................................... 10
- Hardware Chassis ........................................................................ 11
- Supported (32-bit/64-bit) Drivers .................................................. 12
- Supported Broadcast Devices .......................................................... 12
- Play lists and Transmission Lists ................................................... 13
- Automated Recording ..................................................................... 14
- Global Media Transfer ................................................................... 14
- Operating as a Virtual Machine ..................................................... 15
- Device Server Display Overview .................................................... 15
- Main Menu .................................................................................... 16

## Installation .................................................................................. 18

- The Pre-installed Device Server Application ....................................... 18
  - To Reinstall the OS (if required) ..................................................... 18
  - To reinstall the Device Server application (if required) ................. 18
  - Confirm the Application Icon Command Line ............................... 19
- To Install the Config Tool application (if required) ............................ 20
  - Rename the Application Icon (Optional). ..................................... 21
- IPv6 Setup .................................................................................... 22

## Operation .................................................................................... 23

- To Start the Device Server .............................................................. 23
- To Exit the Device Server ................................................................ 24
- To View Connections ....................................................................... 24
- To Close a Hung API connection .................................................. 25
- To Show IP Address Connections .................................................. 25
- Help Information ........................................................................... 26
- To Launch the Help System ............................................................ 26
- To View About Information ............................................................ 27
Configuring Devices using Configuration Manager ........................... 35

About Device Types........................................................................... 35
Media Devices..................................................................................... 35
About Device Control.......................................................................... 37
To Change the Config Tool Password ............................................. 40
To Start Device Configuration........................................................... 41
Main Menu Options............................................................................ 42
To close a hung API connection from Config Tool......................... 44
To configure the System Reference Clock (Clocking)....................... 44
About Drop Frame / Non Drop Frame Settings................................. 46
About Device Server Clocking............................................................ 46
About Consuming Chronos Timings over a Network......................... 48
To Configure GPI Control................................................................. 50
To Configure Enhanced GPI Triggering ........................................... 51
GPI Card Support................................................................................ 52
To configure skipping a commercial break after a GPI (input)......... 54
To configure Sync Skip after a GPI (input)...................................... 56
To Set Device Server ‘Keep Alive Time’ and ‘Multicast Address Scope’ .. 57
Adjust TimeCode on the Generator.................................................. 58
To Assign a Device to a Device Channel........................................... 59
(Option) To Remove a Device from a Device Channel...................... 60
Video Disk Configuration (VDCP Driver)........................................... 60
To Configure a Video Disk (VDCP Driver).......................................... 60
DTP Insertion Driver........................................................................... 80
To configure the DTP Insertion Driver.............................................. 81
Video Disk Configuration (API/IP Driver).......................................... 88
Additional Port of Same Disk (w/ Air Protect).................................... 88
To Configure a NEXIO Video Disk (API/IP Driver)............................ 89
To Configure an Omneon Spectrum Video Disk (API/IP Driver)........ 114
To Configure a GVG K2 Video Disk (API/IP Driver) ................................................................. 137
To Configure the mCapture Driver ......................................................................................... 158
N+1 Video Server Redundancy Configuration (Virtual Pool Driver) ..................................... 165
(N+M) Protection Concept ....................................................................................................... 165
Protect Pool Driver Configuration .......................................................................................... 166
List Assignment ...................................................................................................................... 169
To configure A/V tables for a general pool device ............................................................... 170
VTR Configuration (General) ................................................................................................. 170
To Configure a VTR ................................................................................................................. 171
Cart Machine Configuration (General) .................................................................................... 177
To Configure a Cart Machine .................................................................................................. 178
M/C Switcher Configuration (General) .................................................................................... 194
To Configure an M/C Switcher ............................................................................................... 194
Router Configuration (General) .............................................................................................. 220
To Configure a Router ............................................................................................................. 220
Switch Only Configuration (General) ...................................................................................... 244
About Switch Only Device ....................................................................................................... 245
About Switch Only (missing) Configuration .......................................................................... 245
About Extended Switch Only Device ..................................................................................... 246
To Configure a Switch Only Device ....................................................................................... 246
Requestor Configuration (General) ......................................................................................... 249
About Requestors ................................................................................................................... 249
About the Content Handler Requestor .................................................................................. 249
To Configure a Requestor ....................................................................................................... 250
Distributor Configuration (General) ......................................................................................... 263
About Distributors .................................................................................................................. 263
To Configure a Distributor ...................................................................................................... 264
Proxy Device Configuration (General) .................................................................................... 276
To Configure a Proxy Device ................................................................................................... 276
Transcode Configuration (General) .......................................................................................... 281
To Configure a Transcode Device .......................................................................................... 281
Archive Configuration (General) ............................................................................................. 285
To Configure an Archive Device ............................................................................................ 285
Video Effect Device Configuration (General) ........................................................................... 289
To Configure a Video Effect Device ....................................................................................... 289
Still Store Device Configuration (General) ............................................................................. 291
To Configure a Still Store Device ............................................................................................ 291
Character Generator Device Configuration (General) .............................................................. 299
To Configure a Character Generator Device ........................................................................... 299
# Configuring Device Assignments

Assigning Devices to Lists ................................................................. 355

To Start List Configuration ............................................................. 355

Main Menu Options ................................................................. 356

To Assign a Device to a List ............................................................ 357

Assigning a Breakaway Device to a Breakaway List ....................... 357

Add Breakaway Device to a Channel ............................................... 358

Assign a Switch Only Breakaway Device to a Breakaway List ........... 358

Assigning a Protect Device ............................................................ 359

To Assign a Protect Device to a List ................................................ 359

Configuring a GPI Trigger ............................................................. 360

To Configure a GPI Trigger .......................................................... 360

Configuring List Types .................................................................... 363

About Play lists and the Traffic Translator ....................................... 363
Configuration Manager tools.................................................................................................................460
Device Status window............................................................................................................................460
GPI diagnostics ...........................................................................................................................................461
Real-time diagnostic traces .......................................................................................................................462
Distributor diagnostics ..............................................................................................................................462
Diagnostic log file .................................................................................................................................465
Archive diagnostics ...............................................................................................................................466
ProxyFTP diagnostics ...............................................................................................................................466
VDCP diagnostics ......................................................................................................................................467
Diagnostic Monitor .....................................................................................................................................468
   To Set up Diagnostic Monitoring ........................................................................................................468
TraceView ...................................................................................................................................................469
Application and exception errors .............................................................................................................471
The ADC List Dump Tool ...........................................................................................................................471
   GUI application .......................................................................................................................................471
   Console application ...............................................................................................................................472

Appendix A: Error Messages ..................................................................................................................474
Device Server Errors ..................................................................................................................................474
SQL Server Database Error Messages ......................................................................................................488
   For SQL Server Error Definitions .......................................................................................................489
Device Server Overview

About the Device Server

The ADC Device Server is the heart of the automation system. The Device Server controls devices either through RS-422 serial connections, General Purpose Interface (GPI) contact-closure triggers, or an Ethernet connection. The Device Server communicates with remote clients through a Local Area Network (LAN) connection. The ADC Device Server application software runs on the Device Controller computer.

The ADC Device Controller is a rack mount computer that contains: an onboard Single board computer (CPU, Serial /Parallel Ports, 2 GigE NICs, VGA, PS2 Keyboard / Mouse), up to eight PCI 8-port RS-422 serial boards (OR up to four 16-port serial boards), one (or more) PCI GPI cards, and a PCI timecode reader / video sync card or a PCIe SER4-LTC TimeCode card.

**Note:** While 8 port and 16 port serial cards can be used in conjunction within a facility, all of the cards within any Device Controller chassis must be of the same type.

ADC Device Server v12 configurations can control a maximum of 24 lists per system that can comprise any combination of lists. This includes: Transmission lists, Compile lists, Media lists and/or GMT lists. If more capacity is needed, additional Device Servers may be added to the system. (For example: Since the limit is defined as any quantity of list types equaling 24, a system could be configured as (24) playlists.)

The ADC Device Server is configured remotely from any client PC in the Automation System containing the Configuration Manager application. The Configuration Manager incorporates common Windows usability features, such as drag and drop, cut and paste, and a point-and-click graphical user interface.

The system is highly flexible and may be configured for most broadcast operations and equipment. The ADC Device Server controls most types and models of broadcast devices, including cart machines, video servers, VTRs, still stores, character generators, routers, and master control switchers.

One of the ADC Device Server’s major strengths is its powerful software. The software interfaces with and controls the broadcast devices (instead of through hardware interface boxes). The software can be easily modified to incorporate new models or types of devices.

The ADC Device Server integrates the on-air playout system by using station timecode or reference video to maintain timing. The Master Control operator can control the on-air playout from an automation hardware control panel (similar to a Master Control Switcher Panel). The system’s Transmission lists may also be started automatically by time of day, as well as remotely by a GPI trigger.

Clarification of Nomenclature

Historically, ADC used the term 'Device Server' for both the physical unit (chassis) and the software application.

Current nomenclature designates the chassis as the Device Controller and the software application as the Device Server.
About Internet Protocol Version 6 (IPV6)

ADC v12 supports IPV6 for networking. IPv6 (IPng) is an upgrade to the Internet Protocol, that is designed to rectify the addressing problems in IPv4, and to provide a way to interpret, assign, and use addresses in a way more in line with modern internetworking. It will coexist with the older IPv4.

Minimum System Requirements

The following are minimum system requirements for ADC v12 Automation system components as of the release of this document.

Supported Database

The following databases are supported:

SQL 2008, SQL 2008 Express, SQL 2012, SQL 2012 Express

Supported OS Level

ADC Device Server v12.18 and higher and Client v4.18 and higher support operation on 32-bit and 64-bit operating systems.

Maximum Number of Connections to the Device Server

The total number of connections to the Device Server cannot exceed 32. This is because while the Device Server has 50 slots for NetBios connections, there is a second limit in APILIB32.dll that equals to 30-31 slots.

Server Requirements

<table>
<thead>
<tr>
<th>Type</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>Device Controller (CHP/iCHP chassis)</td>
</tr>
<tr>
<td>Software</td>
<td>Current Device Server v12.x release</td>
</tr>
<tr>
<td></td>
<td>• Device Server v12 uses IPV6 Network Protocol.</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT:</strong> Ensure the Windows default Firewall is DISABLED on the Device Server, Air Client, Media Client and Config Tool.</td>
</tr>
<tr>
<td>Network Interface Card</td>
<td>GigE Gigabit NIC and Ethernet switch is required</td>
</tr>
</tbody>
</table>

© 2017 Imagine Communications Corp. Proprietary and Confidential.
Client Requirements

<table>
<thead>
<tr>
<th>Type</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Hardware           | Processor – Pentium 4 3.0 GHz or greater  
RAM – For 32-bit OS: 1 GB RAM or higher, For 64-bit OS: 2 GB RAM or higher  
HD – 80 GB Hard Drive or greater (Required: 25MB of free Hard Drive Space)  
(For Windows 7: 16 GB available hard disk space (32-bit) or 20 GB (64-bit))  
2 TCP 1000BT NICs  
Additional Intel Network Interface Cards (Pro 100S) may be required for systems connecting to external networks, or a database using TCP/IP. |
| Software           | Current Air Client v4.x release  
Current Media Client v4.x release |
| Operating System   | Windows 7  
• When connecting to Device Server v12, ensure IPV6 Network Protocol is enabled on the Client v4 computer. |
| Network Interface Card | GigE GB Ethernet and switch is required |

Hardware Chassis

The Device Server can be run on a single chassis or as a dual redundant pair.

Note: The current chassis is referred to as H-Class ADC Device Controller. For information on the installation and setup of this chassis reference: “ADC Device Controller Hardware Reference”.

ADC Device Controller

The ADC Device Controller is the computer dedicated to communicating and controlling the broadcast devices and client workstations. This computer runs the Device Server application which controls devices via an RS-422 point-to-point serial connection, a GPI contact-closure trigger, or an Ethernet connection. It also sends and receives frame-accurate information across the Local Area Network (LAN) to and from remote client workstations.

There are two models of Device Controller; a 2RU model and a 4RU model. Both chassis are built around the same single board computer. The chassis model used in a given installation depends on the needs and budget of the customer.

• The 2RU Device Controller Chassis: The 2RU model offers a smaller rack footprint and includes limited hardware redundancy with dual power supplies.
• The 4RU Device Controller Chassis: The 4RU model offers greater expandability and hardware redundancy with dual power supplies and (optionally) raided hard drives.
Backup (Redundant) Device Controller

(Optional) Redundancy is an important part of automation. The ability to recover immediately from hardware failure in a broadcast environment is crucial. Protection against Device Controller failure can be achieved through a backup (redundant) Device Controller. The backup Device Controller is a computer that is identical to the main Device Controller and is configured the same way. If the main Device Controller fails, the backup Device Controller takes over the tasks handled by the main Device Controller. If the main Device Controller fails, device control may be manually transferred to the backup Device Controller. The transfer is accomplished by an RS-422 switching device.

Supported (32-bit/64-bit) Drivers

With ADC Device Server 12.18 and higher the following card drivers are available in both 32-bit and 64-bit versions. The 64-bit versions can function in a 64-bit Operating System.

- **AB4 Serial / GPI card.** This allows ADC to control external devices using the AB4 GPI / Serial card.  
  Note: An ADC system can use either the AB4 card or the "standard" PCI Serial RS422, but not both.

- **8-Port/16-Port Serial Drivers:** The 8-port driver installs only on the 8-port serial card and the 16-port driver installs only on the 16 port serial card.

- **GPI Driver:** After loading the 64-bit GPI Drivers the server must be rebooted. The card number depends on the order in which drivers were installed or initialized. During installation drivers can be installed in any order. The first installed driver will have the number 1 and so on. After the server reboot, the drivers initialize in the correct order and GPI cards have the correct numbers.

- **For Version:** GPI adapter for the AB4 Serial / GPI card driver. With this implementation GPI ports of the AB4 card are used instead of PCI GPI card ports.  
  IMPORTANT: The Device Server must be built with enabled $DEFINE USE_AB4_GPI_CARD define.  
  Note: The AB4 card must be programmed before using: D2XX driver must be selected for all GPI ports and "AB4_GPIO" description must be set for all GPI ports.

- **Time Code / Sync card driver.**

- **Cloning driver:** The Device Server installer detects the Operating System version (x86 vs. x64) and deploys the correct cloning driver.
  - The *lptwdmio.sys* driver is used for cloning in the new CHP Device Controller chassis and in older PCI chassis running Windows XP.
  - The *lptwdmio.sys* driver comes in two flavors: a 32-bit and a 64-bit version. On installation of this driver the system automatically detects the correct version to install based on the Operating System being run.
  - (i.e. For a 64-bit OS the 64-bit version of *lptwdmio.sys* is automatically installed. For a 32-bit OS the 32-bit version of *lptwdmio.sys* is automatically installed.)

Supported Broadcast Devices

The ADC Device Server is designed to interface with most devices commonly found in broadcast operations including:

- Cart Machines
- Video Servers
Most broadcast devices may be controlled by the Device Server through a point-to-point RS-422 serial connection. Some broadcast devices do not accept RS-422 serial control. These devices may be triggered by a GPI contact closure. Archive systems may be controlled by an Ethernet connection to the archive manager.

**Play lists and Transmission Lists**

Play lists are files that contain the schedules of events to be played, recorded or compiled. In a play list, each event contains information such as start time, event type, material identifier (ID), title, segment number, duration, start-of-message time (SOM), and audio/video output. Play lists may be created locally at the Air Client workstations or from traffic schedules. Play lists are stored on the file server and are available to all users on the system for viewing and editing. When a play list is ready for transmission, the play list file is loaded into the transmission window where it becomes a Transmission list. A Transmission list can contain a maximum of 2,500 events by default. (This number may be increased if necessary. Contact Automation Support for more information.)

When an event in the Transmission list is activated, the event performs a predefined function such as Play, Record, Switch or Cue. The ADC Device Server supports multiple Transmission lists; each list may be made up of several appended play lists.

When the system is initially configured, each broadcast device is assigned to a specific Transmission list. During playout of the Transmission list, the devices assigned to the list are available to run the events in the list. Each Transmission list represents a separate playout channel. This feature allows for simultaneous multichannel operations. Additionally, cart machine VTRs may be assigned to two or more Transmission lists for two (or more) channel operation, if each VTR in the cart machine has a separate audio/video path through a router. Cart machine VTRs may be assigned different tasks. For example, two VTRs might be used for playout, one for recording, and one for compiling. Video servers with multiple decoder ports may be shared among Transmission lists as well.

The ADC Device Server runs each event in the list sequentially for its full duration, unless the operator manually intervenes or until specific types of events, such as live events or time-triggered events, are encountered. If changes to the list are needed during playout, the operator may directly edit an event in the list.

Playout may be controlled by the control panel (software or hardware). Using the control panel buttons, it is possible to skip events, hold events beyond their duration, re-cue events and then restart them. An
on-air event may also be edited by either adding or subtracting seconds to the event’s duration using the control panel.

Automated Recording

(Optional) An ADC Device Server record function allows automated recording of material. A recording may be set up for a specific time and duration. Record events may be placed on a Record list - similar to a play list but containing only primary record events. Like a play list, the Record list is loaded into a transmission window to run the record events in the list. The Record list has only recording devices assigned to it as resources.

A secondary record event, also an ADC Device Server option, is available to record live events as they play out on a Transmission list. The secondary record event feature uses a play list that has both record and playout events. This feature can store program segment information (for future replay of a live event).

The ADC Device Server may use any VTR or video server encoder port in the system for a recording. For long VTR recordings that require several tapes, or to create duplicate copies of a show, several VTRs may be assigned. This also allows multiple recordings to take place simultaneously using the same Record list.

The ADC Device Server controls input audio and video switching when the recording begins. Recordings may be made from program output or from external satellite feeds.

**Note:** AutoSat system is available to automate acquisition and recording of satellite feeds. AutoSat works as an integrated part of the automation system, using a simple menu-driven system. Contact your Automation representative for more information on AutoSat.

Global Media Transfer

(Optional) Global Media Transfer (GMT) is the Automation system’s technology for controlling media movement within a broadcast facility. GMT is an integrated component of the automation system. Each Transmission list may request that GMT find media that is not available in the playout devices assigned to the list. GMT finds the media in other devices (VTRs, cart machines, other video servers on a fibrechannel or wide-area network, or data archives) and copies the media to a destination device (the playout device - a video server) assigned to the Transmission list. The Transmission list is then able to air the media.

The main tasks of GMT are:
- Find media needed by an on-air Transmission list
- Copy that media to a video server assigned to that Transmission list
- Monitor the transfer of the media
- Log the transfer of the media
- Provide automatic media duplication on multiple video servers for air protection
- Copy media to or from an archive
By accomplishing these tasks, GMT extends the level of automation beyond the basic on-air system. By allowing the automation system to handle the movement of media, less manual operator intervention is required.

**Operating as a Virtual Machine**

The ADC Device Server v12.23 can operate in a Virtual Machine (VM) environment. This functionality is directly related to the implementation of the following abilities:

- **Device Server’s ability to consume timings over a network.**
  - For details see section: Operation > Consume Timings Over a Network
- **Device Server’s ability to use external network attached GPI/O hardware.**
  - For details see section: Configuring Devices using Configuration Manager > To Configure GPI Control > GPI Card Support > Use External Network Attached GPI/O Hardware.
- **External serial control using Moxa:**
  - Support Moxa and legacy serial cards.
    - For details see section: Configuring Devices using Configuration Manager > Configuring Moxa NPorts and Legacy Serial Ports.
  - See also: MOXA_ADC_Virtualization_UserNote.

---

**Device Server Display Overview**

The Automation Device Server(s) operates from a rack mounted computer that is away from normal operational areas of the facility. The Device Server(s) is extremely active in the day-to-day operation of the facility, and it is strongly recommended that no other applications be operated from the Device Server(s).

When installed and running there is actually little to see. The following is only the Device Server display – visible: the current date, the timing source to the Device Server, timing mode, the current time, software build version and the date of compilation.

![Device Server Display](image)

Timing sources include:

- **PC:** For internal clock from the Device Server
- **SYNC:** For house video reference
- **TC:** For local timecode generator
Chronos: For Chronos PTP reference

Timing modes include:
- DF for drop frame
- NDF for non-drop frame

Main Menu

File menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Handle</td>
<td>Used to configure/change the Global Server Number for the Main Device Server.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit and closed the Device Server application.</td>
</tr>
</tbody>
</table>

View menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Opens a window that displays all of the Device Server and client applications currently logged into this Device Server.</td>
</tr>
</tbody>
</table>

Help menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Launches the Device Server Help System.</td>
</tr>
<tr>
<td>About...</td>
<td>Launch a dialog displaying Device Server version and copyright information.</td>
</tr>
</tbody>
</table>

Note: When calling Automation Technical Support to report a problem, make sure
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>you have the displayed version number handy.</em></td>
</tr>
</tbody>
</table>
Installation

The Pre-installed Device Server Application

Your Automation system comes with all required software preinstalled. If, for some reason, the operating system and/or Device Server software need to be reinstalled, contact Automation Technical Support for assistance.

A compressed image of the hard drive is supplied for each Device Controller (and client workstation computer) in your system at the time the system was delivered. This image does not contain your custom build of Device Server software or any configuration changes you or the Automation Support Engineer may have made to the system during commissioning.

**Note:** It is essential to back up your Device Server software and configuration files (ADC1000NT.INI, LISTCONF.INI, HANDLES.INI) to another location before attempting to reinstall the operating system. These files are usually located in the "C:\Server" folder on the Device Controller.

To Reinstall the OS (if required)

If required, follow Microsoft standard procedures to reinstall the Windows Operating System on your Device Controller. Contact Automation Support for more information and/or assistance.

**IMPORTANT:** Before attempting to reinstall the operating system, it is essential to back up your Device Server software and configuration files (ADC1000NT.INI, LISTCONF.INI, HANDLES.INI) to another location. These files are typically located in the "C:\Server" folder on the Device Controller.

Reference Note: For installation information see Windows Server 2008 64Bit install guide for ADCv11 and v12.

To reinstall the Device Server application (if required)

This section describes how to install the Device Server on a Device Controller computer using the Installation Wizard.

If installing a new version of Device Server over an existing version: Before installing, reboot the computer. Do not run Device Server on this computer after rebooting and before installing the new version. If this is not done, the installation may not complete successfully, and may have to be restarted.

1. Run the Installation Wizard (ServerInstall.exe) on a Device Controller computer.
2. Read the Welcome dialog. When ready to continue press **Next**.
3. On the License dialog the Read and accept the license, and then press **Next**.
4. On the Server Name and Destination dialog specify the following:
   - **Installation Path:** Accept the default or - if you like - press **Browse** to change the directory into which the application program files will be installed.
   - **Server Name:** This is the name of the Device Server (e.g. MAIN-1).
   - When ready to continue press **Next**.
5. On the Installation Confirmation dialog, click Install. The application is installed.
6. On the Completion dialog, click Finish to complete the installation.

**Note:** All ADC setup programs create shortcuts in the Start\All Programs\ADC Automation except for SecurityAdministrationTool -it creates a sub folder in ADC Automation.

---

## Confirm the Application Icon Command Line

Before running the ADC Device Server application, you may wish to check that the command line for the application is written correctly.

1. Right-click on the ADC icon on the Device Server’s desktop, and then select "Properties".
2. In the window that opens, select the "Shortcut" tab.
3. In the target field, the command line should read "C:\Server\adc1000nt.exe MAIN". The "MAIN" in the command line is the application name for this instance of the Device Server application.
   Your backup Device Server may be configured to run as backup, so the name designation may be "BACKUP".
4. Each instance of the Device Server application on the LAN must have a unique application name. The names used are optional. You may rename your Device Server application name to suit your needs.

   **Note:** If you change the application name for your Device Server, the command lines for all client applications must be changed accordingly. If not, the client applications will not be able to log into the Device Server.

   **CAUTION:** The path name should not have spaces; otherwise quotation marks are automatically placed around the path. If quotation marks appear around the path, all command line syntax must be placed outside of the quotation marks.

   For example,
   Correct: C:\ADCServer\adc1000nt.exe MAIN
   Correct: "C:\ADC Server\adc1000nt.exe" MAIN
   Incorrect: "C:\ADC Server\adc1000nt.exe MAIN"
   Incorrect: C:\ADC Server\adc1000nt.exe MAIN

   **IMPORTANT:** While up to 16 characters are allowed, only the first 10 characters are observed. For each name of main and backup Device Servers that share the same naming convention, one character must be unique in the first ten characters.

   In the following example, while the names are the same to a point, notice that the tenth character is different:
   - Main-playout Name: POD100-DSA-SVR01
5. When finished, click **OK**.

**BuildInformation.ini**

ADC v12.19 and higher includes a BuildInformation.ini file in the Device Server build which contains the build information (Version, Build name, etc.). This ini file is created in the same directory as executable file 1000 DS (ADC1000NT.exe).

Example of BuildInformation.ini file:

```
[General]
ProductName=ADCNT SERVER
CustomerName=ANY CUSTOMER
VersionBuild=12.19.2.0A
BuildDate=May 5, 2012
ConnectionName=MAIN
```

---

**To Install the Config Tool application (if required)**

This section describes how to install the Configuration Manager Tool on a **Client Workstation** computer using the Installation Wizard.

**If installing a new version of Config Tool over an existing version**: Before installing, reboot the computer. Do not run Config Tool on this computer after rebooting and before installing the new version. Failure to do this may result in an unsuccessful installation, and require you restart the process.

1. Run the Installation Wizard (ConfigToolInstall.exe) on a Client Workstation.
2. Read the Welcome dialog. When ready to continue press **Next**.
3. On the License dialog the Read and accept the license, and then press **Next**.
4. On the Server Name and Destination dialog specify the following:
   - Installation Path: Accept the default or - if you like - press Browse to change the directory into which the application program files will be installed.
   - Client Name: This is the name of the client workstation on which the Config Tool is being installed.
   - Config Tool Password: Specify a password for the Config Tool (Default is Admin)
   - Confirm Password: Re-enter the password that was just specified.
   - (Option) Install MOXA Files: Check this option if MOXA is part of the system configuration. PComm.dll is required for MOXA operations. Select (check) this option to load the PComm.dll.
   - When ready to continue press Next.
5. On the Installation Confirmation dialog, click **Install**. The application is installed.
6. On the Completion dialog, click **Finish** to complete the installation.

**Rename the Application Icon (Optional)**

Before running the ADC Config Tool application, you may wish to rename the icon.

1. Right-click on the Config Tool icon on the client workstation desktop, and then select "**Rename**". The icon name field is highlighted.
2. Enter a new name for the icon then click off the name.
IPv6 Setup

ADC v12 supports IPv6 for networking. IPv6 (IPng) is an upgrade to the Internet Protocol, that is designed to rectify the addressing problems in IPv4, and to provide a way to interpret, assign, and use addresses in a way more in line with modern internetworking. It will coexist with the older IPv4.

- Windows Server 2008: TCP/IPv6 is automatically installed as part of Windows Server 2008 operating systems. It is a standard implementation.

**ODBC Connections and Networking:**

For information on configuring Automation Client Computers for ODBC connectivity to SQL Server 2012, see ADC_SQL_Server_2012_Installation_Guide.

For information on system networking, see ADC_Networking_Best_Practices.
To Start the Device Server

Use this procedure to start the Device Server.

1. On the Device Server’s desktop, double-click the Device Server icon. This launches the ADC Device Server application. *(Note: In some installations this icon may be named ADCNT.)*

2. Only on initial startup of an installed Device Server:
   - If your system has only one active Network connection to the Device Server, skip to step 3.
   - If your system has two active Network connections to the Device Server, the Active Network Interface dialog is displayed prompting the operator to select an interface.
     - Select the "Automation LAN". If this LAN is not clearly indicated and you are uncertain which one to select, please contact your Network Administrator for guidance.
     - Press OK. The system creates a Network.ini file in the system’s designated installation location. (Once correctly set, this dialog will not be displayed for any subsequent restarts.)
       - If the incorrect network connection was selected, Device Server will not connect. To correct this delete the Network.ini file from the systems designated installation location, restart the Device Server, and then select the correct network connection from the Active Network Interface dropdown.

3. The system prompts to select the active network.

4. From the dropdown list select a network interface and then click OK. Settings are saved in the network.ini file.
5. When the Device Server application is running, an application bar - similar to the one below - is displayed at the top of the screen. This bar can be minimized to the tray or repositioned on the screen as required.

![Device Server Application Bar]

To Exit the Device Server

Use this procedure to exit and close the main Device Server.

- From the Device Server main menu select **File > Exit**

Or

- Click the **X** button in the upper right corner of the Device Server display.

To View Connections

Use the following procedure to view of the Device Server and client applications currently logged into this Device Server.

1. From the Device Server main menu select **View > Connections**. The Connections window is displayed showing all connections made via the automation Network to this Device Server.

![Connections Window]

2. From the Connections window main menu an operator can choose:
   - **File > Close**: Close the Connections window
   - **View > Refresh**: (or Press F5) to refresh the display
   - **Help > ...**: Launch the Help System or About information.
To Close a Hung API connection

A hung API connection can be closed from the Device Server View Connections window and the Configuration Tool View Connections window so that a hung API connection does not require a Device Server reboot.

To disconnect a connection...

A right-click menu option in the Connections window allows disconnecting the Device Server connection with any remote application (not only hung).

1. Open the Device Server Connection window or the Config Tool Connection Window
2. Right click on connection item which represents undesired connection.
3. Select the Disconnect menu item. This option is illustrated in the following images.

- Device Server View > Connections window

![Device Server View](image1)

- ConfigTool Connections Window

![ConfigTool Connections](image2)

To Show IP Address Connections

The connection list window can display the IP address of connections.

Device Server: To enable display of IP Address Connections
1. From the Device Server dialog main menu select View > Show IP address.

   The IP Addresses is shown for each connection in the Device Server Connections Window

   ![Connections](image)

   **Config Tool: To enable display of IP Address Connections**

   1. In the Config Tool Configuration window select File > Connection Management.
   2. In the Config Tool connection list window select a Device Server. The IP address of the selected connection is displayed in the status bar on the bottom of the window.

   ![Connections](image)

---

**Help Information**

**To Launch the Help System**

- From the Device Server main menu select **Help > Help**. The Device Server Help System is launched.
To View About Information

- From the Device Server main menu select Help > About... The About Device Server window is displayed.

**IMPORTANT:** When calling Automation Technical Support to report a problem, make sure you have the displayed version number handy.

Configuration from the Device Server Display

A limited number of configuration settings that can be made from the Device Server display. These are presented in this section.

The bulk of the Device Server Configuration is done using the Configuration Tool. For details see Configuring Devices using the Configuration Manager.

**IMPORTANT:** When the ADC Device Server is started, if a Server handle is not set, it automatically random generates with a handle that is not used in the current network.

To Configure a Server Handle

Use this procedure to configure the Global Server Number (must be unique on the network) for the main Device Server.

**IMPORTANT:** For correct connection of devices and clients, configure the Server Handle first from the Device Server side. Once done, it can then be changed from the Configuration Manager Tool.

1. From the Device Server main menu select File > Server Handle. The Server Number dialog is displayed.

2. Use the spin arrows to specify a Global Server Number. (This number must be unique on the network.)

3. When finished select OK.

About the Server Port for Device Server v12.22 and higher

The default value for server port was changed from 57125 to 47125 in order to exclude it from dynamic port range.
To comply with Internet Assigned Numbers Authority (IANA) recommendations, Microsoft has increased the dynamic client port range for outgoing connections in Windows Vista and in Windows Server 2008. The new default start port is 49152, and the default end port is 65535. This is a change from the configuration of earlier versions of Windows that used a default port range of 1025 through 5000. It applies to Windows Server 2008.

- Device server saves the server port number into NETWORK.ini configuration file when it shutdown. The section example:
  
  [Server]
  Server Port=47125

- Initialization of Networking in Device Server was modified. The first step now is creation of server socket. If this step succeeds DS continues initialization and creates multicast receive and senders.

**To Modify the Port Number:**

1. Following steps should be used to modify port number:
2. Shutdown DS. It will save actual value for port number.
3. Open network.ini file and modify port number. Save and close it.
4. Restart Device Server.

**To Diagnose Thread State**

For diagnostic purposes, sometimes it is necessary to obtain the state of Device Server threads if some of them are considered stuck in an infinite loop or perform are take too long to perform operations.

From the Device Server main menu select **File > Diagnose Thread State**. When this option is selected the current state of Device Server threads is written to an exception log.

In addition, threads state is automatically written to an exception log when Device Server is closed.
Example Exception Log showing Thread State:

<table>
<thead>
<tr>
<th>Exception report #1</th>
<th>2015.12.15 18:27:36:093</th>
<th>Exception 00937CA3 at Main</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thread ID</td>
<td>00000684</td>
<td></td>
</tr>
<tr>
<td>ThreadName</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>Exceptions skipped since last report</td>
<td>0 items</td>
<td></td>
</tr>
<tr>
<td>Time passed since last report</td>
<td>1899.12.30 00:00:00:000</td>
<td></td>
</tr>
<tr>
<td>Exception raised at this address</td>
<td>1 times</td>
<td></td>
</tr>
<tr>
<td>Exception message</td>
<td>Exception to diagnose threads state</td>
<td></td>
</tr>
<tr>
<td>Exception stack trace</td>
<td>44 items</td>
<td></td>
</tr>
</tbody>
</table>

Other threads 154 items

<table>
<thead>
<tr>
<th>Thread ID</th>
<th>ThreadName</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000884</td>
<td>Main</td>
</tr>
<tr>
<td>Exception stack trace 26 items</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Thread ID</th>
<th>ThreadName</th>
</tr>
</thead>
<tbody>
<tr>
<td>00001388</td>
<td></td>
</tr>
<tr>
<td>Exception stack trace 7 items</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Thread ID</th>
<th>ThreadName</th>
</tr>
</thead>
<tbody>
<tr>
<td>00004A44</td>
<td></td>
</tr>
<tr>
<td>Exception stack trace 4 items</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Thread ID</th>
<th>ThreadName</th>
</tr>
</thead>
<tbody>
<tr>
<td>000018C0</td>
<td></td>
</tr>
<tr>
<td>Exception stack trace 1 items</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Thread ID</th>
<th>ThreadName</th>
</tr>
</thead>
<tbody>
<tr>
<td>00001F44</td>
<td></td>
</tr>
<tr>
<td>Exception stack trace 4 items</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Thread ID</th>
<th>ThreadName</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000614</td>
<td>SaveDevs</td>
</tr>
<tr>
<td>Exception stack trace 4 items</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Thread ID</th>
<th>ThreadName</th>
</tr>
</thead>
<tbody>
<tr>
<td>00001C54</td>
<td></td>
</tr>
<tr>
<td>Exception stack trace 5 items</td>
<td></td>
</tr>
</tbody>
</table>
To Disable/Enable Cloning

This procedure requires the cloning build for the Device Server. For more information on Cloning see section Introduction to ADC Cloning.

Purchase Note: Cloning is a for-purchase option to Device Server. Contact your Automation Sales representative for details.
Reference Note: For more information on Cloning operations reference the ADC Cloning User Guide_Complete v8 document.
Reference Note: For details on setting up the Cloning panel see the ADC Hardware Control Panels Reference, Cloning panel section.

Using Alternate Handle

To disable cloning because a cloning-related problem has been identified or is suspected- or simply to disable it for an extended period of time- then the following the 'Alternate Handle' technique provides a more complete de-activation of cloning.

Change Rules:

When the DS application is running as "Main With Clone", any attempt to change the alternative handle to 0, displays a popup message informing the user to set the alternative handle to 0 on the clone DS application first.

- Once the alternative handle on the clone DS application is changed to 0, the main DS application becomes "Main Without Clone". Now the user can set its alternative handle to 0.
- If the main DS application is not running as "Main With Clone", it is OK to set its alternative handle to 0.

Disable cloning feature

Once the clone Device Server (DS) is running in synchronization with the main DS, if disabling of the cloning feature is required, implement the following procedure, exactly.

1. On the clone DS from the main menu select File > Alternate Handle and change the alternate handle to 0.
   When this is done, there will be empty caption on clone DS and the caption on main DS becomes "Main Without Clone". The relay position is on the main DS.
2. On the main DS from the main menu select File > Alternate Handle and change the alternate handle to 0.
   When this is done, the cloning feature code is completely bypassed. The caption on the main DS becomes empty. The relay position is still on main DS.

   Why change the Clone DS Alternate Handle to 0 first?
   When the alternative handle on the clone DS application is not 0 (is the handle of main DS), and the alternative handle on the main DS application is changed to 0 first, the clone DS takes over control. The relay position is on the clone DS. This behavior is explained as follows:
When the cloning feature is disabled on the main DS application, the heart beat between the main DS application and the cloning control panel is stopped. However, the clone DS application continues to send heart beat signals to the cloning control panel. In this scenario, the cloning control panel judges that the main DS has failed and that the clone DS is still active. This results in the relay being incorrectly switched from the main DS to the clone DS.

**Enable cloning feature again**

1. Put back alternate handle on the main Device Server (DS).
   The caption on the main DS application will become "Main Without Clone" in RED color. The relay position is on main DS.
2. Put back alternative handle on the clone DS.
   The caption on the clone DS application will become "Clone Of Main", at the same time, the caption on the main DS application will become "Main With Clone".

---

**Monitor List Updates and Actions**

It is possible to monitor list updates and actions with subscribers in the Device Server Debug Log.

**Note:** This log contains a lot of information and can cause high growth of the debug file.

1. Toggle Device Server Subscription Log on/off by using the Alt+Ctrl+Shift+S keyboard combination.
2. The letter F is displayed on the Device Server Main Form (F means Feedback).

---

**Logging for threads deadlock cases and memory usage**

Device Server 12.26 and higher provide Memory Usage Log and Main Thread Hang Log features.

**Memory Usage Log**

Memory usage logger thread ticks every second. Each time it checks current memory usage and writes a new line to the log file when any of the following conditions is met:

- 10 seconds passed since last time when memory report line was written
- Memory usage changed more than by 10% since last time when memory report line was written
Memory usage logger writes log files to log subfolder located in the same folder where executable file is located.

- Log file name format is: `log\MODULENAME-mem-DATE_TIME.txt`
- For example: `log\ADC1000NT-mem-2015-12-18_17-36-00.txt`

Log file content sample:

```
# 2015-12-18_17-36-00 start
2015-12-18_17-36-00 2070232
2015-12-18_17-36-02 13429096
2015-12-18_17-36-11 14852788
...
```

- On the first line we have log start date.
- On the second line we have ADC Device Server version info.
- Next on each line we have date_time and used memory measured in bytes.

Scripts to plot memory usage graph using GNUPlot app:

- `corevob\common\Exception\Source\PlotMemory.txt`
- `corevob\common\Exception\Source\PlotMemoryLog.bat`

### Main Thread Hang Log

Automatic logging in case of deadlock of main Device Server threads. The following DeviceServer threads are monitored:

- Main: SIMPMAIN.TSimpleMainForm.MainTimerTimer
- Background: SyObject.TSysObject.Background
- Interrupt: SyObject.TSysObject.InterruptRoutine

Monitored threads call GlobalServerThreadMonitor.Update to inform server thread monitor that they have not hanged yet. If one of the monitored threads does not call Update for 5 seconds then a report is being written to log file:

- `log\ADC1000NT-thm-2015-12-18_17-36-00.txt`

Server thread monitor writes report 3 times after hang situation was detected. Each report is written one second after the previous report. The report contains stack traces of every thread in the application.

Report sample:

```
!REPORT #0 2015-12-21_13-04-35
mt #0 timeSinceLastUpdate=5,500 name="Main" hanged
mt #1 timeSinceLastUpdate=0,000 name="Background"
mt #2 timeSinceLastUpdate=0,025 name="Interrupt"
    Thread #0 ID=7856 Name="Main"
    (0001EDDD){ntdll.dll   } [7734FDDD]
    [00C14603]\(ADC1000NT.exe\) SIMPMAIN.TSimpleMainForm.FormKeyDown (Line 796, "SIMPMAIN.pas")
```
Enabling multiple diagnostic monitors (i.e. Broadcast Supervisors) to log into a Device Server

With ADC Device Server 12.26 and higher, to enable logging more than one Broadcast Supervisor into a Device Server edit the the constant MAXDIAGNOSTICS in usercons.inc. The count of Diagnostic Monitor is configurable by editing of constant value MAXDIAGNOSTICS. The allowable range for the constant is 0..32

MAXDIAGNOSTICS = 1;   { always allow a diagnostic program }.

Adjust TimeCode on the Generator

TC Adjust option to Device Server.

- When it is enabled it is Okay to change TC on generator e.g. for daylight saving.
- When it is disabled it is not recommended to adjust TC on generator and DS is comparing previous and next TC values.
- Option is enabled by default and not saved anywhere.

The option can be toggled in two ways:

- Device Server  Main menu -> File -> TC Adjust ON/OFF
- CT -> Configured Devices window for a server -> File menu -> Clocking -> TC Adjust ON/OFF buttons.
Configuring Devices using Configuration Manager

About Device Types

Devices supported by the Automation system generally fall into one of two categories: media devices and non-media devices. Media devices include any devices that can be assigned to a list, have a storage collection of available media, and have the ability to cue and play media. Non-media devices are devices that perform other functions within the automation system. The following descriptions refer to software objects within the automation system that control the actual devices.

Media Devices

Media devices may be categorized as one of two types within the Automation system: physical media devices and virtual media devices. Media devices have a number of common characteristics including:

- A storage collection of available media
- Assignment to a list (or several lists, in the case of multiple-stream devices)
- Ability to cue media
- Ability to play or record media
- One or more "media heads" (I/O streams)

<table>
<thead>
<tr>
<th>Physical Media Devices</th>
<th>Virtual Media Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Server Encoder and Decoder Ports</td>
<td>Switch-Only Devices</td>
</tr>
<tr>
<td>VTRs</td>
<td>GMT Requesters</td>
</tr>
<tr>
<td>Cart Machines</td>
<td>GMT Distributors</td>
</tr>
<tr>
<td>Still Stores</td>
<td>Demo Devices</td>
</tr>
<tr>
<td>Character Generators</td>
<td></td>
</tr>
<tr>
<td>Audio Disk Carts</td>
<td></td>
</tr>
<tr>
<td>Serial Devices</td>
<td></td>
</tr>
<tr>
<td>Video Effect Devices</td>
<td></td>
</tr>
<tr>
<td>VChip Encoders</td>
<td></td>
</tr>
</tbody>
</table>

**Physical Media Devices**: These are devices that physically exist within the broadcast control room and are controlled through an RS-422 serial or GPI connection. The configuration GUIs for software objects that the automation uses to control these devices contain a Serial Port tab for designating the serial port the Device Server will use to communicate with the device.

**Virtual Media Devices**: These devices exist only as software objects and perform special functions within the automation system.
• Switch-Only devices switch a designated source to a designated destination on a switcher or router when their device name is placed in the ID column of a Transmission list
• GMT Requesters are special GMT components that request missing media to populate a playout device.
• GMT Distributors are special GMT components that distribute media from a source device at the request of a Requester.
• Demo Devices simulate the behavior of certain physical media devices. Demo Devices are used primarily for testing, diagnostics and demonstration purposes.

Storage Collection of Available Media

All media devices have a storage collection of available media. This storage collection is maintained in the Device Server’s RAM as the application is running. The storage collection for a device may consist of one ID or many IDs. Mass-storage devices, such as video servers and cart machines, may have storage collections consisting of hundreds or thousands of IDs. Single-stream devices, such as VTRs, have storage collections that consist of either one ID (if a tape has been loaded into the VTR), or no IDs (if the VTR is empty).

The storage collections for mass storage devices may be viewed from the Device Storage window in either the Air Client or Media Client application.

Media Head

A media head is a software representation or abstraction of the I/O stream to or from a media device. A single-stream device, such as a VTR, has a single media head. A VTR is capable of playing out only one piece of media at a time. A multi-stream device, such as a cart machine, has as many media heads as there are VTRs available within the cart machine. Each VTR may produce a separate audio/video stream simultaneously.

A video server encoder or decoder port is abstracted in the software as a two-headed device because of its ability to play out (or record) a continuous stream of audio and video. A decoder port may be thought of as analogous to a cart machine with two VTRs – while one VTR is playing out, the other has the next media cued. While one of the decoder port’s media heads is playing out, the other media head has the next clip cued.

Switch-Only devices have eight media heads. A Switch-Only device may be configured with eight ID names, each representing a crosspoint on a router or switcher. All eight heads may be cued simultaneously on a list.

Non-Media Devices

Non-media devices behave differently than media devices. Non-media devices:

• Are not assigned to lists
• Are shared by all lists
• Do not have storage collections
• Cannot cue, play or record
• Do not have "media heads"
Like media devices, non-media devices may be controlled through an RS-422 serial connection. Some of the non-media devices supported by the automation system include:

- **Routers and switchers** are the most common types of non-media devices. Routers and switchers (including master control switchers) are not assigned to lists. Instead, they are shared by all lists through the audio/video routing tables (A/V tables) configured for each device on each list.

- **Barcode readers** or barcode wands are used to identify tapes by a barcode label.

### Special Device Types

A few device types supported by the Automation system do not fall into the categories of either media or non-media devices. They have some of the characteristics of media devices, but are never assigned to a list. They include the following types:

- **Archives**, archive managers and archive systems are controlled through an Ethernet connection, rather than a point-to-point RS-422 serial connection.

- **ProxyFTP Devices** are software gateways the automation system uses to initiate FTP file transfers between video servers over a wide area network (WAN).

- **Database Update Redirectors** are software devices that propagate changes to database records to events on lists running on multiple Device Servers.

**Note:** All devices, whether they are media devices, non-media devices or the special devices described above, must be assigned to a device channel in the Configured Devices window of the Configuration Manager.

### About Device Control

Devices supported by the Automation system may be controlled by one of several means: a point-to-point RS-422 serial connection, an Ethernet connection on a local area network, or by a GPI trigger.

### RS-422 Control

Physical media devices are generally controlled through a point-to-point RS-422 serial connection. Different devices utilize different command protocols for their serial control. Video server ports on all makes and models of servers are controlled using VDCP (Video Disk Communication Protocol). VTRs are typically controlled using Sony VTR protocol. Other devices are controlled using their manufacturer’s native command protocols.

Depending on the requirements of the command protocol, devices may be polled periodically for status updates. Video server ports, for example, are polled every frame for port status and every 8 seconds (approx.) for system status. Sony VTRs are polled every frame for an update of the current timecode position. Other devices are not polled but sent commands only when they are called upon to perform some action.

Serial boards in the Device Server contain serial communication status LEDs that indicate the current status of the board. On the top edge of each serial board are banks of three LEDs corresponding to the eight RS-422 serial ports on the board (1 bank of eight LEDs for an 8-port card, 2 banks of eight LEDs for a serial 16 card). These LEDs are only visible by removing the Device Server’s cover.
• The green LED indicates that there is data being transmitted to the device from the Device Server.
• The yellow LED indicates that there is data being received by the Device Server from the controlled device.
• The red LED indicates that a communications error has occurred. Only a mismatch in the communication parameters configured for the device (Baud rate, parity, stop bits, data bits) will cause this LED to illuminate.

Depending on the types of devices connected to the serial board, the transmit and receive LEDs either solidly illuminate or intermittently illuminate. The communications error LED will illuminate upon the first occurrence of an error and remain illuminated until normal communications are established.

For most devices supported by the Automation system, the communication parameters are not configurable within the Configuration Manager. The devices themselves must be configured to match the automation system’s requirements.

8 Port Serial Card LEDs

On the rear panel of the 8-port serial card, visible from the outside of the Device Server, are three summary status LEDs. These LEDs are a summary of the eight sets of LEDs on the top edge of the board. A communications error on any one of the eight serial ports will cause this LED to illuminate.

8-port serial board (rear)

16 port Serial Card LEDs

Transmit, Receive, and Error indications are available for each of the 16 ports via green, yellow, and red LEDs respectively. Global Transmit and Receive LEDs are visible thru the rear bracket.
Ethernet Control

Archives and archive systems are controlled through a separate Ethernet connection to the archive manager. The Device Server contains a second network interface, bound to TCP/IP protocol, which may be used to connect the Device Server to the local area network for the archive system.

**Reference Note:** Installation of Device Server uses TCP/IP on two separate LAN’s, one for Automation Hardware Control (IPv6), and one for the SQL Database interaction (TCP/IPv4). It is recommended to use TCP/IPv4 with a 2nd NIC installed into Clients for the SQL interaction.

Another optional archive control architecture involves the use of a bridge computer. The bridge computer serves as a gateway between the Device Server and the archive system. It contains two network interfaces, one bound to TCP/IP protocol for connection to the automation LAN, and one bound to TCP/IP protocol for connection to the archive system LAN. The bridge computer runs a separate instance of the Device Server application with a single device configured: the archive device. This architecture separates the functions of the Device Server's devices and the archive device, and frees the TCP/IP network interface in the Device Server for other purposes.
- The Automation system uses the Video Archive Communication Protocol (VACP) to control archive systems. This command protocol is widely supported by archive system manufacturers.
- FTP file transfers between video servers on a wide area network may be controlled through an Ethernet connection as well. The ProxyFTP device may be configured with the IP addresses of any video servers on the WAN and initiate and control file transfers.
- Device Servers are shipped with IP default addresses configured for their TCP/IP network interfaces. These IP addresses may be changed at installation time to suit the needs of your particular network.

**GPI Control**

Devices that cannot be controlled through a serial or Ethernet interface may be controlled using a General Purpose Interface (GPI) trigger. A GPI is a relay contact closure that provides either a high-to-low or a low-to-high transition to trigger devices that accept this type of control. A single Device Server can support up to 32 contact closures (four GPI cards), although the standard Device Server configuration includes two GPI cards. Additional GPI cards may be purchased separately.

GPI triggers are configured in the Configuration Manager Tool as Switch-Only devices.

**To Change the Config Tool Password**

Use the following procedure to change the Config Tool password as required.

1. From the Config Tool menu select **File > Change password**.
2. In the opened dialog enter the current/old password and the new password. Under Confirm Password reenter the new password again.

![Password dialog]

3. Press OK.

---

**To Start Device Configuration**

The Configuration Manager Tool is used to configure the device drivers for devices controlled by a specific Device Server.

1. Highlight a Device Server and then from the main menu select **File > Configured Devices** OR Right-click on the name of the Device Server, and from the pop-up menu select "Configured Devices".

2. The Configured Devices window opens to display the devices already configured and the available device drivers.
   - The left pane displays the available device channels. The Device Channel is not necessarily the same as RS-422 Serial Port to be used.
   - The right pane displays the available device drivers.
The number in parentheses next to the device type in the right pane displays the number of available device drivers for that device type.

**Main Menu Options**

The Configured Devices window has a number of drop-down menus available.

**File menu**

The File menu has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Select to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Devices</td>
<td>Write the current configuration to the Device Server’s configuration files in the &quot;C:\Server&quot; folder on the Device Server.</td>
</tr>
<tr>
<td>Save Configuration</td>
<td>Save the Device Server’s configuration files to an alternate location. Only the ADC1000NT.INI and LISTCONF.INI files are saved. This allows you to back up your current configuration on a floppy disk (recommended). Choosing this option will open an Explorer window and allow you to choose where to save the files.</td>
</tr>
<tr>
<td>Print Configuration</td>
<td>Print the Device Server’s configuration files, if you have a printer attached to the client PC (or a network printer configured).</td>
</tr>
</tbody>
</table>

**CAUTION:** The configuration files can be quite large! Be sure to have plenty of paper in your printer.
### Clocking
Configure the system reference clock for the Device Server. In the Clocking Information dialog, select the appropriate type of clock input your system will be using (SMPTE timecode, Video Sync, or the Device Server’s internal PC clock), the correct frame rate (NTSC – 30 fps, or PAL – 25 fps), and if you are using drop-frame or non-drop-frame timecode.

### Delete
Delete the selected device from its device channel.

### Properties
Open the configuration GUI for the selected device.

### Diagnostics
Open a modeless diagnostics logging window for the selected device. For more information see Diagnostics and Troubleshooting.

**Note:** This option is only available for certain types of devices (GMT Distributors, Archives, ProxyFTP devices).

### Close
Close the Configured Devices window.

### Edit menu
The Edit menu has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Select to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>This option is not currently available. (use the keyboard shortcut CTL+C)</td>
</tr>
<tr>
<td>Paste</td>
<td>This option is not currently available (use the keyboard shortcut CTL+V)</td>
</tr>
</tbody>
</table>

### View menu
The View menu has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Select to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Icons</td>
<td>Display large icons in the left pane of the Configured Devices window.</td>
</tr>
<tr>
<td>Details</td>
<td>Displays device details in the left pane of the Configured Devices window.</td>
</tr>
<tr>
<td>Device Status</td>
<td>Open the Device Status window. This window displays the real-time status of devices in use by the automation system.</td>
</tr>
<tr>
<td>Port Usage</td>
<td>Open a window that displays the devices in order of serial port number.</td>
</tr>
<tr>
<td>Connections</td>
<td>Open a window that displays all of the Device Servers and client applications currently logged into this Device Server</td>
</tr>
<tr>
<td>GPI Card 1 (2, 3, 4)</td>
<td>Open a diagnostic utility for testing the GPI cards in the Device Server. Opening the appropriate GPI card window and placing a check in a checkbox will close the relay contacts for the corresponding GPI output.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refresh the display in the Configured Devices window.</td>
</tr>
</tbody>
</table>
Help menu

The Help menu has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Select to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>About…</td>
<td>Launch a dialog displaying version and copyright information of the currently selected Device Server.</td>
</tr>
<tr>
<td>Help</td>
<td>Launch the help file.</td>
</tr>
</tbody>
</table>

To close a hung API connection from Config Tool

A hung API connection can be closed from the Configuration Tool View Connections window with any remote application (not only hung) via a right-click menu option so that a hung API connection does not require a Device Server reboot.

Use the following procedure to close a Device Server connection.

1. From the Config Tool Main menu select File > Connection Management. The Connections window is displayed showing all connections made via the automation Network to this Device Server.
2. Right click on a connection. A 'Disconnect' option is displayed. Click the option to close the Device Server connection.

To configure the System Reference Clock (Clocking)

Use the following procedure to configure the system reference clock for the Device Server.

IMPORTANT: A restart of the Device Server is recommended when the clocking settings are changed in the Config Tool.

1. From the ADCNT Configuration screen, right-click on the name of a listed Device Server. A pop-up menu is displayed.
2. From the pop-up menu select "Configured Devices." The Configured Devices window opens to display the devices already configured and the available device drivers for that Device Server.

3. On the Configured Devices window, from the main menu select **File > Clocking**. The Clocking dialog is displayed.

4. **Source:** Select the appropriate type of clock input connected to your system:
   - **PC:** The Device Server’s internal PC clock
   - **SYNC:** The house Video Sync reference
   - **TC:** For local timecode generator
   - **Chronos:** For Chronos PTP reference. This option must be selected if using Chronos PTP timing. The Source title will change to reflect the connected input.
     - **Note:** With ADC v12.19 and higher the default Source - PC setting is Time Code.
     - **Note:** If no sources are connected, the Source title will always revert to "- PC".
     - **Note:** If running multiple Device Servers and PC Clock is selected as Source, the clocks must be manually synchronized.
     - **Note:** For the NEXIO AMP select SYNC.
     - **IMPORTANT:** The Time Code Source used (e.g. timecode generator) must be set to 24 hour format. (See also About Device Server Clocking (on page 46).)
     - **Note:** If no sources are connected, the Source title will always revert to "- PC".

5. **Rate:** Select the correct frame rate (NTSC – 30 fps, or PAL – 25 fps).

6. **Drop Frame:** If you are using timecode to clock the system, select whether the timecode source is drop-frame or non-drop-frame timecode. (See also About Drop Frame / Non Drop Frame Settings (on page 46).)

7. **Round DF:** Select (enable) the round drop frame parameter if you want to force the play list timing to always be accurate with respect to Time of Day, when using NTSC drop frame (DF).
   - **Without Rounded DF checked in NTSC timing mode,** the drop frame follows the rule from RS-170A, in the full minute. If an event’s duration is not a full minute, the drop frame is ignored for the segment smaller than a minute.
   - **With Rounded DF checked in NTSC timing mode,** all the event duration segments smaller than 1 minute are accumulated to a full minute and then drop frame is implemented. This makes the timing more accurate.

8. **(Optional) Date:** Change the current date. The date can be changed while the Device Server application is running. When the date drop down is selected, a calendar view is presented, with the
Currently set date noted. The correct date can be selected by highlighting it. If necessary, the arrow controls can be used to select the month.

**About PC Clock Date:** When the Device Server application is first launched, the PC clock's date is used to determine the date. However, since the Device Server uses an external reference to maintain its clocking—typically house timecode—the point at which the day is incremented cannot be maintained using the PC clock. Therefore the date is incremented whenever the Device Server's clocking passes through 00:00:00:00. Under certain circumstances, the date may become out of sync with the actual date. This has no effect on the execution of events, but affects certain processes such as AsRuns.

9. When finished click **Apply** and then click **OK**.

**About Drop Frame / Non Drop Frame Settings**

The Drop Frame or Non Drop Frame settings must be correctly set across the system.

- If the Drop Frame (DF) option is set to ON, and Drop Frame is received, then DF is shown in BLACK in the Device Server window and in the Client's transmission windows.
- If the Drop Frame (DF) option is set to OFF, and Drop Frame is received, then DF is shown in RED in the Device Server window and in the Client's transmission windows.
- If the Drop Frame (DF) option is set to ON, and Non Drop Frame is received, then NDF is shown in RED in the Device Server window and in the Client's transmission windows.
- If the Drop Frame (DF) option is set to OFF, and Non Drop Frame is received, then NDF is shown in BLACK in the Device Server window and in the Client's transmission windows.

To see NDF in Black, genlock the system with Timecode, select NDF in the configuration, AND ensure the clock being fed to the Device Server is NDF.

**About Device Server Clocking**

If the Source option selected in the configuration (PC Clock, SYNC, TimeCode, or Chronos) is available, it is shown in BLACK in the Device Server window and in the Client's transmission windows. The Source title on the Clocking Information dialog will change to reflect the connected input.
If a selected Source option is not available, then the next available option is shown in RED on the Clocking Information dialog, according to the source initially selected. These sequences are described below.

**Note:** Timecode and Sync are high priority (with Timecode higher than Sync) and – if either are connected – will always take precedence over PC Clock.

**Sequence 1:**

If TIMECODE is selected and is connected to the Device Server, it is shown in BLACK. If it is not connected to the Device Server, then SYNC is shown in RED - if it is connected. If SYNC is not connected either, then PC CLOCK (PC) is shown in RED.
Sequence 2:

If SYNC is selected and is connected to the Device Server, it is shown in BLACK. If it is not connected to the Device Server, then TIMECODE is shown in RED - if it is connected. If TIMECODE is not connected either, then PC CLOCK (PC) is shown in RED.

Sequence 3:

If PC CLOCK is selected and either Timecode and / or Sync are also connected, the system will revert to the highest priority connected source and that source will be shown in RED. If neither are connected, then PC CLOCK (PC) is shown in BLACK.

About Consuming Chronos Timings over a Network

Chronos is a utility developed by Imagine Communications that implements IEEE 1588-2008 Precision Time Protocol (PTPv2) and SMPTE 2059 to provide SMPTE timecode over a network to playout systems that do not have hardware inputs on which to receive LTC.

ADC v12.23 and higher support Chronos via the SMPTE API clocking type.

- This functionality worked in 12.23 to 12.25 versions by having the dll’s copied in the C:\Server folder.
- With ADC 12.25M when the Chronos clocking option is selected, the ADC Device Server looks to the hardcoded path where Chronos is installed. This ensures the proper dlls are always referenced for the version of Chronos installed.

Note: The legacy clock is kept as a fall back design for compatibility of time code card reader.

IMPORTANT: This feature has been tested and released using the Chronos PTP clock generator.
About Installation

Chronos is installed and configured using its own utilities. For details see the Chronos Installation and Setup Reference.

When Chronos is installed on a 64-bit OS, it writes files into two directories:

- /Program Files: Service and 64-bit version of dlls
- /Program Files (x86): 32-bit version of dlls

The hardcoded install path is %ProgramFiles%\Imagine Communications\Chronos. The Device Server uses the ProgramFiles environment variable that points to the right folder at the right disk.

For example:

- On a 32-bit OS, the Device Server will look into "C:\Program Files\Imagine Communications\Chronos" directory.
- On a 64-bit OS, the Device Server will look into "C:\Program Files (x86)\Imagine Communications\Chronos" directory.

**WARNING**: If the install path is changed, the Device Server will not find the dlls and will not be able to use Chronos.

About Upgrade

Use the following process to upgrade the Chronos software on the system.

1. Shutdown the Device Server because Chronos libraries can be locked by Device Server.
2. Install Chronos.
3. Start the Device Server. Device Server loads ChronosClient.dll only on start up.

**Note**: If Chronos is not installed, but the Device Server needs to migrate to it, the Device Server can be restarted after installation of Chronos because the Device Server configured to be locked to PC, SYNC or TIMECODE does not use any part of it.

About Configuration

With SMPTE 2059 specification, non-drop frame is not supported. When a Chronos clock is selected, on the Clocking Information dialog the "Drop Frame" and "Round DF" options are grayed out. Their default values are "Drop Frame ON" and "Round DF OFF".

1. Run the Device Server.
2. Run the Configuration Tool.
3. On the configuration tool window, select the icon for the running Device Server.
4. Right click to select the item menu "Configured Devices" to open a window.
6. Select "CHRONOS" option and then click Apply.
7. Observe that ‘Chronos’ is displayed as a caption on the Device Server screen, to indicate that the clock type is Chronos.

![Device Server Screen](image)

**Operation**

ADC can register a handle in a Chronos network clock, and be signaled by the clock at the beginning of each frame period. ADC response is a signal to retrieve a corresponding FILETIME record from the clock. The signals are used to trigger running an interrupt routine of an ADC Device Server application. The FILETIME record can be converted to a clock record used by ADC software.

1. Run a new automation client application (Air Client or Playlist v5) with connection to the Device Server.
2. Open the "Device Status" window and observe that a letter ‘C’ is displayed on the bottom display row to indicate that the clock type is of Chronos.
3. Assign a disk (e.g. demo disk) to a playlist and load a list of demo disk events.
4. Open the List window and run the playlist.
5. The Chronos clock is displayed on the bottom row, as well as a letter ‘C’ to indicate clock type of Chronos.

**To Configure GPI Control**

The GPI configuration GUI provides Enhanced GPI Triggering with ADC. The primary aspects of this functionality include:

- The GPI inputs extended to encompass all 32 inputs.
  
  **Note:** Versio v1.01 only encompasses 8 GPI inputs.

- The ability to configure the action taken for each input.

- The ability to select Single or multiple Lists for each GPI. (i.e. the equivalent of gang rolled functionality).

- The default configuration matches the existing fixed functionality.

**IMPORTANT:** This GPI configuration is independent of the GPI configuration for Switch Only devices.

**IMPORTANT:** For this feature to be enabled, ini files generated by versions 11.55 or higher must be utilized. Ini files created by previous versions do not contain the necessary configuration settings for correct operations. Please contact ADC Technical Support if you would like to utilize this feature.

**IMPORTANT RECOMMENDATION:** Wait at least one minute before applying power to the Device Server CHP after a shut-down. This allows sufficient time for the capacitor or capacitors to discharge, at which point the circuitry is inactive on restart, and prevents transient functions, such as GPI firing.
**GPI Card Status**: For information on checking the status and functionality of GPI cards installed in the Device Server see GPI diagnostics.

**WARNING ABOUT GPI CARD SETTINGS**: For North American customers using IconStation, Input GPI 1 is reserved for EAS that is controlled by the IconStation, and Input GPIs 2-8 are available for ADC. For more information see GPI Card Support (on page 52).

---

**To Configure Enhanced GPI Triggering**

1. From the Configuration Tool’s main menu select **File > GPI Input Configuration**. The GPI Input configuration screen is displayed and provides easy viewing of all GPIs at a glance.

2. On the GPI Input configuration screen configure the following parameters as required:
   - **Action**: Specify the action for a specific GPI: The drop down menu for the Action field offers all Playlist Control Panel options. These include: Run, Ready, Play, Hold, Skip, Tension Release, Freeze, Roll, Unthread, Protect, Add, Recue, Sub, Cut Next, Roll Secondary, Play to Next, Skip to Next, and Roll to Next.

   **About ‘Roll to Next’**: "Roll to Next" uses the Instant Roll value of the next Switch Only event (AUN) to return to the Live program more quickly. The Instant Roll value is set to 4 frames.
List: Select the Lists to which the GPI will issue a command. Single or multiple lists can be selected (checked) for each GPI. A single GPI can issue a command to multiple lists - with the limitation that only a single command can be selected. This is the equivalent of gang rolled functionality.

GPI Card Support

Device Server v12.20.24/v12.19.33.0M includes three adapters for communication with: standard PCI SeaLevel GPI card, GPI ports of AB4 card (directly), and LLM (by TCP/IP). It is possible to change/configure this adapter type by modifying the ADC1000NT.ini file.
To Change/Configure the GPI Adapter/Device Type

Use the following procedure to change/configure the GPI Adapter/Device Type in the ADC1000NT.ini file.

1. Using a text editor, such as WordPad, open ADC1000NT.ini. (This file is located in the Device Server installation folder.)
   - If there is no ADC1000NT.ini file in the Device Server folder...
     - Launch Device Server and Config Tool
     - Open Configured Devices window in the Config Tool and click Save on the Devices menu
     - ADC1000NT.ini is created in the Device Server folder

2. Locate the "GPI Driver configuration" section in the .ini file.

3. Change "GPI Driver type" value. Possible values are:
   - 0: (Default) PCI SeaLevel GPI card.
     ADC GPI functionality works when the GPI Driver type is set to 0 with the standard build of ADC Device Server v12.20.24 and a SeaLevel card.
   - 1: GPI ports of AB4 card (direct communication).
     ADC GPI functionality works when the GPI Driver type is set to 1 with Versio Device Server v12.19.33.0M and the NEXIO and IconStation are off.
   - 2: LLM by TCP/IP.
     ADC GPI functionality works when the GPI Driver type is set to 2 with Versio Device Server v12.19.33.0M and the NEXIO and IconStation are running. Input GPI 1 invokes the configured action for ADC, but also starts any GPI configured in IconStation.

   **WARNING:** For North American customers using IconStation, Input GPI 1 is reserved for EAS that is controlled by the IconStation, and Input GPIs 2-8 are available for ADC.

4. When finished, save the ADC1000NT.ini file.

Use External Network Attached GPI/O Hardware

ADCv12.23 and higher allows the Device Server to use external network attached GPI/O hardware (e.g. the SeaLevel 410E).

- The ADC system is able to operate with or without one or more 410E devices.
- The ADC system usage of the 410E devices is based upon the compiler directives {$IFDEF USE_SEALEVELIP} and {$IFNDEF USE_SEALEVELIP} as implemented in the ADC POC.
- The ADC system is able to operate per current production level GPI functionality with one or more 410E devices when built with the compiler directive USE_SEALEVELIP defined.
- The ADC system is able to operate per current production level GPI functionality without one or more 410E devices when built without the compiler directive USE_SEALEVELIP defined.
- The slave ID is a configurable value that the Device Server can read and pass to the initialize procedure. The SeaMax API function SM_SelectDevice requires a Slave ID parameter in order to distinguish between Modules.
  - The Slave ID is configured on the module’s physical casing by moving the ADDR dial. If the ADDR dial is set to 0, the Slave ID is 247. Otherwise, the Slave ID is the non-0 position on the dial. (i.e. from 1 up to 9.)
To indicate that device is not present, when configuring SeaMAX GPI in ADC1000NT.INI configuration file, use SlaveID = -1. For example, the following configuration indicates that only one SeaMAX device is present:

```plaintext
[GPI Driver Configuration]
SeaIO410E_ADDRESS=192.168.19.49
SeaIO410E_SLAVEID1=2
SeaIO410E_SLAVEID2=-1
Type=3
```
Alternatively, to indicate that second device is not present, do not specify second SlaveID:

```plaintext
[GPI Driver Configuration]
SeaIO410E_ADDRESS=192.168.19.49
SeaIO410E_SLAVEID1=2
Type=3
```

To configure skipping a commercial break after a GPI (input)

ADC Device Server functionality allows skipping a commercial break after receiving a contact closure input. The following two GPI Input options are used to configure this action: "Play to Next" and "Skip to Next". These options work together with the "Contact Start" option of a transmission list.

**Note:** The "Play to Next" and "Skip to Next" options work together with the "Contact Start" option of a transmission list.

When a transmission list plays an up-count event and a GPI closure is received...

- The Up count event rolls to the next event.
- This new feature allows rolling out of the commercial break back to the next N event.

For example, in a playlist with the following events:

- AU LIVE
- A  SPOT1
- A  SPOT2
- A  SPOT3
- AUN LIVE

If a GPI is received any time in between the AU LIVE event, in any of the SPOT1, 2 or 3, the transmission list skips all the SPOT 1, 2, 3 and mark MISSED, and starts playing the next N event - similar to having a hard started the U LIVE Event, but instead of a fixed time (AO) it is started with a GPI trigger.

In Operation

- The event modifier - "N" Time-to-next event type - marks where to jump. This allows the user to define arbitrary points: segmented or non-segments, up-count or not and so on.
- Time-to-next event must be in look ahead.
The events that are skipped when receiving a GPI input are marked as MISSED.

Skip-to-next mark all events between current and time-to-next as MISSED. The Current event is skipped.

Play-to-next marks all events between current and time-to-next as MISSED. The Current event will finish playing and then time-to-next event will start playing.

If current event is up-count event type, the Play-to-next signal is processed as Skip-to-next.

If time-to-next event is not cued, the playlist tries to thread and cue it.

If any error occurs (N event is absent or cannot be threaded), it is displayed on client side and the playlist will continue playing events in normal order not skipping any event.

**Note:** This functionality applies only to a GPI input. It does not apply to a function available on the Air Client Software/Hardware control panel. That is, this functionality is not available on the Air Client software panel nor the Air Client hardware panel.

**To Configure this functionality**

1. From the Configuration Tool’s main menu select **File > GPI Input Configuration**. The GPI Input configuration screen is displayed and provides easy viewing of all GPIs at a glance.

2. On the GPI Input configuration screen configure the following parameters as required:
   - **Action:** Specify the action for a specific GPI: The drop down menu for the Action field offers all Playlist Control Panel options. For this enhancement select "Play to Next" or 'Skip to Next".
     - Skip-to-next marks all events between current and time-to-next as MISSED. The Current event is skipped.
     - Play-to-next marks all events between current and time-to-next as MISSED. The Current event will finish playing and then time-to-next event will start playing.
     - If the current event is an up-count event type, the Play-to-next signal is processed as Skip-to-next.
   - **List:** Select the Lists to which the GPI will issue a command. Single or multiple Lists can be selected (checked) for each GPI. A single GPI can issue a command to multiple lists - with the limitation that only a single command can be selected. This is the equivalent of gang rolled functionality.
To configure Sync Skip after a GPI (input)

The SyncSkip mechanism provides synchronous payout of commercials across multiple lists. GPI triggers were expanded to support SyncSkip command by adding a SyncSkip action to the GPI Input Configuration in the Config Tool.

<table>
<thead>
<tr>
<th>Action</th>
<th>List 1</th>
<th>List 2</th>
<th>List 3</th>
<th>List 4</th>
<th>List 5</th>
<th>List 6</th>
<th>List 7</th>
<th>List 8</th>
<th>List 9</th>
<th>List 10</th>
<th>List 11</th>
<th>List 12</th>
<th>List 13</th>
<th>List 14</th>
<th>List 15</th>
<th>List 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>SyncSkip</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Run</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Skip</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Skip to Next</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>SyncSkip</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Tension_Rise</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Lift</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

To Configure this functionality

1. From the Configuration Tool’s main menu select File > GPI Input Configuration. The GPI Input configuration screen is displayed and provides easy viewing of all GPIs at a glance.
2. On the GPI Input configuration screen configure the following parameter as required:
   - **Action**: Specify the action for a specific GPI: The drop down menu for the Action field offers all Playlist Control Panel options. For this enhancement select "SyncSkip".
     - With this action selected, if an appropriate GPI signal is received and the SyncSkip command is chosen, the SyncSkip list action is performed.
   - **List**: Select the Lists to which the GPI will issue a command. Single or multiple Lists can be selected (checked) for each GPI. A single GPI can issue a command to multiple lists- with the limitation that only a single command can be selected. This is the equivalent of gang rolled functionality.

Basic Functionality

The SyncSkip command is applied to primary events only under the following conditions:

- Type of current playing event should be AN – time-to-next.
- Current event should have non-blank segment number in segment column.
- There should be another event down the list within lookahead meeting such requirements:
  - The same ID as current playing event.
  - The same type – AN
  - Non-blank segment number.
  - Segment number should be one more than segment number of current playing event, i.e. segments should be sequential.
If the conditions are satisfied, the SyncSkip action can be performed.

In other cases this command is replaced with simple Skip.

**Note:** Each of two events for SyncSkip (current and next) should represent the same entire program, with the same DUR and SOM, i.e. there should be 2 identical events in the transmission list.

---

**To Set Device Server ‘Keep Alive Time’ and ‘Multicast Address Scope’**

The Keep Alive Time specifies the Device Server’s network timeout. This parameter can be dynamically updated from the Config Tool and applied immediately (without having to restart the Device Server).

Since a high number of Versions on the same network can produce network congestion due largely to Device Server multicast packets, Multicast Scope provides a switchable option to isolate the multicast packets to interface-local or site-local, as defined in IPv6 protocol. (Change requires restart of the Device Server)

Use the following procedure to configure the special "Networking" form from the Config Tool’s Configure Devices dialog. This option allows specifying the Keep Alive Time configuration, to change Keep Alive Time value dynamically according to user’s choice, and to select a Multicast Address Scope.

1. From the Config Tool’s Configure Devices dialog, select File > Networking. A Networking dialog is displayed.

   ![Networking Dialog](image)

2. Specify the Keep Alive Time (in seconds).
   - Minimal value is 3 seconds.
   - Maximum value – 3600 seconds.
3. Select the Multicast Address Scope from the dropdown list of available addresses. Available options are: site-local, interface-local, and organization-local. (Default: Site-Local)

4. When finished click OK.
   - The system checks if a specified Keep-Alive interval is valid before saving it. Entering an incorrect value causes the Keep-Alive value edit visual control to change its color to white on red while the OK button becomes disabled.
   - The value:
     - Is automatically saved to "Network.ini" file (as currently) and restored after server restart.
     - Immediately affects the server’s network timeout without the necessity to restart server.
   - After Multicast Scope is changed from the ConfigTool it is required to restart Device Server.
   - The new option value:
     - Is saved in Network.ini file to status, status change, and log multicasts.
     - Is applied only after restart. If scope is changed, a notification message is displayed on the Networking form.

---

**Adjust TimeCode on the Generator**

TC Adjust option to Device Server.

- When it is enabled it is Okay to change TC on generator e.g. for daylight saving.
- When it is disabled it is not recommended to adjust TC on generator and DS is comparing previous and next TC values.
- Option is enabled by default and not saved anywhere.

The option can be toggled in two ways:

- Device Server  Main menu -> File -> TC Adjust ON/OFF
CT -> Configured Devices window for a server -> File menu -> Clocking -> TC Adjust ON/OFF buttons.

To Assign a Device to a Device Channel

1. Display Device Drivers: To display the specific device driver, click on the ⊹ symbol next to a device type. This expands the tree to display the specific device drivers for that device that are available in the system. (e.g. VTRs expanded would list Sony, Ampex, etc.)
2. Select the specific device in the right pane with the mouse, and then drag-and-drop the device on a device channel in the left pane. The number to the left of the device in parentheses decrements by one to indicate one less device driver is available.

3. Once a device has been assigned to a device channel, it may be configured for specific options.

(Option) To Remove a Device from a Device Channel

Use the following procedure to remove a device from a device channel.

1. Select the device you wish to remove.
2. Right-click on the entry and from the popup menu select Remove (or use the keyboard DEL key).
   The device is removed from the device channel and is made available for assignments to another channel.

Video Disk Configuration (VDCP Driver)

The following is an example video disk configuration for VDCP type drivers. Your device may have slightly different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.

IMPORTANT Note: Due to significant differences in configuration screens, configurations for API/IP Video Disk drivers are addressed under their own section. For details see Video Disk Configuration (API/IP driver) (see "DTP Insertion Driver" on page 80).

To Configure a Video Disk (VDCP Driver)

1. Under Video Disk Servers (VDCP) in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).
Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the Video Disk device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the General tab. Available options may differ depending on the device selected.

Configure the following parameters as required:

- **Device Name**: The device name identifies the disk port. The default name for standard video disks is DISK. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name. (See ID Match Name below.)
- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name selected as the device name. Enter the name by using up to four characters. When an event is threaded, a fifth character - the head number - is added to the name.

The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

- **Options**.
  - **Stop Disk Play/Record on Init**: A stop command is issued to the disk whenever the Device Server is started or the port is re-initialized. When disabled, the Device Server connects to the video disk port if it can. If it cannot, the port must manually be re-initialized on the Device Server (under System, Diagnostics). When disabled, it is the operator’s responsibility to check the port status in the Device Status Window and the IDs in the Device Storage Window and re-initialize if required. Default is enabled (checked).
  
  **Note**: Some sites prefer to DISABLE on ports the play to Air, and also Auto Record List ports.
  
  - **Back to Back Play**: When performing back to back play of short spots (for example, five second spots), keep the preroll and postroll of the lists as short as possible. The postroll time must be compatible with the VTR, switcher and effect minimum postroll times. Also, the
ADC Device Server allows a video disk that has started cueing to continue cueing during preroll as long as cueing finishes before playout time. If disabled, the second head status line never threads (staying offline). This option should typically be left enabled. Default is enabled (checked).

- **Update Event Durations From Disk**: The ADC Device Server reads from the video disk the duration of every item in the disk. This duration is displayed at the Device Storage window. The ADC Device Server shortens the duration of any event that is longer than what is reported from the disk. This feature is not typically needed for normal on-air operations since the automation database has the exact durations. Default is disabled (unchecked).

- **Report Spot Shorter than Scheduled**: Becomes available when "Update Event Durations From Disk" is selected. Check to enable report.

- **Reset registered IDs on Init**: Check to retain any registered IDs in the storage collection and clear any unused spots when the device is reinitialized.
  
  Unchecked: Continue to use the old storage collection after the reconnection.

  **Recommendation**: Uncheck if the disk frequently looses communication.

- **Disable heart beat checking for device air protection**: Enable/Disable heartbeat check.
  
  Checked: The Driver will not check if the device lost heart beat.

  Unchecked: The driver will sense the lost heart beat error and try to reset and reconnect with the device.

  **Recommendation**: Uncheck unless the device can’t reply to the driver's heart beat checking query command.

4. Select the **Serial Port** tab. Use this tab to specify the serial COM port on which the device is physically connected. Click the down arrow button to select from a list of available serial ports.
5. Select the **Ports** tab.

Configure the following parameters as required:

- **Video Input Port In Disk.** (Default: 1, Range: No Port (0) to 127) The video port number in the video disk that the automation serial board port logs into. The video input port number you enter depends on the disk system being used. Input ports are used for recording. Typically, only one video port is assigned to a list. A value of ‘No Port’ closes the video port and makes it available to another communications port.

  This must be configured for a video port number that is available in the video disk for the disk to record. ‘No Port’ in the port number: it cannot record and the status is OFFLINE. The disk port should only be configured to ’No Port’ if the port is not to be used for recording, or you want to CLOSE the port so another controller’s communication port can take control of that video port number. Normally this should have the same value as the VIDEO OUTPUT PORT if not zero (No Port).

- **Video Output Port In Disk.** (Default: 1, Range: No Port (0) to 127) The video output port is typically the same as the input port. The output board is used for playout. This is the video port number in the video disk that the automation serial board port logs into. Typically, only one video port is assigned to a list. A value of 0 closes the video port and makes it available to another communications port.

  Normally, each video disk uses a unique number to specify which video port to use for playing. This must be configured for a video port number that is available in the video disk for the disk to play. A zero in the port number specifies no port (disabling play). The status is OFFLINE if configured to zero. Only configure the disk port to zero if the port is not to be used for playing, or to CLOSE the port so another controller’s communication port can take control of that video port number. When not zero, this typically has the same value as the VIDEO INPUT PORT.

  **Note:** A single disk port can only play or record at a given time (not both). ADC changes from input to output port and back when required, but will not change until it has finished its current task and is in STANDBY. For example it can be scheduled to record a news feed for an hour, then play that news program the next hour on the same port providing there is at least 10 seconds (disk dependent) from the time it ends recording to the time it is scheduled to begin play out. If
play out must begin sooner, or during recording, then use a different disk port of that video disk to play out the news that is recorded.

- **Close Disk Port When Not In Use.** The default is disabled. This feature is rarely used. It should only be enabled when the disk port is used by different controllers at different times. A television station might use it so the day shift plays out from the disk port and the night shift records new material into the port (This, however, is limiting because if a spot needs to be recorded into the disk during the day, the port is busy for playout).

- **Disk To Use As Storage Port.** Default is Self. Select a disk to be used for storing clips. Typically this is the same disk being configured.

- **Additional Port Of Same Disk.** Default: None (not used). This device parameter is only used when you want to assign two video ports from the same video disk to the same play list. There are only two situations where this is useful: (1) To do mixed effects from one piece of material in the disk to the next piece of material in the disk. This situation requires two different video ports from the same disk because two streams of simultaneous video are needed to do the mix. (2) To play spots smaller than Preroll + Postroll + 10 frames + disk cue time. In this situation two ports can allow the next port to get cued and ready simultaneously thus allowing a very short spot to play and the next event will be cued on the other port.

To configure two video disk ports from the same disk to the same list:

- Assign both disk ports to the list as primary ports (air disk ports) not as protect ports.
- In this parameter of each of the two ports, select the name of the disk of the other ports. This allows the list to control both ports, but the first port will think it can play all the material.

When the list asks the first port to cue the events on the list, the first disk port, knowing it has a pointer to an additional disk port, only threads every other event. It then passes the other events to the additional port for threading.

- Use the same procedure to configure two protect disks, each protecting one of the air disk ports. Thus, when loading a playlist with four disk events and pressing program run you will see:

<table>
<thead>
<tr>
<th>EVENT#</th>
<th>DEVICE</th>
<th>STATUS</th>
<th>PROTECT DEVICE</th>
<th>PROTECT STATUS</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Disk1:1</td>
<td>Cued</td>
<td>Disk 3:1</td>
<td>Cued</td>
<td>SPTA</td>
</tr>
<tr>
<td>2</td>
<td>Disk2:1</td>
<td>Cued</td>
<td>Disk4:1</td>
<td>Cued</td>
<td>SPTB</td>
</tr>
<tr>
<td>3</td>
<td>Disk1:2</td>
<td>Stop</td>
<td>Disk3:2</td>
<td>Stop</td>
<td>SPTC</td>
</tr>
<tr>
<td>4</td>
<td>Disk2:2</td>
<td>Stop</td>
<td>Disk4:2</td>
<td>Stop</td>
<td>SPTC</td>
</tr>
</tbody>
</table>

When configured this way, any editing within or before any threaded and cued events, and all events below the edit point, are ejected and rethreaded in the proper order. This assures that playout toggles ports for every other event.
6. Select the Prerolls/Postrolls tab.

Configure the following parameters as required:

- **Instant Prerolls.**
  - The Instant feature is designed for coming out of a live or upcounting event as fast as possible when the next event has a near instant preroll. If using a master control switcher, the preroll must not be shorter than the shortest preroll supported by the switcher.
  - **Use Instant Prerolls.** This function has a default of zero seconds, four frames. The values can range from four frames to 59 seconds. Instant Preroll provides instant play/skip capability to the device. When enabled, Instant Play Preroll is activated by pressing the Instant button or Roll Now button on the control panel.
    - The preroll must be set to at least the minimum switcher preroll or the disk port may start playing before the switcher switches.
    - The preroll also must be set to at least four frames greater than the Disk Preroll and Number of Frames to Send Play Early. Four frames is the minimum preroll allowed by ADC. If not configured properly, the list may stop, or Roll Now may not work as expected, but take a longer time than desired.
    - If Instant Preroll is set longer than the List Preroll, instant play is actually a delayed play. ADC operations rely on list preroll settings configured through the Options menu, in Configure Lists.
  
- **Device Postroll.**
  - **Use Postroll.** Default: Disabled, zero seconds, four frames. Range: four frames to 59 seconds. When enabled, this setting overrides other configured postroll settings. Device postroll, if enabled, must be set to at least 4 frames.
    - This feature allows the list to use one postroll for VTRs, cart machines, and other devices, and a different postroll for video disks. The Device Postroll can be longer or shorter than the list postroll. Its main purpose is to clear out the disk status line quickly after the disk stops playing, so the status line can be loaded with the next event to cue. This allows small spots to be played back to back.
If the Device Postroll was set to a larger value, and the disk had over recorded the ID compared to the play duration, the disk would continue to play for the post roll duration if on air play switched to another device. This would permit mix effects during the post roll of the disk device into the play out from another device.

- **Seconds.** Select a value of up to 59 seconds.
- **Frames.** Select a value of at least 4 frames.

**Note:** The Seconds and Frames values have no effect unless the Use Postroll box is enabled (checked).

### Prerolls.

- **Disk Prerolls.** This has a default of zero seconds. The values can range from 4 to 300 frames. (Four frames is the minimum preroll allowed.) This feature should not be used unless specified by the disk manufacturer or Imagine Communications (refer to device-specific information).

  Preroll is sent to the video disk port when initialized or configured. All play and record commands are executed at a given time after receipt of the command. Disk preroll provides the preroll the disk requires for frame-accurate playout. It gives the disk more time to get the required video on air on the correct frame. Disk preroll must be set to the same value as Number of Frames to Send Play Early (discussed below).

- **Frames To Send Play Early.** The default is 0 and should not need to be changed unless the disk has a fixed latency of greater than one frame for the play command. This setting determines when (number of frames) the video disk port should receive the play command before playout is performed. A setting of zero sends the play command to the disk port the frame before the command is performed.

  The setting should never be greater than four frames less than List Preroll or Instant Preroll or the disk port will not play and the list will stop. If Disk Prerolls is used, the Frames setting should be the same value unless a frame or two of switcher timing compensation is required.

- **Frames To Send Record Early.** The default is 0 and should not need to be changed unless the disk has a fixed latency of greater than one frame for the play command. This setting determines when (number of frames) the video disk port should receive the record command before recording is performed. A setting of zero sends the record command to the disk port the frame before the command is performed. (The minimum possible value of "Frames to send Record Early" is -300.)

  The setting should never be greater than four frames less than List Preroll or Instant Preroll or the disk port will not record and the list will stop. If Disk Prerolls is used, the Frames setting should be the same value unless a frame or two of switcher timing compensation is required.

- **Never Send DiskPreRoll Command:** (Recommended only for NEXIO) Enable/Disable sending of Disk preroll command.

  Checked: The disk driver never sends the Diskpreroll Command to disk.

  Unchecked: The disk driver sends the Diskpreroll command to the video disk when initialized.

**Recommendation:** Check only when you know the disk doesn’t support the disk PreRoll Command.

**sQ Server Note:** When controlling an ISA system via the Quantel VDCP Interface, check this parameter as the sQ Server does not require and does not support disk preroll.
Always Send Preroll on Open: (Recommend only for Omneon) Enable (check)/Disable (uncheck) issuing a Preroll after opening a port.

- (Default) When Disabled (unchecked), the existing behavior is unchanged. i.e. The existing Preroll is issued before the port open.
- When enabled (checked), a Preroll is issued immediately after every Port Open, regardless of the reason for the open, but before any other commands to the opened port.

Note: It is anticipated that this new behavior is transparent in all cases, as issuing a Preroll immediately after open should have no other effect.

7. Select the Storage tab. (Entries below are Demo Disk, Standard, and STS 10)

Configure the following parameters as required:
- **Automatically Delete From Disk When Full.** The automation system ensures that the specified amount of free disk space is maintained. Material is deleted from the disk automatically, based on a first-entered, last-played formula.
  Example: A disk has 1000 spots on it, numbered 1 through 1000. Spot 23 is played, at which point it is assigned a new number of 1001. Spot 65 is then played, at which point it is assigned a new number of 1002. Each time a spot is played, it is incremented using this same sequence. As a result, spots that have been on the disk the longest without ever being played have the lowest numbers, and are deleted first. If material must be deleted on the disk, the lowest number would be deleted first, then the second lowest number, then the third lowest, etc. Default is disabled (unchecked).
  Spots registered in the Lookahead are never automatically deleted.

- **Disk Space to Keep Free (Mins).** The default is 10 minutes. The range is from 0 to 32,000 minutes. This parameter attempts to keep the disk with at least the entered number of minutes of disk space free. This prevents trying to record something larger than the available amount of time, then having to delete the unfinished (truncated) item. For playout, the default value is typically used. Set this to the size of the largest ID you expect to record if Automatically Delete From Disk When Full is enabled.
  Use this parameter in time delay and record event applications. It is not recommended to set the value below four minutes (since all space available numbers are estimates due to variable rates of compression on different video images). This parameter has no effect unless Automatically Delete From Disk When Full is enabled.

- **Delete IDs After Play.** Check to delete a played event from the video disk. This is typically only enabled for testing or when recording for a one-time playout. Default is disabled (unchecked).
  For testing, this allows a short list of spots, repeated continuously, to record or cache. The spots are then continuously deleted. For actual on-air playout, the setting automatically deletes from a disk when it is full. This keeps the disk filled with the most current spots to reduce multiple recording or caching of a spot repeated more than once. This function only deletes a spot if it is completely played out, and was recorded by this port.

- **Prevents 'In-Use' Clips from Being Deleted:** Enable/Disable deletion of In-Use clips.
  Checked: (Recommended) Users can't delete an ID when it is inside the lookahead of a list from any clients.
  Unchecked: Users can delete any event from the disk storage collection window of clients.

**Note:** This parameter ONLY works when the operator attempts to delete clips from the Storage Window. The Purge List ignores this setting and might delete events that are in the current transmission lists’ lookaheads.

**Note:** When "Prevents 'In-Use' Clips from Being Deleted" is enabled and the "Allow Delete IDs from Storage Window" is also enabled in the "Storage Options" tab of the Air Client, attempting to delete in-use clips in the Device Storage Window results in a confirmation popup.

Clicking OK on the Confirm message will not result in these in-use clips being deleted. This applies to in-use clips that are not Protected and are not in a CUED state.

- **DemoDisk Storage:** (Available for Demo Disk Selections) Demo Disk’s storage size can be changed by 2 parameters:
  - Demodisk Leading Word and Number of IDs. The ID's in demodisk are combined by these two parts.
    For example, using the leading word of "Demo" and number "99999", allows 99,999 IDs in demodisk’s storage from Demo00001 to Demo99999.
**Device uses ID request only**: (For Standard, Demo, Profile, Quantel, HP Buffer, Extended ID, and 2-10 Port Video Disk) This option allows VDCP drivers to repeat 3x.16. This feature is intended for "non-standard" VDCP devices that do not support the normal storage management processes, such as the Quantel.

It enables working with devices which can use only ID request command to work with storage.

- If this option is disabled (default value), there are no changes.
- If option" is enabled, the system regularly checks all red events in the list.

**Note**: To have the driver recheck blue events in the list, enable the option "Update event duration from disk" on the General" tab of the configuration.

8. Select the **Recording** tab.

Configure the following parameters as required:

Any combination of record qualifiers may be used, or all may be disabled. The recording qualifiers are effective on record events and caching, and Secondary Record Device Events. This is useful in caching to record only IDs that are commercials as they are short and not program material (program material normally has a segment number). Default is disabled.

- **Allow Recording**.
  - **Recording of Record Events**. Allows recording of record events or other types of recordings. When disabled, the disk port will not record. Recording with segment play enabled is equivalent to performing an insert edit or assemble record, depending on the SOM (if the video disk server supports this function).
  - **Back to Back Recording**. For secondary record events, this parameter must be disabled. Only enable this option if your video disk server supports this function.

This setting is useful when setting up a disk to perform continuous time delay applications. To set this up, enable this parameter and then place a sequence of continuous IDs on a record list. The video disk records every frame into the proper ID. The record list can be made into a playlist and played out. The play output is exactly the same as what was recorded.
This function affects the play out and recording list function and the disk driver function; no other function is affected. When enabled, it:

- Allows the recording port to support back to back recording between different recording IDs.
- The leading Switch Only Device will allow the back to back play between the different play IDs.
- The back to back recording function records single-file-multi-segment file to single file in video disk and the Air Client updates the database after each segment has finished the record.
- The recording operation to video disk will not stop until the recording of all segments is finished.

**Note:** Refer to the documentation on your disk to verify if your disk supports back-to-back recording.

- **Record Only No Playout.** When enabled, this port will not play any material. This allows a port to be assigned to a playlist for recording, with a separate port assigned for playout. Without enabling this parameter, if one port goes down, the other port will try to do both (record and playout). Since it cannot do both at the same time, the list will not work properly. Default is disabled.

  - **Disable Recording With Segments.** If enabled, the disk port will not record any event with a segment number in it. Default is disabled (unchecked).

  - **Record Only Segments.** Enable to only record events with non-blank segment fields. If not enabled, the disk port will not record any event with a segment number in it.

  - **Prevent Recordings Greater Than (Mins).** Check to enable, then specify a maximum length (in minutes) for any recording. When this parameter is enabled, the disk port will not record any ID whose duration is greater than the number of minutes specified in parameter.

  - **Prevent Recordings Less Than (Mins).** Check to enable, then specify a minimum length (in minutes) for any recording. When this parameter is enabled, the disk port will not record any ID whose duration is less than the number of minutes specified in parameter.

  - **Only Record Events with ID in.** Check to enable, then specify the event range ‘--to--’ limits. When enabled, the disk will only record IDs whose first character is between or equal to the limits. Numeric and alphabetic entries (upper and lower case) are permitted.

    **For example:** If only IDs starting with a ‘9’ are to be recorded, enter a ‘9’ in both boxes. To record only IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters. ’A’ to ‘Z’ and ’a’ to ‘z’ are permitted, and uppercase letters are sorted before lower case letters, and uppercase letters are sorted after numbers.

    The ID qualifier is useful where some IDs are recorded and others not, and the Duration and Segment qualifiers cannot distinguish between them. The traffic system can designate a certain range of IDs that will be cached or recorded only.
9. Select **Qualifiers** tab. Use this tab to set playing event qualifiers.

![Image of Qualifiers tab]

Configure the following parameters as required:

Any combination of qualifiers may be used, or they all may be disabled.

- **Playing Event Qualifiers.**
  
  Event qualifier means playlist events must satisfy the selected qualifier before being allowed to play out through this VDCP port. If they do not pass the qualifier check, the event is not registered to this port, and is not allowed to play.

  - **Primary Event**: Select (check) this option, if this VDCP disk port allows primary events to play.
    
    Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Secondary to this VDCP disk port, and register Primary events to other devices, such as VTR.

  - **Secondary event (without Data Event)**: Select (check) this option, if this VDCP disk port allows secondary events to play.
    
    Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Primary to this VDCP disk port, and register Secondary events to other devices, such as VTR.

  - **Duration Range.**
    
    If a duration qualifier is enabled then the disk port will not play any ID whose duration is greater (or less) than the number of minutes specified in parameter.

    - **No Events Greater Than (Mins)**: Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).

    - **No Events Less Than (Mins)**: Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).

- **ID Range.**

  This qualifier is useful where some IDs are to be played and others not, and the Duration qualifier cannot distinguish between them.

  - **Qualify Events by ID**: Check to enable qualification.
• Only Event with ID Between: Check to enable. Then specify range in the associated number field. If this qualifier is enabled, then the disk will only play IDs whose first character is between or equal to the ‘--’ limits.
   
   For example: If only IDs starting with a ‘9’ are to be played, enter a ‘9’ in both boxes. To play only IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters.

• No Event with ID Between: Check to enable. Then specify range in the associated number field. If this qualifier is enabled, then the disk will ignore IDs whose first character is between or equal to the ‘--’ limits.
   
   For example: To ignore and not play IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters.

• from-- to --: Alphanumeric entry. Specify range. Up to 32 characters can be entered in each field.
   
   ‘A’ to ‘Z’ and ‘a’ to ‘z’ are permitted, and uppercase letters are sorted before lower case letters, and uppercase letters are sorted after numbers.

10. Select Segments tab.

Configure the following parameters as required:

  ▪ Enable Cue with Data: Enable this function only if your video disk server supports this function.
   
   • This is only enabled to play a part of an ID. It is similar to playing segments of a program or show.

   When enabled, the disk port uses the event’s SOM (start of message) to play or record individual segments of program material. For example, enable this setting if you want to play a program or news item in several parts. However, the different video disk devices implement this feature in various ways. For further details, refer to the documentation on your video disk device. Default is disabled (unchecked).

   • This feature must be enabled to play or record individual segments of program material. (The HP AMS can only start at the beginning of the file for play and record. The Profile can start play or insert recording at any time into the file.) If the SEGMENT field in an event is
not blank then the video disk can only play or record that event if this option is enabled. If you always want to start at the beginning of every ID, or your disk does not support segments, then do not enable this feature.

- **Modify Segment IDs (# of Characters)**. Up to two characters can be added to IDs. Useful for multi-segment recording, this option causes the ID on a video disk to be appended with either 1 or 2 characters to distinguish the segments.

  If you never use more than 9 segments in any ID, select 1 character (which allows up to 9 segments). If you select 2 characters here, a maximum of 99 segments is allowed. Valid numbers are 0, 1, and 2. Default is 0.

  **Example**: If Modify Segment IDs (# of Characters) were set to 2, a 3-segment ID titled "spot" would reside on the video disk as "spot01," "spot02," and "spot03." If the disk has a maximum of 32 characters allowed for an ID, the ID is truncated on the disk if the ID takes up 30 or more characters (2 characters are lost to allow for the 2 segment characters).

- **Segment Play Search path**: Use this parameter to specify segmented program ID search through various settings of the Modify ID parameter. For media play out, the first valid setting is used.

  The list permits each setting to be individually enabled or disabled, and for the order in which they are checked to be defined. Populating the search path with a single entry matching the fixed settings allows operation identical to current behavior.

  Select a listed segment then use the associated buttons to arrange:

  - **Up / Down**: Use these buttons to position the segment in the list.
  - **Enable**: Use this buttons to enable a selected segment.
  - **Disable**: Becomes active when Enable is selected. Use this button to disable a selected segment.
  - **Cue**: Becomes active when Enable is selected.
  - **Cue with Data**: Becomes active when Cue is selected

- **Reject Blank SOM**: Check to enable rejection of segments with blank SOM.

- **Reject Blank or Zero Duration**: Enable (check) / Disable (uncheck) rejection of events with null durations.

  - When disabled (unchecked), the driver behaves as it currently does.
    - Events are Blue on the Transmission List
    - Events with 00:00:00.00 durations miss at time of play
    - Events with 00:00:00.00 durations are marked missed on the asrun log.
    - Events with 00:00:00.00 durations generate an Error with the message "EVENT NOT PLAYED - MEDIA MISSING - NOT FOUND OR BLANK SOM OR DUR"
    - Events with blank (NULL) durations play without stop until the end of physical clip, then they are marked RAN SHORT.
    - Default setting is disabled.

  - When enabled (checked) the VDCP object will not register to play any event in the transmission list that has a blank or 00:00:00.00 Duration. (With default colors, these events remain RED on the Transmission List and do not play). The Transmission List treats this event like any other missing event.
11. Select **Spots** tab.

Configure the following parameters as required:

- **Reject Blank SOM**: Check to enable rejection of single spots with blank SOM.
- **Reject Blank or Zero Duration**: Enable (check) / Disable (uncheck) rejection of events with null durations.
  - When disabled (unchecked), the driver behaves as it currently does.
    - Events are Blue on the Transmission List
    - Events with 00:00:00.00 durations miss at time of play
    - Events with 00:00:00.00 durations are marked missed on the asrun log.
    - Events with 00:00:00.00 durations generate an Error with the message "EVENT NOT PLAYED - MEDIA MISSING - NOT FOUND OR BLANK SOM OR DUR"
    - Events with blank (NULL) durations play without stop until the end of physical clip, then they are marked RAN SHORT.
    - Default setting is disabled.
  - When enabled (checked) the VDCP object will not register to play any event in the transmission list that has a blank or 00:00:00.00 Duration. (With default colors, these events remain RED on the Transmission List and do not play). The Transmission List treats this event like any other missing event.
- **Cue Non-Segmented material with Data**: Check to enable. This must be enabled to allow proper review of Multi-Segmented material. This is because in the Media Client, Segments are treated as Single-Spots for Review purpose.
12. Select **Archive** tab. (For Demo Video Disk, Demo 5-Port Video Disk)

Configure the following parameters as required:
- **Disk Has Archive**: Check to indicate the Video Disk has an associated Archive.
- **Backup Play From Archive**: Check to enable backup of playout material from the Archive.

13. Select **E to E** tab.

Configure the following parameters as required:
- **Send Disk EE Mode Commands**. (Default: disabled) These commands are only supported on certain video disks. Do not enable unless you are sure they are supported in your version. When enabled, ADCNT sends EE commands to the disk when it starts and stops playing.
This effectively makes the video disk a video player and insert switcher if the input to the port is a primary video feed, and the video disk is controlled by a ‘break away’ list. Once the video disk receives an EE command, it enters an EE controlled mode where it no longer controls the internal switcher. If EE commands are then disabled, the video disk software must be stopped and restarted so it will control the internal switcher automatically again.

- **Frames to Send EE On Early.** (Default: 2) Enter the number of frames that the EE ON command should be sent early. This box is ignored unless the Send Disk EE Mode Commands box is enabled (checked).

- **Frames to Send EE Off Early.** (Default: 3) Enter the number of frames that the EE OFF command should be sent early. This box is ignored unless the Send Disk EE Mode Commands box is enabled (checked).


Configure the following parameters as required:

- **Disk Specific Warnings.** Displays diagnostic messages used for software development and debugging. If a specific problem or suspected bug is noticed, turn on this setting. If a disk diagnostic message appears when the problem occurs, the diagnostic code associated with the message should be reported to Automation Support. Default is disabled (unchecked).

- **Items Automatically Deleted or Recorded.** This setting should only be used to verify or test that the disk is functioning properly. When enabled, diagnostic messages are only written to the error log at a client computer (if the client is configured to write error log files) when a spot is deleted, recorded or played from this disk port. Default is disabled (unchecked).

15. Select **Disk Status** tab.

The Disk Status tab is informational only. No user-configurable settings are available in this tab. Click the Refresh tab to update the displayed information.
IMPORTANT: For some video disks, such as the NEXIO, the total clips reported in Config Tool (Disk Status) may be higher than what is reported in Air Client due to the inclusion of certain hidden or system files.

16. Select Diagnostics tab.

Configure the following parameters as required:
- Diagnostics.
  - Reinitialize: Click to reinitialize the device/port. Executing this action and confirming will stop any play out or recording in progress, clear the disk status lines, clear all spots in the Device Storage Window, then initialize the disk port.
    This should only be done if the disk is not recording or playing on air, and it is felt something is hung up in the software.
This may need to be done if a videodisk communications program is brought down, then
back up, and it does not signal the ADC controller that it was rebooted.

- **ReVerify**: Click to reverify all IDs from the video disk. This action removes all IDs from the Device Storage Window that are not in any list look ahead, (no ‘*’ in the USED column) then reads all IDs from the video disk and puts them into the Device Storage Window. This should only be used if you suspect the Device Storage Window does not have the correct IDs in it (they should only be what is in the disk or to be recorded or transferred in to the disk).

Before doing this note the ID count and any suspected IDs or lack of IDs, and note if after the ID List is re-read if the IDs in the Device Storage Window are different.

Using this function reduces the efficiency of the Auto Delete (Device Parameter Delete When Full). It will still delete as needed, but the history of what spots were most recently used will be lost.

Reverify affects the most recently used information in the following way:

The ID list sort mode is always set to FIFO. If the disk follows VDCP protocol, when selecting to Re-verify IDs against the disk storage, the video disk gives the IDs following the rule that, oldest items are listed first, newest items are listed last. This maintains the usage frequency sequence.

If the video disk doesn't follow VDCP, the usage frequency sequence will be lost.

- **Make Input Port**: Specify the port as a port for recording material. This should never be needed as the software automatically changes the port type for record or play out as needed. This option allows you to manually force the port to be an input port, overriding the default configuration.

- **Make Output Port**: Specify the port as a port for playing out material. This should never be needed as the software automatically changes the port type for record or play out as needed. This option allows you to manually force the port to be an output port, overriding the default configuration.

- **Port Status**.
  - **Off Line / On Line**: Manually take the port offline and online. Click the appropriate tab (Off Line or On Line).

- **Trace Status**: Allows tracing of the VDCP communications. This gives more intelligent filtering of the data logged in order to limit the amount data produced in the log.
17. Select the **Sony Disk** tab. (For STS 10.)

Specify the following parameters as required:

- **Play.**
  - **Play latency in frames:** Enter the number of frames that the play should be send early. (Default: 0) Play command latency from CUED state in frames. In ADC this value is configured on the Prerolls/Postrolls tab with Parameter: Frames To Send Play early.

- **Record.**
  - **Record latency in frames:** (Default: 0) Record command latency from CUED state in frames. In ADC this value is configured on the Prerolls/Postrolls tab with Parameter: Frames To Send Record early.
  - **Record Confidence Stream:** <<IMPORTANT: This parameter is currently unused. It exists only for historical reasons. In future builds this parameter will be removed from driver’s configuration.>>

- **Free Space.** Space remaining in the server. Duration/size of the largest spot on the server.
  - **Space Remaining:** Shows available free space on the server.
  - **Largest Spot:** Shows available free space on the server.
  - **Refresh:** Click to refresh the free space display.

18. Select the **Stream Set** tab. (For MAV70). A Stream on the Device Driver represents a media input or output on the physical device. It is possible to have two or more instances of a driver in a single Device Server. The only limitation – all instances should control different ports.
Use this tab to set up channel count and type of each channel.

Specify the following parameters as required:

- **Stream 1, 2, 3, 4, 5**: For each Stream 1-5, select the stream and then on the Stream configuration dialog specify...
  - **Serial Port**: Enter the serial port which controls this video port. Use the dropdown menu to select the port (No Port, 1, 2, 3...64).
  - **Stream Type**: The encoder or decoder type of a video port. Use the dropdown menu to select the Stream type. Options are: Encoder, CoDec, Decoder.
  - When finished click **Apply**, and then click **OK**.

19. **Apply the Configuration Changes**: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

   **Note**: Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

20. **Save the Configuration**: From the Configured Devices window select **File> Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

   - Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

**DTP Insertion Driver**

The driver talks to DTP using RCS (Remote Control System) protocol via TCP/IP. So, there should be TCP/IP connection between ADC100 and DTP. By default, it uses port number 49227. There is also java based GUI, jRCS (see image below), that it comes with DTP. Any java capable client PC can get the codes just by connecting to DTP. Please refer to DTP’s manual for the detail.
• **The DTP Insertion driver** is intended to control Cueing and Splicing of clips and input programs with the DTP through the use of Primary or Secondary AV (SAV) events within the Transmission List. The device itself should be configured first as desired by using jRCS, then the driver can be configured in ADC100 based on the DTP’s configuration.

• **The DTP-20 driver** is used primarily to control Logos and text, and text crawls within the DTP stream by using secondary A/V events for cueing and playing. The DTP Insertion driver uses Primary or Secondary AV (SAV) events and users can check the Device Storage window upon the Client applications to view the DTP clip storage.

• **Working in Conjunction**: The DTP Insertion Driver can work in conjunction with ADC’s legacy DTP-20 Driver. These drivers can be assigned to the same ADC Playlist for dual control of the DTP (i.e. Both drivers can be assigned separately to the same ADC Playlist for playout of Clips, Input Programs, Graphics, and graphic effects.) In addition, when configuring the Communications parameters on each of our DTP drivers, they can both share the same cable, network IP address, and Port #.

**Driver Use Note:** If intending to utilize features on both DTP drivers, contact Sales and Support to determine how both drivers can be enabled in your Device Server Build.

---

**Summary of function lists**

- Cueing and Splicing of clips and input programs to a configured DTP output program
- Viewing of DTP clips and, if configured, input programs at Air Client or Media Client storage window
- Assigning output programs to driver streams.
  - The Driver stream handles one DTP output program.
  - Programs assignment is configurable at the driver configuration form
- Supported events
  - Primary or Secondary AV (SAV) events are supported
  - Supported Primary event types are A, AO (hard start) and U (up-count event) in combinations AU and AOU.
- When the DTP Insertion driver is assigned to the same list as the video file server that plays the stream over which the insertions will occur, there is a potential for registration conflicts. To manage this issue the DTP Insertion Driver configuration supports playout qualifiers.

---

**To configure the DTP Insertion Driver**

Use the following procedure to configure this driver.

1. Under **Video Disk Servers (VDCP)** in the Available pane (right pane), select the DTP Insertion device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To configure Sync Skip after a GPI (input)" on page 56).

2. Select the DTP Insertion device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the **General** tab. The Client ID parameter must be unique in different instances of DTP insertion driver (or instances of older DTP drivers, such as "DTP-20" used to control logos and text crawls). The value is used as a cookie in commands to and from DTP to let drivers determine which instance should process DTP reply.
By default the driver sends Splice command to DTP server before program "Splice Pre-roll" time which is configured at jRCS client. If it is necessary to send Splice command some time prior to "Splice Pre-roll time", then use the "Frames to Send Splice Early" parameter. It is zero by default.

4. Select the **Socket** tab. The DTP IP address and the port number are required. The default port for RCS port is **49227**.

If log setting is enabled, all the communication logs are captured in a log file in "\Log\DtpInsertion" directory. Please use logging only if you have problems with using driver and remember, since there is no log file management using logging may result in eating up local hard disk space.
Note: The following graphic is for reference only. The information on your tab screen will show the discrete IP Address of the DTP Server, which is its own Linux box, not local to the Device Controller (Device Server).

5. Select the Streams tab. This tab allows the mapping any of active DTP output program to any available stream using drag and drop. The mechanism is similar to assigning driver streams to lists. During configuration of multiple instances of this driver which will communicate with a single DTP, output programs must not be assigned to more than one stream in different instances.

Note: If any assigned to stream program was deleted or become not active after the driver re-initializes, the stream heads must have "OFFLINE" status at Device status window.

Note: Only Active output program references are displayed at Available list.
6. Select the **Prerolls** tab. Use this tab to configure instant preroll and postroll values for the DTP insertion driver. Instant preroll and postroll values are applied to all driver heads.

Configure the following parameters as required:

- **Instant Prerolls.**

  The Instant feature is designed for coming out of a live or upcounting event as fast as possible when the next event has a near instant preroll. If you are using a master control switcher, the preroll must not be shorter than the shortest preroll supported by the switcher.

  - **Use Instant Prerolls.** This function has a default of zero seconds, four frames. The values can range from four frames to 59 seconds. Instant Preroll provides instant play/skip capability to the device. When enabled, Instant Play Preroll is activated by pressing the Instant button or Roll Now button on the control panel. The preroll must be set to at least the minimum switcher preroll or the disk port may start playing before the switcher switches.

  The preroll also must be set to at least four frames greater than the Disk Preroll and Number of Frames to Send Play Early. Four frames is the minimum preroll allowed by ADC. If not configured properly, the list may stop, or Roll Now may not work as expected, but take a longer time than desired.

  If Instant Preroll is set longer than the List Preroll, instant play is actually a delayed play. ADC operations rely on list preroll settings configured through the Options menu, in Configure Lists.

- **Device Postroll.**

  - **Use Postroll.** Default: Disabled, zero seconds, four frames. Range: four frames to 59 seconds. When enabled, this settings overrides other configured postroll settings. Device postroll, if enabled, must be set to at least 4 frames.

  This feature allows the list to use one postroll for VTRs, cart machines, and other devices, and a different postroll for video disks. The Device Postroll can be longer or shorter than the list postroll. Its main purpose is to clear out the disk status line quickly after the disk stops...
playing, so the status line can be loaded with the next event to cue. This allows small spots to be played back to back.

If the Device Postroll was set to a larger value, and the disk had over recorded the ID compared to the play duration, the disk would continue to play for the post roll duration if on air play switched to another device. This would permit mix effects during the post roll of the disk device into the play out from another device.

- **Seconds.** Select a value of up to 59 seconds.
- **Frames.** Select a value of at least 4 frames.

**Note:** The Seconds and Frames values have no effect unless the Use Postroll box is enabled (checked).

7. Select the **AutoReturn** tab. This tab is used to set – by stream - the input program which will be spliced after clip insertion.

- **Requirements:** The following requirements must be met for this feature to work:
  - "Auto Ripple Times" option at "Options" tab of the list properties window must be enabled for correct operation of the Auto-Return feature. The option must be enabled for all lists which will run DTP Insertion events with enabled Auto-Return.
  - An Input reference, which will be set as default Source (Auto-Return program), must be active.
  - About points A and C from MRD (\{Clip Playing\} / \{Clip Cued\} → \{Clip Cued\} / \{Idle\} and .\{Clip Playing\} / \{Source Cued\} → \{Source Cued\} / \{Idle\}). The recommended minimal interval between the end of the first event (not postroll) and preroll of the second one is 3 seconds. Splice to the second event can fail if the interval is lesser then 3 seconds. The back to back splice is not affected.

Configure the following parameters as required:

- **Stream 1 – 8:**
  - Check "Enabled" to enable a stream.
  - **Input Program name:** Each driver stream has a combo box populated with available ACTIVE input names. An error message is displayed if an incorrect input name is entered. It is
recommended not to type it, but instead choose the input from the combobox to avoid an incorrect input.

**Note:** Auto-Return settings are saved into ADC100NT.ini file with key "DTP_StreamARProgram%d", where %d is the zero based stream number.

8. Select the **Qualifiers** tab. When the DTP Insertion driver is assigned to the same list as the video file server that plays the stream over which the insertions will occur, there is a potential for registration conflicts. To avoid this issue use this tab to add playout qualifiers to the DTP Insertion Driver configuration.

**Note:** This functionality is supported by ADC v12.19 and higher.

Configure the following parameters as required. Any combination of qualifiers may be used, or they all may be disabled.

- **Playing Event Qualifiers.**
  
  Event qualifier means playlist events must satisfy the selected qualifier before being allowed to play out through this VDCP port. If they do not pass the qualifier check, the event is not registered to this port, and is not allowed to play.

  - **Primary Event**: Select (check) this option, if this VDCP disk port allows primary events to play. Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Secondary to this VDCP disk port, and register Primary events to other devices, such as VTR.

  - **Secondary event (without Data Event)**: Select (check) this option, if this VDCP disk port allows secondary events to play. Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Primary to this VDCP disk port, and register Secondary events to other devices, such as VTR.

- **Duration Range.**
  
  If a duration qualifier is enabled then the disk port will not play any ID whose duration is greater (or less) than the number of minutes specified in parameter.
• **No Events Greater Than (Mins):** Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).

• **No Events Less Than (Mins):** Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).

- **ID Range.**
  This qualifier is useful where some IDs are to be played and others not, and the Duration qualifier cannot distinguish between them.
  - **Qualify Events by ID:** Check to enable qualification.
  - **Only Event with ID Between:** Check to enable. Then specify range in the associated number field. If this qualifier is enabled, then the disk will only play IDs whose first character is between or equal to the ‘--to--’ limits.
    
    **For example:** If only IDs starting with a ‘9’ are to be played, enter a ‘9’ in both boxes. To play only IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters.

  - **No Event with ID Between:** Check to enable. Then specify range in the associated number field. If this qualifier is enabled, then the disk will ignore IDs whose first character is between or equal to the ‘--to--’ limits.
    
    **For example:** To ignore and not play IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters.

  - **from -- to --:** Alphanumeric entry. Specify range. Up to 32 characters can be entered into each field.
    
    ‘A’ to ‘Z’ and ‘a’ to ‘z’ are permitted, and uppercase letters are sorted before lower case letters, and uppercase letters are sorted after numbers.

9. **Select the Diagnostics tab.** Users can hit the "Reinitialize" button when needed. The driver will close TCP connection, reset it state machine, and reread programs and clips collections.

**Important Note:** Pressing the "Reinitialize" button stops all splicings on all DTP Streams that are currently in progress. If it is necessary to update programs and clips collection without stopping splicing, use the "ReVerify" button.
10. **Apply the Configuration Changes**: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

**Note:** Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

11. **Save the Configuration**: From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

- Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.
- Closing Device configuration prompts to save the configuration. The configuration information is saved to the ADC ini file (e.g. "ADC100NT.INI").

---

### Video Disk Configuration (API/IP Driver)

The following is an example video disk configuration (NEXIO IP, GVG K2 IP, Omneon Spectrum IP). Your device may have slightly different options and the selection of configuration tabs may be different for that device. For configuration details refer to the User Notes for your device.

**IMPORTANT Note:** Due to significant differences in configuration dialogs, the VDCP Video Disk Configuration drivers are addressed under their own section. For details see [Video Disk Configuration (VDCP driver)](on page 60).

### Additional Port of Same Disk (w/ Air Protect)

The following procedure outlines setting up Additional Port of Same Disk functionality on an IP driver.

1. Configure two pairs of IP drivers: two from one disk and two from another.
2. Configure the first pair using ‘Additional Port of Same Disk’.
   - On the Config screen select Global > Port
     - **Additional Port Of Same Disk**: Use this parameter to enable alternating playout of two streams on the same disk for the same list. Select the additional stream from the drop down list.
   **IMPORTANT:** Additional port of same video disk works only if you are using it with two separate IP Multi Stream drivers.
3. Configure the second pair (taken as protected) using Additional Port of Same Disk.
4. If the first pair is configured with additional port reference, then configure the second pair in the same way.
5. Assign first pair to list as Air and second pair as Protect to Air disks accordingly.
6. In Air Client add several events to the list and Cue it.
   - Events are registered in rotation in both Device and Protect columns.
To Configure a NEXIO Video Disk (API/IP Driver)

ADC supports up to 8 ports per NEXIO native driver and can support numerous NEXIO Native drivers. Each port used by the customer counts against their total number of individual ports purchased.

Driver Limitations

- Cloning: This ADC feature is currently not supported with the NEXIO Native Driver, as this feature does not support IP devices.
- AFD: ADC currently does not support overwriting current NEXIO Active Format Description parameters. Support for AFD is targeted for future ADC releases.
- SD/HD Filtering feature does not apply to Record ports/streams
- If the New AFD of a CUED event is changed to an unsupported value: the event will remain blue and will not turn red, the new unsupported value will not be applied, and clip will be played with its original New AFD.

IMPORTANT - Required Configuration changes: Configuration changes are required on the Device Server and NEXIO server to maximize the performance of IP control. For details see the NEXIO IP User Note.

Multi-Stream Driver Limitations

All new video servers can be controlled through TCP/IP connection. These drivers have more than one stream (Port) and therefore are very different from common drivers for video servers which required all streams to have the same parameters. Multi stream driver configurations allow each stream to be assigned its own parameters. However, ADC100/1000 limitations impact its use.

Example: The following example configuration is used to illustrate the impact of ADC100/1000 limitations. If two Ports of a NEXIO device are assigned to the same list and have the same type (for example, both ports are Player), two possible configurations can be established:

- Case 1: Use two copies of the driver (one driver for each port).
- Case 2: Use only one driver and select both Ports as Player.

Impact on Feature/Functions:

- Auto Copy:
  - Case 1: The "Auto Copy" function will only work if both Ports belong to the same Media list and use one port as Source and the other port as Preview/Review.
  - Case 2: The "Auto Copy" function will work only if the Source port number is less than the Preview/Review Port number. If it is not, Auto Copy will not work.
  - Case 3: If the Preview/Review port is removed from the Media List, then Auto Copy will work.
- Air Protection:
  - Case 1: Air Protection will work.
  - Case 2: Air Protection will not work.

Recommendations:
• If different streams of the same device are used as the source and review devices at the same time, it is recommended to use the stream with the smaller number as the source and the stream with the larger number as the review.

• If, for some reason, it is necessary to use the stream with the smaller number as the source device, and the stream with the larger number as the review device, manually unassign the review device from the Media List with the help of the Config Tool right after the Prep Form is opened.

This second Recommendation may only be used when the "Review with Switching" feature is disabled.

About NEXIO ARC (Aspect Ratio Conversion) override

The NEXIO Native IP driver can control ARC (Aspect Ratio Conversion) override. It uses Secondary Events to trigger the ARC on the NEXIO Port.

Many stations use override control of the NEXIO Aspect Ratio Conversion (ARC). The NEXIO media file's ARC is typically set at the point of ingest. NEXIO users can set a default Port ARC which can be used for their 24/7 playout. This default port ARC setting can be changed by a user or by Automation.

Automation Network Consideration

To take advantage of the Extended Device Storage Window view on the ADC Clients, the NEXIO and the ADC Clients must be on the same LAN. If the NEXIO and ADC Clients are on separate LANs, then only the standard Device Storage Window view is available.

NEXIO high-speed Mediabase poll method

ADC v12.23 and higher supports NEXIO's new API for getting - at full wire-speed - all IDs in Nexio Mediabase with all metadata. This allows populating data in the hundreds of megabits rate instead of laboriously polling each ID for each metadata field and extended metadata (28 polls per ID in all).

To configure the NEXIO Driver (API/IP)

1. Under Video Disk Servers (API/IP) in the Available pane (right pane), select the NEXIO IP device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the NEXIO IP device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device.
Note: The settings within the Global Section of the multi stream driver will have an effect upon all of the configured Streams. Unique settings may be stored per each Stream within the Stream configuration portion of the multi stream driver.

3. In the navigation pane expand the Global entry and then select **General**. Available options may differ depending on the device selected.

Configure the following parameters as required:
**Device Name:** Specify the name of the driver into the ADC1000NT configuration. Change this to the preferred name for the device, up to 16 characters. (Default: "NEXIO"). The device name identifies the disk port.

*Note: When an event is threaded, an extra character - the head number - is added to the end of the name.*

The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

**Options:**
- **Report Spot Shorter than Scheduled:** Check to enable reporting. (This setting is not supported by the NEXIO Driver.)
- **Disable heartbeat checking for device air protection:**
  - **Checked:** The Driver will not check if the device lost heartbeat.
  - **Unchecked:** The driver will sense the lost heartbeat error and try to reset and reconnect with the device.

*Recommendation:* Uncheck unless the device can’t reply heartbeat checking query command from driver.

4. In the navigation pane expand the Global entry and then select **Communications**. Use this tab to specify the TCP configuration.

Specify the following parameters as required:
- **IP:** IP address of the controlled NEXIO/VR device.
Note: The NEXIO server allows up to 16 (VR) TCP/IP connections (The driver will use up to 8 connections).

- **Port**: IP port of the controlled NEXIO/VR device. TCP/IP communication is conducted on this port. (Range: 1:65000) (Default: 557)

Note: The NEXIO driver creates (configured channels + 1) separate links (socket connections) to server. There shouldn’t exist more than 56 connections to a single server. Other control application such as NXOS also creates several connections.

5. In the navigation pane expand the Global entry and then select **Prerolls/Postrolls**.

![NEXIO Prerolls/Postrolls Configuration](image)

Configure the following parameters as required:

- **Prerolls**.
  - **Frames To Send Play Early**: The default should not need to be changed unless the disk has a fixed latency of greater than one frame for the play command. This setting determines when (number of frames) the video disk port should receive the play command before playout is performed. A setting of zero sends the play command to the disk port the frame before the command is performed. (The default values shown in the screen shot above are recommended starting points. Your settings may differ.) Typically, the setting should never be greater than four frames less than List Preroll or Instant Preroll or the disk port will not play and the list will stop. If Disk Prerolls is used, the Frames setting should be the same value unless a frame or two of switcher timing compensation is required.

- **Frames To Send Record Early**: The default should not need to be changed unless the disk has a fixed latency of greater than one frame for the play command. This setting determines when (number of frames) the video disk port should receive the record command before
recording is performed. A setting of zero sends the record command to the disk port the frame before the command is performed. (The default values shown in the screen shot above are recommended starting points. Your settings may differ.)

Typically, the setting should never be greater than four frames less than List Preroll or Instant Preroll or the disk port will not play and the list will stop. If Disk Prerolls is used, the Frames setting should be the same value unless a frame or two of switcher timing compensation is required.

6. In the navigation pane expand the Global entry and then select **Storage**.

Configure the following parameters as required:

- **Automatically Delete From Disk When Full.** The automation system ensures that the specified amount of free disk space is maintained. Material is deleted from the disk automatically, based on a first-entered, last-played formula. Example:
  
  A disk has 1000 spots on it, numbered 1 through 1000. Spot 23 is played, at which point it is assigned a new number of 1001. Spot 65 is then played, at which point it is assigned a new number of 1002. Each time a spot is played, it is incremented using this same sequence. As a result, spots that have been on the disk the longest without ever being played have the lowest numbers, and are deleted first. If material must be deleted on the disk, the lowest number would be deleted first, then the second lowest number, then the third lowest, etc. Default is disabled (unchecked).

  Spots registered in the Lookahead are never automatically deleted.

- **Disk Space to Keep Free (Mins).** The default is 10 minutes. The range is from 0 to 32,000 minutes. This parameter attempts to keep the disk with at least the entered number of minutes of disk space free. This prevents trying to record something larger than the available amount of
time, then having to delete the unfinished (truncated) item. For playout, the default value is typically used. Set this to the size of the largest ID you expect to record if Automatically Delete From Disk When Full is enabled. This parameter should be used in time delay and record event applications. It is not recommended to set the value below four minutes (since all space available numbers are estimates due to variable rates of compression on different video images). This parameter has no effect unless Automatically Delete From Disk When Full is enabled.

- **Prevents ‘In-Use’ Clips from Being Deleted**: Enable/Disable deletion of In-Use clips.
  
  Checked: (Recommended) Users can’t delete an ID when it is inside the lookahead of a list from any clients.

  Unchecked: Users can delete any event from the disk storage collection window of clients.

  **Note**: This parameter ONLY works when the operator attempts to delete clips from the Storage Window. The Purge List ignores this setting and might delete events that are in the current transmission lists’ lookaheads.

  **Note**: When "Prevents ‘In-Use’ Clips from Being Deleted" is enabled and the "Allow Delete IDs from Storage Window" is also enabled in the "Storage Options" tab of the Air Client, attempting to delete in-use clips in the Device Storage Window results in a confirmation popup. Clicking OK on the Confirm message will not result in these in-use clips being deleted. This applies to in-use clips that are not Protected and are not in a CUED state.

7. In the navigation pane expand the Global entry and then select **Reporting**.

Configure the following parameters as required:

- **Disk Specific Warnings**: Displays diagnostic messages used for software development and debugging. If a specific problem or suspected bug is noticed, turn on this setting. If a disk
diagnostic message appears when the problem occurs, the diagnostic code associated with the message should be reported to Automation Support. Default is disabled (unchecked).

- **Items Automatically Deleted or Recorded.** This setting should only be used to verify or test that the disk is functioning properly. When enabled, diagnostic messages are only written to the error log at a client computer (if the client is configured to write error log files) when a spot is deleted, recorded or played from this disk port. Default is disabled (unchecked).

8. In the navigation pane expand the Global entry and then select **Ports**.

Configure the following parameter as required:

- **Additional Port Of Same Disk**: Use this parameter to enable alternating playout of two streams on the same disk for the same list. Select the additional stream from the drop down list.

  **IMPORTANT:** Additional port of same video disk works only if you are using it with two separate Nexio Multi Stream drivers.

- **Disk Port Comm. Timeout (frame)**: Specify the time-out period (in frames) which the driver uses to determine that the connection is lost. Default value of this option is 10 frames – that means that if there is no reply from the device (on any command) during this time, then the driver starts to reinitialize.

  **Note:** Another application for this option is related to AirProtect functionality (all of these are also true for VDCP driver). Regardless the reason (device error, internal driver error, etc.) the driver reports that the transport command failed if the driver did not get PLAY (CUED) status after appropriate command during:

  - **PLAY**: Timeout value (frames)
  - **CUE**: Timeout value*3(frames)
9. In the navigation pane expand the Global entry and then select a Stream 1 – Stream 6.

The selections for Stream 1 - Stream 6 provide the same configuration criteria. Use these selections to set up channel count and type of each channel. In ADC channels are treated as streams.

A Stream on the Device Driver represents a media input or output on the physical device. It is possible to have two or more instances of a driver in a single Device Server. The only limitation – all instances should control different ports.

Specify the following parameters as required:

- **Port Type**: Specify the type of ADC stream. Each NEXIO port appears in ADC as a stream with two heads (Stream one have heads number 1 and 2, stream two – 3 and 4, and so on. Stream X always controls physical NEXIO Server port X.)

  Each stream may be configured as:
  
  - Disabled
  - Encoder (record only),
  - Decoder (play only),
  - Encoder/Decoder (both play and record)

  **Note**: Currently, the configuration should match the device abilities. Setting a play-only stream as "Encoder" will not lead to an error, but record events will be skipped. If there is at least one "Encoder" or "Encoder/Decoder" stream, then enable "Recording of Record Events" on the "Recording" tab.

Currently ADC Media Client has the following limitation:
Even if some driver instances have configured ports 5 and 6 of a NEXIO Device, they will be shown as STRM1 and STRM2 in a Prep Form Configuration window. Nevertheless, the "List Configurations" window contains the actual port names.

- **Reinitialize**: If a NEXIO stream becomes non-responsive to Automation commands, then click this button to reinitialize a single NEXIO Stream. This does not impact other NEXIO streams when selected or pressed.

10. In the navigation pane expand a Stream 1 – Stream 6 and then select **General**.

Configure the following parameters as required:

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name (Default: NEXIO). When an event is threaded, the head number is added to the name.

  The name is also used to identify the stream used to execute secondary data events. If a stream's name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

- **Options**.
  - **Stop Disk Play/Record on Init**: A stop command is issued to the disk whenever the Device Server is started or the port is re-initialized. When disabled, the Device Server connects to the video disk port if it can. If it cannot, the port must manually be re-initialized on the Device Server (under System, Diagnostics). When disabled, it is the operator's responsibility to check the port status in the Device Status Window and the IDs in the Device Storage Window and re-initialize if required. Default is enabled (checked).
Note: Some sites prefer to DISABLE on ports the play to Air, and also Auto Record List ports.

11. In the navigation pane expand a Stream 1 – Stream 6 and then select PreRolls/PostRolls.

Configure the following parameters as required:

- **Instant Prerolls.**
  The Instant feature is designed for coming out of a live or upcounting event as fast as possible when the next event has a near instant preroll. If you are using a master control switcher, the preroll must not be shorter than the shortest preroll supported by the switcher.

  - **Use Instant Prerolls.** This function has a default of zero seconds, four frames. The values can range from four frames to 59 seconds. Instant Preroll provides instant play/skip capability to the device. When enabled, Instant Play Preroll is activated by pressing the Instant button or Roll Now button on the control panel.

    The preroll must be set to at least the minimum switcher preroll or the disk port may start playing before the switcher switches.

    The preroll also must be set to at least four frames greater than the Disk Preroll and Number of Frames to Send Play Early. Four frames is the minimum preroll allowed by ADC. If not configured properly, the list may stop, or Roll Now may not work as expected, but take a longer time than desired.

    If Instant Preroll is set longer than the List Preroll, instant play is actually a delayed play. ADC operations rely on list preroll settings configured through the Options menu, in Configure Lists.

    - **Seconds.** Select a value of up to 59 seconds.
    - **Frames.** Select a value of at least 4 frames.
- **Device Postroll.**
  - **Use Postroll.** Default: Disabled, zero seconds, four frames. Range: four frames to 59 seconds. When enabled, this setting overrides other configured postroll settings. Device postroll, if enabled, must be set to at least 4 frames.
  
  This feature allows the list to use one postroll for VTRs, cart machines, and other devices, and a different postroll for video disks. The Device Postroll can be longer or shorter than the list postroll. Its main purpose is to clear out the disk status line quickly after the disk stops playing, so the status line can be loaded with the next event to cue. This allows small spots to be played back to back.
  
  If the Device Postroll was set to a larger value, and the disk had over recorded the ID compared to the play duration, the disk would continue to play for the post roll duration if on air play switched to another device. This would permit mix effects during the post roll of the disk device into the play out from another device.
  
  - **Seconds.** Select a value of up to 59 seconds.
  
  - **Frames.** Select a value of at least 4 frames.

**Note:** The Seconds and Frames values have no effect unless the Use Postroll box is enabled (checked).

**Note:** The settings for Frames To Send Play Early and Frames to Send Record Early are located within the Prerolls/Postrolls tab within the Global section.

12. In the navigation pane expand a **Stream 1 – Stream 6** and then select **Storage**.

![Stream 1 - Enabled: Storage](image)

Configure the following parameters as required:

- **Delete IDs After Play.** Deletes a played event from the video disk. This is typically only enabled for testing or when recording for a one-time playout. Default is disabled (unchecked).
For testing, this allows a short list of spots, repeated continuously, to record or cache. The spots are then continuously deleted. For actual on-air playout, the setting automatically deletes from a disk when it is full. This keeps the disk filled with the most current spots to reduce multiple recording or caching of a spot repeated more than once. This function only deletes a spot if it is completely played out, and was recorded by this port.

13. In the navigation pane expand a Stream 1 – Stream 6 and then select Recording. This dialog is available only for an Encoder or Encoder/Decoder stream and is grayed out for a Decoder stream.

Configure the following parameters as required:

Any combination of record qualifiers may be used, or they all may be disabled. The recording qualifiers are effective on record events and caching, and Secondary Record Device Events. This is useful in caching to record only IDs that are commercials as they are short and not program material (program material normally has a segment number). Default is disabled.

- **Allow Recording.**
  - **Recording of Record Events.** Allows recording of record events or other types of recordings. When disabled, the disk port will not record. Recording with segment play enabled is equivalent to performing an insert edit or assemble record, depending on the SOM (if the video disk server supports this function).
  - **Record Only No Playout.** When enabled, this port will not play any material. This was added to the software so a port can be assigned to a playlist for recording, with a separate port assigned for playout. Without enabling this parameter, if one port goes down, the other port will try to do both (record and playout). Since it cannot do both at the same time, the list will not work properly. Default is disabled.
- **Disable Recording With Segments.** If enabled, the disk port will not record any event with a segment number in it. Default is disabled (unchecked).

- **Record Only Segments.** Record only events with non-blank segment fields. If not enabled, the disk port will not record any event with a segment number in it.

- **Prevent Recordings Greater Than (Mins).** Check to enable, then specify a maximum length (in minutes) for any recording. When this parameter is enabled, the disk port will not record any ID whose duration is greater than the number of minutes specified in parameter.

- **Prevent Recordings Less Than (Mins).** Check to enable, then specify a minimum length (in minutes) for any recording. When this parameter is enabled, the disk port will not record any ID whose duration is less than the number of minutes specified in parameter.

- **Only Record Events with ID in.** Check to enable, then specify the event range ‘--to--’ limits. When enabled, the disk will only record IDs whose first character is between or equal to the limits. Numeric and alphabetic entries (upper and lower case) are permitted.

  **For example:** If only IDs starting with a ‘9’ are to be recorded, enter a ‘9’ in both boxes. To record only IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters. ‘A’ to ‘Z’ and ‘a’ to ‘z’ are permitted, and uppercase letters are sorted before lowercase letters, and uppercase letters are sorted after numbers.

  The ID qualifier is useful where some IDs are recorded and others not, and the Duration and Segment qualifiers cannot distinguish between them. The traffic system can designate a certain range of IDs that will be cached or recorded only.

14. In the navigation pane expand a **Stream 1 – Stream 6** and then select **Recording Parameters**. Use this tab to set record parameters.

- This step is optional.

  Please note that setting up record parameters is allowed only for Encoder and Encoder/Decoder type ports. This dialog is available only for an Encoder or Encoder/Decoder stream and is grayed out for a Decoder stream.

  **Record Parameters** is equivalent to NEXIO Native API Protocol Set Record Parameters (C8 C1) command.

**About Recording Clips:** To record a clip, streams/ports must be assigned and used in the appropriate order:

- **Stream/Port 1 - rec**
- **Stream/Port 2 - review**
Note: A clip cannot be recorded if both streams/ports are assigned to one Media list, but the review device isn’t assigned in Media Client.

Specify the following parameters as required:

- **Record Channel**: Select a record channel to configure (Stream 1 – 6). A message is displayed indicating its current configuration status.

- **Record Parameters**.
  - **Video format**: From the dropdown list, select a supported video format encoding algorithm (i.e. MPEG2, DV, etc.) used for recorded clips.
  - **Video N**: The total size of Group of Pictures (GOP). Possible values are: 1 - 16.
  - **Video M**: The distance between reference picture frames in Group of Pictures (GOP). Possible values are: 1 – 3. Must be an equal divisor of Video N value.
  - **Bit Rate (Mbps)**: Manually enter the compressed bit rate in Mbps of the video portion of the clip being recorded. The highest value this parameter can be set to is 500 Mbps.
  - **Audio Channels**: The number of Audio channels / tracks currently enabled. (Range: 1-6)
  - **VBI Present**: Check if Vertical Blanking Interval (VBI) data is present in the video.
  - **Aspect ratio**: Select the aspect ratio being used for clips: 3:4, or 16:9.

About GOP:

GOP is an MPEG term meaning Group Of Pictures. It is a collection of consecutive frames of video. Usually between 0.5 and 1 second of video will be held in 1 GOP. Each picture within the GOP can be 1 of 3 types: I, P, or B.

Note: A GOP always starts with an I picture.
<table>
<thead>
<tr>
<th>Type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>I (Intra)</td>
<td>A complete picture that can be decoded without the need to decode any other pictures first. It is similar to a JPEG still image.</td>
</tr>
<tr>
<td>P (Predicted)</td>
<td>P frames are predicted from the previous &quot;reference&quot; (I or P) frame. If the encoder can find correlation between the previous reference and the P frame, macroblocks in the P frame will be derived from the reference with a motion vector and DCT difference information. In the case where a good match cannot be found, the P frame will contain some intra coded macroblocks.</td>
</tr>
<tr>
<td>B (Bidirectional)</td>
<td>These are predicted from the previous and future reference frames. The encoder can use macroblock information each of these frames to produce the best match for each macroblock in the B frame. If no good matches can be found the macroblock will be intra coded.</td>
</tr>
</tbody>
</table>

About Supported Video Formats:

The NEXIOVR driver supports all video formats currently supported by NEXIO.

- **Video Format List Rule Process**: The following table outlines the rules for forming a list of currently available record formats:

<table>
<thead>
<tr>
<th>NEXIO channel support:</th>
<th>NEXIO channel support for recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>JPEG</td>
</tr>
<tr>
<td>MPEG2 4:2:0</td>
<td>MPEG2 4:2:0</td>
</tr>
<tr>
<td>MPEG2 4:2:2</td>
<td>MPEG2 4:2:2, IMX (MPEG 4:2:2)</td>
</tr>
<tr>
<td>DV, all types</td>
<td>DVCAM (DV25), DVCPRO (DV25), DVCPRO HD (DV50)</td>
</tr>
<tr>
<td>H.264, MPEG4 Part 10 (Long GOP, AVC)</td>
<td>H.264 4:2:0, H.264 4:2:2</td>
</tr>
<tr>
<td>AVC-Intra, MPEG4 Part10 (I-Frame, AVC)</td>
<td>H.264[4:2:0] CBG (AVC-Intra class 50)</td>
</tr>
<tr>
<td></td>
<td>H.264[4:2:2] CBG (AVC-Intra class 100)</td>
</tr>
</tbody>
</table>

* Other record formats are always unavailable.

For example if NEXIO channel returned the following list of supported formats:

MPEG2 4:2:0, MPEG2 4:2:2, DV, all types,
then the available record format list will contain:

MPEG2 4:2:0, MPEG2 4:2:2, IMX (MPEG 4:2:2), DVCAM (DV25), DVCPRO (DV25), DVCPRO HD (DV50)

**Note**: The driver can’t automatically determine SD or HD channel mode, so some formats may be unavailable for recording even if they present in list of video format. For example if NEXIO channel returned DV, all types then video format will contain DVCAM (DV25), DVCPRO (DV25), DVCPRO HD (DV50), but if channel is in SD mode, then DVCPRO HD (DV50) actually is unavailable.

- **Video Format on the Recording Parameters sheet**:

The Configuration form can’t populate the record video format list until a port is initialized (the port has to determine what formats are currently available and this is possible only when the port is enabled), so the ‘Recording Parameters’ sheet is enabled only when port is...
type is Encoder or Encoder/Decoder and initialization of a port is complete. The following is an example of all video formats listed.

15. In the navigation pane expand a **Stream 1 – Stream 6** and then select **Qualifiers**. Use this tab to set playing event qualifiers.
Configure the following parameters as required:

Any combination of qualifiers may be used, or they all may be disabled.

- **Playing Event Qualifiers**: Event qualifier means playlist events must satisfy the selected qualifier before being allowed to play out through this VDCP port. If they do not pass the qualifier check, the event is not registered to this port, and is not allowed to play.
  
  - **Primary Event**: Select (check) this option, if this VDCP disk port allows primary events to play.
    
    Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Secondary to this VDCP disk port, and register Primary events to other devices, such as VTR.
  
  - **Secondary event (without Data Event)**: Select (check) this option, if this VDCP disk port allows secondary events to play.
    
    Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Primary to this VDCP disk port, and register Secondary events to other devices, such as VTR.

- **Duration Range**: If a duration qualifier is enabled then the disk port will not play any ID whose duration is greater (or less) than the number of minutes specified in parameter.
  
  - **No Events Greater Than (Mins)**: Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).
  
  - **No Events Less Than (Mins)**: Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).

- **ID Range**: If the ID qualifier is enabled, then the disk will only play IDs whose first character is between or equal to the ‘--to--’ limits.
  
  This qualifier is useful where some IDs are to be played and others not, and the Duration qualifier cannot distinguish between them.
  
  - **Only Events with ID Between**: Check to enable. Then specify range in the associated number field.
    
    **For example**: If only IDs starting with a ‘9’ are to be played, enter a ‘9’ in both boxes. To play only IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters.
  
  - **No Event with ID Between**: Check to enable. Then specify range in the associated number field.
    
    **For example**: To ignore and not play IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters.
  
  - **from -- to --**: Alphanumeric entry. Specify range for the two options. Up to 32 characters can be entered in each field.
    
    ‘A’ to ‘Z’ and ‘a’ to ‘z’ are permitted, and uppercase letters are sorted before lower case letters, and uppercase letters are sorted after numbers.
16. In the navigation pane expand a Stream 1 – Stream 6 and then select Segments.

Configure the following parameters as required:

- **Modify Segment IDs (# of Characters)**: Up to two characters can be added to IDs. Useful for multi-segment recording, this option causes the ID on a video disk to be appended with either 1 or 2 characters to distinguish the segments.
  - If you never use more than 9 segments in any ID, select 1 character (which allows up to 9 segments). If you select 2 characters here, a maximum of 99 segments is allowed. Valid numbers are 0, 1, and 2. Default is 0.
  - **Example**: If Modify Segment IDs (# of Characters) were set to 2, a 3-segment ID titled "spot" would reside on the video disk as "spot01," "spot02," and "spot03." If the disk has a maximum of 32 characters allowed for an ID, the ID is truncated on the disk if the ID takes up 30 or more characters (2 characters are lost to allow for the 2 segment characters).

- **Segment Play Search path**: Use this parameter to specify segmented program ID search through various settings of the Modify ID parameter. For media play out, the first valid setting is used. The list permits each setting to be individually enabled or disabled, and for the order in which they are checked to be defined. Populating the search path with a single entry matching the fixed settings allows operation identical to current behavior.
  - Select a listed segment then use the associated buttons to arrange:
    - **Up / Down**: Use these buttons to position the segment in the list.
    - **Enable**: Use this button to enable a selected segment.
    - **Disable**: Becomes active when Enable is selected. Use this button to disable a selected segment.
    - **Cue**: Becomes active when Enable is selected.
- **Cue with Data**: Becomes active when Cue is selected
  - **Reject Blank SOM**: Check to enable rejection of segments with blank SOM.
  - **Reject Blank or Zero Duration**: Enable (check) / Disable (uncheck) rejection of events with null durations.
  - When disabled (unchecked), the driver behaves as it currently does.
    - Events are Blue on the Transmission List
    - Events with 00:00:00.00 durations miss at time of play
    - Events with 00:00:00.00 durations are marked missed on the asrun log.
    - Events with 00:00:00.00 durations generate an Error with the message "EVENT NOT PLAYED - MEDIA MISSING - NOT FOUND OR BLANK SOM OR DUR"
    - Events with blank (NULL) durations play without stop until the end of physical clip, then they are marked RAN SHORT.
    - Default setting is disabled.
  - When enabled (checked) the VDCP object will not register to play any event in the transmission list that has a blank or 00:00:00.00 Duration. (With default colors, these events remain RED on the Transmission List and do not play). The Transmission List treats this event like any other missing event.

17. In the navigation pane expand a **Stream 1 – Stream 6** and then select **Spots**.

Configure the following parameters as required:
- **Reject Blank SOM**: Check to enable rejection of single spots with blank SOM.
- **Reject Blank or Zero Duration**: Enable (check) / Disable (uncheck) rejection of events with null durations.
• When disabled (unchecked), the driver behaves as it currently does.
  o Events are Blue on the Transmission List
  o Events with 00:00:00.00 durations miss at time of play
  o Events with 00:00:00.00 durations are marked missed on the asrun log.
  o Events with 00:00:00.00 durations generate an Error with the message "EVENT NOT PLAYED - MEDIA MISSING - NOT FOUND OR BLANK SOM OR DUR"
  o Events with blank (NULL) durations play without stop until the end of physical clip, then they are marked RAN SHORT.
  o Default setting is disabled.

• When enabled (checked) the VDCP object will not register to play any event in the transmission list that has a blank or 00:00:00.00 Duration. (With default colors, these events remain RED on the Transmission List and do not play). The Transmission List treats this event like any other missing event.

18. In the navigation pane expand a Stream 1 – Stream 6 and then select E to E.

Configure the following parameters as required:
- **Send Disk EE Mode Commands.** (Default: disabled) These commands are only supported on certain video disks. Do not enable unless you are sure they are supported in your version.
  When enabled, Automaton will send EE commands to the NEXIO stream when it starts and stops playing.
  This effectively makes the video disk a video player and insert switcher if the input to the port is a primary video feed, and the video disk is controlled by a ‘break away’ list. Once the video disk receives an EE command, it enters an EE controlled mode where it no longer controls the
internal switcher. If EE commands are then disabled, the video disk software must be stopped and restarted so it will control the internal switcher automatically again.

- **Frames to Send EE On Early**. (Default: 2) Enter the number of frames that the EE ON command should be sent early. This box is ignored unless the Send Disk EE Mode Commands box is enabled (checked).

- **Frames to Send EE Off Early**. (Default: 3) Enter the number of frames that the EE OFF command should be sent early. This box is ignored unless the Send Disk EE Mode Commands box is enabled (checked).

19. In the navigation pane expand a **Stream 1 – Stream 6** and then select **Video ARC**.

Configure the following parameters as required:

**IMPORTANT:** Only streams which satisfy the following conditions are enabled for configuration:

- The selected Stream must have a "Decoder" or "Encoder/Decoder" port type to configure these parameters. If the NEXIO port is Record only, the "Output Aspect Ratio" displays as "Unknown".
- The Stream should be online (i.e. connected to the NEXIO Server).
- If stream does not match these conditions, it is shown as grayed out, its Output Aspect Ratio is shown as Unknown, and the Video ARC list shown as empty.

- **Output Aspect Ratio**: This read-only parameter displays the aspect ratio for the output video stream. (e.g. 4:3, 16:9, Unknown).

- **Video ARC**: Video clips can be played back in different Aspect Ratio Conversions (ARCs), resulting in different sized images on a display. From the dropdown list select the type of ARC to use. The options available depend on the Output Aspect Ratio:
### Output Aspect Ratio and Video ARC options

<table>
<thead>
<tr>
<th>Output Aspect Ratio</th>
<th>Video ARC options</th>
</tr>
</thead>
<tbody>
<tr>
<td>4:3</td>
<td>Default, Letter Box, Center Cut, 14:9, 21:9</td>
</tr>
<tr>
<td>16:9</td>
<td>Default, Pillar Box, Middle Cut, 14:9, 21:9</td>
</tr>
<tr>
<td>Unknown</td>
<td>Grayed out (no options displayed)</td>
</tr>
</tbody>
</table>

**Note:** Linear Video ARC is not available for configuration. Only Video ARC modes with pre-defined size and crop parameters are supported.

### About the Stream Initialization Process:

Information about Output Aspect Ratio and the Video ARC assigned to a NEXIO stream is obtained by the driver during the stream initialization process (this process can take several seconds). When the driver receives this information, it updates the stream Output Aspect Ratio field of the configuration dialog and available Video ARC modes are changed according to this Output Aspect Ratio of the stream.

Saved Video ARC modes are applied after the driver has initialized the stream and received the stream Output Aspect Ratio.

**CAUTION:** If the Video ARC option in the configuration dialog is opened at the moment when driver has not yet receive information about stream configuration from the NEXIO Server, an Output Aspect ratio of Unknown is displayed and the following Video ARC options are displayed: Default, Letter Box, Pillar Box, Center Cut, Middle Cut. These parameters will be updated once the driver receives the stream information.

20. In the navigation pane expand a Stream 1 – Stream 6 and then select **Filters**.

---

Configure the following parameters as appropriate:
- **SD Playout**: Enabled (check) this parameter for this stream to register the clips in SD format (SD clip is a clip with resolution less than 720).
- **HD Playout**: Enabled (check) this parameter for this stream to register the clips in HD format (HD clip is a clip with resolution 720p, 1080i, 1080p).
- **Play Unidentified Clips**: Enabled (check) this parameter for this stream to register the clips for whom the concept of "SD / HD" does not apply. (Currently, only "AUDIO ONLY" type is supported.)

**Note:** By default each checkbox is enabled; this means that there is no filtering involved.

21. In the navigation pane expand the Global entry and then select **Disk Status**. The Disk Status tab is informational only. No user-configurable settings are available in this tab. Click the **Refresh** tab to update the displayed information.

<table>
<thead>
<tr>
<th>Nexio - Channel 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Status</td>
</tr>
<tr>
<td>Selected ports: [1]</td>
</tr>
<tr>
<td>Port Initializing</td>
</tr>
<tr>
<td>Disk Full</td>
</tr>
<tr>
<td>Max Record: 00:00:00:00</td>
</tr>
<tr>
<td>Minutes Free In Disk: 0</td>
</tr>
<tr>
<td>Offline Archive Not Full</td>
</tr>
</tbody>
</table>

**Disk Status Parameters:**
- **Selected ports** shows numbers of ports, which are configured via this driver by user.
- **Returned ports** displays numbers of ports, which have been really configured and correctly reply to commands.
- **Port Initializing** (or "Port Initializing") indicates whether initialization process has been finished.
- **Ports Opened** shows amount of ports, specified on page "K2ClientInfo".
- **Disk Not Full** (or "Disk Full") and **Archive Not Full** (or "Archive Full") show condition of disk and archive.
- **Spots in Disk** shows amount of clips in current working folder.
- **Disk Free** and **Max Record** display free space and free continuous space in timecode format.
• **Minutes Free In Disk** shows free space in minutes.

• **Minutes Signal Free** shows critical amount of free minutes in disk, when the video disk is considered to be full (it is specified on page Storage in Global parameters).

  - **Refresh**: Press this button to obtain current information about the device.

22. In the navigation pane expand the Global entry and then select **Diagnostics**.

Configure the following parameters as required:

- **Diagnostics**.
  - **Reinitialize**: Click to reinitialize the device/port. Executing this Global action will impact (stop) any in-progress play/record operations of all configured NEXIO streams. It will clear the disk status lines, clear all spots in the Device Storage Window, and then initialize the disk port.

  **IMPORTANT**: If a specific NEXIO stream requires a Re-Init, then the user should click on the specific stream name in the Config Device Tool and press the Reinitialize button on that configuration tab.

  This should only be done if the disk is not recording or playing on air, and it is felt something is hung up in the software.

  A Reinit may be required if the videodisk communications program is brought down, then back up, and it does not signal the ADC controller that it was rebooted.

  - **ReVerify**: Click to reverify all IDs from the video disk. This action removes all IDs from the Device Storage Window that are not in any list look ahead, (no ‘*’ in the USED column) then reads all IDs from the video disk and puts them into the Device Storage Window.
This should only be used if you suspect the Device Storage Window does not have the correct IDs in it (they should only be what is in the disk or to be recorded or transferred in to the disk).

Before doing this note the ID count and any suspected IDs or lack of IDs, and note if after the ID List is re-read if the IDs in the Device Storage Window are different.

Using this function reduces the efficiency of the Auto Delete (Device Parameter Delete When Full). It will still delete as needed, but the history of what spots were most recently used will be lost.

- **Verbose Diagnostic Logging**: Enable (check) this option to include additional messages to the log and to save state in the .ini file (driver section, "DiagLogMode" key). This option improves readability of Nexio IP driver logging by redirecting console logging to Diagnostic logging in the Config Tool.

  - **Trace Setting: Only Trace the Following IDs**: Check to enable tracing of the communications for designated IDs. This gives more intelligent filtering of the data logged in order to limit the amount data produced in the log.

23. **Apply the Configuration Changes**: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

**Note**: Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

24. **Save the Configuration**: From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

  - Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

### To Configure an Omneon Spectrum Video Disk (API/IP Driver)

This driver configuration:

- Provides IP API support for Spectrum
- Allows control of multiple ports by a single driver
- Provides an option for Serial communications for real time control

### Multi-Stream Driver Limitations

All new video servers can be controlled through TCP/IP connection. These drivers have more than one stream (Port) and therefore are very different from common drivers for video servers which required all streams to have the same parameters. Multi stream driver configurations allow each stream to be assigned its own parameters. However, ADC limitations impact its use.
Example: The following example configuration is used to illustrate the impact of ADC limitations. If two Ports of an Omenon device are assigned to the same list and have the same type (for example, both ports are Player), two possible configurations can be:

- Case 1: Use two copies of the driver (one driver for each port).
- Case 2: Use only one driver and select both Ports as Player.

Impact on Feature/Functions:

- Auto Copy:
  - Case 1: The "Auto Copy" function will only work if both Ports belong to the same Media list and use one port as Source and the other port as Preview/Review.
  - Case 2: The "Auto Copy" function will work only if the Source port number is less than the Preview/Review Port number. If it is not, Auto Copy will not work.
  - Case 2: If the Preview/Review port is removed from the Media List, then Auto Copy will work.

- Air Protection:
  - Case 1: Air Protection will work.
  - Case 2: Air Protection will not work.

Recommendations:

- If different streams of the same device are used as the source and review devices at the same time, it is recommended to use the stream with the smaller number as the source and the stream with the larger number as the review.
- If, for some reason, it is necessary to use the stream with the smaller number as the source device, and the stream with the larger number as the review device, the review device should be manually unassigned from the Media List with the help of the Config Tool right after the Prep Form is opened. This second Recommendation may only be used when the "Review with Switching" feature is disabled.

To configure the Omneon Driver (API/IP)

1. Under Video Disk Servers (API/IP) in the Available pane (right pane), select the Omneon Spectrum IP device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50). Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the Omneon Spectrum IP Video Disk device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device.
**Note:** The settings within the Global Section of the multi stream driver will have an effect upon all of the configured Streams. Unique settings may be stored per each Stream within the Stream configuration portion of the multi stream driver.
3. In the navigation pane expand the Global entry and then select General. Available options may differ depending on the device selected.

Configure the following parameters as required:

- **Device Name**: Specify the name of the driver into the ADC1000NT configuration. Change this to the preferred name for the device, up to 16 characters. (Default: "Spect"). The device name identifies the disk port.

  **Note**: When an event is threaded, an extra character - the head number - is added to the end of the name.

  The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

- **Options**:
  - **Report Spot Shorter than Scheduled**: Check to enable reporting.
  - **Reset Storage on ReInit**: Check to reset the storage when the device is reinitialized.
    - Checked: Destroy the old storage collection and recollect storage from disk whenever the disk driver reconnects with the video disk from a lost communication.
    - Unchecked: Continue to use the old storage collection after the reconnection.

  **Recommendation**: Uncheck if the disk frequently loses communication.

In Operation:

- If "Reset Storage on Init" is Enabled and communication is lost, the storage collection is re-populated.
• If "Reset Storage on Init" is Disabled and communication is lost, no action is performed upon the storage collection.

  Disable heart beat checking for device air protection: Enable/Disable heartbeat check.
  Checked: The Driver will not check if the device lost heart beat.
  Unchecked: The driver will sense the lost heart beat error and try to reset and reconnect with the device.

  **Recommendation:** Uncheck unless the device can’t reply heart beat checking query command from driver.

4. In the navigation pane expand the Global entry and then select **Communications**. Use this tab to specify the TCP configuration.

   Specify the following parameters as required:
   ▪ **IP:** IP address of the controlled Omneon Spect VR device.
5. In the navigation pane expand the Global entry and then select Omneon Disk.

Specify the following parameters as required:

- **Play**
  - Play latency in frames: Enter the number of frames that the play should be send early. (Default: 0) Play command latency from CUED state in frames. In ADC this value is configured on the Prerolls/Postrolls tab with Parameter: Frames To Send Play early.

- **Record**
  - Record latency in frames: (Default: 0) Record command latency from CUED state in frames. In ADC this value is configured on the Prerolls/Postrolls tab with Parameter: Frames To Send Record early.
  - Record extra frames: Specify the number of extra frames to record.
  - Record confidence stream: <IMPORTANT: This parameter is currently unused. It exists only for historical reasons. In future builds this parameter will be removed from driver’s configuration.>>

- **Free Space**
  - Space Remaining: Shows available free space on the server
  - Largest Spot: Shows available free space on the server
  - ID: Click to refresh the free space display
6. In the navigation pane expand the Global entry and then select **Prerolls/Postrolls**.

Configure the following parameters as required:

- **Prerolls**.
  - **Frames To Send Play Early**. The default is -4. (Recommended range is -4 to -6) Adjust the parameter to best accommodate the latency for the specific facility. This setting determines when (number of frames) the video disk port should receive the play command before playout is performed. A setting of zero sends the play command to the disk port the frame before the command is performed.
  
The setting should never be greater than four frames less than List Preroll or Instant Preroll or the disk port will not play and the list will stop. If Disk Prerolls is used, the Frames setting should be the same value unless a frame or two of switcher timing compensation is required.

- **Frames To Send Record Early**. The default is 0 and should not need to be changed unless the disk has a fixed latency of greater than one frame for the play command. This setting determines when (number of frames) the video disk port should receive the record command before recording is performed. A setting of zero sends the record command to the disk port the frame before the command is performed.
  
The setting should never be greater than four frames less than List Preroll or Instant Preroll or the disk port will not play and the list will stop. If Disk Prerolls is used, the Frames setting should be the same value unless a frame or two of switcher timing compensation is required.
7. In the navigation pane expand the Global entry and then select **Storage**.

Configure the following parameters as required:

- **Automatically Delete From Disk When Full.** The automation system ensures that the specified amount of free disk space is maintained. Material is deleted from the disk automatically, based on a first-entered, last-played formula. Example:

  A disk has 1000 spots on it, numbered 1 through 1000. Spot 23 is played, at which point it is assigned a new number of 1001. Spot 65 is then played, at which point it is assigned a new number of 1002. Each time a spot is played, it is incremented using this same sequence. As a result, spots that have been on the disk the longest without ever being played have the lowest numbers, and are deleted first. If material must be deleted on the disk, the lowest number would be deleted first, then the second lowest number, then the third lowest, etc. Default is disabled (unchecked).

  Spots registered in the Lookahead are never automatically deleted.

- **Disk Space to Keep Free (Mins).** The default is 10 minutes. The range is from 0 to 32,000 minutes. This parameter attempts to keep the disk with at least the entered number of minutes of disk space free. This prevents trying to record something larger than the available amount of time, then having to delete the unfinished (truncated) item. For playout, the default value is typically used. Set this to the size of the largest ID you expect to record if Automatically Delete From Disk When Full is enabled. This parameter should be used in time delay and record event applications. It is not recommended to set the value below four minutes (since all space available numbers are estimates due to variable rates of compression on different video images). This parameter has no effect unless Automatically Delete From Disk When Full is enabled.
Prevents ‘In-Use’ Clips from Being Deleted: Enable/Disable deletion of In-Use clips.

Checked: (Recommended) Users can’t delete an ID when it is inside the lookahead of a list from any clients.

Unchecked: Users can delete any event from the disk storage collection window of clients.

**Note:** This parameter ONLY works when the operator attempts to delete clips from the Storage Window. The Purge List ignores this setting and might delete events that are in the current transmission lists’ lookaheads.

**Note:** When "Prevents ‘In-Use’ Clips from Being Deleted" is enabled and the "Allow Delete IDs from Storage Window" is also enabled in the "Storage Options" tab of the Air Client, attempting to delete in-use clips in the Device Storage Window results in a confirmation popup.

Clicking OK on the Confirm message will not result in these in-use clips being deleted. This applies to in-use clips that are not Protected and are not in a CUED state.

List of Extensions: The field format is a sequence of extensions without any space characters. Each extension must start with a dot. Extensions are case sensitive. The default list of extensions will be used if the field is empty.

Clip Directory: Specify the directory for clips.

8. In the navigation pane expand the Global entry and then select Reporting.

Configure the following parameters as required:

Disk Specific Warnings: Displays diagnostic messages used for software development and debugging. If a specific problem or suspected bug is noticed, turn on this setting. If a disk diagnostic message appears when the problem occurs, the diagnostic code associated with the message should be reported to Automation Support. Default is disabled (unchecked).
- **Items Automatically Deleted or Recorded.** This setting should only be used to verify or test that the disk is functioning properly. When enabled, diagnostic messages are only written to the error log at a client computer (if the client is configured to write error log files) when a spot is deleted, recorded or played from this disk port. Default is disabled (unchecked).

9. In the navigation pane expand the Global entry and then select **Ports**.

Configure the following parameter as required:
- **Additional Port Of Same Disk**: Use this parameter to enable alternating playout of two streams on the same disk for the same list. Select the additional stream from the drop down list.

10. In the navigation pane expand the Global entry and then select a **Stream 1 – Stream 5**. The selections for Stream 1- Stream 5 provide the same configuration criteria. Use these selections to set up channel count and type of each channel. In ADC channels are treated as streams.
A Stream on the Device Driver represents a media input or output on the physical device. It is possible to have two or more instances of a driver in a single Device Server. The only limitation – all instances should control different ports.

Specify the following parameters as required:

- Specify the type of ADC stream. Each stream may be configured as:
  
  **Note:** The configuration should match the device abilities.

- Disabled
- List of available ports from Omneon. As shown in the following example, when a port is selected the port designation appears alongside the specified stream:

Example Available Ports:

The following are examples of available ports. As shown ports can have different names depending on Omneon.
These names are configured at Omneon devices (not from the Config Tool). The following image is of the Media Director for the Omneon.

- **Reinitialize**: If an Omneon stream becomes non-responsive to Automation commands, then click this button to reinitialize a single Omneon Stream. This does not impact other Omneon streams when selected or pressed.
11. In the navigation pane expand a Stream 1 – Stream 5 and then select General.

Configure the following parameters as required:

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name (Default: Spect). When an event is threaded, the head number is added to the name.

  The name is also used to identify the stream used to execute secondary data events. If a stream’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

- **Options**:
  - **Stop Disk Play/Record on Init**: A stop command is issued to the disk whenever the Device Server is started or the port is re-initialized. When disabled, the Device Server connects to the video disk port if it can. If it cannot, the port must manually be re-initialized on the Device Server (under System, Diagnostics). When disabled, it is the operator’s responsibility to check the port status in the Device Status Window and the IDs in the Device Storage Window and re-initialize if required. Default is enabled (checked).
  - **Back To Back Play**: When performing back to back play of short spots (for example, five second spots), keep the preroll and postroll of the lists as short as possible. The postroll time must be compatible with the VTR, switcher and effect minimum postroll times. Also, the ADC Device Server allows a video disk that has started cueing to continue cueing during preroll as long as cueing finishes before playout time. If disabled, the second head status
line never threads (staying offline). This option should typically be left enabled. Default is enabled (checked).

12. In the navigation pane expand a **Stream 1 – Stream 5** and then select **PreRolls/PostRolls**.

   ![Stream 1 - Disabled: Prerolls/Postrolls](image)

Configure the following parameters as required:

- **Instant Prerolls**.

  The Instant feature is designed for coming out of a live or upcounting event as fast as possible when the next event has a near instant preroll. If you are using a master control switcher, the preroll must not be shorter than the shortest preroll supported by the switcher.

  - **Use Instant Prerolls**. This function has a default of zero seconds, four frames. The values can range from four frames to 59 seconds. Instant Preroll provides instant play/skip capability to the device. When enabled, Instant Play Preroll is activated by pressing the Instant button or Roll Now button on the control panel.

  The preroll must be set to at least the minimum switcher preroll or the disk port may start playing before the switcher switches.

  The preroll also must be set to at least four frames greater than the Disk Preroll and Number of Frames to Send Play Early. Four frames is the minimum preroll allowed by ADC. If not configured properly, the list may stop, or Roll Now may not work as expected, but take a longer time than desired.

  If Instant Preroll is set longer than the List Preroll, instant play is actually a delayed play. ADC operations rely on list preroll settings configured through the Options menu, in Configure Lists.

  - **Seconds**. Select a value of up to 59 seconds.

  - **Frames**. Select a value of at least 4 frames.
Device Postroll.

- **Use Postroll.** Default: Disabled, zero seconds, four frames. Range: four frames to 59 seconds. When enabled, this setting overrides other configured postroll settings. Device postroll, if enabled, must be set to at least 4 frames.

  This feature allows the list to use one postroll for VTRs, cart machines, and other devices, and a different postroll for video disks. The Device Postroll can be longer or shorter than the list postroll. Its main purpose is to clear out the disk status line quickly after the disk stops playing, so the status line can be loaded with the next event to cue. This allows small spots to be played back to back.

  If the Device Postroll was set to a larger value, and the disk had over recorded the ID compared to the play duration, the disk would continue to play for the post roll duration if on air play switched to another device. This would permit mix effects during the post roll of the disk device into the play out from another device.

- **Seconds.** Select a value of up to 59 seconds.
- **Frames.** Select a value of at least 4 frames.

  **Note:** The Seconds and Frames values have no effect unless the Use Postroll box is enabled (checked).

**Note:** The settings for Frames To Send Play Early and Frames to Send Record Early are located within the Prerolls/Postrolls tab within the Global section.

13. In the navigation pane expand a **Stream 1 – Stream 5** and then select **Storage**.

Configure the following parameters as required:

- **Delete IDs After Play.** Deletes a played event from the video disk. This is typically only enabled for testing or when recording for a one-time playout. Default is disabled (unchecked).
For testing, this allows a short list of spots, repeated continuously, to record or cache. The spots are then continuously deleted. For actual on-air playout, the setting automatically deletes from a disk when it is full. This keeps the disk filled with the most current spots to reduce multiple recording or caching of a spot repeated more than once. This function only deletes a spot if it is completely played out, and was recorded by this port.

14. In the navigation pane expand a Stream 1 – Stream 5 and then select Recording.

About Recording Clips: To record a clip, streams/ports must be assigned and used in the appropriate order:
- Stream/Port 1 - rec
- Stream/Port 2 - review

Note: A clip cannot be recorded if both streams/ports are assigned to one Media list, but the review device isn’t assigned in Media Client.

Configure the following parameters as required:
Any combination of record qualifiers may be used, or they all may be disabled. The recording qualifiers are effective on record events and caching, and Secondary Record Device Events. This is useful in caching to record only IDs that are commercials as they are short and not program material (program material normally has a segment number). Default is disabled.

- Allow Recording.
  - Recording of Record Events. Allows recording of record events or other types of recordings. When disabled, the disk port will not record. Recording with segment play enabled is equivalent to performing an insert edit or assemble record, depending on the SOM (if the video disk server supports this function).
• **Back to Back Recording.** For secondary record events, this parameter must be disabled. Only enable this option if your video disk server supports this function.

  This setting is useful when setting up a disk to perform continuous time delay applications. To set this up, enable this parameter and then place a sequence of continuous IDs on a record list. The video disk records every frame into the proper ID. The record list can be made into a playlist and played out. The play output is exactly the same as what was recorded.

  This function affects the play out and recording list function and the disk driver function; no other function is affected. When enabled, it:
  
  - Allows the recording port to support back to back recording between different recording IDs.
  - The leading Switch Only Device will allow the back to back play between the different play IDs.
  - The back to back recording function records single-file-multi-segment file to single file in video disk and the Air Client updates the database after each segment has finished the record.
  - The recording operation to video disk will not stop until the recording of all segments is finished.

  **Note:** Refer to the documentation on your disk to verify if your disk supports back-to-back recording.

• **Record Only No Playout.** When enabled, this port will not play any material. This was added to the software so a port can be assigned to a playlist for recording, with a separate port assigned for playout. Without enabling this parameter, if one port goes down, the other port will try to do both (record and playout). Since it cannot do both at the same time, the list will not work properly. Default is disabled.

  - **Disable Recording With Segments.** If enabled, the disk port will not record any event with a segment number in it. Default is disabled (unchecked).
  
  - **Record Only Segments.** Record only events with non-blank segment fields. If not enabled, the disk port will not record any event with a segment number in it.
  
  - **Prevent Recordings Greater Than (Mins).** Check to enable, then specify a maximum length (in minutes) for any recording. When this parameter is enabled, the disk port will not record any ID whose duration is greater than the number of minutes specified in parameter.
  
  - **Prevent Recordings Less Than (Mins).** Check to enable, then specify a minimum length (in minutes) for any recording. When this parameter is enabled, the disk port will not record any ID whose duration is less than the number of minutes specified in parameter.
  
  - **Only Record Events with ID in.** Check to enable, then specify the event range ‘--to--’ limits. When enabled, the disk will only record IDs whose first character is between or equal to the limits. Numeric and alphabetic entries (upper and lower case) are permitted.

  **For example:** If only IDs starting with a ‘9’ are to be recorded, enter a ‘9’ in both boxes. To record only IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters. ‘A’ to ‘Z’ and ‘a’ to ‘z’ are permitted, and uppercase letters are sorted before lowercase letters, and uppercase letters are sorted after numbers.

  The ID qualifier is useful where some IDs are recorded and others not, and the Duration and Segment qualifiers cannot distinguish between them. The traffic system can designate a certain range of IDs that will be cached or recorded only.
15. In the navigation pane expand a Stream 1 – Stream 5 and then select Qualifiers. Use this tab to set playing event qualifiers.

Configure the following parameters as required:

Any combination of qualifiers may be used, or they all may be disabled.

- **Playing Event Qualifiers**: Event qualifier means playlist events must satisfy the selected qualifier before being allowed to play out through this VDCP port. If they do not pass the qualifier check, the event is not registered to this port, and is not allowed to play.
  - **Primary Event**: Select (check) this option, if this VDCP disk port allows primary events to play.
    - Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Secondary to this VDCP disk port, and register Primary events to other devices, such as VTR.
  - **Secondary event (without Data Event)**: Select (check) this option, if this VDCP disk port allows secondary events to play.
    - Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Primary to this VDCP disk port, and register Secondary events to other devices, such as VTR.

- **Duration Range**: If a duration qualifier is enabled then the disk port will not play any ID whose duration is greater (or less) than the number of minutes specified in parameter.
  - **No Events Greater Than (Mins)**: Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).
  - **No Events Less Than (Mins)**: Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).
- **ID Range**: If the ID qualifier is enabled, then the disk will only play IDs whose first character is between or equal to the ‘---to---’ limits.

  This qualifier is useful where some IDs are to be played and others not, and the Duration qualifier cannot distinguish between them.

- **Only Events with ID Between**: Check to enable. Then specify range in the associated number field.

  **For example**: If only IDs starting with a ‘9’ are to be played, enter a ‘9’ in both boxes. To play only IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters.

- **No Event with ID Between**: Check to enable. Then specify range in the associated number field.

  **For example**: To ignore and not play IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters.

- **from --- to ---**: Alphanumeric entry. Specify range for the two options. Up to 32 characters can be entered in each field.

  ‘A’ to ‘Z’ and ‘a’ to ‘z’ are permitted, and uppercase letters are sorted before lower case letters, and uppercase letters are sorted after numbers.

16. In the navigation pane expand a **Stream 1 – Stream 5** and then select **Segments**.

   ![Stream 1 - Disabled : Segments](image)

   Configure the following parameters as required:

   - **Modify Segment IDs (# of Characters)**. Up to two characters can be added to IDs. Useful for multi-segment recording, this option causes the ID on a video disk to be appended with either 1 or 2 characters to distinguish the segments.
If you never use more than 9 segments in any ID, select 1 character (which allows up to 9 segments). If you select 2 characters here, a maximum of 99 segments is allowed. Valid numbers are 0, 1, and 2. Default is 0.

**Example:** If Modify Segment IDs (# of Characters) were set to 2, a 3-segment ID titled "spot" would reside on the video disk as "spot01," "spot02," and "spot03." If the disk has a maximum of 32 characters allowed for an ID, the ID is truncated on the disk if the ID takes up 30 or more characters (2 characters are lost to allow for the 2 segment characters).

- **Segment Play Search path:** Use this parameter to specify segmented program ID search through various settings of the Modify ID parameter. For media play out, the first valid setting is used. The list permits each setting to be individually enabled or disabled, and for the order in which they are checked to be defined. Populating the search path with a single entry matching the fixed settings allows operation identical to current behavior. Select a listed segment then use the associated buttons to arrange:
  - **Up / Down:** Use these buttons to position the segment in the list.
  - **Enable:** Use this buttons to enable a selected segment.
  - **Disable:** Becomes active when Enable is selected. Use this button to disable a selected segment.
  - **Cue:** Becomes active when Enable is selected.
  - **Cue with Data:** Becomes active when Cue is selected

- **Reject Blank SOM:** Check to enable rejection of segments with blank SOM.
- **Reject Blank or Zero Duration:** Enable (check) / Disable (uncheck) rejection of events with null durations.
  - When disabled (unchecked), the driver behaves as it currently does.
    - Events are Blue on the Transmission List
    - Events with 00:00:00.00 durations miss at time of play
    - Events with 00:00:00.00 durations are marked missed on the asrun log.
    - Events with 00:00:00.00 durations generate an Error with the message "EVENT NOT PLAYED - MEDIA MISSING - NOT FOUND OR BLANK SOM OR DUR"
    - Events with blank (NULL) durations play without stop until the end of physical clip, then they are marked RAN SHORT.
    - Default setting is disabled.
  - When enabled (checked) the VDCP object will not register to play any event in the transmission list that has a blank or 00:00:00.00 Duration. (With default colors, these events remain RED on the Transmission List and do not play). The Transmission List treats this event like any other missing event.
17. In the navigation pane expand a **Stream 1 – Stream 5** and then select **Spots**.

Configure the following parameters as required:

- **Reject Blank SOM**: Check to enable rejection of single spots with blank SOM.
- **Reject Blank or Zero Duration**: Enable (check) / Disable (uncheck) rejection of events with null durations.
  - When disabled (unchecked), the driver behaves as it currently does.
    - Events are Blue on the Transmission List
    - Events with 00:00:00.00 durations miss at time of play
    - Events with 00:00:00.00 durations are marked missed on the asrun log.
    - Events with 00:00:00.00 durations generate an Error with the message "EVENT NOT PLAYED - MEDIA MISSING - NOT FOUND OR BLANK SOM OR DUR"
    - Events with blank (NULL) durations play without stop until the end of physical clip, then they are marked RAN SHORT.
  - Default setting is disabled. When enabled (checked) the VDCP object will not register to play any event in the transmission list that has a blank or 00:00:00.00 Duration. (With default colors, these events remain RED on the Transmission List and do not play). The Transmission List treats this event like any other missing event.
18. In the navigation pane expand the Global entry and then select **Disk Status**. The Disk Status tab is informational only. No user-configurable settings are available in this tab. Click the **Refresh** tab to update the displayed information.

 Disk Status Parameters:
- **Output Port Selected** shows numbers of ports, which are configured via this driver by user.
- **Output Port Returned** displays numbers of ports, which have been really configured and correctly reply to commands.
- **Port Initialized** (or "Port Initializing") indicates whether initialization process has been finished.
- **Ports Opened** shows amount of ports, specified on page "K2ClientInfo".
- **Disk Not Full** (or "Disk Full") and **Archive Not Full** (or "Archive Full") show condition of disk and archive.
- **Spots in Disk** shows amount of clips in current working folder.
- **Disk Free** and **Max Record** display free space and free continuous space in timecode format.
- **Minutes Free In Disk** shows free space in minutes.
- **Minutes Signal Free** shows critical amount of free minutes in disk, when the video disk is considered to be full (it is specified on page Storage in Global parameters).
- **Offline Archive Not Full** indicates status of the archive.
- **Refresh**: Press this button to obtain current information about the device.
19. In the navigation pane expand the Global entry and then select **Diagnostics**.

Configure the following parameters as required:

- **Reinitialize**: Click to reinitialize the device/port. Executing this action and confirming will stop any play out or recording in progress, clear the disk status lines, clear all spots in the Device Storage Window, then initialize the disk port.

  This should only be done if the disk is not recording or playing on air, and it is felt something is hung up in the software.

  This may need to be done if a videodisk communications program is brought down, then back up, and it does not signal the ADC controller that it was rebooted.

- **ReVerify**: Click to reverify all IDs from the videodisk. This action removes all IDs from the Device Storage Window that are not in any list look ahead, (no ‘*’ in the USED column) then reads all IDs from the video disk and puts them into the Device Storage Window.

  This should only be used if you suspect the Device Storage Window does not have the correct IDs in it (they should only be what is in the disk or to be recorded or transferred in to the disk). Before doing this note the ID count and any suspected IDs or lack of IDs, and note if after the ID List is re-read if the IDs in the Device Storage Window are different.

  Using this function reduces the efficiency of the Auto Delete (Device Parameter Delete When Full). It will still delete as needed, but the history of what spots were most recently used will be lost.

  Reverify affects the most recently used information in the following way:

  - The ID list sort mode is always set to FIFO. If the disk follows VDCP protocol, when selecting to Re-verify IDs against the disk storage, the video disk gives the IDs following the rule that,
oldest items are listed first, newest items are listed last. This maintains the usage frequency sequence.

- If the video disk doesn’t follow VDCP, the usage frequency sequence will be lost.

  - **Trace Setting: Only Trace the Following IDs:** Check to enable tracing of the communications for designated IDs. This gives more intelligent filtering of the data logged in order to limit the amount data produced in the log.

20. **Apply the Configuration Changes:** When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

   **Note:** Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

21. **Save the Configuration:** From the Configured Devices window select **File> Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

   - Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

### To Configure a GVG K2 Video Disk (API/IP Driver)

This driver configuration:

- Provides IP API support for GVG K2
- Allows control of multiple ports by a single driver
- Provides an option for Serial communications for real time control

#### About Loop Playback Mode option

The Loop Playback Mode option can be selected/deselected: manually using K2 App Center or automatically using automation (i.e. send Set Loop Playback Mode command).

- If the Loop Playback Mode option is selected, the K2 will play only the first clip.
- If the Loop Playback Mode option is deselected, the K2 plays the list correctly.

#### To configure the GVG K2 Driver (API/IP)

1. Under **Video Disk Servers (API/IP)** in the Available pane (right pane), select the **GVG K2 IP** device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: **To Assign a Device to a Device Channel** (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the **GVG K2 IP Video Disk** device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device.
Note: The settings within the Global Section of the multi stream driver will have an effect upon all of the configured Streams. Unique settings may be stored per each Stream within the Stream configuration portion of the multi stream driver.

3. In the navigation pane expand the Global entry and then select General. Available options may differ depending on the device selected.

Configure the following parameters as required:
Device Name: Specify the name of the driver into the ADC1000NT configuration. Change this to the preferred name for the device, up to 16 characters. (Default: “K2TCP”.) The device name identifies the disk port.

**Note:** When an event is threaded, an extra character - the head number - is added to the end of the name.

The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

Options: Report Spot Shorter than Scheduled: Check to enable reporting.

Disable heart beat checking for device air protection: Enable/Disable heartbeat check.

Checked: The Driver will not check if the device lost heart beat.

Unchecked: The driver will sense the lost heart beat error and try to reset and reconnect with the device.

**Recommendation:** Uncheck unless the device can’t reply heart beat checking query command from driver.

4. In the navigation pane expand the Global entry and then select **Communications**. Use this tab to specify the TCP configuration.

Specify the following parameters as required:

- **IP:** IP address of the controlled device. Default IP address is 127.0.0.1. User should type correct IP address to establish connection with K2 Client. More than one copy of driver can use the same IP address (for example, if the ports of the K2 Client use the different Working Folders).
- **Port**: This port number is defined in the Protocol Document and should not be changed.
- **Log Setting: Disable Log Creation**: This option is used to create a special Log file which can be very useful in debugging. By default, "Disable Log Creation" is selected (log is not created). Uncheck to enable log creation.

5. In the navigation pane expand the Global entry and then select **K2ClientInfo**. The driver will allow using only those ports, which are defined on this page.

Configure the following parameters as required:
- **Type of K2 Client**: The "GVG K2 IP" driver can work with different types of K2 Clients. Select the type of client: SD or HD.
- **Number of Ports**: Use the spin arrows to specify the number of available ports: Range is 2 - 4. (The number of specified ports are enabled under Type of Ports. If 2 ports are specified Port 1 - 2 are enabled. If 3 ports are specified, then Ports 1 – 3 are enabled. If four ports are specified then ports 1 - 4 are enabled)
- **Types of Ports**: Specify the type of port for each enabled port. Options are Player, Recorder, Player/Recorder.
6. In the navigation pane expand the Global entry and then select **WorkingFolder**. The driver can work with any number of ports of the single K2 Client if they use the same Working Folder.

Configure the following parameters as required:

- **Current Working Folder**: GVG K2 storage always has one folder – default, but the storage can be divided into any number of the folders.
7. In the navigation pane expand the Global entry and then select **Storage**.

Configure the following parameters as required:

- **Automatically Delete From Disk When Full**. The automation system ensures that the specified amount of free disk space is maintained. Material is deleted from the disk automatically, based on a first-entered, last-played formula. Example:

  A disk has 1000 spots on it, numbered 1 through 1000. Spot 23 is played, at which point it is assigned a new number of 1001. Spot 65 is then played, at which point it is assigned a new number of 1002. Each time a spot is played, it is incremented using this same sequence. As a result, spots that have been on the disk the longest without ever being played have the lowest numbers, and are deleted first. If material must be deleted on the disk, the lowest number would be deleted first, then the second lowest number, then the third lowest, etc. Default is disabled (unchecked).

  Spots registered in the Lookahead are never automatically deleted.

- **Disk Space to Keep Free (Mins)**. The default is 10 minutes. The range is from 0 to 32,000 minutes. This parameter attempts to keep the disk with at least the entered number of minutes of disk space free. This prevents trying to record something larger than the available amount of time, then having to delete the unfinished (truncated) item. For playout, the default value is typically used. Set this to the size of the largest ID you expect to record if Automatically Delete From Disk When Full is enabled. This parameter should be used in time delay and record event applications. It is not recommended to set the value below four minutes (since all space available numbers are estimates due to variable rates of compression on different video images). This parameter has no effect unless Automatically Delete From Disk When Full is enabled.

- **Prevents ‘In-Use’ Clips from Being Deleted**: Enable/Disable deletion of In-Use clips.
Checked: (Recommended) Users can’t delete an ID when it is inside the lookahead of a list from any clients.

Unchecked: Users can delete any event from the disk storage collection window of clients.

**Note:** This parameter ONLY works when the operator attempts to delete clips from the Storage Window. The Purge List ignores this setting and might delete events that are in the current transmission lists’ lookaheads.

**Note:** When "Prevents ‘In-Use’ Clips from Being Deleted" is enabled and the "Allow Delete IDs from Storage Window" is also enabled in the "Storage Options" tab of the Air Client, attempting to delete in-use clips in the Device Storage Window results in a confirmation popup.

Clicking OK on the Confirm message will not result in these in-use clips being deleted. This applies to in-use clips that are not Protected and are not in a CUED state.

8. In the navigation pane expand the Global entry and then select **Ports**.

Configure the following parameter as required:

- **Additional Port Of Same Disk**: Use this parameter to perform A/B routing between the different ports of the same K2 device. Select the additional port from the drop down list.

**IMPORTANT:** If this option is to be used, create two copies of K2 driver, which are controlling the same K2 Client.
9. In the navigation pane expand the Global entry and then select **Reporting**. Options on this page allow setting types of messages, which are displayed in Status Bar in Air Client.

Configure the following parameters as required:

- **Disk Specific Warnings**. Displays diagnostic messages used for software development and debugging. If a specific problem or suspected bug is noticed, turn on this setting. If a disk diagnostic message appears when the problem occurs, the diagnostic code associated with the message should be reported to Automation Support. Default is disabled (unchecked).

- **Items Automatically Deleted or Recorded**. This setting should only be used to verify or test that the disk is functioning properly. When enabled, diagnostic messages are only written to the error log at a client computer (if the client is configured to write error log files) when a spot is deleted, recorded or played from this disk port. Default is disabled (unchecked).

10. In the navigation pane expand the Global entry and then select **Port 1 – Port 4**.

The selections for Port 1- Port 4 provide the same configuration criteria. Use these selections to set up channel count and type of each channel.
A Port on the Device Driver represents a media input or output on the physical device. It is possible to have two or more instances of a driver in a single Device Server. The only limitation – all instances should control different ports.

Specify the following parameters as required:

- **Port Type**: From the dropdown list select the port type. Options are Player, Recorder, Player/Recorder.

  This option specifies the way of using selected ports (not their physical type). This drop-down list contains alternatives, available for the current port according to information specified on page "K2ClientInfo" in Global parameters. For example, if Port 1 is physically player/recorded port, it can be used in driver as player, recorder or player/recorder port. But if it’s only player (recorder) port, it can be used only as player (recorder).

  **Note**: The Physical type of each port of the controlling K2 device is chosen on "K2ClientInfo" of the Global parameters.

- **Port Reinitialize**: If a port becomes non-responsive to Automation commands, then click this button to reinitialize a single port. This does not impact other ports when selected or pressed.

  **Note**: To reinitialize the whole driver use Reinitialize button at Diagnostics tab.
11. In the navigation pane expand a Port 1 – Port 4 and then select General.

Configure the following parameters as required:

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name (Default: K2TCP). When an event is threaded, the head number is added to the name.
  
The name is also used to identify the stream used to execute secondary data events. If a stream’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

- **Options**:
  - **Stop Disk Play/Record on Init**: When enabled (checked) a stop command is issued to the disk whenever the Device Server is started or the port is re-initialized.
  - When disabled (unchecked), the device continues playing/recording, while the driver is being reinitialized. The Device Server connects to the video disk port if it can. If it cannot, the port must manually be re-initialized on the Device Server (under System, Diagnostics).
  - When disabled, it is the operator’s responsibility to check the port status in the Device Status Window and the IDs in the Device Storage Window and re-initialize if required. Default is enabled (checked).

**Note**: Some sites prefer to DISABLE on ports the play to Air, and also Auto Record List ports.
12. In the navigation pane expand a **Port 1 – Port 4** and then select **PreRolls/PostRolls**.

Configure the following parameters as required:

- **Instant Prerolls.**
  
  The Instant feature is designed for coming out of a live or upcounting event as fast as possible when the next event has a near instant preroll. If you are using a master control switcher, the preroll must not be shorter than the shortest preroll supported by the switcher.

  - **Use Instant Prerolls.** When enabled, Instant Play Preroll is activated by pressing the Instant button or Roll Now button on the control panel. This function has a default of zero seconds, 20 frames. The K2 AMP cannot guarantee the instant preroll in 4 frames, so 20 frames are set as default value. Values up to 15 frames, but not less, can be tried.

  **IMPORTANT:**
  
  The preroll must be set to at least the minimum switcher preroll or the disk port may start playing before the switcher switches.

  The preroll also must be set to at least four frames greater than the Disk Preroll and Number of Frames to Send Play Early. If not configured properly, the list may stop, or Roll Now may not work as expected, but take a longer time than desired.

  If Instant Preroll is set longer than the List Preroll, instant play is actually a delayed play. ADC operations rely on list preroll settings configured through the Options menu, in Configure Lists.

  - **Seconds.** Select a value of up to 59 seconds.
  
  - **Frames.** Specify values up to 15 frames, but not less.

- **Device Postroll.**
• **Use Postroll.** Default: Disabled, zero seconds, four frames. Range: four frames to 59 seconds. When enabled, this setting overrides other configured postroll settings. Device postroll, if enabled, must be set to at least 4 frames.

This feature allows the list to use one postroll for VTRs, cart machines, and other devices, and a different postroll for video disks. The Device Postroll can be longer or shorter than the list postroll. Its main purpose is to clear out the disk status line quickly after the disk stops playing, so the status line can be loaded with the next event to cue. This allows small spots to be played back to back.

If the Device Postroll was set to a larger value, and the disk had over recorded the ID compared to the play duration, the disk would continue to play for the post roll duration if on-air play switched to another device. This would permit mix effects during the post roll of the disk device into the play out from another device.

- **Seconds.** Select a value of up to 59 seconds.
- **Frames.** Select a value of at least 4 frames.

**Note:** The Seconds and Frames values have no effect unless the Use Postroll box is enabled (checked).

**Note:** The settings for Frames To Send Play Early and Frames to Send Record Early are located within the Prerolls/Postrolls tab within the Global section.

13. In the navigation pane expand a **Port 1 – Port 4** and then select **Storage**.

Configure the following parameters as required:

- **Delete IDs After Play.** Deletes a played event from the video disk as soon as they have been played in Air Client transmission list. This is typically only enabled for testing or when recording for a one-time playout. Default is disabled (unchecked).
To use the "Delete IDs after Play" option, ensure "Prevents In-Use Clips from Being deleted" option is disabled at the Global storage parameters group.

14. In the navigation pane expand a Port 1 – Port 4 and then select **Recording**. This dialog is available only for Recorder or Player/Recorder port and is grayed out for Player port.

**About Recording Clips:** To record a clip, streams/ports must be assigned and used in the appropriate order:
- Stream/Port 1 - rec
- Stream/Port 2 - review

**Note:** A clip cannot be recorded if both streams/ports are assigned to one Media list, but the review device isn’t assigned in Media Client.

Configure the following parameters as required:

Any combination of record qualifiers may be used, or they all may be disabled. The recording qualifiers are effective on record events and caching, and Secondary Record Device Events. This is useful in caching to record only IDs that are commercials as they are short and not program material (program material normally has a segment number). Default is disabled.

- **Allow Recording**
  - **Recording of Record Events.** Allows recording of record events or other types of recordings. When disabled, the disk port will not record. Recording with segment play enabled is equivalent to performing an insert edit or assemble record, depending on the SOM (if the video disk server supports this function).
  - **Record Only No Playout.** When enabled, this port will not play any material. This was added to the software so a port can be assigned to a playlist for recording, with a separate port assigned for playout. Without enabling this parameter, if one port goes down, the other
port will try to do both (record and playout). Since it cannot do both at the same time, the list will not work properly. Default is disabled.

- **Disable Recording With Segments.** If enabled, the disk port will not record any event with a segment number in it. Default is disabled (unchecked).

- **Record Only Segments.** Record only events with non-blank segment fields. If not enabled, the disk port will not record any event with a segment number in it.

- **Prevent Recordings Greater Than (Mins).** Check to enable, then specify a maximum length (in minutes) for any recording. When this parameter is enabled, the disk port will not record any ID whose duration is greater than the number of minutes specified in parameter.

- **Prevent Recordings Less Than (Mins).** Check to enable, then specify a minimum length (in minutes) for any recording. When this parameter is enabled, the disk port will not record any ID whose duration is less than the number of minutes specified in parameter.

- **Only Record Events with ID in.** Check to enable, then specify the event range ‘--to--’ limits. When enabled, the disk will only record IDs whose first character is between or equal to the limits. Numeric and alphabetic entries (upper and lower case) are permitted.

**For example:** If only IDs starting with a ‘9’ are to be recorded, enter a ‘9’ in both boxes. To record only IDs whose first character of the ID is from ‘0’ to ‘5’ inclusive, place ‘0’ and ‘5’ in the two parameters. ‘A’ to ‘Z’ and ‘a’ to ‘z’ are permitted, and uppercase letters are sorted before lower case letters, and uppercase letters are sorted after numbers.

The ID qualifier is useful where some IDs are recorded and others not, and the Duration and Segment qualifiers cannot distinguish between them. The traffic system can designate a certain range of IDs that will be cached or recorded only.
15. In the navigation pane expand a Port 1 – Port 4 and then select Qualifiers. Use this tab to set playing event qualifiers.

Configure the following parameters as required:

Any combination of qualifiers may be used, or they all may be disabled.

- **Playing Event Qualifiers**: Event qualifier means playlist events must satisfy the selected qualifier before being allowed to play out through this VDCP port. If they do not pass the qualifier check, the event is not registered to this port, and is not allowed to play.
  
  - **Primary Event**: Select (check) this option, if this VDCP disk port allows primary events to play.
    
    Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Secondary to this VDCP disk port, and register Primary events to other devices, such as VTR.
  
  - **Secondary event (without Data Event)**: Select (check) this option, if this VDCP disk port allows secondary events to play.
    
    Deselect (uncheck) this option, if a playlist has both Primary and Secondary events, and the user wants to only register Primary to this VDCP disk port, and register Secondary events to other devices, such as VTR.

- **Duration Range**: If a duration qualifier is enabled then the disk port will not play any ID whose duration is greater (or less) than the number of minutes specified in parameter.
  
  - **No Events Greater Than (Mins)**: Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).
  
  - **No Events Less Than (Mins)**: Check to enable, then specify number of minutes in the associated number field (use spin arrows to increment / decrement).
- **ID Range**: If the ID qualifier is enabled, then the disk will only play IDs whose first character is between or equal to the `--to--` limits.
  This qualifier is useful where some IDs are to be played and others not, and the Duration qualifier cannot distinguish between them.
  - **Only Events with ID Between**: Check to enable. Then specify range in the associated number field.
    - **For example**: If only IDs starting with a '9' are to be played, enter a '9' in both boxes. To play only IDs whose first character of the ID is from '0' to '5' inclusive, place '0' and '5' in the two parameters.
  - **No Event with ID Between**: Check to enable. Then specify range in the associated number field.
    - **For example**: To ignore and not play IDs whose first character of the ID is from '0' to '5' inclusive, place '0' and '5' in the two parameters.
  - **from -- to --**: Alphanumeric entry. Specify range for the two options. Up to 32 characters can be entered in each field.
    - 'A' to 'Z' and 'a' to 'z' are permitted, and uppercase letters are sorted before lower case letters, and uppercase letters are sorted after numbers.

16. In the navigation pane expand a Port 1 – Port 4 and then select **Segments**. Options on this dialog describe the driver’s behavior for events with segments (Multi Segment).

Configure the following parameters as required:
- **Enable Cue with Data**: Enable this function only if your video disk server supports this function.
  - This is only enabled to play a part of an ID. It is similar to playing segments of a program or show.
When enabled, the disk port uses the event’s SOM (start of message) to play or record individual segments of program material. For example, enable this setting if you want to play a program or news item in several parts. However, the different video disk devices implement this feature in various ways. For further details, refer to the documentation on your video disk device. Default is disabled (unchecked).

- **This feature must be enabled to play or record individual segments of program material.**

  **Modify Segment IDs (# of Characters).** Up to two characters can be added to IDs. Useful for multi-segment recording, this option causes the ID on a video disk to be appended with either 1 or 2 characters to distinguish the segments.

  If you never use more than 9 segments in any ID, select 1 character (which allows up to 9 segments). If you select 2 characters here, a maximum of 99 segments is allowed. Valid numbers are 0, 1, and 2. Default is 0.

  **Example:** If Modify Segment IDs (# of Characters) were set to 2, a 3-segment ID titled "spot" would reside on the video disk as "spot01," "spot02," and "spot03." If the disk has a maximum of 32 characters allowed for an ID, the ID is truncated on the disk if the ID takes up 30 or more characters (2 characters are lost to allow for the 2 segment characters).

  **Segment Play Search path:** Use this parameter to specify segmented program ID search through various settings of the Modify ID parameter. For media play out, the first valid setting is used. The list permits each setting to be individually enabled or disabled, and for the order in which they are checked to be defined. Populating the search path with a single entry matching the fixed settings allows operation identical to current behavior.

  Select a listed segment then use the associated buttons to arrange:

  - **Up / Down:** Use these buttons to position the segment in the list.
  - **Enable:** Use this buttons to enable a selected segment.
  - **Disable:** Becomes active when Enable is selected. Use this button to disable a selected segment.
  - **Cue:** Becomes active when Enable is selected.
  - **Cue with Data:** Becomes active when Cue is selected

  **Reject Blank SOM:** Check to enable rejection of segments with blank SOM.

  **Reject Blank or Zero Duration:** Enable (check) / Disable (uncheck) rejection of events with null durations.

  - When disabled (unchecked), the driver behaves as it currently does.
    - Events are Blue on the Transmission List
    - Events with 00:00:00.00 durations miss at time of play
    - Events with 00:00:00.00 durations are marked missed on the asrun log.
    - Events with 00:00:00.00 durations generate an Error with the message "EVENT NOT PLAYED - MEDIA MISSING - NOT FOUND OR BLANK SOM OR DUR"
    - Events with blank (NULL) durations play without stop until the end of physical clip, then they are marked RAN SHORT.

  - Default setting is disabled. When enabled (checked) the VDCP object will not register to play any event in the transmission list that has a blank or 00:00:00.00 Duration. (With default colors, these events remain RED on the Transmission List and do not play). The Transmission List treats this event like any other missing event.
17. In the navigation pane expand a Port 1 – Port 4 and then select Spots.

Configure the following parameters as required:

- **Reject Blank SOM**: Check to enable rejection of single spots with blank SOM.
- **Reject Blank or Zero Duration**: Enable (check) / Disable (uncheck) rejection of events with null durations.
  
  - When disabled (unchecked), the driver behaves as it currently does.
    - Events are Blue on the Transmission List
    - Events with 00:00:00.00 durations miss at time of play
    - Events with 00:00:00.00 durations are marked missed on the asrun log.
    - Events with 00:00:00.00 durations generate an Error with the message "EVENT NOT PLAYED - MEDIA MISSING - NOT FOUND OR BLANK SOM OR DUR"
    - Events with blank (NULL) durations play without stop until the end of physical clip, then they are marked RAN SHORT.
    - Default setting is disabled.
  
  - When enabled (checked) the VDCP object will not register to play any event in the transmission list that has a blank or 00:00:00.00 Duration. (With default colors, these events remain RED on the Transmission List and do not play). The Transmission List treats this event like any other missing event.
18. In the navigation pane expand a Port 1 – Port 4 and then select E to E.

Configure the following parameters as required:

- **Send Disk EE Mode Commands.** (Default: disabled) These commands are only supported on certain video disks. Do not enable unless you are sure they are supported in your version. When enabled, Automaton will send EE commands to the port when it starts and stops playing. This effectively makes the video disk a video player and insert switcher if the input to the port is a primary video feed, and the video disk is controlled by a ‘break away’ list. Once the video disk receives an EE command, it enters an EE controlled mode where it no longer controls the internal switcher. If EE commands are then disabled, the video disk software must be stopped and restarted so it will control the internal switcher automatically again.

- **Frames to Send EE On Early.** (Default: 2) Enter the number of frames that the EE ON command should be sent early. This box is ignored unless the Send Disk EE Mode Commands box is enabled (checked).

- **Frames to Send EE Off Early.** (Default: 3) Enter the number of frames that the EE OFF command should be sent early. This box is ignored unless the Send Disk EE Mode Commands box is enabled (checked).
19. In the navigation pane expand the Global entry and then select **Disk Status**. The Disk Status tab is informational only. No user-configurable settings are available in this tab. Click the **Refresh** tab to update the displayed information.

- **Disk Status Parameters:**
  - **Selected ports** shows numbers of ports, which are configured via this driver by user.
  - **Returned ports** displays numbers of ports, which have been really configured and correctly reply to commands. For example, if user configured 1st and 2nd ports via K2 IP driver, but 1st port has AMP protocol and 2nd port has VDCP protocol on K2 Client, only 1st port will be shown in "Returned ports".
  - **Port Initializing** (or "Port Initializing") indicates whether initialization process has been finished.
  - **Ports Opened** shows amount of ports, specified on page "K2ClientInfo".
  - **Disk Not Full** (or "Disk Full") and **Archive Not Full** (or "Archive Full") show condition of disk and archive.
    - Under label "Disk Not Full" there is label with the type of device controlled by this driver.
  - **Spots in Disk** shows amount of clips in current working folder.
  - **Disk Free** and **Max Record** display free space and free continuous space in timecode format.
  - **Minutes Free In Disk** shows free space in minutes.
  - **Minutes Signal Free** shows critical amount of free minutes in disk, when the video disk is considered to be full (it is specified on page Storage in Global parameters).
  - **Refresh**: Press this button to obtain current information about the device.
20. In the navigation pane expand the Global entry and then select **Diagnostics**.

Configure the following parameters as required:

- **Diagnostics.**
  - **Reinitialize**: Click to reinitialize the device/port. Executing this Global action will impact (stop) any in-progress play/record operations of all configured ports. It will clear the disk status lines, clear all spots in the Device Storage Window, and then initialize the disk port.

  **IMPORTANT**: If a specific port stream requires a Re-Init, then the user should click on the specific port name in the Config Device Tool and press the Reinitialize button on that configuration tab.

  This should only be done if the disk is not recording or playing on air, and it is felt something is hung up in the software.

  A Reinit may be required if the videodisk communications program is brought down, then back up, and it does not signal the ADC controller that it was rebooted.

- **ReVerify**: Click to reverify all IDs from the video disk. This action removes all IDs from the Device Storage Window that are not in any list look ahead, (no ‘*’ in the USED column) then reads all IDs from the video disk and puts them into the Device Storage Window.

  This should only be used if you suspect the Device Storage Window does not have the correct IDs in it (they should only be what is in the disk or to be recorded or transferred in to the disk).

  Before doing this note the ID count and any suspected IDs or lack of IDs, and note if after the ID List is re-read if the IDs in the Device Storage Window are different.
Using this function reduces the efficiency of the Auto Delete (Device Parameter Delete When Full). It will still delete as needed, but the history of what spots were most recently used will be lost.

21. **Apply the Configuration Changes**: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

   **Note**: Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

22. **Save the Configuration**: From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

   - Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

### To Configure the mCapture Driver

This interface to mCapture uses RCS protocol to control ingesting material from program feeds.

- As default the driver records to mCapture storage. To record to Nexio requires specific setup.
- The driver uses TcpClient08.pas module to communicate with the device.
- RCS Commands: Currently the driver allows performing only three actions: Stop, Record, Cued.
- The mCapture driver handles changing device and input lists. When an input program is changed the mCapture device sends notification to the driver, so it can updates its program lists.
- The driver ignores input streams (inside a program) that are not in the following list: MPEG1(Video), MPEG2(Video), H.264(Video), MPEG1(Audio), MPEG2(Audio), AAC(Audio), AES(Audio), AC3(Audio). mCapture device doesn’t support all the other streams.

1. Under **Video Disk Servers (API/IP)** in the right pane, select **Imagine Communications mCapture** device and drag-n-drop it to the left pane. For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50). Once a device has been assigned to a device channel, it may be configured for specific options.

2. In the left pane, select the mCapt device, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device.

   **Note**: The settings within the Global Section of the multi stream driver will have an effect upon all of the configured Recorders. Unique settings may be stored per each Recorder within the Recorder configuration portion of the multi recorder driver.
3. In the navigation pane select **Global**. The "Info" Pane provides dynamic information about available recorders on the device and a current mapping state. This is auto-populated and cannot be changed on this screen.

![mCapt - Channel 14](image)

4. In the navigation pane expand the Global entry and then select **General**.

![mCapt - Channel 14](image)

Configure the following parameters as required:

- **Device Name**: The device name identifies the mCapture device. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name.
The "Device Name" appears in the Device Status and configuration window on the client applications. The default name may be used, but it is recommended to use unique names for easy device identification.

- **ClientID**: The goal of this parameter is to distinguish the answers from different clients which work with the same DTP (mCapture) device.
  - If there is only one client, use default value (0) or choose any other value in the range [0..65000].
  - If there are several clients, specify different clients ID for each (the real values do not matter. They just need to be different.)

**Note**: If using multiple drivers, use unique Device Names and ClientIDs for each copy of the driver.

5. In the navigation pane under Global select **Communication**.

![Configuration Manager](image_url)

Configure the following parameters as appropriate:

- **Socket Information**
  - **IP**: Enter the IP host address of the computer running the mCapture device. (Default: 127.0.0.1)
  - **Port**: (Default: 49227). This default value was defined in the description of the RCS Protocol. This can be confirmed in the title bar of JRCS.

6. In the navigation pane select a **Recorder Head** (e.g. Recorder Head 1 – Recorder Head 10).
Note: The number of Recorder Heads available in a customer build are set when compiling the software. (Maximum: 20)

Note: The number of Recorders available in a customer build are set when compiling the software. (Maximum: 20)

The Recorder-specific selections provide the same configuration criteria and are applicable to the specific driver head (currently these are mapping and delay options). These options can be set and saved even if no device recorder is currently mapped to this head. When any of device recorders is mapped to driver head, the head options applies to this recorder (driver sends appropriate commands). Thus, the driver overrides device options (during initialization or after mapping).

Configure the following parameter as required:

- **Recorder Head Mapped to**: From the dropdown list select the desired recorder to map to for this Recorder Head. The driver stores the reference to a recorder for each head.

7. Expand the selected Recorder Head and select **Recorder Option**.
Configure the following parameter as required:

- **Delay (ms)**: Specify the record delay in milliseconds. The mCapture protocol (RCS) does not specify the maximum value of the Delay option (minimum is 0), so this driver option has no upper limit.

  The Delay is a recorder-specific option. A value of the option can be set even the Recorder Head is not mapped to a device recorder; the setting applies once the head is mapped.

  The driver saves the value of this option in INI file for each head. If, after restarting of the Device Server, a recorder head is mapped to an existing recorder, then during the initialization the driver overrides delay option of appropriate recorder with value from the INI file (this is also true when the new instance of the driver is connected to a device. In this case the option is overridden with default delay value with is 0).

**IMPORTANT**: If the value of the delay option is quite significant (on the order of a few seconds) a significant difference might occur between record event status in the list and the actual recorder status: because the recorder starts to record later than an appropriate event turns to RECORD state (due to Delay value), it (recorder) also stops later than the event turns to DONE. In this scenario, since the recorder is still busy, the driver won't cue the next record event in the list until the recorder reports it is stopped (this is true if only one Recorder Head is assigned to the list).
8. In the navigation pane select the **Diagnostic** option. If required, click the **Reinitialize** button to reinitialize the device; the driver closes TCP/IP connection and then tries to create a new connection.

![Reinitialize Device](image)

9. When finished click **Apply**, then click **OK**.

10. **Save the Configuration.** From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

    - The driver saves mapping to the INI file, so if the Device Server is restarted, the driver restores its mapping. If some recorder was deleted, before the Device Server is started, the appropriate Recorder Head drops its reference.

**Viewing Diagnostic Messages via the Diagnostic Windows**

The mCapture driver allows operators to view diagnostic messages via the standard Config Tool - > diagnostic window.

1. Select the **mCapt** device in the left pane, right-click and from the popup menu select **Diagnostics**.
2. The Diagnostics window for the device is opened showing running device diagnostic messaging.

![Diagnostics Window]

```
Log Started on: 01/26/2016 15:30:29.17-2403, Reference Local Time: 15:30:25.075
subversion=12.25.31.2M  customename=ADC2000 ENGINEERING DEMO dateVersion=January 26, 2016
Connectionname=BABKIN  ConnectionSign=

15:30:29:23 Got a response
15:30:29:23 Payload is assigned
15:30:29:23 HandleResponse: [RCSRecorderList]Payload

15:30:30:16 GetRecordedListCmd

15:30:30:23 Got a response
15:30:30:23 Payload is assigned
15:30:30:23 HandleResponse: [RCSRecorderList]Payload

15:30:31:16 GetRecordedListCmd

15:30:31:23 Got a response
15:30:31:23 Payload is assigned
15:30:31:23 HandleResponse: [RCSRecorderList]Payload
```

![Close button]

3. When the window is open and logs are being generated, the information inside this window is saved in a text file (.log) located in `C:\Config\Log`. The file name is composed of the driver name, the channel of the Config Tool it is configured on and the Date:

![Text File]

**Record Head Operations**

A Record Head can only be used for recording if it points (mapped) to some device recorder. If number of recorders is changed via some external tool, the driver automatically handles this and updates head statuses. If configuration form is opened at the time of change, it will also be updated (reopening is not required)

When the driver is initially configured, its heads have no references to device recorders.

- If the driver successfully connects to a device, it retrieves all recorders descriptions that can be used to set a reference for each head.
- If the driver is connected to the device, but some head is not mapped to a recorder its status is NO COM, when head is mapped, the status is UNTHRD.
If the driver is not connected, then the status of all heads is NO DEV.

N+1 Video Server Redundancy Configuration (Virtual Pool Driver)

Air/Protect is a popular and widely used feature of ADC. However, it is a 1-to-1 protection of devices, requiring dedicated main and redundant playout devices. Many facilities, however, do not want to incur the expense of purchasing redundant playout devices for each transmission path, especially for less critical sub-channels. However, it is still of operational importance to be able to protect these channels against the critical failure of an on-air device.

N+1 Video Server Redundancy implements a new special multiport Virtual Pool Driver (VPD) that provides the ability to configure a single device (N+1) or group of devices (N+M) that can be used to assume playout responsibilities in the advent of the critical failure of an on-air device. (i.e. the Virtual Pool Driver (VPD) collects a few video server drivers and provides them as protect devices once an air device fails.)

About Other Protect Functions:
- Disable the Protect button from the Control Panels (Hardware and Software) as this is an unsupported function.
- There is also a Protect option in the List Context Menu, that cannot be disabled as it is for the next event, not the currently playing one.

(N+M) Protection Concept

Using the new virtual protected device driver, one instance of the driver protects N device drivers assigned to N playlists. Since a single list might have more than one device assigned to it, and each must be individually protected, mapping is not per list, but per device.

This virtual driver has M ports. To provide M\(\times\)N protection the virtual driver looks like a container (pool) for M "real" device drivers (Pr.Driver 1...M), and each port of the Virtual Driver is a port of any "real"
device driver. Currently, there is a limit of 20 heads per device - which limits a single virtual driver to protecting a maximum of 10 real devices.

**Note:** To support back to back play, the streams noted are in fact two heads.

When the N-th driver fails while playing the M-th playlist, the driver requests its own protected device, which is the new Virtual Pool Driver. This determines the first available free port in its pool which can provide the needed media spot and occupies the port. From this moment the port becomes non-free. After playing out an event using the spot from the Virtual Pool Driver, the driver releases the port and makes it free. If the VirtualDriver can't provide a media spot by any free port it has, the playing of the corresponding list fails.

### Protect Pool Driver Configuration

Virtual Pool Driver (VPD) collects a few video server drivers and provides them as protect devices should the on air device fail.

1. From Configuration utility, right-click on the Device Server icon and select the Configured Devices item to display the "Configured Devices" window.

2. From the list on the right hand pane select "Protect Pool Device" from the "Protect Pool Devices" category. Use the mouse pointer to drag this item to one of the available "No Device" lines on the left side of the Configured Device Window.

   Example: The following image shows a configuration containing three air device (AIRDEV1, AIRDEV2, AIRDEV3 channels 7,8 and 9 respectively), a virtual device on the 15th channel with three ports has a pool of two devices PROTDEV1 PROTDEV2

   **IMPORTANT:** Do not assign crosspoints to the Pool device.
IMPORTANT: Using Hold or Freeze while using Protect Pool is not supported.

3. On the configured pane right click on the Protect Pool Device and form the context menu select Properties.

4. Select the General Tab. Use this tab to specify the Virtual Pool Device name.

5. Select the Devices Tab. Use this tab to associate the protect devices(s) with available devices.
   - Select a device and/or stream form the Available pane and click <Add to Pool.
   - Use Up and Down buttons to arrange listing entries in the Pool pane. The list order determines which free driver in a pool is selected first.
- To remove an entry from the Pool pane click Remove. The entry is returned to the Available pane.
- Virtual Ports: Use spin arrows to set how many ports this Virtual driver can provide.
- Cueing Offset (sec): Specify the offset value the delay requires (in seconds) to allow the protect device to cue and play when it takes over.

6. Select the Runway Lists tab. A protect device needs a "runway" to process all stages from "standby" to "playing". Use this tab to designate runway lists that will provide continuous playing out without stopping in order to prepare a Real Protect Device (RPD) for playing. It is possible to have a small runway list pool; its size can be less than protect device pool, thus a few RPDs can share one runway list.

**Note:** For more information see also About Runway Lists.
- Select a list from the Available pane and click <Add to Pool.
- Use Up and Down buttons to arrange listing entries in the Runway List Pool pane. The list order determines which list in a pool is selected first.
- To remove an entry from the Runway List Pool pane click Remove. The entry is returned to the Available pane.
- About Runway Lists: In general a runway list is used as a staging point for content prior to its being moved into a Transmission List for playout.
  - The maximum number of runway lists (4) is defined in "Userconc.inc" file as: MAXRUNWAYLISTS=4;
  - It is impossible to assign any available media source to a runway list on "List Assignments" screen.
  - Only runway lists are available on "Runway Lists" tab of Pool Driver properties dialog.
  - A runway list is available in Air Client as a generic transmission list. It is possible to watch events on it. However it is protected against an operator’s manual intervention. The following manual actions are prohibited on this list type:
List Assignment

Pool streams are assigned to lists as required, protect streams are ports of a (Virtual Protect Device). List assignments and air-protected device configuration are performed in the usual manner.

**Note:** Pool Streams can be added to any list type except Runway Lists.
To configure A/V tables for a general pool device

For each playlist use the following procedure to configure the correct switching if the Pool device contains 2 or more devices.

1. For the main disk the A/V table is populated as follows (for example):

   ![Playlist 1 M1 STRM1 Output](image)

   - Device: ROUTR
   - Input Cross Point: 1
   - Output Cross Point: 1

2. Protect line must be empty.

3. For all protect disk the A/V table is populated as follows (for example):

   ![Playlist 1 P1 STRM1 Output](image)

   - Device: ROUTR
   - Input Cross Point: 0
   - Output Cross Point: 0

4. Output crosspoint is defined in run time dynamically.

---

**VTR Configuration (General)**

The following is an example video tape recorder (VTR) configuration. Your VTR may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.
To Configure a VTR

1. Under **VTRs** in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the VTR device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select **General** tab.

   ![VTR Configuration Dialog](image)

   Configure the following parameters as required:

   **Note:** The parameters displayed depend on the device selected.

   - **Device Name**: Enter a name for the VTR to help you identify the VTR during event transmission. The name can have up to 16 characters. The device name has no relation to the ID of any tape inserted in the VTR.

   - **Options.**

     - **Standbyoff for Tension Release**: This parameter forces the software to issue a Standby Off command to the VTR. In Sony Betacam decks, a tension release command is used. The setting on this parameter does not affect digital and one inch VTRs - these VTRs always receive the Standby Off command when issued. Default is disabled (unchecked).

     - **Eject on Initialization**: A stop command is issued to the VTR whenever the Device Server is started or the port is re-initialized. Default is disabled (unchecked).
Keep Media in VTR: A tape inserted in a VTR is retained by the VTR (not ejected). The tape can then only be manually ejected. This feature allows the VTR to behave as if it has a storage location to hold a tape - like a cart machine. Use caution when selecting this parameter for VTRs that are used as record decks for the compiler. Default is disabled (unchecked).

- **Edit Compensation:**
  - **Edit On / Edit Off:** These edit compensations are a frame latency value for how long the VTR takes to respond to either enabling or disabling the edit. Leave these Edit Compensation values at 2 unless you are experiencing problems. If you intend to change these values, contact Automation Support.
  - **Sync Adjust:** This parameter adjusts the sync play value for external VTRs (Sony and Ampex protocols). The Sync Adjust setting has a default of zero and should never have to be changed. However, if it needs to be changed, the value can be changed from -20 to 20 frames.
    - A positive value causes the tape to come up to speed past the SOM by the specified number of frames at the end of preroll.
    - A negative value causes the tape to come up to speed before the SOM by the specified number of frames at the end of preroll.

- **Tape Speed Control Options for Media List:**
  
  **Note:** This entry appears on all VTR setup tabs. This option need only be set once. Since the option is in a separate box, though it shares the same tab page as other setup options, when a different tab is selected, the option and its setting remains.

  **CAUTION:** There is no hard rule for which option works with which VTR. When using these controls, if one option doesn’t produce the desired result, try the other option.

  When a VTR (or tape machine) starts running, its speed increases from 0 to a stable level. However, this transient time to the stable level is not constant and is tape machine dependent. When a clip in the tape is to be recorded to a video disk server, it requires that the record command to the disk record port be frame accurate so that the first recorded screen of a clip in the video disk server is also SOM frame. Because of variant VTR transient times, without software control, a recorded clip can be a few frames off.

  - **Tape Speed Overwrite:** If absolute frame accuracy is not required, this option can be used. When this parameter is enabled, the system changes the speed of the VTR machine to hit the time of playing the SOM frame at the time a record command is sent to video disk server record port.
    - This method typically results in 80% to 90% frame accurate recording.

    **Note:** This option setting is typically required when using Invenio Capture for ingest.

  - **Sampling Tape Time Code:** For frame accurate recording, check this option. By default, this option is enabled.
    - When this parameter is enabled, instead of controlling VTR speed, the system controls the time to send the record command by sampling time code on the tape. When the sampling value shows that the VTR speed is constant, the system calculates the time of sending out the record command.
      - This method can result in 100% frame accurate recording.
The option is saved to the `mclient.ini` file and does not need to be checked again after next launch, or when the next setup tab is selected.

**Note:** This option is also for GMT list.

- Ignore "Audio data error level no good": (For Sony only.) Check to ignore this error.
- **Frame Calibration to Record Device:** This parameter allows adjusting the timing in the VTR driver to get frame accurate recording. Selecting OK saves this parameter setting to the INI file for future use.

**Example Use:**

1. Set the parameter "Frames To Send Record Early" on the disk (destination device) configuration.
2. Select one VTR as the source device and perform autocopy.
3. Check the first recorded frame (this should be the SOM frame), and adjust the VTR parameter "Frame Calibration To Record Device".
4. Select another VTR as the source device and perform autocopy.
5. Check the first recorded frame (this should be the SOM frame), and adjust the second VTR parameter.

4. Select the **Serial Port** tab. (This tab is present when Sony and Panasonic VTR types are being configured).

Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected.

- **Port setting:** Click the down arrow button to select from a list of available serial ports.
5. Select **VTR Offset** tab. (This tab is used to specify the offset parameter for DVC Pro.)

![VTR Offset Configuration](image)

Configure the following parameters as required:
- **One (1) for 25 MBPS**: (Default 0) use spin arrows to set the offset.
6. Select **Diagnostics** tab. (This tab appears when VTR type Demo VTR is selected and being configured.)

Configure the following parameters as required:

- **ID**: The device name identifies the VTR port. The default VTR name is VTR1. Enter the name by using up to four characters. When an event is threaded, a fifth character – the head number - is added to the name.

- **Compile ID**: The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

- **Inject button**: Click to inject IDs to tape.
7. Select **VTR Type** tab. This tab displays information about the VTR, including the model number, protocol ID, cassette size, analog/digital, and if extended errors are reported.

- **Refresh** button: Click the Refresh button to update the information display.
8. **Select Compile tab.** (Extended VTR only) This tab allows selection of the channels to compile for Audio editing.

![Compile tab screenshot]

9. **Apply the Configuration Changes**: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

   **Note**: Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

10. **Save the Configuration**: From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

   - Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

---

**Cart Machine Configuration (General)**

The following is an example cart machine configuration. Your cart machine may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.
To Configure a Cart Machine

1. Under Cart Machines in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the Cart Machine device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select General tab. Available options may differ depending on the device selected.

   Configure the following parameters as required:
   - **Device Name**: Enter a name (using up to 16 characters) for the cart machine. This name is used to identify the cart machine during event transmission.
   - **Options**.
     - **Eject on Initialization**: A stop command is issued to the cart machine whenever the Device Server is started or the port is re-initialized. Default is disabled (unchecked).
     - **Enable VTR 1-6**: This parameter allows you to select which VTRs are available for use. In the Enable VTR window, if a VTR is not selected, the VTR is not used by the ADC Device Server (or the cart machine). This is useful when using a cart machine VTR for some other operation or when the device is broken. To start using a deselected VTR, make sure this VTR is selected in the Enable VTR window. Default is 4 VTRs enabled.
     - **Keep Media in VTR**: A tape inserted in a VTR is retained by the VTR (not ejected). The tape can then only be manually ejected. This feature allows the VTR to behave as if it has a storage location to hold a tape - like a cart machine.
     - **Sync Adjust**: This parameter adjusts the sync play value for external VTRs (Sony and Ampex protocols). The Sync Adjust setting has a default of zero and should never have to be changed. However, if it needs to be changed, the value can be changed from -20 to 20 frames. A positive value causes the tape to come up to speed past the SOM by the specified number of frames at
the end of preroll. A negative value causes the tape to come up to speed before the SOM by the
specified number of frames at the end of preroll.

- **Door Error Delay**: (for Flexicart): Specify the delay before reporting a Door Open error.
- **Sampling VTR Time Code**: Use this parameter for selecting TSO method or "Frame Accurate
  Recording" method. When it is selected, "Frame Accurate Recording" method is used.
  Otherwise, TSO method is used. This option is applied to all the VTRs inside the cart machine. By
default, it is unchecked. The selection is also saved to mclient.ini file for next launch.
- **StandByOff When Tension Release**: Check to enable. This parameter forces the software to
  issue a Standby Off command to the VTR. In Sony Betacam decks, a tension release command is
  used. The setting on this parameter does not affect digital and one inch VTRs - these VTRs
  always receive the Standby Off command when issued. Default is disabled (unchecked).

4. Select the **Serial Port** tab. Use this tab to connect the driver to the ADC's serial COM port that the
device is physically connected. Click the down arrow button to select from a list of available serial
ports.

5. Select Editor Parameters tab.
Configure the following parameters as required:

- **VTR 1 – 6 button**: Click on a desired VTR to edit its compensation properties. The following box appears:

  ![VTR 1 Configuration](image)

  - **Edit On / Edit Off**: Leave these Edit Compensation values at 2 unless you are experiencing problems. If you intend to change these values, contact automation Support.
  - **Keep Media in VTR**: Enable (check) to have the device retain (i.e. not eject) the media.
- **Four Channel Audio**: Enable audio recording on four channels instead of the normal two channels. Default is disabled (unchecked).

6. Select **VTR Parameters** tab. (This tab is available for Odetics Cart Machines.)

   ![Configuration Manager Interface]

   Configure the following parameters as required:

   - **VTR 1 – 6 button**: Click on a desired VTR to edit its compensation properties. The VTR Configuration dialog box appears:
     - Select **General** tab.

     ![General Tab Interface]

     Configure the following parameters as required:
Standbyoff for Tension Release: This parameter forces the software to issue a Standby Off command to the VTR. In Sony Betacam decks, a tension release command is used. The setting on this parameter does not affect digital and one inch VTRs - these VTRs always receive the Standby Off command when issued. Default is disabled (unchecked).

Edit Compensation: This parameter adjusts the sync play value for external VTRs (Sony and Ampex protocols). The Sync Adjust setting has a default of zero and should never have to be changed. However, if it needs to be changed, the value can be changed from -20 to 20 frames. A positive value causes the tape to come up to speed past the SOM by the specified number of frames at the end of preroll. A negative value causes the tape to come up to speed before the SOM by the specified number of frames at the end of preroll.

Leave the Edit Compensation values at 2 unless you are experiencing problems. If you intend to change these values, contact Automation technical support.

- Select the Serial Port tab. Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.
• Select **VTR Offset** tab *(Used by DVC Pro)* to specify the offset parameter:

Configure the following parameters as required:

**One (1) for 25 MBPS**: *(Default 0)* use sin arrows to set the offset.

• Select **VTR Type** tab. This tab displays information about the VTR, including the model number, protocol ID, cassette size, analog/digital, and if extended errors are reported.
Refresh button: Click the Refresh button to update the information display.

7. Select Qualifiers tab. Use this tab to specify what types of material may be played out by the cart machine on each playlist.
The Qualifiers option is particularly important in GMT environments where some of a cart machine’s VTRs are assigned to the playlist and others are assigned to the GMT list for baseband caching to a video server. For example, if two of a cart machine’s four VTRs are assigned to play Events With Segments Only on the playlist, then any missing single-spot clips requested for caching will be played out only by the two VTRs assigned to the GMT list. If the qualifiers are not set, any missing single-spot clips will be registered with the cart machine for direct playout, instead of being registered with the playlist’s Requester for caching. If the missing clip is not found in the cart machine, the event will remain red on the playlist and be missed.
- Select a playlist and then click the **Edit** button. A properties sheet opens with playout qualification parameters: No Events With Segments, Events With Segments Only, No Events Greater Than xx (Mins.), No Events Less Than xx (Mins.), Only Events With ID in [an ASCII character range – the first character of the ID].

![Playlist Qualifiers](image)

- The individual VTRs in the cart machine may be assigned to different lists with different qualifiers. One VTR may be assigned to Playlist1 and only allowed to play segmented events, while another VTR assigned to Playlist2 is only allowed to play single-spot tapes. The qualifiers apply to playlists globally – any VTRs assigned to that list will be subject to the same playout qualifications.

8. Select **Diagnostics** tab.

The Diagnostics tab has several different functions depending on the make and model of cart machine.

For example:
- The Betacart’s Diagnostics tab, contains one button: Reinitialize (device). All Automation cart machine objects contain this option.
- The Odetics TCS90’s Diagnostics tab, contains two buttons: Reinitialize (device) and Reverify (storage).
- The SmartCart’s Diagnostics tab, contains three buttons: Reinitialize (device), Reverify (storage), and Reinitialize (elevator).
• **Reinitialize** button: Click to reinitialize the device. Confirm your selection when prompted.

The cart machine is reinitialized. The storage collection for the cart machine is cleared and any tapes in the VTRs are ejected (if Eject On Initialization has been selected on the General tab). All the bins are re-verified by the barcode reader and the automation's storage collection is rebuilt.

**WARNING:** This can be a risky and time-consuming procedure. Do not attempt a reinitialization unless the customer can afford to be without a cart machine for an extended period of time. Depending on the size of the cart machine and the number of bins available, reinitialization could take up to several hours!
Reverify button: This is a less disruptive procedure that a full reinitialization. ReVerify allows the cart machine to continue operating while it reverifies the contents of its bins and VTRs. This is a background procedure and the normal loading, unloading and playout of tapes will continue without interruption. The automation system’s storage collection remains intact, but its data is updated as each bin is reverified. New tapes should not be loaded or unloaded from the cart machine through the I/O door (load/unload bins) until the reverification process has completed.

- Bin By Bin: Select to specify reverify content on a bin-by-bin basis
- Column By Column: Select to specify reverify content on a column by column.

Init Elevator button: This performs a hardware reinitialization of the elevator robot mechanism. This should be used when problems are encountered and the operator has had to open the door and physically remove a tape from the robot.

9. Select Manual Mode tab. (This tab is available only for Panasonic SmartCart and all Odetics cart machines.)

Configure the following parameter as required:

- Manual Elevator Mode: When this mode is enabled (checked), the robot mechanism is placed offline for maintenance and the operator becomes the replacement for the robot.
  - This must be accomplished with the main door open so that the operator may access the storage bins and VTRs.
  - Prompting is given to indicate when tapes need to be loaded into VTRs from the cart machine’s library or removed from VTRs and replaced into the tape library.
  - It is necessary to enable the Pop up Diagnostic Window from the Preferences / Errors menu on the Air Client being used. This allows the prompting messages to appear on that client only.
  - Other clients are not affected.
Each pop up window must be closed before the next diagnostic message is displayed. This insures that no messages are missed and that tapes are moved in the order they are needed by the VTRs.

10. Select **Tape Handling** tab. Use this tab to specify the Label Length. (This tab is available for Odetics and Marc SmartCart Cart Machines.)

Configure the following parameters as required:

- **Odetics:** **Label Length:** Specify label length. (Range: 4 – 8). The length is the number of characters. Odetics labels have a certain number of prepended characters that must be truncated.
- **Marc Smart Cart:** **Use Labels as Read:** Check to enable using label content as read.
11. Select **Robotics Arms** tab. This option is only available for the Odetics TCS-2000.

Configure (check) to place one or more gripper arms offline. The elevator robot will continue to function, and the automation will not use any gripper arms that are disabled. The TCS-2000 can function with only one gripper arm enabled, but its speed and efficiency will be greatly reduced.

12. Select **Robot** tab. (Available for Marc 400-MII Cart, only.)
Specify the following functionality as required. Configure to enable (check) the Primary and or Auxiliary Elevator. The elevator robot will continue to function, and the automation will not use any elevator that is disabled.

- Enable Primary Elevator: Select (check) to enable.
- Enable Auxiliary Elevator: Select (check) to enable.

13. Select **Linkage** tab. (Available for Odetics TCS90M, TSC90LEM, and TCS90A devices, only.) From the dropdown list on tab specify a linkage device from the list of available devices.
14. Select **Tools tab.** *(Available for demo BetaCart and demo DVC1000 devices, only.)* Since no tape is actually being used with a demo device, the tape ID and title are entered here. With an actual device, this action is unnecessary, as the automation system can read this information off either a barcode or from the database record.

![CART - Channel 15](image)

Configure the following parameters as required:

- **Insert and Remove Tapes.**
  - **ID:** Enter the ID of the tape to be inserted or removed.
  - **Title:** Enter the title of the tape to be inserted or removed.
  - **Bin Location (A1-A40):** Select the slot in the cart machine to add the tape to or remove the tape from.
  - **Insert** button: Click to insert a tape.
  - **Remove** button: Click to remove a tape.

- **Hidden Bins.**
  - **Load Text File:** The Load Text File button is used to load list of material IDs with duration and title into bins based on bin ID.
  - **Purge:** Click to remove the content of the bins respectively.
15. Select **Additional Tools** tab. *(Available for demo DVC1000 devices, only.)* With an actual device, this action is unnecessary.

![](image)

Select the following actions as required:
- **Communications:** The "Fail" and "Restore" buttons are used to test communications.
  - **Fail:** Click to turn the device off-line.
  - **Restore:** Click to turn the device on-line and restore communications.

16. **Apply the Configuration Changes:** When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

Note: Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

17. **Save the Configuration:** From the Configured Devices window select **File>Save Devices.** The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

- Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.
M/C Switcher Configuration (General)

In general, the Automation interface treats all makes and models of switchers as generic devices. The specific driver for a particular brand of switcher will communicate using that brand’s control protocol, but this is transparent to the automation system’s user.

The following is an example Master Control (M/C) switcher configuration. Depending on the specific brand and model of switcher, the selection of configuration tabs may be different for that device, and there may be other configuration options not outlined here. Information regarding these options may be found in the user notes for the specific device.

- **Switching under automation**: The Automation system communicates with switchers via the devices’ native protocol. When a switch command is sent to a switcher, the automation sends a "switching triplet" consisting of the device number, the input number and the output number to the software object controlling the device. This "triplet" is then translated to the switcher’s own command language and the command is passed via the RS-422 serial connection to the device. This translated command may also contain transition information or audio mixer and keyer presets for a master control switcher, or the number of levels to switch for a router.

- **About Audio Over Events**: Some MC Switcher devices, such as Maestro and BrandMaster, can use the information in Audio Over events which cannot be included in # field. For these situations the Title field of the Audio Over events can be used. When there is value of event title in audio mixer record, this value can be used by other drivers when they are performing audio over events and sending all necessary commands.

  **Note**: Each MCSwitcher driver will use this functionality differently depending on its functions.

To Configure an M/C Switcher

1. Under **M/C Switchers** in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the M/C Switcher device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.
3. Select **General** tab. Use this tab to enter a specific name for the device, specify the dimensions of the switcher, and compensate for any switcher latency.

Configure the following parameters as required:

- **Device Name**: Enter a name (using up to 16 characters) for the switcher. This name is used by the automation system to identify the switcher. Systems with multiple switchers should have each switcher assigned a unique name.

- **Dimensions**.
  - **Input Crosspoints**: Specify the input crosspoint on a cascaded switcher to which the device’s setting is connected. The valid range is 0 to 32768. Default is 16.
  - **Output Crosspoints**: Specify the output crosspoint on a cascaded switcher to which the device’s setting is connected. The valid range is 0 to 32768. Default is 1.

  **Note on Versio MCS**: For Versio MCS the Input Crosspoints and Output Crosspoints options are grayed out. The Versio MCS driver will display all sources the VMCS is configured to show from the sources available on the upstream Platinum router. The Input Crosspoints field is filled in with the real number of sources requested from Versio device.

  **Note on Utah MC2020**: The MC-2020 is a 0-based switcher. Since ADC software is 1-based, all desired A/V port locations must be entered in the software as "A/V port +1." This includes all VTR A/V information, as well as all source names in the source name table. Crosspoint values up to 64k are supported.

- **Switcher Latency**: This parameter adjusts the latency of the switcher. The adjustment range depends on the device. Most switchers range -/+ 10 frames. (The Versio MCS ranges from -/+ 100 frames.)
  - If the adjustment is positive, the switcher switches the entered number of frames later.
  - If the adjustment is negative, the switcher switches the entered number of frames earlier.

  The default value of zero is usually sufficient.

  Adjust latency only if it has been determined that the switcher is indeed switching early or late. Some switchers have a built-in latency of one frame and will always switch one frame late if this latency is not compensated for.
IMPORTANT Versio / Versio MCS Note: For the switcher latency functionality to work with a Versio instance running the Versio MCS:
- Configure the Nexio Ports on the Versio instance for VdcpStopOnNext.
- The Registry setting for VdcpStopOnNext needs to be set to 1 for this functionality to work with the Nexio Ports of the Versio in the "Additional Port of Same Disk" configuration: Registry HKCU\Software\ASC Audio Video\LLM\Control, DWORD: VdcpStopOnNext.
- List Preroll must be increased for negative values above -88 for them to work correctly (assuming a 3 second preroll).

4. Select Serial Port tab. Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.
5. Select **Socket Port** tab. (For Versio MC) Use this tab to configure the driver’s TCP/IP connection.

Configure the following parameters as appropriate:

- **Socket Information**: The NGC MCS driver is independent driver. Default IP address is 127.0.0.1
  - **Host**: Enter the IP host address of the computer running the driver
  - **Port**: Enter the IP port number on which the driver is running. Default port is 8890.
- **URL**: Specify the URL for the Versio switcher. The setting is saved in "Adc1000nt.ini" file in order to be restored after Device Server restart.
  - The commands are wrapped in the HTTP 1.1 protocol. The Versio Switcher requires all MC XML commands be sent to this URL: http://127.0.0.1:8880/NGCSwitcher/NGCSwitcher.rest
  - For this parameter "NGCSwitcher.rest" is the default string when working with real switcher. However, the url can depend on switcher’s configuration.
  - All unnecessary slashes (/ or \) in the beginning or in the end of this line are automatically removed. This means, for example, that string "/NGCSwitcher.rest", incorrectly typed by the user, is converted to the correct line "NGCSwitcher.rest".
- **Log Setting**: The driver can create its own log file. This file can be created in the folder where Device Server will be started from or forwarded to another computer.
  - **Enable**: (Default: unchecked) Check to enable Log creation. When created the Log file will include all the commands from the driver to the NGC MCS device and from the NGC MCS device to the driver.
6. Select **Communications** tab. (For GVG MCS 1600, NVision MCS, Evertz E9625 MCS, Leitch Opus MCS.) Use this tab to specify Baud Rate, Data Bits, Stops Bits, and Parity.

![Communications Tab](image)

7. Select **Sources** tab. Use this tab to create a table of source names (mnemonics) associated with router or switcher inputs that the automation may use for record events. The source names table accepts multiple names for the same input number, but does not accept duplicate names for different inputs.

If a record event is placed on a record list, the source name may be entered in the title field. The automation compares this source name to the source names table and switches the designated input to the record device that has registered the event.
Note: For the Versio MCS Device the sources are assigned default values beginning with 1. Only the crosspoint number can be changed.

Configure the following parameters as required:

Note: For Versio MCS since operators can switch between the supported sources, the Add and Delete buttons are disabled. It is possible to use the Edit button to change the source number only. The value of the source number is valid during current TCP session. The list of sources is updated each time a new TCP session is created. The sources are set with default values starting with 1.

- **Add** button: Click the Add button to enter a source crosspoint name and number.
  - Crosspoint Name: Enter a mnemonic to help the operator identify the crosspoint.
  - Number: Enter the physical connection number of the crosspoint.
- **Edit** Button: To edit an existing entry, select an entry from the crosspoint list display and then click **Edit**. An edit dialog is displayed populated with the parameters currently specified for the selected entry. Make changes as required, and then click **OK**.

- **Delete** button: To delete an existing entry, select an entry from the crosspoint list display and then click **Delete**.

8. Select **Key Parameters** tab. (For TriKey-only)

Configure the following parameters as required:

- **Key Number Field Definition**: Choose either "#" or "sSP" field in the playlist as the keyer number. The selection depends on the functionality of other switcher drivers that may be used in conjunction with the Trikey. If the Trikey is used as a keyer-only slave device expanding the capability of a master control switcher (i.e. a Saturn), then the convention should follow that of the master. Otherwise, this may be set based on preference of the user.
  - **# field of Event**: This field has a range of 1 through 254
  - **sSP field of Event**: This field has a range of 0 to 9

- **Start Key Number**: Specify the first keyer number so that if Trikey is used as a slave, the keyer number will not be in conflict with the numbering system in the master switcher (which always starts from one). (Default: 7, Minimum: 1).

9. Select **Destinations** tab. Use this tab to create a table of destination names that the automation primarily uses for secondary crosspoint switch events. The destination names table accepts multiple names for the same output number, but does not accept duplicate names for different outputs.
If a secondary crosspoint switch event is placed on the playlist, the source and destination names may be entered in the title field using the format: *source name:destination name* (the colon is required)

The automation compares these names to the source and destination names tables and switch the designated input to the designated output at the appropriate time.

Configure the following parameters as required:

- **Add** button: Launches the Add Destination Data dialog. Specify the CrossPoint Name, Number, and then click **OK**
  - **Crosspoint Name**: The Crosspoint Name is a mnemonic to help the operator identify the crosspoint.
  - **Number**: The physical connection number of the crosspoint.
- **Edit** button: To edit an existing entry, select an entry from the crosspoint list display and then click **Edit**. An edit dialog is displayed populated with the parameters currently specified for the selected entry. Make changes as required, and then click **OK**.

![Edit Destination Data](image)

- **Delete** button: To delete an existing entry, select an entry from the crosspoint list display and then click **Delete**.

10. Select **System Inputs** tab. Use this tab to specify the switcher inputs for common sources such as Black, Colorbars, Station ID, and Initial Input. All four inputs designated here may be switched manually from the diagnostic switch panel (see Switching Tab below). In addition, the Black and Station ID inputs are used by the automation if the corresponding list settings, Switch to Black and Station ID on Skip, are enabled on the **List Configuration / Properties / Options** tab.

![MCS21 - Channel 7](image)

Configure the following parameters as required:

- **System Inputs**: For each parameter specify a number from 0 to 32768 to indicate which crosspoints carry the black, colorbars, station ID and initial input signals. Default is 0. These options are not used by the automation system unless the corresponding list settings are enabled for Black Input and StationID.

  - **Black Input**: When the Transmission List Option "Switch to Black" is selected, and the most recent event on the list was running on a device configured to use this router, then the crosspoint listed here (if non-zero) will be switched to the output crosspoint used by that event:
    - If the list stops because of an error,
If the event ends and there is a Hard-Start delay until the next event begins, or
If it ends normally and there are no more events on the list.
If it is set to 0 then nothing will happen.

- **Colorbars**: This crosspoint is used only when the Colorbars button is pressed on the diagnostics control panel (Configuration Utility or Air Client). If it is set to 0 then the Colorbars button will have no action.

- **Station ID**: When the Transmission List Option "Station ID on Skip" is selected, and the most recent event on the list was running on a device configured to use this router, then this crosspoint will be switched to the output crosspoint used by that event if an operator invokes Skip on the Air Client's control panel. When the next event begins to play, the crosspoint is switched to whatever that event requires.

- **Initial Input**: This crosspoint will be switched to all outputs of the router when the Device Server application is launched. If it is set to 0 then nothing will happen. In most cases it is recommended to leave this function disabled (0).

**About Initial Input**: The Initial Input source comes into play when communication is first established with the switcher or in the event of a switcher failure.

- If the switcher fails to switch for some reason – the switcher returns a NAK (i.e. a Negative Acknowledgment because the command format is wrong) or no response to a switch command – the automation retries the switch command twice.

- If the switcher fails to switch after two retries, the automation attempts to reinitialize the switcher. It sends a command to switch to the designated Initial Input. In most cases, particularly if there are intermittent serial communication problems with the switcher, it may be safer to leave the Initial Input set to zero. That way, the automation will not attempt to reinitialize the switcher and possibly switch to black (or whatever has been designated as the Initial Input).

11. Select **Effect Durations** tab. To configure Effect durations in frames.

Configure the following parameters as required:

- **Slow**: Specify a number from 0 to 999. Default is 60.
12. Select **Reporting** tab. Use this tab to enable reporting of the condition of the switcher to the error log.

Configure the following parameters as required:

- **Enable reporting for**: There are three available options on the Reporting tab, depending on the amount of information that is necessary to be logged into the ADC error file when the router is used. The actual log is configured on the Air Client application, but the information supplied to the logging mechanism from the router driver is regulated here.

  These parameters allow the switcher to generate an error whenever the switcher does not respond to a communication request. Place a check mark in each box to enable reporting (default is disabled for all).
  - **Errors**: Enables the logging of critical failures, such as the device failing to confirm that a transition command was executed, or when communication is lost with the router.
  - **Warnings**: Enables the logging of other information reported by the router. The 1200 series routers do not provide such information to automation; so enabling Warnings will have no effect on the system.
  - **Crosspoint Changes**: Enables the logging of each transition with a timestamp from when it occurred.

**IMPORTANT**: Normally these are left disabled, but can be enabled for diagnostic purposes. If reporting for Crosspoint Changes is enabled, the error log will quickly fill up with every crosspoint switch command the automation has sent to the switcher.

- **Medium**: Specify a number from 0 to 999. Default is 30.
- **Fast**: Specify a number from 0 to 999. Default is 15.

**IMPORTANT**: These durations, in frames, must match the effect durations configured in the switcher itself.
13. Select **Log** tab.

Configure the following parameters as required:

- **AsRun Log**: This group enables As Run Logging of Manual Actions on Program, Keyer and Audio Over Bus with the help of 3 check boxes: Select the type of bus to log: Program Bus, Keyer Bus, Audio Over Bus.
- **Program Bus**: When selected enables the manual change in PGM bus to be reported as an error or as a warning.
- **Keyer Bus**: When selected enables the manual change in KEY bus to be reported as an error or as a warning.
- **Audio Over Bus**: When selected enables the manual change in AUDIO OVER bus to be reported as an error or as a warning.
- **Contextual Error Message**: When this box is checked and the user presses or releases Hold button, the Air Client displays the following additional error messages:
  - "Manual Intervention of System"
  - "Return to Automated Control of System"
14. Select **Backup** tab. Use this tab to designate another switcher as the backup to the main switcher in case of a failure. The switcher that is configured here will receive all of the transition commands that are sent to the main device. For this reason the Backup switcher must be wired identically to the Main. There are other methods for driving a second switcher if this limitation cannot be accommodated.

Configure the following parameters as required:

- **Backup Switcher**: Select from the dropdown list of available backup switchers. Use this parameter when installing a redundant switcher to act as backup if the main switcher fails. In the Configure Backup Switcher window, enter the number of the port that has the backup switcher connected to it (i.e. the device server channel number).
  
  The main and backup switchers do not need to be the same model, but the backup should have dimensions large enough to back up all of the main switcher’s crosspoints. Both switchers must receive the same inputs. During playout, the backup switcher switches whenever the main switcher switches.
  
  The default is None (no backup switcher configured).

**IMPORTANT**: The backup switcher is switched simultaneously with the main switcher. The inputs on the backup switcher **must match**, in a one-to-one correspondence, the inputs on the main switcher.

Once a backup switcher/router has been specified, two additional new configuration tabs are displayed: Input Mapping and Output Mapping, which are used to define the input and output mappings between the designated devices.

If a backup switcher is not specified, the "Enable backup mapping" check-box is disabled (grayed out), and the additional mapping tabs are hidden (not displayed).

- **Enable backup mapping**: Check this box to enable backup Input and Output mapping.
  
  - If this parameter is checked, the Input Mapping and Output Mapping tabs are displayed, and enabled for entry.
  
  - If a backup switcher is set, but "Enable backup mapping" is disabled (unchecked), the Input Mapping and Output Mapping tab their but tables are in a disabled state. This allows the user can see what mapping is used if backup mapping is enabled.
15. **Input Mapping** tab and the **Output Mapping** tab. When the user specifies backup switcher/router for the first time, the mapping tables are filled with default values, using one-to-one correspondence.

**Default Mapping:** The following default mapping is used only if the backup device is specified for the first time.

- If both Main and Backup switcher/router have the same amount of inputs/outputs, the tables are filled using one-to-one correspondence between Main and Backup inputs. If Backup switcher/router has more inputs/outputs than Main, the same order is used.

<table>
<thead>
<tr>
<th>Main Input (16 inputs)</th>
<th>Backup Input (16 or more inputs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
</tr>
</tbody>
</table>

- If the Main switcher/router has more inputs/outputs than the Backup, all Main inputs/outputs whose numbers are more than the Backup inputs/outputs amount will correspond to Backup input/output 1:

<table>
<thead>
<tr>
<th>Main Input (6 inputs)</th>
<th>Backup Input (4 inputs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
</tr>
</tbody>
</table>

**Modified Mapping:** If the backup switcher/router is already specified and mapping tables are filled by the user, but then the user changes backup device, already adjusted input and output mapping values are retained – as much as possible.

- If the first chosen backup switcher/router has more inputs/outputs than the second, all inputs/outputs that are not in range are replaced by appropriate ones.
For Example: The user first chooses an IconMaster MC which has 16 inputs and specified mapping, then changes the backup switcher/router to a Sony Isara MC which has 12 inputs. The old input mapping is kept, but values which are not in range are replaced automatically.

Note: This example is for reference only. The configuration dialog of your selected devices may appear different than those shown in this example.

- If the user fills mapping tables and then changes the amount of inputs/outputs on the Main switcher/router, the number of lines in the mapping tables is automatically updated and the new lines populated with default values.

For Example: The main switcher M2100 has 16 inputs, but then the user increases the number of inputs on the M2100 to 20 and presses "Apply".

Note: This example is for reference only. The configuration dialog of your selected devices may appear different than those shown in this example.
16. Select **Audio Control** tab. Use this tab to set up specific audio control commands for switchers that support this feature.

Unsupported audio options (e.g. audio channel mapping) are hidden on the "Audio Control" tab in MCS driver configuration screens. This simplifies configuration by ensuring less confusion over supported vs. unsupported features per specific MCS make/model.

Configure the following parameters as required:

- **Control Audio Mode**: Enable (check) to allow control of Audio Mode.
- Audio Mode:
  - **Stereo/Mono**: Enable (check) stereo / mono control for audio recording. Default is disabled (unchecked).
    
    If an event has either Stereo or Mono in the sSP column of the transmission list, the automation will command the switcher to use the appropriate audio mixing.
  - **Enhanced Audio Modes**: (For MC2020) Check to enable Audio support for mono/stereo/SAP/Dolby modes.
If an event has either Mono/Stereo/SAP in the SSP column of the transmission list, the automation will command the switcher to use the appropriate audio mixing.

- **Switcher Audio Crosspoint**: Enable (check) for secondary audio routing.
- **Current number of audio outputs**: Specify the number of switcher audio crosspoints (up to 16). This parameter is enabled only if the Switcher Audio Crosspoint option is selected. Otherwise it is grayed out.
- **Default input for Audio**: Specify the input (1-x) for Audio 1-x. These options are enabled when Switcher Audio Crosspoint is selected.
- **ADC v12: About Controlling Audio Overs**: (For IconMaster) To better manage automation control of Audio Over busses, the IconMaster driver implements a subscription service that subscribes to changes and monitors device status according to received notifications.

17. Select **Cascade** tab. Use this tab to set up Cascade routing.

Cascading (sometimes called "chaining") allows the user to route audio and video through multiple switchers and routers simultaneously.

**Example**: A customer has ten VTRs, each with a designated output on their router. They have only one input on their master control switcher that must be shared among all ten VTRs. Each VTR output on the router may be cascaded to the single input on the master control switcher to switch it to air. This particular arrangement negates the possibility of using transition effects on the master control switcher between two back-to-back VTR events—the switcher cannot transition between events on the same input.

- **Add** button: Launches the Add Cascade Data dialog. Specify the following parameters as required, click **OK**, and then click **Apply**.
  - **Output Active Line**: This setting specifies which of the switcher’s crosspoints the cascaded switcher is connected to. The valid range is 0 to 32768.

  **Note**: If the "Output Active Line" number is the same as "Cascade Crosspoint Out" number, it is treated as invalid. This only occurs if the Cascade Device is the same and not if it is a different switcher/router.

- **Cascade Device**: Select a cascade device from the dropdown list.
- Cascade Crosspoint In: The crosspoint on the cascaded switcher to which the Output Active Line setting (above) is connected. The valid range is 0 to 32768.
- **Cascade Crosspoint Out**: The out crosspoint on the cascaded switcher to which the signal is to be routed. The valid range is 0 to 32768.

![Add Cascade Data](image)

- **Edit Button**: To edit an existing entry, select an entry from the cascade list display and then click **Edit**. An edit dialog is displayed populated with the parameters currently specified for the selected entry. Make changes as required, click **OK**, and then click **Apply**.

![Edit Cascade Data](image)

- **Delete button**: To delete an existing entry, select an entry from the cascade list display and then click **Delete**.

18. Select **Switching** tab. Use this tab to manually switch inputs and outputs for diagnostic purposes.
This utility is not intended as an on-line substitute for the switcher’s own control panels. The source and destination names tables must be completed before any sources or destinations will appear in the drop-down boxes.

Configure the following parameters as required:

- **Black, Colorbars, Station ID, Initial Input buttons**: These selections refer to the sources designated on the System Inputs tab above. If a source and destination are selected in the drop-down boxes, clicking the "Switch" button will cause the switch to occur.

19. Select **Timing** tab. Used by devices that support Max Latency and join in progress functionality. (e.g. IconMaster, NVision MCS.)

Configure the following parameters as required:
- **Max Latency Count**: (Default: 20) Specify the time in frames that a device needs to reply to a command. Adjust the "Max Latency Count" based on the number of secondary events to bring up with the primary event. (Range: 0 - 300)
- **Join in progress**: (For IconMaster) Enable (check) the IconMaster driver option to re-join the ADC playlist at its current schedule location after the IconMaster has reported to its serial port that Automation control has been restored from the local mode (hold button on IconMaster Panel). (Default: disabled)


![Manual Intervention Tab](image)

Configure the following parameters as required:
- **Do not remove manually enabled keyers**: Use this option to configure handling of manually inserted and enabled keyers.
  - When this option is enabled (checked), manually enabled keyers are NOT removed with the next transition.
  - When this option is disabled, manually enabled keyers are removed with the next transition.
21. Select **Command** tab. (for BTS Saturn Switcher and GVR Maestro) If required, enable (check) to preroll a transition.

![Command Tab](image)

22. Select **MCS Status** tab. (For Versio sub device). After a control connection has been initialized, the Versio MCS driver regularly checks the status of the MCS device. All requested information is available upon the MCS Status tab.

![MCS Status Tab](image)

23. Select **MCS Status** tab. (For Versio MCS) After a control connection has been initialized, the Versio MCS driver regularly checks the status of the MCS device. All requested information is available upon the MCS Status tab.

![MCS Status Tab](image)
24. Select **Diagnostics** tab. (For GVG 100 and Versio MCS) If required, click the **Reinitialize** button to reinitialize the device.
25. Select **Manual Control** tab. (For Probel TX520). Use this tab to set keyer 1 thru keyer 4 to Manual or Auto mode. For example, if Manual Control is selected for keyer1, Automation will not send any commands to turn on/off the keyer 1.

![PR520 - Channel 13](image)

26. Select **Imagestore** tab. (For Miranda MCS SubDev only).

![MC50X - Channel 13](image)
27. Select **Transition Attributes** tab. (For Pesa MCLite MCS only).

Configure the following parameters as required:
- **Cut Input Name**: Select option from dropdown list
- **Hold Input Name**: Select option from dropdown list
- **Wipe Pattern**: Select option from dropdown list
- **Wipe Border**: Select option from dropdown list

28. Select **Audio Over** tab. (For QMC and Oxtel Presmaster)

Configure the following parameters as required:
- **Uses**: Choose between the # field and the sSP field to represent the Audio unit (value of 1 or 2). Default will be the current behavior, i.e. # Field.
Audio Over number and Keyer number can be specified in ‘#’ field or the ‘sSP’ field. Up to 254 logos can be recalled.

- **# field of Event**: This field has a range of 0 to 9
- **sSP field of Event**: This field has a range of 1 through 254

29. Select **Keyer Number Over** tab. (For QMC)

![Keyer Number Over dialog box](image)

Configure the following parameters as required:

- **Uses**: Choose between the # field and the sSP field to represent the Keyer Number. Default will be the current behavior, i.e. # Field.
  
  Keyer number can be specified in ‘#’ field or the ‘sSP’ field. Up to 254 logos can be recalled.

- **# field of Event**: This field has a range of 0 to 9
- **sSP field of Event**: This field has a range of 1 through 254
30. Select **Extra Keyers** tab. (For Oxtel Presmaster only).

Configure the following parameters as required:

- **Fitted**: This parameter defines the Intuition mode from unfitted to fitted. Default parameter is unfitted (unchecked).

The Presmaster has two downstream keyers, an optional two extra keyers (when the second Imagestore is fitted) or an optional 8 extra keyers (when an Imagestore Intuition is fitted).

31. Select **Logo Source** tab. (For Oxtel Presmaster only.)

Configure the following parameters as required:

- **Uses**: Select one of the following:
  - **# field of Event**: (Default selection) When selected, has logo limit of 254.
• **Title field of Event:** Select to allow the operator to use the title field to enter logo numbers up to 4000.

  The format of Title filed for Logo is as follows: "L=\<logoNumber>" (without quotation marks and brackets)

32. **Apply the changes.** When finished click **Apply**, then click **OK**.

  When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

  **Note:** Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

33. **Save the Configuration:** From the Configured Devices window select **File> Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

  * Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

---

**Router Configuration (General)**

In general, the Automation interface treats all makes and models of routers as generic devices. The specific driver for a particular brand of router will communicate using that brand’s control protocol, but this is transparent to the automation system’s user.

The following is an example router configuration. Depending on the specific brand and model of router, the selection of configuration tabs may be different for that device, and there may be other configuration options not outlined here. Information regarding these options may be found in the user notes for the specific device.

* **Routing under automation:** The Automation system communicates with routers via the devices’ native protocol. When a switch command is sent to a router, the automation sends a "switching triplet" consisting of the device number, the input number and the output number to the software object controlling the device. This "triplet" is then translated to the router’s own command language and the command is passed via the RS-422 serial connection to the device. This translated command may also contain transition information or audio mixer and keyer presets for a master control switcher, or the number of levels to switch for a router.

**To Configure a Router**

1. Under **Router Switchers** in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.
2. Select the Router device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select **General** tab. Use this tab to enter a specific name for the device, specify the dimensions of the router, and compensate for any router latency.

![Configuration Dialog](image)

Configure the following parameters as required:

- **Device Name**: Enter a name (using up to 16 characters) for the switcher. This name is used by the automation system to identify the switcher. Systems with multiple switchers should have each switcher assigned a unique name.

- **Dimensions**.
  - **Input Crosspoints**: Specify the input crosspoint on a cascaded switcher to which the device’s setting is connected. The valid range is 0 to 32768. Default is 16.
  - **Output Crosspoints**: Specify the output crosspoint on a cascaded switcher to which the device’s setting is connected. The valid range is 0 to 32768. Default is 1.

- **Switcher Latency**: This parameter adjusts the latency of the switcher. The adjustment can range from -10 to +10 frames.
  - If the adjustment is positive, the switcher switches the entered number of frames later.
  - If the adjustment is negative, the switcher switches the entered number of frames earlier. The default value of zero is usually sufficient.

Adjust latency only if it has been determined that the router is indeed switching early or late. Some routers have a built-in latency of one frame and will always switch one frame late if this latency is not compensated for.

4. Select Connection tab. (For PassThrough and Panacea C&Q routers) Use this tab to configure the driver for serial or IP control.
Serial: To configure a serial connection select the Serial radio button. The Serial Port pane is made active. Also, when this option is selected the Communications tab is displayed.

- From the Serial Port drop-down list choose a connection port. This port selected is the physical port which the device is connected to.
- When viewing the serial port cards on the back of the ADC Device Server, the upper left serial port is Port 1. The port numbers increase as you count down the ADC serial board. The top serial port of the next serial card will be the following port number.

TCP/IP: To configure a TCP/IP connection using telnet select the TCP/IP radio button. The TCP/IP (telnet) pane is made active.

- Host: Specify the host IP address.
- Port: Specify the communications port to use. (Default: 23)
- Telnet Login: Specify your telnet login.
- Telnet Password: Specify your telnet password.

**Note:** The driver opens a Telnet session into the Router. It establishes TCP connection with Telnet port (23 by default), sends login/password, and then operates according to the same protocol as serial connection.

**Note:** The number of Telnet sessions that can be opened at the same time depends on the device. (For Example: Maximum 4 sessions with Platinum router. Maximum 10 sessions with Panacea router.) The number of Telnet sessions used will reduce the total number of connections allowed for a device.

5. Select Serial Port tab. Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.
Set this to the physical serial port number on the Device Server where the router is connected (start from the first serial card on the left; the ports are numbered top-down). You need not use the same value as the Channel number for the Serial Port, although it may make troubleshooting easier for you in the future.

6. Select **Communications** tab. (For Evertz-Quartz, Miranda-Nvision, Network Proline, BTS Venus, DiTech, and Leitch PT) Use this tab to specify Baud Rate, Data Bits, Stops Bits, and Parity.

7. Select **Sources** tab. Use this tab to create a table of source names (mnemonics) associated with router inputs that the automation may use for record events. The source names table accepts multiple names for the same input number, but does not accept duplicate names for different inputs.
If a record event is placed on a record list, the source name may be entered in the title field. The automation compares this source name to the source names table and switches the designated input to the record device that has registered the event.

This is important if you plan on using the router in conjunction with ADC record events, which use the descriptions to identify the source on the router. Otherwise, it is not necessary to fill in this information (the Transmission List will not use this information for Playout events).

Configure the following parameters as required:

- **Add** button: Click the Add button to enter a source crosspoint name and number.
  - **Crosspoint Name**: The Crosspoint Name is a mnemonic to help the operator identify the crosspoint. (up to 8 characters)
  - **Number**: The physical connection number of the crosspoint.
- **Edit** button: To edit an existing entry, select an entry from the crosspoint list display and then click **Edit**. An edit dialog is displayed populated with the parameters currently specified for the selected entry. Make changes as required, and then click **OK**.

![Edit Source Data dialog]

- **Delete** button: To delete an existing entry, select an entry from the crosspoint list display and then click **Delete**.

8. Select **Destinations** tab. Use this tab to create a table of destination names that the automation primarily uses for secondary crosspoint switch events. The destination names table accepts multiple names for the same output number, but does not accept duplicate names for different outputs. If a secondary crosspoint switch event is placed on the playlist, the source and destination names may be entered in the title field using the format: *source name:destination name* (the colon is required). The automation compares these names to the source and destination names tables and switches the designated input to the designated output at the appropriate time.

![Destinations tab]

Configure the following parameters as required:
- **Add** button: Launches the Add Destination Data dialog. Specify the CrossPoint Name, Number, and then click **OK**
  - **Crosspoint Name**: The Crosspoint Name is a mnemonic to help the operator identify the crosspoint.
• **Number**: The physical connection number of the crosspoint.

![Add Destination Data](image)

- **Edit** Button: To edit an existing entry, select an entry from the crosspoint list display and then click **Edit**. An edit dialog is displayed populated with the parameters currently specified for the selected entry. Make changes as required, and then click **OK**.

![Edit Destination Data](image)

- **Delete** button: To delete an existing entry, select an entry from the crosspoint list display and then click **Delete**.

9. Select **System Inputs** tab. Use this tab to specify the router or switcher inputs for common sources such as Black, Colorbars, Station ID, and Initial Input.

All four inputs designated here may be switched manually from the diagnostic switch panel (see Switching Tab below). In addition, the Black and Station ID inputs are used by the automation if the corresponding list settings, Switch to Black and Station ID on Skip, are enabled on the **List Configuration / Properties / Options** tab.

![System Inputs](image)

Configure the following parameters as required:
- **System Inputs:** For each entry specify a number from 0 to 32768 to indicate which crosspoints carry the black, colorbars, station ID and initial input signals. Default is 0. These options are not used by the automation system unless the corresponding list settings are enabled for Black Input and Station ID.

  - **Black Input:** When the Transmission List Option "Switch to Black" is selected, and the most recent event on the list was running on a device configured to use this router, then the crosspoint listed here (if non-zero) will be switched to the output crosspoint used by that event:
    - If the list stops because of an error,
    - If the event ends and there is a Hard-Start delay until the next event begins, or
    - If it ends normally and there are no more events on the list.
    - If it is set to 0 then nothing will happen.

  - **Colorbars:** This crosspoint is used only when the Colorbars button is pressed on the diagnostics control panel (Configuration Utility or Air Client). If it is set to 0 then the Colorbars button will have no action.

  - **Station ID:** When the Transmission List Option "Station ID on Skip" is selected, and the most recent event on the list was running on a device configured to use this router, then this crosspoint will be switched to the output crosspoint used by that event if an operator invokes Skip on the Air Client's control panel. When the next event begins to play, the crosspoint is switched to whatever that event requires.

  - **Initial Input:** This crosspoint will be switched to all outputs of the router when the Device Server application is launched. If it is set to 0 then nothing will happen. In most cases it is recommended to leave this function disabled (0).

**Note:** During initialization of the router driver, all destinations are set to the source entered in the "Initial Input".

### About Initial Input:
The Initial Input source comes into play when communication is first established with the switcher or in the event of a switcher failure.

- If the router fails to switch for some reason – the router returns a NAK (i.e. a Negative Acknowledgment because the command format is wrong) or no response to a switch command – the automation retries the switch command twice.

- If the router fails to switch after two retries, the automation attempts to reinitialize the router. It sends a command to switch to the designated Initial Input. In most cases, particularly if there are intermittent serial communication problems with the router, it may be safer to leave the Initial Input set to zero. That way, the automation will not attempt to reinitialize the router and possibly switch to black (or whatever has been designated as the Initial Input).
10. Select **Effect Durations** tab. (For Panacea Clean Quiet) Use this tab to select duration of transitions in frames for Slow, Medium and Fast duration transitions.

11. Select **Reporting** tab. Use this tab to enable reporting of the condition of the switcher or router to the error log.

Configure the following parameters as required:

- **Enable reporting for**: There are three available options on the Reporting tab, depending on the amount of information that is necessary to be logged into the ADC error file when the router is used. The actual log is configured on the Air Client application, but the information supplied to the logging mechanism from the router driver is regulated here.
These parameters allow the switcher to generate an error whenever the switcher does not respond to a communication request. Place a check mark in each box to enable reporting (default is disabled for all).

- **Errors**: Enables the logging of critical failures, such as the device failing to confirm that a transition command was executed, or when communication is lost with the router.
- **Warnings**: Enables the logging of other information reported by the router. The 1200 series routers do not provide such information to automation; so enabling Warnings will have no effect on the system.
- **Crosspoint Changes**: Enables the logging of each transition with a timestamp from when it occurred.

**IMPORTANT**: Normally these are left disabled, but can be enabled for diagnostic purposes. If reporting for Crosspoint Changes is enabled, the error log will quickly fill up with every crosspoint switch command the automation has sent to the router.

12. Select **Log** tab. Use this tab to configure manual intervention logging parameters.

Configure the following parameters as required:

- **AsRun Log**: This group enables As Run Logging of Manual Actions on Program, Keyer and Audio Over Bus with the help of 3 check boxes: Select the type of bus to log: Program Bus, Keyer Bus, Audio Over Bus.
- **Program Bus**: When selected enables the manual change in PGM bus to be reported as an error or as a warning.
- **Keyer Bus**: When selected enables the manual change in KEY bus to be reported as an error or as a warning.
- **Audio Over Bus**: When selected enables the manual change in AUDIO OVER bus to be reported as an error or as a warning.
- **Contextual Error Message**: Check to enable two additional error messages:
  - "Manual Intervention of System"
  - "Return to Automated Control of System"
13. Select **Backup** tab. Use this tab to designate another router as the backup to the main router in case of a failure. The router that is configured here will receive all of the transition commands that are sent to the main device. For this reason the Backup router must be wired identically to the Main. There are other methods for driving a second switcher if this limitation cannot be accommodated.

Configure the following parameters as required:

- **Backup Switcher**: Select from the dropdown list of available backup switchers. Use this parameter when installing a redundant switcher to act as backup if the main switcher fails. In the Configure Backup Switcher window, enter the number of the port that has the backup switcher connected to it (i.e., the device server channel number).

  The main and backup switchers do not need to be the same model, but the backup should have dimensions large enough to back up all of the main switcher’s crosspoints. Both switchers must receive the same inputs. During playout, the backup switcher switches whenever the main switcher switches.

  The default is None (no backup switcher configured).

  **IMPORTANT**: The backup router is switched simultaneously with the main router. The inputs on the backup router must match, in a one-to-one correspondence, the inputs on the main router.

Once a backup switcher/router has been specified, two additional new configuration tabs are displayed: Input Mapping and Output Mapping, which are used to define the input and output mappings between the designated devices.

- **Enable backup mapping**: Check this box to enable backup Input and Output mapping.
  - If this parameter is checked, the Input Mapping and Output Mapping tabs are displayed, and enabled for entry.
  - If a backup switcher is set, but "Enable backup mapping" is disabled (unchecked), the Input Mapping and Output Mapping tab their but tables are in a disabled state. This allows the user can see what mapping is used if backup mapping is enabled.

14. **Input Mapping** tab and the **Output Mapping** tab. When the user specifies backup switcher/router for the first time, the mapping tables are filled with default values, using one-to-one correspondence.
Default Mapping: The following default mapping is used only if the backup device is specified for the first time.

- If both Main and Backup switcher/router have the same amount of inputs/outputs, the tables are filled using one-to-one correspondence between Main and Backup inputs. If Backup switcher/router has more inputs/outputs than Main, the same order is used.

<table>
<thead>
<tr>
<th>Main Input (16 inputs)</th>
<th>Backup Input (16 or more inputs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
</tr>
</tbody>
</table>

- If the Main switcher/router has more inputs/outputs than the Backup, all Main inputs/outputs whose numbers are more than the Backup inputs/outputs amount will correspond to Backup input/output 1:

<table>
<thead>
<tr>
<th>Main Input (6 inputs)</th>
<th>Backup Input (4 inputs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
</tr>
</tbody>
</table>

Modified Mapping: If the backup switcher/router is already specified and mapping tables are filled by the user, but then the user changes backup device, already adjusted input and output mapping values are retained – as much as possible.

- If the first chosen backup switcher/router has more inputs/outputs than the second, all inputs/outputs that are not in range are replaced by appropriate ones.

For Example: The user first chooses an Evertz router which has 128 inputs and specified mapping, then changes the backup switcher/router to an IconMaster which has 16 inputs. The old input mapping is kept, but values which are not in range are replaced automatically.
Note: This example is for reference only. The configuration dialog of your selected devices may appear different than those shown in this example.

- If the user fills mapping tables and then changes the amount of inputs/outputs on the Main switcher/router, the number of lines in the mapping tables is automatically updated and the new lines populated with default values.

For Example: The main switcher Maestro has 6 inputs, but then the user increases the number of inputs on the Maestro to 12 and presses "Apply".

Note: This example is for reference only. The configuration dialog of your selected devices may appear different than those shown in this example.

Maestro set for 6 Inputs
Input tab shows 6 lines for input

Maestro changed to 12 Inputs
Input tab now shows 12 lines for input
15. Select **Cascade** tab. Use this tab to set up Cascade routing.

**Cascading** (sometimes called "chaining") allows the user to route audio and video through multiple routers and switchers simultaneously.

**Example**: A customer has ten VTRs, each with a designated output on their router. They have only one input on their master control switcher that must be shared among all ten VTRs. Each VTR output on the router may be cascaded to the single input on the master control switcher to switch it to air. This particular arrangement negates the possibility of using transition effects on the master control switcher between two back-to-back VTR events – the switcher cannot transition between events on the same input.

**Recursive Cascading** allows Router sources to be cascaded back into the same router for special purposes.
Example: a customer wishes to route certain analog sources through an analog-to-digital converter (ADC) before routing them to a digital record device. The router output for the analog device may be recursively cascaded back into the router input for ADC. The output of ADC may then be routed to the digital record device.

- Click the Add button to enter new cascade data for the switcher OR click the Edit button to modify cascade data selected on the Cascade tab:

Configure the following parameters as required, and then click OK.

- **Output Active Line**: This setting specifies which of the switcher's crosspoints the cascaded switcher is connected to. The valid range is 0 to 32768. Default is 0.

  **Note**: If the "Output Active Line" number is the same as "Cascade Crosspoint Out" number, it is treated as invalid. This only occurs if the Cascade Device is the same and not if it is a different switcher/router.

- **Cascade Device**: Select a cascade device from the dropdown list.
- Cascade Crosspoint In: The crosspoint on the cascaded switcher to which the Output Active Line setting (above) is connected. The valid range is 0 to 32768. Default is 0.
- **Cascade Crosspoint Out**: The out crosspoint on the cascaded switcher to which the signal is to be routed. The valid range is 0 to 32768. Default is 0.
- Click the **Delete** button to remove cascade data selected on the Cascade tab.

16. Select **Switching** tab. Use this tab to manually switch inputs and outputs for diagnostic purposes. This utility is not intended as an on-line substitute for the switcher's own control panels. The source and destination names tables must be completed before any sources or destinations will appear in the drop-down boxes.

Configure the following parameters as required:

- **Black, Colorbars, Station ID, Initial Input buttons**: These selections refer to the sources designated on the System Inputs tab above. If a source and destination are selected in the drop-down boxes, clicking the "Switch" button will cause the switch to occur.
17. Select **Address** tab. (For Sony DVS and Sony Router). Specify the address (level) of the Sony DVS switcher you want to control.

Configure the following parameter as required:

- **Sony Address**: This is the hex address (level) of the Sony DVS switcher you want to control.
  - Routing switchers are connected using multidrop connections, UA1 (31h fixed) and UA2 must be set for each model as their own addresses. **UA2 is specified using this Select Address tab.**
    - When the host CPU controls switchers, the corresponding bit of the switcher to be controlled is set to '1' and the command is transmitted.
    - If more than one of UA2's bits are on, the command is executed, but no response is returned. However, Negative Acknowledgement (NAK) is returned if NAK (i.e. a Negative Acknowledgment because the command format is wrong) conditions exist.
  - (For Sony Router 16x16, 32x32 and 256x256, and for Sony 4096 router.) By default all levels are disabled and the level switching is done based on the value entered in "Address" tab.

**Note:** If any levels are enabled in the "Levels" tab, then the "Address" tab is ignored.
18. Select **Cart Machine** tab. (For LMS Router)

Configure the following parameters as required:
- **Cart Machine**: Select the cart machine.
- **Monitor Enabled**: Check to enable switcher monitoring

19. Select **Diagnostics** tab. If required, click the **Reinitialize** button to reinitialize the device.
20. Select "**Device Specific**" Channel tab. (For M2100 and Icon Master Aux Routers). Use this tab to specify the Auxiliary device.

![AxBus - Channel 20](image)

**About the IconMaster Aux Router:**

ADCv12 supports Aux Bus control on the IconMaster. The AxBus can be switched manually through the switch panel and through automation.

**IMPORTANT:** The AuxBus driver must be requested and added to your Device Server build prior to use.

21. Select **Levels** tab. Use this tab to specify how many levels to switch on a multi-level router.

The options available on this tab depend on the device selected. The following example tabs are from the Sony 256 (left), Datatek (right), Pesa (lower left) and NVision Router (lower right).

**Note:** These are global settings for all inputs and outputs on the router. The automation does not have the ability to do input-specific level switching, i.e. the automation cannot be configured to specify that one input should only switch levels 1, 2, 3 and another input should switch levels 1 through 8. The "Levels to Switch" parameter applies to all inputs on the router.

**Note:** Other routers may not have this tab available in the configuration sheet. The "Levels to Switch" may be configured in the router itself allowing more flexibility in level switching. Refer to the user notes for the specific device and to the vendor’s documentation for more information.
Configure the following parameters as required,

- **Number of Levels**: Specify the number of video and audio router levels. For Example: The System 3 router itself has internal association tables. There is an association table for source and one for destination. These internal association tables allow the System 3 to be set up such that the audio and video can be different for a given table entry. To use the association feature on the list, set the value of "levels" in level tab of device configuration to 0.

- **Router Levels**: Select the number of router levels.
  - (For Sony Router 16x16, 32x32 and 256x256, and for Sony 4096 router.) This tab is used to support multiple levels for the SONY Router (S-BUS protocol) 256x256 driver. If any of the levels are enabled in the "Levels" tab, then the "Address" tab is ignored.

- For NVision and Panacea Clean Quiet Routers:
• **Add button:** When selected launches an 'Add Cascade Data' dialog. On this dialog specify Level name, Level number, and select Video, Audio, and/or AFV. When finished click **OK**.

![Add Cascade Data](image)

• **Edit button:** To edit an entry, select an existing entry from the display list and then click **Edit**. A populated Cascade Data dialog is launched. Make any required changes then click **OK**.

![Edit Cascade Data](image)

• **Delete button:** To delete an entry, select an existing entry from the display list and then click **Delete**.
22. **Select Wire tab.** (For GVG 10XL and Evertz 1200) Use this tab to configure the driver to operate in Simplex or Full Duplex mode.

![Wire Configuration Tab](image)

Configure the following parameters as required:

- **2 Wires:** If selected, the driver will ignore any input from the device and never report any comm. errors. If RS-485 operation is attempted with multiple routers (not recommended), this option must be used and the return lines from the switcher must be disconnected. The Device Server hardware is not capable of negotiation on an RS-485 bus.

- **4 Wires:** If selected, the driver will look for confirmation from the router that a transition has occurred, and retry (twice) if there is no reply. If there is still no reply after three tries, the driver will stop trying and report an error (if Warnings is selected on the Reporting tab). This is the recommended mode of operation, but only one router can be connected to the driver.

23. **Select Salvo tab.** (For Probel System 2L & 3L, and DiTech) Use this tab to enable salvo switching.
If a Switcher/Router is not assigned to any list, then it is used as a share by all the lists. This is important for routers because some of them support salvo switching as the router does not use pre-roll time and effects while switching, so it can do some switches during one frame. Routers which do not support this function can only do sequenced switching.

24. Select **Matrix** tab. (Available for Probel System 3L) Use this tab to specify the Matrix Address.
25. Select **Video/Audio Address** tab. (For Miranda HD 1616D Router). Use this tab to select video/audio addresses (0 to 15) of individual frames to be switched.

26. Select **Protocol** tab. (Available for BTS Venus)

Configure the following parameters as required:

- **Protocol**: Select ASCII or ESSwitch protocol
- **Crosspoint base**: Specify if the protocol is Zero-based or One-based.
- **Add CR/LF**: Check to enable adding of a carriage return / line feed.

27. Select **Leitch** tab. (For Leitch PT Router, Panacea Clean Quiet Router). Use this tab to specify the ID of the device and the specific use of salvo switching.
If a Switcher/Router is not assigned to any list then it is used as a shared by all the lists. This is important for routers because some of them support salvo switching as the router does not use pre-roll time and effects while switching, so it can do some switches during one frame. Routers which do not support this function can only do sequenced switching.

28. **Apply the Configuration Changes**: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

   **Note:** Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

29. **Save the Configuration**: From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

   - Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

---

**Switch Only Configuration (General)**

The Switch Only device parameters configure the ADC Device Server to switch to a switcher crosspoint and/or trigger a GPI (general purpose interface) contact closure. GPI is an option to the standard ADC Device Server system (requires a GPI board to be installed in the Device Server).
About Switch Only Device

Switch Only devices are used to:

- Incorporate material from external sources, such as network and satellite feeds, cameras and presenters;
- Trigger events involving devices not supported by RS422 or RS232 protocols, through a GPI (general purpose interface).

A Switch Only event inserted in a list can be set up to switch a crosspoint, count down a predetermined amount of time and roll the next event. By entering Auto Upcount for the event associated with a Switch Only device, the event counts down to zero and then holds the list while counting up. A live feed can be switched away from by issuing a Play or Skip command to the transmission list. This is done manually, through the control panel.

When a primary event in a list has an ID that matches the ID of the Switch Only device, the event and device become associated (if the Switch Only device is assigned to the list). The event goes through the transmission process like other types of events. The event (and device) goes through preroll, switches at the end of preroll, counts down a duration, rolls the next event and then goes through postroll. You can also Skip the event and roll the next event.

A Switch Only device can be used as a secondary event which is bound to another event. A secondary event can close a GPI relay at a designated time before or after the primary event goes to air. The duration of the closure can be controlled directly by the event. The event can also be used to tag a primary event with a video overlay (such as a station bug) or generate a tone at some predetermined time before entering a commercial break or returning to program material. This type of usage requires an external device that is controlled by a GPI closure. Many such devices are available on the open market.

There are two types of secondary GPI events that can be put on a list to control physical contact closure – GPI Contact or Back-Timed GPI. The type of GPI you use depends on the timing of the secondary event.

- **GPI Contact** runs a contact after the primary event runs.
- **Back-Timed GPI** runs a contact before the primary event runs. Both GPI events are associated with a Switch Only device whose ID matches the ID of the secondary event.

Switch Only events with the same ID may be played back to back as primary events. There are no restrictions as long as these events are both primary events. Since Switch Only events have no SOM, these events are always contiguous and will always play back to back.

When it is necessary for two switch only events of the same ID to be played consecutively in a transmission list, it is necessary to have two of them configured within the same group of 8 and for both to be assigned to the same transmission list.

About Switch Only (missing) Configuration

Although List Redundancy is not required when using missing Switch Only’s, missing Switch Only’s only work for the number of lists set in the UserCons.Inc parameter: maxRedSeqLists = ‘n’. Where ‘n’ is the number of transmission list that can be redundant. This parameter setting is in addition to the standard Switch Only (missing) parameters configured through the Configuration Tool.
About Extended Switch Only Device

The vast majority of Switch Onlys are used to define sources. The number of Switch Onlys that have to be defined, particularly in large channel count systems, can require a huge number of switch only objects.

To address this ADC v12.19 introduced the Extended Switch Only device driver. This driver has all of the same functions and configurations as the existing Switch Only driver with the extended capability of specifying up to 20 individual heads.

To Configure a Switch Only Device

1. Under Switch Onlys in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the Switch Only / Extended Switch Only device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select General tab.

Configure the following parameters as required:

- **Device Name**: Enter a name (using up to 16 characters) for the switcher. This name is used by the automation system to identify the switcher. Systems with multiple switchers should have each switcher assigned unique name.

- **Heads Amount**: (for Extended Switch Only) Use the spin arrows to specify the number of heads as any value from 1 to 20.
- **Switch Only 1-8**: Assign unique names for each Switch Only.
- **Switch Only 1-20**: (for Extended Switch Only) Assign unique names for each Switch Only. Use the scroll bar to scroll up and down to view all designated Switch Onlys.

4. Select Prerolls/Postrolls tab.

Configure the following parameters as required:

- **Use Instant Prerolls**: Enable (check) to provide instant play/skip capability to the device. It allows the device to have its own short preroll for manual intervention in the list. The feature is designed for coming out of a live or upcounting event as fast as possible when the next event has a near-instant preroll. When using a master control switcher, the preroll must not be shorter than the shortest preroll supported by the switcher.
- **Seconds / Frames**: When Use Instant Prerolls is enabled, values for preroll seconds and frames must be entered. The preroll value must be at least 4 frames. These values do not have any effect if the Use Instant Prerolls box is left unchecked.
- **Switch Only**: Select a Switch Only device configured in the previous tab. The settings chosen in the Prerolls/Postrolls tab must be repeated for each Switch Only device. Default is disabled for each device.
5. Select **GPI Sheet** tab.

Configure the following parameters as required:

- **GPI Card.**
  - **No Card**: No GPI Card is connected to the device activated by this event.
  - **Card One – Four**: Indicates which GPI card is connected to the device activated by this event.

- **Contact Number.**
  - **Bit 1 – 8**: Specifies the contact number (i.e., relay number) on the GPI card to which the external device is connected. The contacts are numbered 0 to 7 by the GPI board and 1 to 8 by the ADC Device Server.
  - Add 1 to the GPI board number when the contact number is entered. For example, a device wired to pins 2 (COM 2) on the board should be entered as having Contact number 3.

- **Pulse Width**: Specifies the duration of the GPI contact, in frames (i.e., the length of time the contacts are closed), for primary GPI events. The GPI contact closes when the event goes into preroll.
  For secondary events, the contact duration is specified by the event itself.

- **Pulse Offset**: Specifies the contact closure offset (in frames) for the primary/secondary event associated with a Switch Only device. The contact can be closed at any time during preroll.
  - When the value is set to zero, the contact closure is closed, starting at preroll, for the duration specified for Pulse Width.
  - When the value is greater than zero, the contact is closed when the number of frames remaining in preroll reaches this value.

  The Pulse Offset value is backtimed from the end of preroll, not from the beginning of preroll. The value must not be larger than the preroll used by the list the Switch Only device is attached to, or the instant preroll, if configured.
Switch Only: Select a Switch Only device. The settings chosen in the GPI tab must be repeated for each Switch Only device. Default is disabled for each device.

6. Apply the Configuration Changes: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the Apply button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

Note: Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

7. Save the Configuration: From the Configured Devices window select File > Save Devices. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

Requestor Configuration (General)

The following is an example requester configuration. Your requester may have slightly different configuration options. If necessary, refer to the User Notes for your device for complete details on how to configure it.

About Requestors

A requester is a software object assigned to a transmission list that forwards the ID of a missing media event to distributors. The distributor responds to the requester and, if the distributor’s source device contains the missing media, forwards the ID to the GMT list. The GMT list moves the media to the destination device specified in the requester. A requester can request media based on a push model (for preloading of media) or a pull model (for a static or running playlist).

Most system configurations only require one requester per transmission list; however, additional requesters may be added to segregate the types of material, such as commercials and programs that will be requested from distributors.

Systems using air and protect devices require an additional requester per transmission list; one for each device.

About the Content Handler Requestor

The Content Handler requester is in charge of triggering and monitoring Content Handling process execution when IDs are missing within the ADC transmission lists.

Typically, the main purpose of the Content Handler requester is "media retrieval to playout devices". However, there is no specific limitation of the triggered processes (this could be something different than "media retrieval").
The Content Handler Requestor can provide:

- On-Air time export to Intelligent Media Manager (IMM).
- If Cloning, Content Handler Requester will not requesting missing events.
- If required the system can be configured to "Abort Un-registered Events"!

**To Configure a Requestor**

1. Under **Requestors** in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the Requestor device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select **General** tab. This is where the name is set. This tab also determines if the Requester will automatically resend the request if the Distributor cannot fulfill it the first time. It also is where the parameters are set if this Requester is to be used on a Push List.

Configure the following parameters as required:

- **Device Name**: The name of the requester. This name should be descriptive enough so you know what it is used for. The default is **REQSTxx** where xx is the position of the requester within the server’s device list. This position is also known as the channel number. You may change the device name to any name you wish. There is a 16 character maximum.

- **Request Sending Interval (Frame)**: (Default 100 frames) Specify the request sending interval in frames.

   Usually, GMT system needs more than one minute to transfer one clip, but when loading a new play list, it may generate thousands of missing events and all these missing events will come to
the requestor. This sudden influx of events may cause a traffic jam on the network layer, and affect server operations.

- Request Sending Interval (Frame)'s default value is 100 frames.
- For general usage, usually 1 frame is OK.
- If GMT needs to transfer hundreds even thousands event daily, the GMT flow control needs to be considered. Usually, 30 frames is a recommend value in a GMT system without baseband.
- In baseband GMT system with Air-Protect feature, because the GMT needs to combine both Air and Protect disk's recording, the value of Request Sending Interval (Frame) should not exceed 5 frames.

- **Auto-Retry Missing Media.** Used to automatically send a re-request for missing ID’s.
  - **Retry Interval (Mins):** Select (check) to enable the auto-retry function.
    
    Retry frequency: Specify the retry interval in minutes. (Default: 5) The retry frequency is how often in minutes a request will be sent to look for missing material.
  
  - **Maximum Retry Times:** Specify the maximum number if times to retry for missing media. (Default: 10) This is the maximum number of retries within the given allotted time.
  
  - It is important to note that once an event is in the auto-retry mode; the only way to manually stop the retry is to delete the request from the transmission list.

**CAUTION:** Once an event is in the auto-retry mode; the only way to manually stop the retry is to delete the request from the transmission list, and then reinitialize the requester.

- **Push Requester Parameters.** This section is used when this Requester is being used for a Push List.
  
  - **Play Events:** Off-air simulated (or "faked") playing of the moved event. Used for generating an As-run log entry.
  
  - **Register Events When Moved:** The requester not only removes the "REQUESTED" status, but causes the list to turn the event BLUE after the operation. This provides an indicator to the operator.

If both "Register Events When Moved" and "Play Events" are enabled AND you have used an available GMT list to load the push list into (as opposed to a standard transmission list) then not only will each event turn BLUE, it will be marked PLAY and then DONE (each event is run in a "fake" manner so that a DONE status appears and the event is as-run logged).

For Push Lists, if both ‘Register Events When Moved’ and ‘Play Events’ are enabled, ensure option "Release Tension When Cued" in the List Properties >Options tab is unchecked (the default is checked).

4. **Select Qualifiers tab.** Use this tab to specify the qualifications that this requester uses to determine if it should make requests for media. These parameters would be used if more than one video server was assigned to a transmission list and each server has specific material ID’s in it. These parameters can also be used to optimize performance.
Specify events with or without segments, events that run less than a specific duration, and qualify events based upon the range of the ID. Usually you will need to set the request qualifiers if you have multiple requesters on a transmission list, and these requesters are requesting media from different sources.

Configure the following parameters as required:

- **Program – Spots.** Configure this Requester to request only Programs or only Spots.
  - **No Events With Segments:** To be recorded, events cannot have segments. If enabled (checked), Multi-segment IDs cannot be requested. Default is disabled.
  - **Events With Segments Only:** Events must have segments in order to be recorded. If enabled (checked), single spots will not be requested. Default is disabled.

  **Note:** If both of the above boxes are left at their default settings (both disabled), you can request all material: both single spot IDs and multi segment IDs.

- **Duration Range:** Restrict the length of clip to be requested by this particular Requester. The time parameters are only active if the associated box is checked.
  - **No Events Greater Than (Mins):** Click to enable, and then specify a maximum number of minutes allowed for an event. Default is 5 minutes.
  - **No Events Less Than (Mins):** Click to enable, and then specify a minimum number of minutes allowed for an event. Default is 0 minutes.

- **ID Range.** This qualifier is useful where some IDs are to be requested and others not, and the Duration qualifier cannot distinguish between them.
  - **Only Events with ID in:** Check to enable qualification. If the ID qualifier is enabled, then the disk will only request IDs whose first character is between or equal to the ‘--to--’ limits.
  - **Only Event with ID Between:** Check to enable. Then specify range in the associated number field. If this qualifier is enabled, then the disk will only request IDs whose first character is between or equal to the ‘--to--’ limits.
For example: If only IDs starting with a ‘9’ are to be requested, enter a ‘9’ in both boxes. To request only IDs whose first character of the ID is from ’0’ to ’5’ inclusive, place ’0’ and ’5’ in the two parameters.

- **No Event with ID Between**: Check to enable. Then specify range in the associated number field. If this qualifier is enabled, then the disk will ignore IDs whose first character is between or equal to the ‘-to-’ limits.
  
  For example: To ignore and not request IDs whose first character of the ID is from ’0’ to ’5’ inclusive, place ’0’ and ’5’ in the two parameters.

- **from-- to --**: Alphanumeric entry. Specify range. Up to 32 characters can be entered in each field.
  
  ’A’ to ’Z’ and ’a’ to ’z’ are permitted, and uppercase letters are sorted before lower case letters, and uppercase letters are sorted after numbers.

5. Select the **Priority** tab. This tab allows the Requester to send the Distributor a priority of each item it requests. This parameter should be used to indicate how the Distributor should treat each request when it is time to transfer it.

- **Weighting**: Use this parameter to tell the requester to weight, by time, all requests. This Weighting value is used to prioritize requests made by this Requester. The Weighting value is a time value that is added to the time in the GMT List event’s "Time" column. The requester adds this time to an event’s projected on-air time and the result is the time that the media is expected to be needed. Weighting allows some level of prioritization of requests from different requesters on the same or different transmission lists.

  **Note**: Events with a weighted time stamp are processed after events without a weighting value added.

To prioritize the transfer sequence of requesting events on the GMT List:

- Delay the less urgent event transfer priority by adding a "fixed Time weight", such as 6 hours (06:00:00:00") to each event associated with a Requester.
For time critical requesting events, such as one from a on-air playlist, add a "zero weight" to its process time.

In this way, less urgent events will yield their process priority to the critical one.

**Note:** Normally, a Requester associated with a push list to prepare media for tomorrow’s playlist will have a weight added to all requesting events, so that they will not take over the GMT resource for On-air playlist missing events.

- **Transfer Priority based on:** Set the transfer priority.
  - **On-Air Time:** The GMT event transfer sequence for this particular Requester is based on its On-Air time. When this parameter is selected, the earlier On-Air time is scheduled to transfer first. The Requester—and by association the Distributor—use the time of day in the time field to determine what items are needed first. An item inserted into a transmission list is slotted into the list of things to be transferred based on its On-Air time relative to those items already set to transfer. This slotting is evident to the user on the GMT List.
  - **First-in-First Serve:** The GMT event transfer sequence for this particular Requester is based on the sequence received by this Requester. When this parameter is selected, the requester timestamps the current time on the event for GMT to prioritize the schedule transfer. Items are transferred in the order the requests were received and, secondarily, what order the Distributor determines it can fulfill the request. If an item is added to the transmission list, then it will go to the bottom of the priority list no matter when it is scheduled to air.

6. **Select Routing tab.** (For Requesters and Multi-requesters) This tab allows the Requester to be set to do certain types of transfers. Although all Modes can be selected, some of the types should not be used together on one Requester. Some modes, when used together indicate using a double-hop or multi-hop GMT.

   - **Baseband:** Real time video signal (either analog or digital). Baseband includes SDI and SPI modes. Default is enabled. This is used for real-time copies from tape to video server.
- **Fibre**: JPEG or MPEG compressed data files. Fibre mode is typically used when both the source and destination devices are video disks. Fibre transfers are typically non-real-time. Default is disabled. A Fibre transfer will be selected when a Fibre channel or Fibre Hub is used to move material from one device (typically a video disk) to another.

- **Wan**: Wide Area Network. This routing mode implies the transfer protocol will be FTP. Source and Destination FTP server can be geometrically separate apart. This type of transfer is used specifically for Wide Area Network GMT.

- **Archive**: Usually there is a SCSI connection between the archive system and the video disk server. This mode is used when transferring material to and from a digital archive device source (e.g., a StorageTek or Ampex DST) under control of an Archive Manager (e.g. Avalon, PetaServe, DIVA or Flashnet/SGL). Default is disabled.

  - **Push-to-Archive**: Check to enable push media to archive storage operation, (Activates Take "group-ID" from "ReconcileK" option. See below.) The Push-to-Archive is used in conjunction with the Archive type move when an Archive Push List is being implemented.

- **SOM is required for Baseband**: Sometimes, when a media is still ingesting, its metadata is not entered into the ADC database, but a playlist event to use this media is entered into a playlist. In this scenario, if the playout server does not have the ID, a baseband GMT that is requested and scheduled will result in a failed transfer.

  This parameter determines whether Baseband GMT moves will take place if there is no database record.

  **Enable (check) this option** to prevent this kind of event to transfer prematurely. This ensures a transfer will not start without metadata "SOM" entered into the event either manually or automatically from the ADC Database. The most typical way to get an SOM is to create a database record.

  **Note**: This should be checked if your Baseband source device is a Cart Machine or a VTR.

  - **Take "group-ID" from "ReconcileK"**: Check to enable. (This option is active when Push-to-Archive is selected.) VDCP protocol allows Archive Manager to organize its storage into "Groups", such as "Spot" group, "Program" Group, etc... This "Group" name can also be specified in the "Archive Device--General Tab" UI.

  For a ‘push media to archive storage operation’, the user may allow specification of a "Group" name for each event different than the one specified in "Archive Device-- General Tab" UI, or different from event to event.

  **Enable (check) this option** to specify the archive "Group" name in the "Reconcile Key" field. When this option is enabled, by the time each push event reaches the Archive Device to push to archive, the "Group" name that comes with event determines with which Group in the archive it is categorized.
7. Select **Destination** tab. (for Requestor) Use this tab to specify where the Requester sends the material (i.e. the destination device that receives the requested material). This device should be a record port of a video disk server. Other devices are not supported in this release.

![Destination tab configuration screen](image_url)

Configure the following parameters as required:

- **Server**: This is the server name that the destination device is physically connected to/resides on. Choose the correct server from the dropdown menu.

- **Device**: Choose the device name associated with the destination device from the dropdown menu. These are configured devices available on the previously specified Device Server.

- **Fibre Handle**: This is the unique fibre address assigned to the destination video disk. Each video disk on a fibre network must have a unique address. Valid entries are 0 through 99. Note: By using the up/down buttons, values over 99 can be entered.

  The Fibre handle is ONLY set if this Requester is set to use Fibre or Archive routing in the previous tab. The Fibre handle should be the handle of the Destination device.

- **FTP Handle**: FTP Handle is used only for WAN GMT. For a ProxyFTP device to log into a FTP server, a set of login parameters must be correctly specified. Parameters such as: IP-address, Port-Number (normally set to 21 for FTP), User-Name, Password, login-Directory, etc... are often required parameters.

  When configuring an ADC ProxyFTP device to transfer media from a source to a destination, each FTP server is also assigned a unique FTP-Handle. **This FTP Handle** is a two-digit integer automatically assigned to a FTP server as a "Site ". This FTP-Handle is often referenced as a parameter in the Requester and Distributor to address an FTP server, either for source, or for the destination of an FTP transfer.
8. Select **Distribution** tab. (For Requesters and Multi-requesters) Use this tab to specify which GMT Distributor that this requester communicates with to acquire material (i.e. the Distributor that will be asked to fulfill the requests). The chosen distributor may reside on the same device server as the requester, or may be on a different device server. This setting should point to the Distributor that should be queried first.

Configure the following parameters as required:

- **Server**: Choose the Device Server from the dropdown menu where the distributor object identified in the Device field (below) resides.

- **Device**: Choose the name of the distributor from the dropdown list that requests the distributor representing the primary source of material from this requester. These are the Distributor objects configured on the Device Server specified above.
9. Select **MultiDestination** tab. (for MultiRequestor) A normal Requestor can only request missing media for a single destination disk. A Multi-requestor can simultaneously request missing media for all specified destination disks. Use this tab to specify the destination devices (the devices that receive the requested material). These devices should be a record port of a video disk server. Other devices are not supported in this release.

![MultiDestination tab](image)

Up to 16 destinations can be specified in a single Multi-Requestor configuration. Each destination for found missing media to transfer in is specified as:

- **Server**: This is the ADC server name.
- **Device**: This is the VFS port name
- **Handle**: This is the Fiber Handle number of the destination VFS.
To add a destination, click the **Add** button.

![Configuration Manager](image)

- Configure the following parameters as required:
  - **Server**: This is the server name that the destination device is physically connected to. Choose the correct server from the dropdown menu.
  - **Device**: Choose the device name associated with the destination device from the dropdown menu.
  - **Fibre Handle**: This is the unique fibre address assigned to the destination video disk. Each video disk on a fibre network must have a unique address. Valid entries are 0 through 99.
    - **Note**: By using the up/down buttons, values over 99 can be entered.
      - If a non-zero value is entered into the Media Client for the Fibre Handle parameter on the Single Spot/ MultiSpot/Multi Seg configuration Archive tab, it will override the Fibre handle specified in the Device Server configuration for the Distributor and all ‘Send To Archive’ and ‘Get From Archive’ operations will use this new handle.
      - If the Fibre Handle value is set to 0 on the Media Client for the Fibre Handle parameter on the Single Spot/ MultiSpot/Multi Seg configuration Archive tab, the Fibre Handle value set in the Distributor configuration is used.
  - **FTP Handle**: For a ProxyFTP device to log into a FTP server, a set of login parameters must be correctly specified. Parameters such as: IP-address, Port-Number (normally set to 21 for FTP), User-Name, Password, login-Directory, etc... are often required parameters. When configuring an ADC ProxyFTP device to transfer media from a source to a destination, each FTP server is also assigned a unique FTP-Handle. **This FTP Handle is a two-digit integer automatically assigned to a FTP server as a "Site ".** This FTP-Handle is often referenced as a parameter in the Requester and Distributor to address an FTP server, either for source, or for the destination of an FTP transfer.
    - When finished click **OK**.
10. Select the **Diagnostics** tab. Use this tab to view the retry status for the events.

The following parameters can be reviewed:

- **Total ID Requested**: This is the total number of ids that has been requested.
- **Retry Waiting ID Counter**: This is the number of ID’s waiting in the buffer for the next retry.
- **Retry ID Counter**: This is the number of IDs currently being handled by Distributors--based on a Retry--whose status has not been returned by the Distributor.
- **1st Time Requested ID Counter**: This is the number of ID’s currently being handled by Distributors—for the first time—whose status has not been returned by the Distributor.
- **Update** button: Click to manually update the values in the field listed above at that particular instance. However the values are updated automatically, whenever a value has changed in one of the fields.
- **Reinitialize** button: Click to I reset all outstanding requests to zero.
11. Select the **Content Handler** tab. (Used for Content Handler Requester only).

![Content Handler Tab](image)

This tab dialog is comprised of the following:

- **Content Handler**: This parameter displays the assigned number of the Content Handler.
- **Devices pane**: This box lists all Content Handler published processes. When a Content Handler requester device is assigned to a transmission list, missing IDs initiate the execution of the processes that have been selected in the Devices pane. Content Handler requester is in charge of the processes triggering and monitoring until all of them terminate within the Content Handler engine.

  **Note**: A single process selection is commonly configured.

- **Options pane**: This box lists all the parameters that must be passed to Content Handler engine when triggering processes. The expected parameters depend on the process design itself: this is a customer oriented configuration. Some parameters can be dynamically filled in by the Content Handler requester driver taking into account the information of the missing events.

  The following list of dynamic values are currently supported:

  - **%EVENT_SOM%**: If an option has this value, then the value is dynamically replaced with the Start Of Message information (timecode format) of the missing event.
  - **%EVENT_DUR%**: If an option has this value, then the value is dynamically replaced with the Duration information (timecode format) of the missing event.
  - **%EVENT_OAT%**: If an option has this value, then the value is dynamically replaced with the On Air Time information (timecode format) of the missing event.
  - **%EVENT_RTA%**: If an option has this value, then the value is dynamically replaced with the Remaining Time to Air information (timecode format) of the missing event. Note this only work for values lower than 24 hours.
  - **%EVENT_SEG%**: If an option has this value, then the value is dynamically replaced with the Segment information (numeric format) of the missing event.
Configure the following parameters as required:

- **Add Options**: Click this button to add a new line to the Options pane. Afterward, the user must edit the cell values of the new line (first cell is the option name, second cell is the option value).
  
  **EXAMPLE**: How to setup CH process execution priority based on the on air time.
  
  - Add an option with "REQUEST_PRIORITY=%EVENT_RTA%".
  - The "REQUEST_PRIORITY" option property value is automatically filled in with the remaining time to air information of the missing event.
  - This timecode information is then be used by the Content Handler engine to calculate the execution priority.

- **Remove Option**: Select a currently specified option and then click this button to remove the selected line from the Options pane.

12. Select the **CH Qualifiers** tab. (Used for Content Handler Requester only)

Configure the following parameters as required:

- **Request primaries**: Use this option to request (checked) or do not request (unchecked) primary events like secondary ones. *By default for compatibility with old version the box is checked on.*

- **Request secondaries**: Check this option to request secondaries. When enabled, the IDs of missing secondary events will also initiate Content Handler process execution.

- **Abort unregistered requests**: Check this option to abort any unregistered requests. When enabled, the missing events that are removed from the lookahead will cancel the process execution within Content Handler engine.

  **Note**: An event can be removed from the lookahead if the size of the lookahead is reduced or if it is simply deleted from the lookahead.

- **List of exclusions**: This pane lists the missing IDs that must NOT BE USED to initiate process execution. Specify the list of IDs to exclude, separated by semicolons.
13. **Apply the Configuration Changes**: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

**Note**: Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

14. **Save the Configuration**: From the Configured Devices window select **File> Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

- Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

---

**Distributor Configuration (General)**

The following is an example distributor configuration. Your distributor may have slightly different configuration options.

**About Distributors**

A distributor is a software object assigned to specific output connections of a device. A distributor can be assigned to any type of device: baseband, fibre channel or archive. Several distributors can be assigned to some types of devices to handle multiple requests or move several different spots at a time. Most video file servers, for example, are able to move multiple spots simultaneously on a single fibre channel.

When a distributor receives an ID from a requester, it parses duplicate requests, transport and routing limitations and format mismatches.

- If the device contains the media requested by the requester, it forwards the missing media event’s ID to a GMT list.
- If the distributor does not contain the requested media, the event’s ID is passed to the next distributor.
- If no other distributor is available, an error message is passed to the requester. Errors are displayed in the transmission list window.

**Global Delete Workaround**: If a recalled event remains in the Device Storage Window after performing a Global Delete, in versions 12.19.18 and above open the ADC1000NT.ini with Notepad, locate flag DestUseIt, manually change this flag to TRUE, and then restart Device Server and Media Client. With this change the Global Delete Targets function will work as expected.
To Configure a Distributor

1. Under Distributors in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).
   
   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the Distributor device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select General tab. This is where the name is set.

Configure the following parameters as required:

- **Device Name**: The name of the distributor. This name should be descriptive enough so you know what it is used for. The default is DISTRxx where xx is the position of the distributor within the server’s device list. This position is also known as the channel number. You may change the device name to any name you wish. There is a 16 character maximum.

4. Select Routing tab. Use this tab to configure routing. Source and destination devices can reside on any Device Server. This sets how the Distributor will execute the transfer of material.
Configure the following parameters as required:

- **Routing**: Select one of the available routing options (the default is Baseband). This section allows configuring what type of media transfer this Distributor will perform. Each type of move is very specific. While a Requester can do multiple types of routing, each Distributor can only do one type.
  - **Baseband**: Real time video signal (either analog or digital). Baseband includes SDI and SPI modes. Default is enabled.
    
    When baseband mode is selected, the Intermediate Destination becomes active.
    
    With this configuration media transfers are done by video signal "Play" from source device, and "Recording" simultaneously in the destination device. In this routing mode, media duration determines how long will it takes to perform a media transfer. The GMT system can handle "Multi-hops" media transfer.
For example, if the first leg transfer is done by Baseband routing mode, the second leg of transfer can be done by either Fiber routing mode, or by Archive routing mode to reach the final destination specified in the Requestor or Multi-requestor. In this "Multi-hops" transfer mode, since the destination of the first leg baseband transfer is actually an "intermediate destination", it must be specified in the Baseband Routing mode for next leg transfer to use as a source for final transfer.

- **Fibre**: JPEG or MPEG compressed data files. Fibre mode is typically used when both the source and destination devices are video disks. Fibre transfers are typically non-realtime. Default is disabled.

  When Fibre mode is selected, the ‘Send Disk Command to” becomes active.

  With this configuration missing media file found in a distributor source can be transferred to destination disk though the fiber network connecting source and destination disks. Since a media file contained in a VFS is in compressed mode, Fiber routing mode normally transfers media faster than "real-time", which is limited in baseband routing mode. The fiber distributor uses VDCP protocol to send media transfer commands to a VDCP complied VFS; both source and destination fiber handles are specified in a VDCP Copy command.

  Some VFS prefer sending commands to the source VFS disk, while others prefer sending commands to the destination VFS disk. This option can be specified in configuration.

- **Archive**: Usually a SCSI connection between the archive system and the video disk server. This mode is used when the source device is a digital archive device (e.g., a StorageTek or Ampex DST) under control of an Avalon Archive Manager. Default is disabled.

  With this configuration a distributor is configured as Archive routing mode. Media stored in a VFS can be controlled to Send-To-Archive, or Get-From-Archive through VACP protocol compliant Archive-Manager software. Since the Distributor doesn’t speak VACP protocol directly, the user must configure a VACP protocol handler, which is the "Standard Archive" device to the archive routing mode configured distributor. In the GUI, this is specified in the "Server" and "Device" fields.

- **WAN**: Wide Area Network. This routing mode implies the transfer protocol will be FTP. Source and Destination FTP server can be geometrically separate apart.

  - **Intermediate Destination**: (Active when Broadband is selected). When configuring a system to do baseband double hop, a fibre distributor needs to be in the search loop. This means that the fibre distributor needs to point to the intermediate destination, thus be on the same device server.

  The options in this section differ depending on the type of move selected. For example, if an Archive move was selected, it asks which Archive Device on which Device Server it will be using. If a baseband type is selected, a section for intermediate destination will appear.

  - **Server**: Use the pull-down list and select a server.
  - **Device**: Use the pull-down list and select a device.
  - **Fiber Handle**: The fibre handle needs to be the same as the intermediate disk. This is the unique fibre address assigned to the destination device. Each device on a fibre network must have a unique address. Typical valid entries are 0 through 99.

Double hop transfers occur as follows:

  - First, the source baseband device will record to an intermediate disk. The source and intermediate device will reside on the same device server.
Second, GMT will transfer the recorded media via fiber transfer mode to the destination device. The destination device resides on any device server, no longer the same device server as the source device.

In an **Air and Protect scenario**, there is one play and one record to an intermediate disk. After the transfer to the intermediate disk finishes the baseband distributor determines if the transfer is complete. In order to ensure the transfer is complete, it initializes two follow up fibre transfers. The first transfer is to the air disk and the second is to the protect disk which completes the transfer.

- **Send Disk Command to:** (Active when Fibre is selected) Since disk vendors govern whether a fibre transfer can go to either the source or destination, the fibre routing mode is configurable. Depending upon what is supportable by the disk, specify to send the commands to either:
  - Destination device: (Default)
  - Source device.

- **Standard Archive:** (Active when Archive is selected)
  - **Server:** Choose the correct server from the dropdown menu.
  - **Device:** Choose the device name from the dropdown menu.
  - **Single Hop Archive Transfer only:** Check to enable the source baseband device to record directly to destination device.

- **Proxy FTP:** (Active when WAN is selected)
  - **Server:** Choose the correct server from the dropdown menu.
  - **Device:** Choose the device name from the dropdown menu.

5. Select **Next Ring** tab. Use this tab to configure this Distributor to pass requests on to another ring of Distributors. This allows for multiple search paths for material and may be required or may be used to optimize the operation of GMT.

- The device selected with the assigned distributor must reside on the correct server selected as well.
- A Next Ring search path may only be configured on an "entry point" Distributor – that is, the first Distributor in a search path to which a Requester is directly passing requests.
- At present, Automation only supports one level of Next Ring request forwarding.

Next-ring pointers are used to construct multiple distributor-rings to do media searches. This feature is especially important in a multi-channel facility. In this type of environment, the user wants to achieve three goals simultaneously:

- Share distributors among all play-lists,
- Prioritize the search sequence, and
- Balance the load among all sources.
The next-ring feature allows each request packet from each transmission list to travel the entire ring and return back to its entrance distributor before moving into the next-ring search of low priority devices (such as archive and baseband devices) instead of terminating the search at the first ring. It is only possible to construct two (2) rings.

Configure the following parameters as required:

- **Distributor**: This is where the first Distributor in the next search ring is set. This can be set in different ways as each Distributor may be able to pass requests on to enter the search ring at a different location.
  - **Server**: This is the server name that the destination device is physically connected to. Choose the correct server from the dropdown menu.
  - **Device**: Choose the device name associated with the destination device from the dropdown menu.
6. Select **Source** tab. Use this tab to specify the device supplying material and also to link to additional distributors. The source device can be a cart machine, a standalone VTR or a play port of a video disk server.

Configure the following parameters as required:

- **Server**: This is the server name that the destination device is physically connected to. Choose the correct server from the dropdown menu. This parameter specifies which Device Server this Distributor is looking at to get its device for the material it is to transfer. Once the Device Server is selected, the devices configured on that Device Server are available for selection.
- **Device**: Choose the device name associated with the destination device from the dropdown menu.
- **Fibre Handle**: This is the unique fibre address assigned to the destination video disk. Each video disk on a fibre network must have a unique address. Valid entries are 0 through 99. **Note**: By using the up/down buttons, values over 99 can be entered.

Fibre Handle is used only if this Distributor is using Fibre, Archive or WAN routing. A fibre handle is required for all fibre transfers to be executed. A fibre handle is required for Global Delete Distributors, although it may be the fibre handle of any device among the delete targets.

If this is an Archive or WAN Distributor, the fibre handle set here may refer to the destination for Archive and WAN transfers.

- **Wait until missing media is available**: When enabled (checked), GMT waits for the missing media on the source device specified on the distributor. The missing media is placed on the GMT list and stays red until the media is found. Typically used on a VTR.
  - If your Baseband source device is a Cart Machine, you may wish to enable this option.
  - If your Baseband source device is an external VTR, this option must be enabled.

This forces the Distributor to insert GMT events on the GMT list even if they are missing from the Cart Machine or if an operator is required to insert the tape into the external VTR. When disabled (unchecked), the missing media is skipped and media searching passes
down to the next available distributor (or returns an error to the play list). This gives the operator time to locate and insert the tape.

When disabled (unchecked), the source material is not found in the source machine, nothing is put on the GMT list, and the transfer fails without the operator being allowed to find the source tape. The missing media is skipped and media searching passes down to the next available distributor (or returns an error to the play list).

**Note:** This option is only available with baseband and archive routing. Fibre mode is not supported.

- **Next Distributor:** Specify an additional distributor for locating material. This parameter is used when there is more than one place the missing material may be found. By telling this Distributor to pass the request on to another Distributor, you are creating a chain. Without this, the request would fail if the material could not be found in the device listed in this tab.

  For example, you may have multiple distributors, each associated with a different cart machine. If a distributor cannot process a request because the requested material is not within its source device (i.e., the ID is not in the cart machine), it can pass the request to the next distributor in the chain which may be able to locate the material. All linked distributors must reside on the same device server and be assigned to the same GMT list. It is recommended to link the last distributor back to the first distributor to form a closed loop so that any distributor on the linked list can be the initial distributor (as pointed to by a requester in a multi-requester environment).

7. Select **Segments** tab. Two kinds of multi-segment file name conventions exist in a videodisk and archive system; the Single-File-Multi-Segment (SFMS), or the Multi-File-Multi-Segment (MFMS). In an SFMS convention, all segments with the same program ID will reference the same file name without a segment number. In an MFMS convention, each segment will have a unique file name using the media ID name with a one or two digit segment number forms this unique file name.

Therefore, there are three ways a multi-segmented program event can be translated into a unique file name in a videodisk or archive system: (1) By using the ID for all segments, (2) Modifying the last digit of the ID with the segment number, (3) Modifying the last 2 digits of the ID with the segment number. At many facilities, the methods above would be mutually exclusive to prevent confusion within the video server or archive device.
In order to help prevent file name conflicts for multi-segment events, the Segments tab is used to configure the search order for multi-segment IDs and how many digits of its associated segment number will be used to create the filename for a particular media ID segment.

Configure the following parameters as required:

- **Max ID Length**: Specify the maximum ID length of the segment. (Default: 32)
- **Number**: Specify how many of the last digits are to be used to form an ID name. Highlight a segment number, and then...
  - Use Up/Down buttons are used to specify the direction and order to be used to search for segmented ID files in a device.
  - Use Enable/Disable buttons are used to enable or disable searches for the selected number of last digits to form a segmented ID. When enabled, it has a red background.
- **Use Distributor Segment setting over Disks**: When enabled (checked), the GMT fiber transfer refers to the distributor's segment setting instead of the destination disk's setting.

**Note**: The 'Wait for missing media until it is available function' is currently not supported (grayed out) in this mode, because it is unknown which ID should be put in GMT list to wait.

8. Select **Global Delete Targets** tab. Media Client allows an operator to "Global Delete" a specified media through a Media Client-configured Fiber routing mode distributor. The specified media ID will be deleted from multiple destination VFS that are specified in "Global Delete Targets" tab sheet of a Fiber Distributor.

If this Distributor is to be used to handle delete requests to multiple video servers, this is where it will be configured. Some systems will have the requirement to delete from video servers that cannot be accessed directly from Media Client. This tab allows for deletion of material from those video disks. Under the Routing tab, this Distributor MUST be configured to do fibre transfers.
Global Delete Targets can be added or deleted, they cannot be edited. Each target can be set to access any Video Server on any Device Server. Each target MUST have a fibre handle configured as well.

Configure the following parameters as required:

- **Add** button: Click the Add button to display a dialog box allowing you to enter crosspoints. A total 16 "Global Delete Targets" can be specified in the form "Server (ADC server)", "Device (VFS ports)" and "Handle (Fiber handle number)".

  **Note:** The Global Delete target should be a video disk.

  **Note:** The only allowable routing mode is fibre mode.
Note: If Delete Target specifies a VTR, cart machine or archive destination, or if the routing mode is baseband or archive, the Global Delete command is ignored.

9. Select Diagnostics tab. When this tab is selected the real-time internal log is displayed. The Distributor can also be reinitialized from this tab.

Configure the following parameters as required:

- **Mode**: Select one of the diagnostic modes: Event Log, ID Trace, or Buffer Dump
  
- **Event Log**: An event log is a real-time status display for the Distributor. As requests are processed by the Distributor, the RunState Status pane will update dynamically and display the current status of the operation.
If the diagnostics window has been opened in modeless state, the data written to the RunState Status window will also be written to the text log file.

- **ID Trace.** When selected, the diagnostics window will display an Input ID / Segment field. Enter an ID you wish to trace in the Input ID field (and a segment number if this is a multi-segment ID) and click Start Trace. The current status of the ID is displayed in the RunState Status pane. If the diagnostics window has been opened in modeless state, the status is written to the text log file as well.
• **Buffer Dump**: When selected, the contents of the Distributor’s buffer can be written to the RunState Status pane.

Click the **Start Dump** button and the Distributor will write the contents of its buffer to the RunState Status pane. This action does not clear the contents of the Distributor’s buffer – that can only be accomplished by clicking the Reinitialize button. If the diagnostics window has been opened in modeless state, the buffer data will be written to the text log file as well.

- **Setup Status**: Displays an event log in real-time for the Distributor.
- **RunState Status**: Displays contents for a Trace Log or Buffer Dump.
- **Start Dump** button: Available in Buffer Dump mode. When selected, the Distributor writes the contents of its buffer to the RunState Status pane. This action does not clear the contents of the Distributor’s buffer – that can only be accomplished by clicking the Reinitialize button. If the diagnostics window has been opened in modeless state, the buffer data is written to the text log file as well.
- **Reinitialize** button: Click Reinitialize to clear the Distributor’s collection of pending requests and reset all of its internal variables to zero. Any pending requests on the Transmission List will be marked FAILED.

10. **Apply the Configuration Changes**: When changes are made to a device’s configuration, the Apply button on the configuration GUI becomes active. Click the **Apply** button to immediately apply that configuration change to the system configuration held in random access memory by the Device Server.

    **Note**: Apply does not write the configuration change to the Device Server’s configuration files. This can only be done by using the Save Devices option on the Configured Devices window’s File menu.

11. **Save the Configuration**: From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.
Attempting to close the Configured Devices window without first saving any configuration changes, results in the Configuration Manager prompting to save the changes on the Device Server. Accepting this prompt writes the configuration changes to the Device Server’s configuration files as well.

Proxy Device Configuration (General)

ProxyFTP devices are software gateways the automation system uses to initiate FTP file transfers between video servers over a wide area network (WAN). Like archives, they are not media devices in the sense that they are not assigned to lists, they cannot cue and play, and they are not capable of producing an I/O stream. Instead, ProxyFTP devices interpret commands from the automation system and pass them on to the video server’s file system through an Ethernet connection to the WAN. FTP file transfers using a ProxyFTP device can only be accomplished through the use of GMT components. For more information about ProxyFTP devices and GMT see section: Global Media Transfer.

The following example is an example Proxy device configuration. Your device may have different options. If necessary, refer to the User Notes for your device for complete details on how to configure it.

To Configure a Proxy Device

1. Under Proxies in the Available pane (right pane), select a device (e.g. Proxy FTP or Factum) and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the Proxy device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the General tab. The options available on this tab depend on the device selected.

   For example: The following General tabs show options for PXFTP (left) and Factum (right) selections.
Configure the following properties are required:

- **For PXFTP.**
  - **Device Name:** (Default: PXFTP) This parameter defines the name of the PXFTP driver into the adc1000nt configuration.
  - **Designated FTP Resource Manager:** In the ADC system, there is one "Siteconf.ini" file to store the login parameters of each configured FTP server site. To prevent conflict, the information in this "Siteconf.ini" file is shared among all ProxyFTP devices for "read access", but only one ProxyFTP device is granted "write access" to create and edit this file. **Enable (check) this option** to give this particular ProxyFTP device the right to create, add, delete and modify this "Siteconf.ini" file. If an ProxyFTP device is assigned as FTP Resource Manager, the ProxyFTP device name will be displayed with an associated asterisk "*" mark in the Configuration Device window.
  - **Reinitialize** button: Click to reinitialize the ProxyFTP device. When selected the following prompt appears.

- **For Factum DBS.**
  - **Device Name:** (Default: FACTUM) This parameter defines the name of the Factum driver into the adc1000nt configuration.
  - **Host Name:** (Default: "localhost") This parameter identifies the default address of the Factum DBS100 System the driver is communicating with. This parameter can take an IP address in either dotted or alphanumerical notations.
  - **In Folder:** (Default: C:\IN\) This parameter specifies the folder path, where the input files for the Factum DBS100 device driver will be placed to. The device driver will check this folder 20 times per second and process the input files. After being processed, the field is deleted from the input folder. **Note:** Always specify the last slash character in the configured path. For example: "C:\IN\" – correct, "C:\IN" – incorrect.
  - **Out Folder:** (Default: C:\OUT\) This parameter specifies the folder path, where the output files with the responses from the Factum DBS100 device driver will be placed to. **Note:** Always specify the last slash character in the configured path. For example: "C:\OUT\" – correct, "C:\OUT" – incorrect.
  - **Logging:** (Default: false (unchecked)) This parameter enables or disables logging of actions performed by the Factum DBS100 driver. It’s recommended to check this control if any
troubles occurred while working with the proxy device server (logging may require a lot of disk space for log files).

**Note:** The logging information is stored on a local hard drive, disk "C:". The file name is formed according to the following scheme: log_Factum_mm_dd_yy_xxxx.txt, where mm_dd_yy – current date and xxxx – random generated number.

4. Select the **Disk Type** tab. (Proxy FTP only)

Configure the following properties are required:

- Select the disk type from the listing of available devices.
  - **Generic** (or **Generic FTP**): Select to specify using the industry standard "RFC 959" FTP protocol. When selected, Ext List becomes active.
  - **Omneon**: Select to specify using Omneon’s proprietary media format (instead of .MXF format) for FTP transfers using the Omneon proprietary API.
    - This functionality requires the use of Omneon’s proprietary DLL module. It is strongly recommended that a separate bridge computer be used to hold this ProxyFTP device alone.
  - **Passive Mode**: Check to enable.
  - **Ext List: (Default: *)**. (Active when Generic is selected) Specify file extension(s) for FTP transfer. The operator may specify "mxf" as the extension for FTP transfer.
    - The default value "*" means any extension is qualified for the specified media ID.
    - If multiple file extensions are specified in the FTP transfer, they can be entered into the same extension box, but separated by space.
5. Select the **Site List** tab. (Proxy FTP only)

Configure the following properties are required:

- **Add** button: Launches a site management dialog. Use this dialog to specify transfer sites. When finished click **OK**.
Edit Button: To edit an existing site entry, select an entry from the site list display and then click Edit. The site management dialog is displayed populated with the parameters currently specified for the selected entry. Make changes as required, and then click OK.

Delete button: To delete an existing site entry, select an entry from the site list display and then click Delete.

6. Select the Connect tab. (Proxy FTP only)

Configure the following properties are required:
- **Destination**: Specify the destination device for the transfer. Use the dropdown arrow to select for a list of available devices.
- **Source**: Specify the source device of the transfer. Use the dropdown arrow to select for a list of available devices.
- **Meta data required for transfer**: Enable (check) to include metadata in the transfer.

7. Select the **Diagnostics** tab. This tab displays diagnostic information for the PXFTP. (Proxy FTP only)

8. When finished click **Apply**, then click **OK**.
9. From the Configured Devices window select **File> Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

---

**Transcode Configuration (General)**

The following is an example Transcode configuration. Your device may have different options. If necessary, refer to the User Notes for your device for complete details on how to configure it.

**To Configure a Transcode Device**

1. Under **Archives** in the Available pane (right pane), select a Transcoder device (i.e., FlipFactory or FPD VAST BitSCREAM) and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50). Once a device has been assigned to a device channel, it may be configured for specific options.
2. Select the Transcode device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.
3. Select **General** tab. The options available on this tab depend on the device selected.
For example: The following General Tabs show options for FlipFactory (left) and BitScream (right) selections.

Configure the following parameters as required:

- For Flip Factory:
  - **Device Name**: This parameter defines the name of the driver into the adc1000nt configuration. (Default: FLIPF).
  - **Host Name**: This parameter identifies the Telestream Flip Factory System the driver is communicating with. This parameter can take a name or an IP address. (Default: localhost).
  - **Port**: This parameter identifies the Telestream Flip Factory System the driver is communicating with. This parameter can vary from 0 to 65535. Default parameter is "9000".
  - **Factory Name**: This parameter defines the factory that will be used to transcode the files. This parameter must be configured according to the Telestream Flip Factory settings. Default parameter is ".".
  - **Priority**: This parameter defines the priority to attach to each transcode command. The supported values are from 1 (lowest) to 9 (highest). Default parameter is "5".
  - **User Name**: This parameter defines the user name that will be used to access specified factory for transcoding the files. This parameter must be configured according to the Telestream Flip Factory settings. Default parameter is ".".
  - **Password**: This parameter defines the password that will be used for the current user name to access specified factory for transcoding the files. This parameter must be configured according to the Telestream Flip Factory settings. Default parameter is ".".
  - **Polling**: This parameter enables or disables polling the Flip Factory server by the ADC Flip Factory Transcoder driver. The polling period is about 2 seconds. It’s highly recommended to check this control, otherwise the Flip Factory status information will not be monitored while transcoding nothing. Default parameter is false (unchecked).
*Timeout (msec):* This parameter identifies the Polling period for the Telestream Flip Factory driver in milliseconds. This parameter can vary from 1000 to 60000. Default parameter is "2000".

*Logging:* This parameter enables or disables logging of actions performed by the Flip Factory Transcoder driver. It’s recommended to check this control if any troubles occurred while working with the Flip Factory server (logging may require a lot of disk space for log files). Default parameter is false (unchecked).

**Note:** The logging information will be stored on a local hard drive, disk "C:\". The file name is formed according to the following scheme: log_FF_mm_dd_yy_xxxx.txt, where mm_dd_yy – current date and xxxx – random generated number.

*Source FH:* This parameter specifies the value for the Fiber Handle to use each time the driver receives the request from distributor. This parameter can vary from 0 to 10000. Default parameter is "0".

- If the parameter is zero the source Fiber handle of the request received is used to find the configuration options within the flipfactory.ini file.
- If the parameter is nonzero, then the source Fiber handle value of the request received is ignored and the options from flipfactory.ini are extracted according to the Source FH parameters value.

**Note:** This option may be used when only one distributor points to Flip Factory driver. If two or more distributors are configured to point to the same Flip Factory driver we strongly recommend to set this parameter to "0", so that for request from different distributors there may be used their own specific setting from the flipfactory.ini file.

*Reinitialize button:* Click this button to make the Flip Factory driver re-read the flipfactory.ini file with the configuration.

- **For Front Porch Digital (FPD) VAST BitSCREAM:**
  - *Device Name:* This parameter defines the name of the driver into the adc1000nt configuration. (Default: BSCRM).
  - *Host Name:* This parameter identifies the BitScream system the driver is communicating with. This parameter can take a name or an IP address. (Default: screamer).
  - *Transcoder ID:* (Default: 0, Range: 0 - 9) This parameter defines the transcoder that will be used to transcode the files.
    - If set to 0, the VAST BitSCREAM system is configured in load balancing mode (Transcoder automatically selected by the transcoding system).
    - If set to positive value (greater than 0), the adc1000nt driver selects the transcoder to be used and only this one will be used for transcoding.

  **Note:** The Transcoder ID is randomly generated and hardcoded by Front Porch Digital. As per Front Porch Digital, there is no upper limit to this #; they are generated sequentially starting from 1. However, if a transcoder is deleted, its transcoder ID will not be re-used. (Actual range: 0 - 9999)

  - *Source ID:* (Default: 1, Range: 1 - 10000) This parameter defines the source directory (storage) that will be used to get the files to be transcoded. It must match a Source ID (using ftp) declared and configured in the VAST BitSCREAM.
  - *Source Extension:* (Default: .mpg) This parameter defines the extension of the source filenames from the Source ID. When the driver is declared, the Default parameter is ".mpg"
for the source extension. Then, it can be modified to another value. Ensure that the correct case is used.

**Note:** The driver does not insert the "." (dot) character automatically between the filename and the extension. The "." (dot) character must be set in the "Source Extension" field.

**Note:** A blank field can be configured. In this case, this configuration means that there is no extension for the IDs to be transcoded.

- **Priority:** (Default: 5) This parameter defines the priority to attach to each transcode command. The supported values are from 1 (lowest) to 9 (highest).

4. Select **Transcoding Parameters** tab. (For FPD VAST BitSCREAM)

Configure the following parameters as required:

- **Destination ID:** (Default: 2, Range: 1 - 10000) This parameter identifies the destination device (storage) that will receive the transcoded files. This parameter must match a Destination ID configured in the VAST BitSCREAM.

- **Destination Formats:** (Default: VOD) Select a destination format: VOD or Others (non VOD). When "VOD" is selected, "Others" is unchecked and the text area is empty and grayed.
  - If "VOD" format is selected, the transcoding request manages a single output format (VOD).
  - If "Others" format is selected, the transcoding request manages single or multiple output formats depending of the content of text area (Description field).

- **Description field / Text area:** This text area field becomes active when Others format is selected. The Text area can contain several formats separated with a comma. If several formats are specified in the list, then a transcoding request will manage simultaneous output formats per transcoding request.
  - Example for a Single format request (Windows Media): "WM".
  - Example for a Multiple format request (Windows Media & Real Media): "WM, RM".

All the supported outputs formats depend on the capabilities of the VAST BitSCREAM. Ensure the proper labels for the format(s) are configured. Current supported outputs formats and associated codes are:

- WM - Windows Media
When finished click **Apply**, then click **OK**.

6. From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server's configuration files in the "C:\Server" folder on the Device Server.

---

### Archive Configuration (General)

Archives, archive managers and archive systems are controlled through an Ethernet connection, rather than a point-to-point RS-422 serial connection. The Device Server's second network interface (bound to TCP/IP protocol) connects to a separate network hub or switch that allows it communicate with the archive. Archives are not media devices in the sense that they are not assigned to lists, they cannot cue and play, and they are not capable of producing an I/O stream. Instead, archives stream data into a video server for playout. A video server may also stream data into an archive for storage. Archives are strictly data storage devices and may only be accessed by the automation through GMT components. The Device Server application does maintain a storage collection for archive devices, which may be viewed from the Device Storage window in either the Air or Media Client application. For more information about archives and GMT, see section Global Media Transfer.

The following is an example Archive configuration. Your device may have different options. If necessary, refer to the User Notes for your device for complete details on how to configure it.

---

### To Configure an Archive Device

1. Under **Archives** in the Available pane (right pane), select an Archive device (Standard Archive) and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50). Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the Archive device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select **General** tab. (Standard Archive.)
Configure the following parameters as required:

- **Device Name**: Change this to the preferred name for the device, up to 5 characters.
- **Archive Parameters**:
  - **Instance**: Number of copies of each spot to put on tape when executing a Copy to Archive command.
  - **Copy From Priority**: The priority to attach to each Copy From Archive command. 1 means highest priority; 16 means lowest priority.
  - **Copy To Priority**: The priority to attach to each Copy to Archive command. 1 means highest priority; 16 means lowest priority.
  - **Group**: The group name to use in a Copy to Archive command.

4. Select **Socket** tab.

Configure the following parameters as required:
Socket Information:
- **Host**: Enter the IP host address of the Sun workstation running the Avalon Archive Manager software.
- **Port**: Enter the IP port number on which the AAM process is running its VACP interface. This value should be 1025.

5. Select **VACP Manager** tab. Use this tab to select your Archive Manager from the list of available devices.

6. Select **Storage** tab.

Configure the following parameters as required:
• **ID List Options**: Select one of the following List ID options. During the Archive Device’s initial connection to the Archive Manager, the user can choose what kind of storage ID collection is desired. Archive Device uses VACP (Video Archive Communication Protocol) to request ID and status associated with each ID. These Archive IDs can be displayed in the Air Client Archive Storage Window for browsing. When the GMT List queries Archive Device for the existence of an ID, this Archive storage collection is not referenced. Rather, the VACP ID query command is sent directly to the Archive Manager for refresh status.

  - **Request ID Name List and Status**: When selected this option instructs the ADC Archive Device to collect all ID name and its associated status. If the archive storage has a huge amount of IDs stored, this option may take a significant amount of time to process. This is because some Archive Manager products respond to slower than others VACP ID-Request commands.

  - **Request ID Name List Only**: If only ID name is required without detail ID status, this option can be much faster to process for slower Archive Manager products.

  - **No ID List Required**: When this option is selected, no ID collection is maintained in the ADC Archive Device. This will not affect archive query, nor will it affect archive media transfer. The only limitation is the user will not be able to browse the Archive Storage Window from the ADC system. However, users can still use the browser tool provided with Archive Manager to browse content of archive storage.

7. Select **Diagnostics** tab. Use this tab to view diagnostic summary. If required, click the **Reinitialize** button to reinitialize the device.

![Diagnostics Tab](image)

8. When finished click **Apply**, then click **OK**.

9. From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.
Video Effect Device Configuration (General)

The following is an example video effect device configuration. Your video effect device may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.

To Configure a Video Effect Device

1. Under **Video Effect Devices** in the Available pane (right pane), select a device (e.g. Pinnacle DVExtreme) and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the **General** tab. Fields displayed depend on the device selected.

   Configure the following parameters as required:
   - **Device Name**: The device name identifies the disk port. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name.
   - **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name. Enter the name by using up to four characters. When an event is threaded, a fifth character - the head number - is added to the name.

   The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed.
   - **Options:**
• **Back-time value in frames**: This parameter determines when commands should be sent to the device. A non-zero value in this field indicates the number of frames that commands will be sent early (during preroll, before the play counter actually starts). This value is set at 1 by default, it shouldn’t need to be changed. However if the timing of the device and DVE commands are off with respect to the switcher, this parameter may be changed to adjust the output timing. This parameter does not change the timing for secondary data commands, only A/V events.

• **Enable Internal Keyer**: Check to enable. When **enabled** (checked), the video is brought up on the output at the On Air Time of the Event. It is then cleared when the event is done. There is no preview ability when keyer mode is enabled. The Timing value adjusts when the video appears on the output. It is expected the program video will be put into the device so the internal keyer can overlay the Logo on its output.

  When **disabled** (unchecked), the device server brings up the video on the output of the device as soon as the event is cued. In this way the operator can see the correct video on a preview monitor if desired. The output could be feed into a keyer of a master control switcher, or another external keyer. After the event is done, the video is left on the output of the device unless it is needed for another event.

4. Select the **Serial Port** tab. Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.

5. Select the **Diagnostics** tab. (Available for Quastech Charisma DVE).
Select **Reinitialize** to reinitialize the device.

6. When finished click **Apply**, then click **OK**.
7. From the Configured Devices window select **File> Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

---

**Still Store Device Configuration (General)**

The following is an example still store (i.e. still store or logo generator) configuration. Your device may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.

**To Configure a Still Store Device**

1. Under **Still Stores** in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: **To Assign a Device to a Device Channel** (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the **General** tab. The available options depend on the selected device. (For example, the following General tabs show options for a Leitch DTP 20, a LogoMotion2, an Imagestore750, a Sony SSCU 1000, and an SAV LGA100.)
Configure the following parameters as required and available:

- **Device Name**: The device name identifies the disk port. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name. The "Device Name" appears in the Device Status and configuration window on the client applications. The default name may be used, but it is recommended to use unique names for easy device identification.
  
  - This string is placed in the ID field of events that will be played by this device.
  - The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

  **Evertz 9725 LGA – 16 char logo Note**: Assign the Evertz 9725 LGA – 16 char logo names to a Transmission List to be schedule to air. The Evertz 9725 LGA – 16 char logo names uses A/V, Secondary A/V, and Secondary Data Events to execute the pre-loading and playout of Logos.

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name. Enter the name by using up to four characters. When an event is threaded, a fifth character - the head number - is added to the name.
  
  - This string is placed in the ID field of events that will be played by this device.
  - The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

- **Options**
  
  - **Back-time value in frames**: This parameter determines when commands should be sent to the device. A non-zero value in this field indicates the number of frames that commands will be sent early (during preroll, before the play counter actually starts). This value is set at 1 by default, it shouldn’t need to be changed. However if the timing of the device and DVE commands are off with respect to the switcher, this parameter may be changed to adjust the output timing. This parameter does not change the timing for secondary data commands, only A/V events.

  **LogoMotion2 Note**: This driver allows an "EarlyFrameCount" value as low as -5 frames. An "Early Frame Count" value less than zero means the duration of the event is less than it was
scheduled. For example, if "Early frame count" = -3 then the actual duration DUR' = DUR – 3; where DUR is the scheduled duration.

**ImageStore, ImageStore750, and ImageStore Intuition Note:** In Device Server v12.19 and higher the maximum negative value for the ‘Back-time value in frames’ parameter is -70.

**IMPORTANT ICONSTATION XML VERSION NOTE:** The default back-time value for the Iconstation driver is 76 frames which in PAL is one frame more than the default list preroll so sAV events fail to send the LoadFire command. Reduce the back-time value to below 75 frames and all is good.

**IMPORTANT ICONSTATION XML VERSION NOTE:** The Transmission List Option: Thread Time value controls the length of back-time events on the Iconstation XML. For example, if the Thread Time is set to 2 minutes the max back-time value is also two minutes.

- **Timeout value in frames:** (for Iconstation XML) This is a special value used to specify the time to wait for "Load Layout" and "Setup All Items" commands. By default it is 150*3 = 450 frames.
  
  If the IconStation doesn’t reply "Request Executed Successfully" to "Load Layout" and "Setup All Items" commands during this interval, the driver reports "Communication Lost error" and continues sending next commands.

- **Use Check Asset Command:** (Iconstation) Enable (check) / Disable (uncheck) sending the Check asset command (request) and getting the answer from device. This allows an operator to operator ensure setGraphic sDAT events are targeting media that are present where a layout, region and file path are specified.

  For example:
  
  SetGraphic:<layout>,<region>,d:\media\logo.mov

  These events are "red" if the layout or region or file path is not found.

  - **Enable (check) the option.**
    
    - An sDAT event SetGraphic with existing media will register on the list.
    - An sDAT event SetGraphic with no existing media will not register on the list (i.e. stay red).

  - **Disable (uncheck) the option.**
    
    - An sDAT event SetGraphic with existing media will register on the list.
    - An sDAT event SetGraphic with no existing media will register on the list.

- **Playback Card ID:** (For LogoMotion and LogoMotion2). Under normal circumstances this parameter should be left at 2.

- **Stop Current Play After Initialize:** (For LogoMotion2). Enable (check) / Disable (uncheck) allowing the device to keep playing the logo(s) if the channel(s) is(are) not scheduled to play.

- **Enable Internal Keyer:** Check to enable.

  When enabled (checked), the video is brought up on the output at the On Air Time of the Event. It is then cleared when the event is done. There is no preview ability when keyer mode is enabled. The Timing value adjusts when the video appears on the output. It is expected the program video will be put into the device so the internal keyer can overlay the Logo on its output.

  When disabled (unchecked), the device server brings up the video on the output of the device as soon as the event is cued. In this way the operator can see the correct video on a preview monitor if desired. The output could be fed into a keyer of a master control
switcher, or another external keyer. After the event is done, the video is left on the output of the device unless it is needed for another event.

- **Storage Check**: (for Miranda ImageStore, ImageStore 750, and Miranda Intuition). Enable (check) if the logo's ID is available in the device storage. Disable (uncheck) this option, if the Still Store device does not support the storage check. This lets the list blindly register the event (i.e. turn the event to blue).

- **Guaranteed storage time**: This parameter is available when Storage Check is enabled. This parameter specifies the time (MM:SS) during which media will not change. (i.e. it is the interval of recheck events in a playlist.) Default: 30 seconds. Range: 10-99. Recommended: Specification for this parameters should be a multiple of 10 seconds.

- **Device Type**. (For LogoMotion 2) Select one:
  - **SD**: Choose this option if device type is Standard Definition. The Standard Definition has 4 keyers (4 layers).
  - **HD**: Choose this option if device type is High Definition. The HD version has only 2 layers.

- **DTP Parameters** (For Leitch DTP20 Specify):
  - **Client ID**: Goal of this parameter to distinguish the answers from different clients which work with the same DTP device. If there is only one client, use default value (10) or choose any other value in the range [0..65000]. If there are several clients, specify different clients ID for each (the real values do not matter. They just need to be different.)

4. Select the **Serial Port** tab. Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.

![Serial Port Tab](image)
5. Select the **Communications** tab. (Available for LogoMotion 2 and SAV 50DK) Use this tab to configure the following parameters as required: Baud Rate, Data Bits, Stop Bits, and Parity.

![Communications tab](image)

6. Select the **Socket** tab. (Available for Leitch DTP20, and PixelPower Clarity devices)

![Socket tab](image)

Configure the following parameters as required:

- **Socket Information**.
  - **Host**: (Default: 127.0.0.1)
  - **Port**: (Default: 49227). This default value was defined in the description of the RCS Protocol. DTP driver uses this protocol.
- **Log Setting**.
Both drivers can create own log file. This file can be created in the folder where DS will be started from or forwarded to another computer.

- **Enable**: (Default: unchecked) Check to enable Log creation.
- **Forwarding**: Enable (check) to forward the created log to another computer. When this option is checked (enabled) Forwarding Address and Forwarding Port are active. Disable (uncheck) if the log file can be created in the folder where the Device Server will be started.
- **Forwarding Address**: When this option is active, specify the IP Address of the computer the log will be forwarded to.
- **Forwarding Port**: When this option is active, specify the Port to use on the computer the log will be forwarded to.

7. Select the **Layouts** tab. (For IconStation XML). Use this tab to view a list of all layouts, and the salvos and items corresponding to them.

Configure the following parameters as required:

- **Available Layouts**: Select layouts from the dropdown list.
- 'Update' button allows updating the layouts list if it was changed or is empty ('None').
- "Available salvos" pane: Displays the salvos available based on the selected layouts.
- "Available items" pane: Displays the devices available based on the selected layouts.

**Note**: If 'None' is displayed on the screen, then the IconStation driver didn’t receive a layouts list (the most probable issue that connection is not established).

8. Select the **Diagnostics** tab.
Configure the following parameters are required:

- **Reinitialize** button: If required, click Reinitialize button to reinitialize the device. This clears the buffers in the driver and resets the connection to the device. This should only be used for troubleshooting purposes.

- **IconStation XML Troubleshooting**: Operators can send test commands to the IconStation for trouble shooting purposes or execution of data events without Air Client.
  - **Command**: Select a display command from the dropdown list. All display commands of the IconStation protocol are listed except for 'Get Bypass' and 'Set Bypass'.
  - **Parameters of command**: Specify the required command based on the format displayed for the selected command.

9. Select the "Device" Channel tab. (Available on SubDev selections only) Some Make/Model devices will offer additional functionality through a sub-device. This tab is where the device driver of a primary device is associated with the related sub-device (SubDev) driver.
For Example: The Quartz Logo, the Evertz MCS, and the Harmonic ChannelPort each have an optional DVE sub-device. To illustrate, the following screen shot shows the QuartzQMC Channel tab for a Quartz Logo DVE SubDev selection. In this situation the Quartz QMC device driver is configured, then the Quartz Logo DVE SubDev driver is configured. The QuartzQMC Channel tab is where the two drivers are associated.

EvertzQmcMCS Note: The Logo and DVE sub device driver cannot be used without configuring the QMC MCS device driver first. The "EvertzQMC for DVE&Logo" Subdev must also be assigned to the Transmission List where the Evertz Switcher is used.

10. When finished click Apply, then click OK.
11. From the Configured Devices window select File> Save Devices. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

Character Generator Device Configuration (General)

The following is an example character generator device (e.g. Chyron MAXINE, Aston CG) configuration. Your device may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.

To Configure a Character Generator Device

1. Under Character Generators in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).
   Once a device has been assigned to a device channel, it may be configured for specific options.
2. Select the device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.
3. Select the **General** tab. Options available may differ depending on the device selected.

*For example*: The following General tabs show options for a Chyron Max (left), a Presto DBR (right), a Chyron HyperX (lower left), and a Chyron Duet2 (lower right).

Configure the following parameters as required:

- **Device Name**: The device name identifies the disk port. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name.

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name. Enter the name by using up to four characters. When an event is threaded, a fifth character - the head number - is added to the name.
  
  The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed.

- **Options**.
• **Back-time value in frames**: This parameter determines when commands should be sent to the device. A non-zero value in this field indicates the number of frames that commands will be sent early (during preroll, before the play counter actually starts). This value is set at 1 by default, it shouldn’t need to be changed.

• **Address**: Specify the Address of the CG

• **Enable Internal Keyer**: Check to enable internal keyer.

  When enabled the Program Out line will overlay the graphics onto external video whenever the list event for the CG is on air. Also, the user has the option of enabling Key Hold which will not turn off the keyer after an event finishes playing and the Key Hold will remain in effect until it is ended by another event.

  When disabled the internal keyer is always turned on such that the Program Out and Program Key Out are always enabled as input to a downstream keyer.

• **Display First Frame of Image When Cued**: (For Chyron Duet 2, Duet LE) Enable (check) / Disable (uncheck) allowing the load image command to set the attribute to display the first frame to the frame buffer. This provides operators with the cueing option of either showing the first frame of a cued event or not on the output of the Duet.

4. Select the **Serial Port** tab. Use this tab to connect the driver to the ADC's serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.
5. Select the **Communications** tab. (Available for Chyron Duet selections) On this tab configure the following parameters as required: Baud Rate, Data Bits, Stop Bits, and Parity.

![Communications tab configuration](image)

6. Select the **Diagnostics** tab. Click **Reinitialize** button to reinitialize the device, if required.

![Diagnostics tab reinitialize](image)

7. When finished click **Apply**, then click **OK**.

8. From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

---

**Audio Disk Cart Configuration (General)**

The following is an example audio disk cart configuration (e.g. Digicart, Sony Mini Disk, etc.). Your device may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.
To Configure an Audio Disk Device

1. Under Audio Disk Carts in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the General tab. Options available may differ depending on the device selected.

   For example: The following General tabs show options for a Enco DAD (left), Digicart (right), Sony Mini Disk (lower left), Sony MD B3 (lower right).

Configure the following parameters as required:
- **Device Name**: The device name identifies the disk port. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name. This name is used in the ID field of an event that is to be assigned to the device. You can use the default name or assign another name if multiple devices are in the system.

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name. Enter the name by using up to four characters. When an event is threaded, a fifth character - the head number - is added to the name. The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed.

- **Options**.
  - **Back-time value in frames**: This parameter determines when play commands should be sent to the device. A non-zero value in this field indicates the number of frames that commands will be sent early (during preroll, before the play counter actually starts). This value is set at 1 by default, it shouldn’t need to be changed.
  - **Update Durations from Audio Tracks**: Check to enable the update of durations with actual durations from audio tracks.
  - **Stop Before Play**: (Digicart Option) If enabled (checked), a STOP command is sent from the Device server to the Digicart before each PLAY command. If a cut is still playing this ensures it will be stopped and the new cut played immediately.
  - **Sort Storage by Title**: (Digicart Option) If enabled (checked), the cuts in the device storage window are sorted by cut titles. If disabled (unchecked), the window is sorted by cut number.
  - **Enable Storage Sorted by Title**: (Sony Option) If enabled (checked), the cuts in the device storage window are sorted by cut titles. If disabled (unchecked), the window is sorted by cut number.
  - **Sony MDS Model**: (Sony Option) Check to enable if this is a Sony MDS Model.

- **Preroll Timings**: (Dalet Options)
  - **Send play at Preroll**: Click to enable send of a play command at preroll.
  - **Frames to send play early**: Specify the number of frames that the play command will be sent early (during preroll, before the play counter actually starts). This value is set at 1 by default, it shouldn’t need to be changed.
4. Select the **Serial Port** tab. Use this tab to connect the driver to the ADC's serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.

5. Select the **Diagnostics** tab. As required:
   - **Reinitialize** button: Click to reinitialize the device.
   - **Reverify Storage** button: (available for Digicart) Click to reverify device storage.

6. When finished click **Apply**, then click **OK**.
7. From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.
Serial Device Configuration (General)

The following is an example ‘serial device’ configuration. Your ‘serial device’ (such as a David MultiPlayer, a FAB Subtitler, and an Ayato Remote) may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.

To Configure a Serial Device

1. Under Serial Devices in the Available pane (right pane), select a device and drag-n-drop it to the Configured Pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. In the Configured Pane (left pane), select a ‘Serial device, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the General tab. Options available may differ depending on the device selected.
Configure the following parameters as required:

- **Device Name**: The device name identifies the disk port. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name.
  
  This name is used in the ID field of an event that is to be assigned to the device. You can use the default name or assign another name if multiple devices are in the system.

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name. Enter the name by using up to four characters. When an event is threaded, a fifth character - the head number - is added to the name.

- **Timings / Preroll Timings**:
  
  - **Send play at Preroll**: Click to enable send of a play command at preroll.
  
  - **Frames to send play early**: Specify the latency - in frames (positive or negative) - for sending the Play command (during preroll, before the play counter actually starts). This value is typically set at the default level for the device and shouldn’t need to be changed.
    
    For Example: +4 frames (4 frames after on air time).
  
  - **Frames to send stop early**: Specify the latency - in frames (positive or negative) - for sending the Stop command. This value is typically set at the default level for the device and shouldn’t need to be changed.
    
    For Example: 0 frames (last frame of clip).
  
  - **Polling Delay (Frames)**: Specify the frequency (in frames) of polling the device. Default: 25 frames.
  
  - **ID Request Polling Delay (Frames)**: Frequency (in frames) of the device polling when command is executing (the "Pending" status is received). Default: 25 frames.

- **Number of command retries**: Specify the number of times to retry a command, if the response was not received during the command timeout.

- **Clear OnAir Subtitle When Start**: This parameter allows active subtitles on to remain on-air when the Device Server application starts.
  
  - When this option is enabled (checked), the driver clears active subtitles.
  
  - When the option is disabled (unchecked), on-air subtitles remain active and on-air.

- **Send ID Only** (for Screen Subtitler 24): This option determines the device driver mode used.
  
  - When this option is enabled (checked), the driver uses the ‘ID’ and ‘Title’ fields of the commands only for ID, so a passed ID can be up to 24 characters.
  
  - When option is disabled (unchecked), the behavior of the driver matches the behavior of the SCREEN_SRV2 driver.

**Note**: Changing this setting does not affect the device operation mode, only driver mode.
4. Select the **Serial Port** tab. Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.

5. Select the **Connection** tab (for Screen Subt24 only) and select the required connection approach:
   - **Serial**: Select this radio button, then specify the serial COM port number that the Screen subtitle device is connected to ADC server to establish serial communications between ADC Device Server and Screen subtitle device.
     Selecting this option enables the Communications tab.
   - **TCP/IP**: Select this radio button, then specify the Host IP address and Port that the Screen subtitle device is connected to ADC server to establish IP communications.
6. Select the **Communications** tab. On this tab configure the following parameters as required: Baud Rate, Data Bits, Stop Bits, and Parity.

![Communications tab](image)

7. Select the **Channel** tab.

![Channel tab](image)

Configure the following parameters as required:
Select each Player Channel Number and fill in the channel number for each head of the NDS ESS device. The NDS ESS device is a 10 headed device. By default, the channel number for each head is assigned as 0001 through 0010 for the respective heads.
8. Select the **Macros** tab.

Configure the following parameters as required:

- **Add** button: Click the **Add** button to enter a macro. When finished click **OK**.
  - Macro Name: Enter a mnemonic to help the operator identify the macro name.
  - Macro: Enter the macro commands.

- **Edit** button: To edit an existing macro entry, select a macro entry from the list display and then click **Edit**. An edit dialog is displayed populated with the parameters currently specified for the selected macro. Make changes as required, and then click **OK**.

- **Delete** button: To delete an existing macro entry, select a macro entry from the list display and then click **Delete**.

9. Select the **Diagnostics** tab. Options available depend on the serial device:
Configure the following parameters as required:
- **Reinitialize** button: Click to reinitialize the device.
- **Reset Timer #** button: Click to reset the timer. Click yes when system prompts to confirm.

10. When finished click **Apply**, then click **OK**.
11. From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server's configuration files in the "C:\Server" folder on the Device Server.

---

**Advanced Device Configuration (General)**

The following is an example ‘advanced device’ configuration. Your ‘advanced device’ may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.

**To Configure an Advanced Device**

1. Under **Advanced Devices** in the right pane, select a device and drag-n-drop it to the left pane. For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).
   Once a device has been assigned to a device channel, it may be configured for specific options.

2. In the left pane, select an ‘Advanced’ device, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.
3. Select the **General** tab.

Configure the following parameters as required:

- **Device Name**: The device name identifies the disk port. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name.
  
  The "Device Name" appears in the Device Status and configuration window on the client applications. The default name may be used, but it is recommended to use unique names for easy device identification.
  
  This name is used in the ID field of an event that is to be assigned to the device. You can use the default name or assign another name if multiple devices are in the system.

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name. Enter the name by using up to four characters. When an event is threaded, a fifth character - the head number - is added to the name.
  
  This string is placed in the ID field of events that will be played by this device.
  
  The name is also used to identify the disk port used to execute secondary data events. If a disk port's name matches the ID of a secondary data event, the event is executed. Such secondary data events include those that delete spots, transfer an archived spot, delete protect spots, or undelete protect spots.

4. Select the **Connection** tab.
Configure the following parameters as required:

- (For Iconstation CIII only): Use this tab to specify Baud Rate, Data Bits, Stops Bits, and Parity
- Chose the Connection Type: Specify Serial or TCP/IP.
  - For Selenio: SNMP is enabled. Serial connection is currently disabled.
- Serial Port: (Active when Serial is selected) Use this entry to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.
- TCP Connection: (Active when TCP/IP is selected.) Specify the Host IP address. And enter the port number to lowest field.
- SNMP Connection: (Selenio only) Specify host, port and community for SNMP connection. SNMP port is 161 by default. Community is responsible for user rights, "public" by default.
5. Select **Available Cards** tab (Selenio only). The Selenio Frame supports different cards. Use this tab to specify currently available cards, their ID (for ADC purposes) and location. Buttons Add/Delete/Edit allow managing available cards.

To Add a card:

- Click Add. The Selenio Card Form is displayed.

- Specify the following.
  - Card Type: Defines type of card. Select from the dropdown list. Currently available cards are: XD, FS, Encoder, Decoder, MDX, DEM, NET.
• **Card ID**: Defines ID of card for ADC purposes. This ID doesn’t correlate with any card information in Selenio Frame; it is internal ADC information to be used in macro.

• **Card Location**: Defines location of card in Selenio Frame. This value is added to OID of a certain parameter to uniquely identify combination "card-parameter" (as OID of a certain parameter should be the same on all cards of same type).

   **Note**: Location should start from dot ("."). If starting it with digit, the dot is added automatically.

• **When finished click** **OK**.

6. Select the **Communications** tab. Use this tab to select Baud Rate, Data Bits, Stop Bits, and Parity.
7. Select the **Macros** tab.

Configure the following parameters as required:

**Note:** For details on using macros with Selenio device see For Selenio Macros only (see "For Selenio Macros only:" on page 337).

**Note:** For details on using macros with the SCTE-104 device driver see For SCTE-104 Macros only. (see "For SCTE-104 Macros only" on page 327)

- **Title pane:** Lists titles of macros that already exist.
- **Check if Macro exists:** Enable (check) or disable (uncheck) checking for existence of specified macro in the PlayList. When enabled, the "TITLE" field of each event is checked whether the Macro Template exists in the Universal SerCom or not. If the specified Macro Template does not exist, the event is red colored.
- **Edit button:** Edit an existing macro. Select a macro listed on the Title pane, and then click the Edit button. The Extended macro Entry form opens, populated with the definition of the selected macro. Make any changes necessary, and then click **OK.** (See Add button below for a list of dialog parameters.)
- **Delete button:** To delete an existing macro entry, select a macro listed on the Title pane, and then click the **Delete** button.
- **Add button:** Add a new macro. Click the Add button to open a blank Extended Macro Entry dialog.

To edit an existing macro, select a macro from the defined Macro list and then press Edit; this opens an Extended Macro Entry dialog populated with the macro information.

- **Macro Name:** Enter a mnemonic to help the operator identify the macro name. The "Macro Name" is used in TITLE field of PlayList to identify the Macro Template, which should be processed.
• **Number of Parameters**: Specify the number of playlist parameters. This parameter sets the flexibility of the Macro Template. It defines how many external parameters will be passed to Macro Template.

• **TITLE Field format**: This field shows the way the Macro should be used in TITLE field of Playlist. It is the syntax of the Macro Template.

  For example: If "TEST_MACRO:file1:scene2" (without quotes) is entered into the "TITLE field" of Playlist: "file1" is the first parameter passed to the Macro Template, and "scene2" is the second parameter passed to the Macro Template.

  **IMPORTANT**: For 'Data Event with Data': parameters are passed not in a Title field, but they are entered in a special window in Air Client, when creating an event. Each line in this window represents one parameter in the macro.

• **Event States**: There are 7 states of the event when commands could be sent to the device.
  o "Check" state occurs when an event is ‘checked’ (e.g. enters the lookahead) to confirm if the ID’s media is available.
  o "Cue" state occurs when the media tries to be cued (prepared).
  o "Preroll" state occurs before the "Play" will be started. Preroll time is configurable parameters of Playlist.
  o "Play" state occurs when media is playing.
  o "End" and "Postroll" goes just after the "Play". Postroll time is configurable parameter for the list too.
  o "Skip" state occurs when operator skips the event (for example, by pressing "Skip" button in Air Client).

  **IMPORTANT**: For Universal Sercom Driver v.2 only: 'Data Event' and 'Data Event with Data' are registered with Device Server only if the corresponding macro contains 'play' state, only. If macro includes any other state (Cue, Preroll, End, Postroll, Skip) - an event is registered, because for this type of events there is only 'play' state.

• **Select the required tabs** (Check, Cue, Preroll, Play, End, Postroll, Skip) and set up the following parameters: (It is not required to use all seven states, but it is possible to fill in all of them.)
  o **Command**: When selected the Command pane and the Reply Expected option become available.
  o **Command pane**: Specify the macro commands.
  o **Reply Expected**: Enable (check) if a reply is expected. When selected, the following options become available:
    o **Automatic Reply Processing**: Select to enable automatic reply mode. This means that reply processing should be done automatically by driver. This option is useful only if using a custom device driver.
    o **User defined reply**: Select to enable user reply mode. When selected the Reply pane comes available for entry. This means mode means that you define expected reply yourself. In this case Reply pane text field should contain expected reply. You may use hexadecimal values wrapped with braces inside the expected reply. The sequence received from the device is compared against the sequence stored in the text box for this state. If they don't match, an error occurs.
    o **Reply timeout** (in frames) Specify how long to wait for a reply before timing out the process.


- **Reply pane**: Specify the user reply.

**About Hexadecimal Values.**

Hexadecimal values may be used in the command or reply text fields both for polling and for macro template. Hexadecimal values are wrapped in braces and within braces may be separated with spaces. If hexadecimal value contains odd number of digits then single digit becomes zero-leading.

For example,

- `{1 2}` is equal to `{01 02}`
- `{123}` is equal to `{01 23}`
- `{1234}` is equal to `{12 34}`
- `{12 34}` is equal to `{12 34}`

**Note**: Not used for Selenio.

- **Acceptable for cards**: (Selenio only) Check the card types that the macro is acceptable for. Multiple card types can be selected.

- **OK button**: Click **OK** to save the Macro Template and close the Extended Macro Entry dialog.

- **Cancel button**: Click **Cancel** to close the dialog without saving.

- **Apply button**: Click **Apply** to save the Macro Template, but keep the dialog open.
- **Apply and New** button: Click **Apply and New** to save the Macro Template and open a clear Extended Macro Entry dialog for a new Macro Template creation.

8. Select the **Diagnostics** tab. Use this tab to test commands or reinitialize the device.
Configure the following parameters as required:

- **Test Command**: enter a test command and then click **Send**.
- **Reinitialize** button: If required, click to reinitialize the device.

**Selenio Note**: Currently, Reinit does not perform any operation for the Selenio driver.

- **For Selenio only**: The Diagnostic tab in Selenio configuration window helps to get/set value of any parameter via SNMP protocol. It can be useful if it is necessary to request current value of a certain parameter.

  **Note**: OID should start from digit, not from dot. If you write dot as first symbol, it will be removed automatically.

9. Select the **Initialization** tab. (For Pubtronic, Universal SerCom Driver, Kaleido K2, Fingertext, Softel Pres TX, and SCTE-104 devices.)
Configure the following parameters as required:

- **Command**: When selected the Command pane and the Reply Expected option becomes available.
- **Command pane**: Specify the initialization command.
- **Reply Expected**: Enable (check) if a reply is expected. When selected, the following options become available:
  - **Automatic Reply Processing**: Select to enable automatic reply mode. This means that reply processing should be done automatically by driver. This option is useful only if using a custom device driver.
  - **User defined reply**: Select to enable user reply mode. When selected the Reply pane comes available for entry. This means mode means that you define expected reply yourself. In this case Reply pane text field should contain expected reply. You may use hexadecimal values wrapped with braces inside the expected reply. The sequence received from the device is compared against the sequence stored in the text box for this state. If they don’t match, an error occurs.
  - **Reply timeout**: (in frames) Specify how long to wait for a reply before timing out the process.
  - **Reply pane**: Specify the user reply.

10. Select the **Polling** tab. If your device supports polling command, use this tab to set polling. The Device Server uses polling to check whether device is alive.

For details on SCTE-104 see SCTE-104 Driver Polling (on page 334).
Configure the following parameters as required:

- **Polling Enabled**: Check to enable polling.

  **Selenio Note**: Always enable polling for the Selenio driver. The driver’s SNMP component doesn’t hold connection with remote device; it just sends SNMP queries when necessary. Therefore it is important to use polling for determining status of remote device.

- Polling Parameters:
• **Interval (Frames):** Specify the appropriate polling interval - in frames.

• **Device TimeOut (frames):** Specify the appropriate polling reply timeout - in frames. This is how long driver waits for reply.

• **Command:** Enter the polling command or byte sequence, which will be sent with configured interval. You may enter any characters and use hexadecimal representation. For example, you may use \{20\} instead of space, \{0D0A\} instead of carriage return. All hexadecimal values should be wrapped with braces.

• **OID:** (Selenio Only). OID shows what parameter is requested. This parameter should be related to Selenio Frame in general, not to a certain card.
  
  **Note.** OID should start from digit, not from dot. If a dot is written as the first symbol, it will be removed automatically.

- **Reply Processing.**

  • **Automatic reply processing:** Check to enable automatic reply mode. This means that reply processing is done automatically by driver; any reply from devices is considered as correct reply. This option is useful only if you are using custom device driver.

  • **User defined reply:** Check to enable user-defined reply mode. This means that you define the expected reply yourself. In this case reply pane text field below should contain expected sequence of character, which device will send after polling command is received.

  **Selenio Note:** The value from SNMP reply should be equal to user specified string; otherwise driver supposes that device doesn't reply.

• **Reply pane:** Specify the user reply.

11. Select the **Global Timeout Settings** tab. On this tab enter the reply timeouts in frames for each listed state, and then press "Apply". Now new default values will be used in the Extended Macro Entry.
12. Select SCTE 104 Settings tab. This tab specifies several specific settings which are used in commands.

Configure the following parameters as required.

- **Automation System Index**: This parameter represents a unique index of current automation system (please refer to protocol for more details). Default is 0, range 0 – 255 (1 byte)
- **DPI PID Index**: This parameter represents a unique index of device channel which current driver operates with (please refer to protocol for more details). Default is 0, range 0 – 65535 (2 bytes)
- **Splice Request Preroll**: This parameter represents preroll value for Splice Request commands (please refer to protocol for more details). Default is 8000 ms, range 0 – 65535 (2 bytes field)
- **Use Break Duration**: Check to enable Break duration feature
- **Default Break Duration**: This configurable value is sent by driver if it is not possible to calculate Break duration based on events in a Transmission list.
  The "break_duration" is calculated just before it is sent, because Air Client operators may change the duration of the break in the playlist.

  **Note**: If "Use Break Duration" is disabled (unchecked), the "Default Break Duration" value is not taken in account by the driver and a zero duration is always sent.

These settings can be specified in predefined commands and replies (in macros, initialization and polling) with special designations:

<table>
<thead>
<tr>
<th>Value</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation System Index</td>
<td>$AS</td>
</tr>
<tr>
<td>DPI PID Index</td>
<td>$DP</td>
</tr>
<tr>
<td>Splice Request Preroll</td>
<td>$PR</td>
</tr>
<tr>
<td>Message Number</td>
<td>$MN</td>
</tr>
</tbody>
</table>

The last value, Message Number, is a 1-byte field in a command, which should be incremented after each message. When it reaches 255 or driver is reinitialized, it is reset back to 0.

**Note**: All designations are case-sensitive.
13. Select the **Latency Adjustments** tab. (For Universal Sercom v2 driver only) Use this tab to set latency adjustments in the timing of play, end and skip commands.

Use these parameters to adjust the time (in frames) to send play, end, and skip commands earlier than the crossing point, the end time, and the skip time, respectively.

**Note:** These options can be operated only on primary, secondary A/V events, or any event that supports duration counter.

- The default values of these parameters are zeros.
- The maximum number of frames that currently supported is 90, and the minimum value is zero. The value 90 was chosen to be consistent with other ADC Automation drivers.

14. Select the **Supported Audio Modes** tab. (For NEC vcvd Audio driver only) Use this tab to define the new supported intervals of Audio modes. When supported Audio intervals are defined, the driver checks AM2 (Audio Mode 2), and AM4 (audio Mode 4) macros for use with all supported intervals.

- To add a new interval add the newly define audio interval – in hex – in the "New supported interval" field and then click Add. The new interval is added to the list pane.
To delete an interval select the interval in the list pane and click Delete.

15. When finished click **Apply**, then click **OK**.

16. From the Configured Devices window select **File> Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.
For SCTE-104 Macros only

The SCTE driver has 4 pre-defined macros: "START", "START_IMMED", "END", and "END_IMMED". Custom macros can be created as required.

- Each macro sends an appropriate splice_request command at Play step: spliceStart_normal ("START"), spliceStart_immediate ("START_IMMED"), spliceEnd_normal ("END"), spliceEnd_immediate ("END_IMMED").
  All 4 macros have "Auto" reply processing which means that driver waits for reply from device, but doesn’t parse it (any reply is acceptable).

**IMPORTANT:** Don’t modify default macros as internal driver logic is based on their structure and may fail in case of changes! Create new macros if required.

**About Break Duration Macros:** Break duration value is essential only for START and START_IMMED macros. END and END_IMMED macros (and all other possible macros) always send zero break duration.

Currently, SCTE104 macros have special designations for message number, automation index, etc. which are replaced by related values when a command is sent.

A new $BD sign is used for Break duration.

**Note:** $BD sign is present in START and START_IMMED macros by default.
"START" macro:

**Extended Macro Entry**

- **Macro Name**: START
- **Playlist Parameters**
  - Number of parameters: 2
  - TITLE Field format: START:[1][2]

**Command**

- **Command**:
  
  ```
  (FF FF 00 1E 00)$AS$MN$DP(00 00 01 01 00 0E 01)[1][2]$PR(00 00 00 00 00)
  ```

**Reply processing**

- **Reply expected**
  - Automatic reply processing
  - User defined reply: Reply timeout: 40

**Buttons**

- OK
- Cancel
- Apply
- Apply and New
- "START_IMMED" macro

```
Extended Macro Entry

Macro Name
START_IMMED

Playlist Parameters
Number of parameters: 2
TITLE Field format: START_IMMED:[1:2]

Command
(Command

(FF FF 00 1E 00)$AS$MN$DP(00 00 01 01 00 0E 02)[1][2][00 00 00 00 00 00 00 00]

Reply processing

☑ Reply expected

Automatic reply processing

User defined reply

Reply timeout: 40

OK Cancel Apply Apply and New
```
- "END" macro

![Extended Macro Entry](image)

- **Macros Name**: END
- **Playlist Parameters**
  - Number of parameters: 2
  - TITLE Field format: `END:[1][2]`

**Command**

- **Command**: `(FF FF 0E 00)$AS$MN$DP(00 00 01 01 00 0E 03)[1][2]$PR(00 00 00)00`

**Reply processing**

- **Reply expected**
  - Automatic reply processing
  - User defined reply
  - **Reply timeout**: 40
- "END_IMMED" macro

**Extended Macro Entry**

- **Macro Name**: END_IMMED

**Playlist Parameters**

- **Number of parameters**: 2
- **TITLE Field format**: END_IMMED:1;2

**Command**

- **Command**: (FF FF 00 1E 00)$AS$MN$DP(00 00 01 01 00 0E 04)[1][2][00 00 00 00 00 00 00]

- **Reply processing**
  - **Reply expected**: checked
  - **Automatic reply processing**: selected
  - **User defined reply**: not selected
  - **Reply timeout**: 40

- **Field**

<table>
<thead>
<tr>
<th>Field</th>
<th>Size</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserved</td>
<td>2</td>
<td>FF FF (always)</td>
</tr>
<tr>
<td>messageSize</td>
<td>2</td>
<td>00 1E (30)</td>
</tr>
<tr>
<td>protocol_version</td>
<td>1</td>
<td>00 (always 00)</td>
</tr>
<tr>
<td>AS_index</td>
<td>1</td>
<td>$AS (Driver uses AS index from &quot;SCTE 104 Settings&quot; tab)</td>
</tr>
<tr>
<td>message_number</td>
<td>1</td>
<td>$MN (Driver increments this field after each sent command in range 0-255)</td>
</tr>
<tr>
<td>DPI_PID_index</td>
<td>2</td>
<td>$DP (Driver uses DPI_PID index from &quot;SCTE 104 Settings&quot; tab)</td>
</tr>
<tr>
<td>SCTE35_protocol_version</td>
<td>1</td>
<td>00 (always 00)</td>
</tr>
</tbody>
</table>
Field | Size | Command
--- | --- | ---
timestamp() | 1 | 00 (means message is processed immediately)
num_ops | 1 | 01 (number of commands within data field)
data | * | Operation data, see table below

- **Operation data table:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Size</th>
<th>Start</th>
<th>Start_Immed</th>
<th>End</th>
<th>End_Immed</th>
</tr>
</thead>
</table>
opID                 | 2    | 01 01   | (splice_request_data()) |        |           |
| Message Size        | 2    | 00 0E   | (14)        |        |           |
slice_insert_type    | 1    | 1       | (spliceStart _normal) | 2       | (spliceStart _immediate) | 3       | (spliceEnd _normal) | 4       | (spliceEnd _immediate) |
slice_event_id       | 4    |         | Parameter [1] in macro |        |           |        |           |        |           |
| unique_program_id   | 2    |         | Parameter [2] in macro |        |           |
| pre_roll_time       | 2    | $PR     | (Driver uses Splice Preroll from "SCTE 104 Settings" tab) | 00 00  | (00:00:00.00) | $PR (Driver uses Splice Preroll from "SCTE 104 Settings" tab) | 00 00  | (00:00:00.00) |
| break_duration      | 2    | 00 00   | (always 00 00) |        |           |        |           |        |           |
| avail_num           | 1    | 00      | (always 00) |        |           |        |           |        |           |
| avails_expected     | 1    | 00      | (always 00) |        |           |        |           |        |           |
| auto_return_flag    | 1    | 00      | (always 00) |        |           |        |           |        |           |

- **splice_event_id:** Splice event ID is unique ID used to determine whether different messages refer to the same splice. It is used as a macro parameter and is specified in the title of a secondary event.
  For example: START:0001
  The protocol specifies it as 4-bytes size, so it consists of 4 symbols strictly.
  - **List Provided:** If the parameter is provided by the Transmission list, this list-provided value is used instead of the driver-generated one.
  - **Driver Generated:** In the scenario where they are not provided as a parameter on the Transmission List, the driver has the capability to create these IDs and insert them.
    For this situation:
    The splice_event_id is incremented after each pair of Start/End macro commands.
    Start value when the driver is initialized is 0000.
    When 9999 is reached, it starts over from 0000.
    The default of 0000 when it is not provided
    These are used for log troubleshooting purposes, as well as other workflows that require identification of Start/End pairs.

- **unique_program_id:** Program ID is a unique ID, determined by content originator, that identifies the program during which the avail is occurring; zero value can be used. This is a parameter from the event. If not provided, the value of 00 00 is used.
Pre_roll_time: The number of milliseconds until the avail occurs. This value is essential only for spliceStart_normal and spliceEnd_normal commands. (Default: 8000ms).

**SCTE driver initialization**

According to the protocol, the driver sends an initialization command as soon as TCP connection is established.

- Initialization command (init_request_data) and reply to it (init_reponse_data) are in single operation message format.
  - **OpID**: Operation ID
  - **AS_index**: (automation system index)
  - **DPI_PID_index**: (Digital Program Insertion Packet Identifier)

<table>
<thead>
<tr>
<th>Field</th>
<th>Size</th>
<th>Cmd</th>
<th>Description</th>
<th>Reply</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpID</td>
<td>2</td>
<td>00 01</td>
<td>init_request_data()</td>
<td>00 02</td>
<td>init_reponse_data()</td>
</tr>
<tr>
<td>messageSize</td>
<td>2</td>
<td>00 0D</td>
<td>13 bytes length</td>
<td>00 0D</td>
<td>13 bytes length</td>
</tr>
<tr>
<td>result</td>
<td>2</td>
<td>FF FF</td>
<td>always FF FF</td>
<td>00 64</td>
<td>100 – success</td>
</tr>
<tr>
<td>result_extension</td>
<td>2</td>
<td>FF FF</td>
<td>always FF FF</td>
<td>FF FF</td>
<td>always FF FF</td>
</tr>
<tr>
<td>protocol_version</td>
<td>1</td>
<td>00</td>
<td>always 00</td>
<td>00</td>
<td>always 00</td>
</tr>
<tr>
<td>AS_index</td>
<td>1</td>
<td>$AS</td>
<td>Driver uses AS index from &quot;SCTE 104 Settings&quot; tab</td>
<td>$AS</td>
<td>Driver uses AS index from &quot;SCTE 104 Settings&quot; tab</td>
</tr>
<tr>
<td>message_numbe</td>
<td>1</td>
<td>$MN</td>
<td>Driver increments this field</td>
<td>$MN</td>
<td>Driver waits for the same</td>
</tr>
</tbody>
</table>
### SCTE-104 Driver Polling

The SCTE driver sends polling commands at an interval of 60 seconds from last processed command. As USD driver expects frame value of polling interval, 60 seconds are converted to frames depending on current Device Server frame rate.

- Polling command (alive_request_data) and reply to it (alive_reponse_data) are in single operation message format (please refer to protocol and MRD).

<table>
<thead>
<tr>
<th>Field</th>
<th>Size</th>
<th>Cmd</th>
<th>Description</th>
<th>Reply</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpID</td>
<td>2</td>
<td>00 03</td>
<td>alive_request_data()</td>
<td>00 04</td>
<td>alive_reponse_data()</td>
</tr>
<tr>
<td>messageSize</td>
<td>2</td>
<td>00 15</td>
<td>21 bytes length</td>
<td>00 15</td>
<td>21 bytes length</td>
</tr>
</tbody>
</table>
### Field Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Size</th>
<th>Cmd</th>
<th>Description</th>
<th>Reply</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>2</td>
<td>FF FF</td>
<td>always FF FF</td>
<td>00 64</td>
<td>100 – success</td>
</tr>
<tr>
<td>result_extension</td>
<td>2</td>
<td>FF FF</td>
<td>always FF FF</td>
<td>FF FF</td>
<td>always FF FF</td>
</tr>
<tr>
<td>protocol_version</td>
<td>1</td>
<td>00</td>
<td>always 00</td>
<td>00</td>
<td>always 00</td>
</tr>
<tr>
<td>AS_index</td>
<td>1</td>
<td>$AS</td>
<td>Driver uses AS index from &quot;SCTE 104 Settings&quot; tab</td>
<td>$AS</td>
<td>Driver uses AS index from &quot;SCTE 104 Settings&quot; tab</td>
</tr>
<tr>
<td>message_number</td>
<td>1</td>
<td>$MN</td>
<td>Driver increments this field after each sent command in range 0-255</td>
<td>$MN</td>
<td>Driver waits for the same Message Number which was used in last sent command</td>
</tr>
<tr>
<td>DPI_PID_index</td>
<td>2</td>
<td>FF FF</td>
<td>See Note</td>
<td>FF FF</td>
<td>See Note</td>
</tr>
</tbody>
</table>

**Note:** Although DPI_PID_index is specified in "SCTE 104 Settings" tab, driver uses FF FF value for polling command, because it is sent to the entire device, not to a single Channel.

| data           | *    | -              | 00 00 00 00 00 00 00 00 00 | -     | 00 00 00 00 00 00 00 00 00 |

### About System Upgrades

If upgrading Device Server and using previous ini files, SCTE104 driver will load old macro content for START and START_IMMED macros from "ADC100NT.ini" file.

To correct this, either delete SCTE104 driver and configure it again from scratch or manually change macros by copying the following content:

**START macro, "Play step":**

\{FF FF 00 1E 00\}$AS$MN$DP\{00 00 01 01 00 0E 01\}[1][2]$PR$BD\{00 00 00\}

**START_IMMED macro, "Play step":**

\{FF FF 00 1E 00\}$AS$MN$DP\{00 00 01 01 00 0E 02\}[1][2]\{00 00\}$BD\{00 00 00\}

### SCTE-104 GPI Macros

The GPI Macro updates watch trigger Macros for the SCTE104 driver. Now the Timestamp field is filled by 0x03 0xXX 0x00, where 0xXX is GPI number according to S104 event title GPI:01 or GPI:02.
The GPI macro sends an SCTE 104 splice request command, much like the existing START, END, etc. macros, but with different parameters.

The GPI macro has two parameters:

- GPI number
- GPI edge. This parameter can be 0 or 1. It defaults to 0 if the parameter is not specified.

Place these parameters in the timestamp field of the SCTE 104 splice request command.

- Set time_type = 3 to indicate GPI, and then fill in GPI_number and GPI_edge with the parameters from the macro.
- Set the splice_event_id and unique_program_id to 0. The splice_insert_type should be spliceStart_normal (0x01).

In the existing START, END, etc. macros, the timestamp field is set to zero, and splice_event_id and unique_program_id come from macro parameters.

**Reference Note:** See pages 83-84 of the SCTE 104 specification.

**Reference Note:** For more information on using SCTE-104 GPI Macros, reference the SCTE User Note.
For Selenio Macros only:

Macro for the Selenio driver is similar to the usual USD macro except for the macro body syntax and acceptable cards configuration.

- **Acceptable cards**: A Selenio macro can contain OID of a certain parameter which is available for one card type and unavailable for others, this is why it is necessary to define what cards macro is acceptable for. This information is then verified by matching the set of acceptable cards with the type of card found by Card ID field of macro. If the found card type isn't acceptable, secondary event with this macro will be unregistered (red).

  **Example.** Logo1080 macro is acceptable for XD and FS card types (see picture above). In secondary event with this macro user wrote Card ID "Enc001". According to Available Cards information this is Encoder, not XD card. Logo1080 macro can’t be executed for Encoder card, therefore it will be red (unregistered) in Air Client.

- **Macro syntax**: As mentioned above, the Selenio macro can’t be represented as a sequence of bytes/symbols. Therefore it has a special syntax recognized by the Selenio driver.
Currently five sections comprise the macro body: Card ($CARD), OID ($OID), Action ($ACTION), Value ($VALUE) and Value type ($TYPE). The name of each section starts with $ symbol to identify that it is a section, not just text. Section names are not case-sensitive.

User can type a section value right in macro body (such as command entries: OID, Action, Value, Type in the example above) or can assign it with macro parameter (such as AD Card and FS Card in the example above). If assigned, the section will get its value from the title field of the secondary event.

**Note.** Currently it is possible to define only one SNMP command in each macro step (prepare, cue, preroll, play, etc). If it is necessary to send two or more commands simultaneously at one step, user can add several secondary events, each with appropriate macro, to one primary event in Air Client.

**Note: Start OID from digit, not from dot!** Currently there is no verification for this in macro body. If an OID is started with a dot, the SNMP query won’t be executed!

## Sections description:

<table>
<thead>
<tr>
<th>Section</th>
<th>Available values</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>$CARD</td>
<td>Any string value (should match one of available cards IDs)</td>
<td>Represents Card ID. This is important if there are several cards of one type. It’s also important to construct full parameter address which consists of OID and card location (found by Card ID). Sec event will be unregistered if: 1. such Card ID doesn’t exist 2. macro is not acceptable for cards of such type</td>
</tr>
<tr>
<td>$OID</td>
<td>String value representing OID</td>
<td>Represents parameter OID</td>
</tr>
<tr>
<td>$ACTION</td>
<td>Key words $GET $GETNEXT $GETRESPONSE $SET $TRAP</td>
<td>Defines SNMP action. The most important is $SET. Sec event will be unregistered if: 1. Value of $ACTION section doesn’t match any key word. 2. Value of $ACTION section is $SET, but section $VALUE or $TYPE is empty</td>
</tr>
<tr>
<td>$VALUE</td>
<td>Any string value (should represent information of such type as defined in Type section)</td>
<td>Defines new value for $SET action. Can be empty for other actions.</td>
</tr>
<tr>
<td>$TYPE</td>
<td>Key words $INT</td>
<td>Defines type of value for $SET action. Sec event will be unregistered if:</td>
</tr>
<tr>
<td>Section</td>
<td>Available values</td>
<td>Purpose</td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>$STR, $NULL, and others defined later</td>
<td>1. Value doesn’t match any key word.</td>
</tr>
</tbody>
</table>

- **Reply processing**: There are three ways to process replies to macro commands.
  - **Reply isn’t expected**: Selenio driver just sends command to device and doesn’t pay attention to the reply, no matter if reply is received or not.
  - **Automatic reply processing**: Selenio driver sends SNMP command and waits for reply. If any reply is received, the behavior is correct. If no reply is received, Selenio driver supposes that an error occurs and shows appropriate message in Air Client. Type of error depends on macro step (cue, preroll, play, ...).
• **User defined reply.** Selenio driver sends SNMP command and waits for reply. If reply is exactly the same as defined by user, this is correct behavior. In all other cases Selenio driver supposes that an error occurs and shows appropriate message in Air Client. Type of error depends on macro step (cue, preroll, play, ...).

It should be mentioned, that SNMP reply consists of OID and its value. For "user defined reply" Selenio compares user specified string with value from SNMP reply.

In the example above Selenio will reply

1.3.6.1.4.1.290.9.3.3.21.3.1.3360.1.1.6: 1

OID + Card locationValue

The driver takes only Value (1) for comparison with user defined reply. Therefore user should write "1" in the appropriate field of macro window.

**Note.** Automatic reply allows verifying that device really replied and doesn’t require re additional knoledge from user.

- **Default macro set:** Selenio driver provides default macros which are available just after you add Selenio to available devices in Config Tool.
  - Macros Logo1080, Logo525, Logo625, Logo720 correspond to requirement: "Use the Selenio FS/XD logo in the same way as other keyers".
  - Macro SET can be used for requirement: "Based on current/next event text, set related values in the encoder or mux".

<table>
<thead>
<tr>
<th>Macro name</th>
<th>Description</th>
<th>Parameters</th>
<th>Acceptable for cards</th>
<th>Reply processing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo1080</td>
<td>Step &quot;Play&quot; – enable raster 1080 logo</td>
<td>Card ID</td>
<td>XD, FS</td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td>Step &quot;Stop&quot; – disable</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Macro name</td>
<td>Description</td>
<td>Parameters</td>
<td>Acceptable for cards</td>
<td>Reply processing</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------</td>
<td>------------</td>
<td>----------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>raster 1080 logo</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logo525</td>
<td>Step &quot;Play&quot; – enable raster 525 logo</td>
<td>Card ID</td>
<td>XD, FS</td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td>Step &quot;Stop&quot; – disable raster 525 logo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logo625</td>
<td>Step &quot;Play&quot; – enable raster 625 logo</td>
<td>Card ID</td>
<td>XD, FS</td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td>Step &quot;Stop&quot; – disable raster 625 logo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logo720</td>
<td>Step &quot;Play&quot; – enable raster 720 logo</td>
<td>Card ID</td>
<td>XD, FS</td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td>Step &quot;Stop&quot; – disable raster 720 logo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SET</td>
<td>Assignes new value to any parameter on any card</td>
<td>Card ID, OID, Value, Value type</td>
<td>All</td>
<td>Automatic</td>
</tr>
</tbody>
</table>

Barcode Reader Configuration (General)

Barcode readers or barcode wands are used to identify tapes by a barcode label. Generally, they are used in conjunction with cart machines. Barcode readers are shared by all lists, although in special cases they may be assigned to a single list.

The following is an example Barcode Reader configuration. Your Barcode Reader may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.

To Configure a Barcode Reader

1. Under Barcode Readers in the right pane, select a device (e.g. Unitech) and drag-n-drop it to the left pane. For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).

   Once a device has been assigned to a device channel, it may be configured for specific options.

2. In the left pane, select a Barcode Reader device, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the General tab.
Configure the following parameters as required:

- **Device Name**: Enter a name for the VTR to help you identify the VTR during event transmission. The name can have up to 16 characters. The device name has no relation to the ID of any tape inserted in the VTR.

- **Odetics Type Label Length**: Use spin arrows to specify the label length.

4. Select **Serial Port** tab. Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.

5. When finished click **Apply**, then click **OK**.

6. From the Configured Devices window select **File> Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.
VChip Encoder Configuration (General)

The following is an example VChip Encoder device configuration. Your device may have different options and the selection of configuration tabs may be different for that device. If necessary, refer to the User Notes for your device for complete details on how to configure it.

To Configure a VChip Encoder Device

1. Under VCHIP Encoders in the Available pane (right pane), select a device (e.g. Norpak) and drag-n-drop it to the Configured pane (left pane). For details on assigning a device see: To Assign a Device to a Device Channel (see "To Configure GPI Control" on page 50).
   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.

3. Select the General tab.

Configure the following parameters as required:

- **Device Name**: The device name identifies the disk port. Enter the name by using up to 16 characters. When an event is threaded, an extra character - the head number - is added to the end of the name.
  
  This name is used in the ID field of an event that is assigned to the device. The default name can be used or another name assigned, if multiple devices are in the system.

- **ID Match Name**: The ID match name identifies the disk port in secondary events, where the device name is played in the ID field. The default name is the same name you selected as the device name. Enter the name by using up to four characters. When an event is threaded, a fifth character - the head number - is added to the name.
The name is also used to identify the disk port used to execute secondary data events. If a disk port’s name matches the ID of a secondary data event, the event is executed.

- **Run at Preroll**: Check to enable sending play command at preroll. (For Evertz devices this option is typically unchecked.)

4. Select the **Serial Port** tab. Use this tab to connect the driver to the ADC’s serial COM port that the device is physically connected. Click the down arrow button to select from a list of available serial ports.

5. Select the **Communications** tab. As required, configure the following parameters as required: Baud Rate, Data Bits, Stop Bits, and Parity.
6. Select the **Diagnostics** tab. If required, click **Reinitialize** button to reinitialize the device.

![Diagnostics Tab](image)

7. Select the **Regional** tab. Use this tab to set up Rating System, Time Zone, and Day Light Savings.

![Regional Tab](image)

Configure the following parameters as required:
- **Rating System**: From the dropdown select the rating system to be used. The actual codes to be used are dependent on the Country setting of the device.
- **Time Zone**:
  - **Hours / Minutes**: Specify hours and minutes as required for the timezone.
  - **Uses Daylight Savings Time**: Check to enable if daylight savings is used.
  - **Send Time Zone Packets**: Check to enable if time zone packets are sent.

8. When finished click **Apply**, then click **OK**.
9. From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C: \Server" folder on the Device Server.

---

### Database Update Redirector Support

#### Configuration (General)

Database Update Redirectors are software devices that propagate changes to database records to events on lists running on multiple Device Servers.

For Example: If an operator changes the database record for ID 1234 at a Media Client logged into Device Server "A", any instances of ID 1234 on lists running on Device Server "A" is immediately updated with the new information.

- If a Database Update Redirector is **not configured**, any instances of ID 1234 on lists running on Device Servers "B" or "C" (on the same LAN) will not be updated.
- If a Database Update Redirector is **configured** on Device Server "A", changes to database records will update events on lists running on Device Servers "B" and "C" as well.

**Note:** All devices, whether they are media devices, non-media devices or special devices (such as Archives, Proxy FTPs, or Redistributors), must be assigned to a device channel in the Configured Devices window of the Configuration Manager.

The following is an example Database Update Redirector configuration. If necessary, refer to the User Notes for your device for complete configuration details.

#### To Configure Database Update Redirector Support

1. Under **Database Support** in the Available pane (right pane), select a device (e.g. Database Update Redirector) and drag-n-drop it to the Configured pane (left pane). For details on assigning a device see: **To Assign a Device to a Device Channel** (see "To Configure GPI Control" on page 50).  
   Once a device has been assigned to a device channel, it may be configured for specific options.

2. Select the device in the left pane, right-click and from the popup menu select **Properties**. The configuration dialog is displayed for this device. Use the left and right arrows at the upper right to scroll through the other tabs.
3. Select the **General** tab.

![General tab](image)

Configure the following parameters as required:
- **Device Name**: The device name identifies the disk port. Enter the name by using up to 16 characters.

4. When finished click **Apply**, then click **OK**.
5. From the Configured Devices window select **File > Save Devices**. The current configuration is written to the Device Server’s configuration files in the "C:\Server" folder on the Device Server.

---

### Configuring Moxa NPorts and Legacy Serial Ports

Device Server 12.23 and higher support a hybrid environment where both Moxa and the serial cards are supported by adding a form to the Config Tool that allows changing the number of legacy/Moxa ports number forported drivers

**Note**: These settings are available for all drivers that require port connections.

---

### Configure Ports Count

Use the following procedure to configure Port Counts.

1. Launch Config Tool > Configured Devices > View > Ports Count.
2. Ports Count

![Communication Ports ALAZAREVICH](image)

3. Specify as required.
   - Standard Card: Specify Legacy (RS-422) serial ports. (Range: 0-64)
   - Moxa NPort: Specify the moxa terminal server ports. (Range: 0 – ‘Total available Moxa NPorts’). The total number of available Moxa NPorts is determined by the number of Moxa Terminal Servers configured at a site.
     - Device Server can be used with Moxa only after the number of Moxa ports setting is configured
     - Moxa ports have "Moxa" prefix on the port assignment tab of device configuration form

**Review Ports Usage**

Use the following procedure to review Ports Usage.

*Port Usage*

1. Config Tool > Configured Devices > View > Ports Usage
2. Port Usage form. It shows legacy ports with "Serial" prefix and Moxa ports with "Moxa" prefix.

![Port Usage Form]

**Device Driver Configuration**

Use the following procedure when configuring Device Drivers that require port connections.

1. "Driver Name" > Properties
2. Serial Port tab (e.g. Ex.ID Video disk) This form displays the number of Legacy (RS-422) serial ports and Moxa terminal server ports that were configured.

3. Click OK. The Number of ports is saved in ADC1000NT.ini file.

**About Warning Messages**

Warning/Error messages are displayed when the number of ports cannot be changed because some of ports are in use. The user is warned regarding port changes, if:

- The number of ports is about to decrease
- Some of ports that about to be removed are currently used by some device drivers.
In this scenario, the user has to remove serial ports from drivers manually and only then decrease number of ports.

### Configuring AB4 Ports

Versio Device Server 12.22.40 and higher supports a hybrid environment where both AB4 and the serial cards are supported by adding a form to the Config Tool that allows changing the number of legacy/AB4 ports number for ported drivers.

**Note:** These settings are available for all drivers that require port connections.

**Example device config**

To provide a general reference, the following settings are used to support a Panacea router using the AB4 card:

Set "No Port" in Panacea properties

Configured Devices -> Ports Count -> set "Standard Card" = 0 "AB4 Card" = 8

Set required AB4 port in Panacea properties

**Ports Count**

1. Launch Config Tool > Configured Devices > View > Ports Count.
2. Ports Count

![Ports Count Image](image)

3. Specify as required.
   - Standard Card: Specify Legacy (RS-422) serial ports. (Range: 0-64)
   - AB4 Card: Specify the card ports. (Range: 0 – ‘Total available Ports’).

Port Usage

1. Config Tool > Configured Devices > View > Ports Usage
2. Port Usage form. It shows AB4 ports with "AB4" prefix. This is illustrated in the following image.

![Port Usage Image](image)
Device Driver Configuration

1. "Driver Name" > Properties
2. Serial Port tab: (e.g. VTR). This form displays the number of Legacy (RS-422) serial ports and AB4 ports that were configured.

3. Click OK. The Number of ports is saved in ADC1000NT.ini file.

About Warning Messages

Warning/Error messages are displayed when the number of ports cannot be changed because some of ports are in use. The user is warned regarding port changes, if:

- The number of ports is about to decrease
- Some of ports that about to be removed are currently used by some device drivers.
In this scenario, the user has to remove serial ports from drivers manually and only then decrease number of ports.
Configuring Device Assignments

Assigning Devices to Lists

To assign devices to lists for a specific Device Server, perform the following procedures in order presented in this section.

Generally speaking, once a device has been assigned to a list, it cannot be used by any other lists. To use a media device on another list, it must first be un-assigned from the first list.

Devices with multiple output streams may be assigned to several lists simultaneously. A cart machine with four VTRs, assuming that the cart machine is capable of routing the output from each VTR to a different destination simultaneously, may have its VTRs assigned to different lists for different purposes. A video server with multiple decoder ports will generally have each decoder port assigned to a different list.

Stand-alone VTRs may be left un-assigned and used as "floater" VTRs. This makes the VTR available for use by any list. See the Air Client Operator Guide for more information about using "floater" VTRs.

To Start List Configuration

1. From the main menu select **File > List Configurations** OR Right-click on the name of the Device Server and from the pop-up menu select "List Configurations.
2. The List Assignments window is opened.
   - The left pane displays the available lists in your system – your system may not have a full 16 lists available.
   - The right pane displays the configured media devices available for assignment to a list.

![List Assignments Window]

© 2017 Imagine Communications Corp. Proprietary and Confidential.
Main Menu Options

The List Assignments window has a number of drop-down menus available.

File menu

The File menu has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Select to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Properties</td>
<td>Save the current configuration to the Device Server’s configuration files. It has the same action as the Save Devices option in the Configured Devices window’s File menu.</td>
</tr>
<tr>
<td>Save Configuration Locally</td>
<td>Save the Device Server’s configuration files to an alternate location. Only the ADC1000NT.INI and LISTCONF.INI files are saved. This allows you to back up your current configuration on a floppy disk (recommended). Choosing this option will open an Explorer window and allow you to choose where to save the files.</td>
</tr>
<tr>
<td>Print Configuration</td>
<td>Print the Device Server’s configuration files, if you have a printer attached to the client PC (or a network printer configured). <strong>CAUTION:</strong> The configuration files can be quite large! Be sure to have plenty of paper in your printer.</td>
</tr>
<tr>
<td>Unassign</td>
<td>Un-assign the selected device from its list and return it to the Available Media pane. This may be accomplished using the keyboard’s DEL key as well.</td>
</tr>
<tr>
<td>Add Requester</td>
<td>Associate a GMT Requester with a specific device. See chapter 7 of this manual for more details about GMT and Requesters.</td>
</tr>
<tr>
<td>Remove Requester</td>
<td>Remove a GMT Requester from its association with a specific device.</td>
</tr>
<tr>
<td>Properties</td>
<td>Invoke the properties configuration GUI for the selected list.</td>
</tr>
<tr>
<td>Audio Video</td>
<td>Invoke the audio/video routing table configuration GUI for the selected list.</td>
</tr>
<tr>
<td>Preview Audio Video</td>
<td>Preview audio/video routing table configuration GUI. The routing tables configured here apply globally to all devices used by the system.</td>
</tr>
<tr>
<td>Close</td>
<td>Close the List Assignments window.</td>
</tr>
</tbody>
</table>

View menu

The View menu has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Select to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Open a window that displays all of the Device Servers and client applications currently logged into this Device Server.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refresh the display in the List Assignments window.</td>
</tr>
</tbody>
</table>
Help menu

The Help menu has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Select to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Launch the help file.</td>
</tr>
<tr>
<td>About…</td>
<td>Launch a dialog displaying version and copyright information of the currently selected Device Server.</td>
</tr>
</tbody>
</table>

To Assign a Device to a List

1. Select a device in the right pane (Available Media), drag and drop it on to the desired list in the left pane.
   - Once a device has been assigned to a list, that device is exclusive to that list, and cannot be shared by another list.
   - The only exception to this rule is a video disk with multiple streams. Each stream of a video disk can be assigned to a different list, thereby allowing multiple lists to share the same video disk. Example: The record stream could be assigned to a media list, and the playout stream assigned to the play list.

2. Save this assignment: From the List Assignments window main menu select File > Save Properties. This saves the list configurations to the device server’s configuration files.

Assigning a Breakaway Device to a Breakaway List

With the initial implementation of the AirFlex functionality, if ADC AirFlex functionality is enabled and properly set up on your system, Breakaway Lists are visible in the List Assignments window, but are not accessible as no configuration is necessary at this time.
• While Breakaway Lists do not count towards the maximum number of allowed lists, Breakaway Devices do occupy device channels and count towards the 128 device maximum. However, they do not require a serial port and do not count towards the limit of 64. Breakaway Devices require no configuration other than assignment to a Breakaway List.

• In the current implementation of ADC AirFlex, Breakaway devices are the part of Switch Onlys in Config Tool. By default there can be only 30 Switch Only devices which contains Switch Only, Switch Only (Missing) and Breakaway devices. If a customer uses lots of Switch Only devices, they can be limited in use of Breakaway devices.

**IMPORTANT:** Breakaway Lists and Breakaway Devices will not be added to Device Server configurations without prior consultation. Contact Automation Support for assistance.

**Reference Note:** For information on viewing Breakaway lists in the Config Tool List Assignments window, reference section: Configuring List Types > About Breakaway Lists > To View Breakaway Lists in the Config Tool (see "To View Breakaway Lists in the Config Tool" on page 443).

### Add Breakaway Device to a Channel

For each Breakaway List, a Breakaway Device is required. First, a Breakaway Device object must be created for each Breakaway List, then one Breakaway Device assigned to each Breakaway List.

1. From the Config Tool select a Server, then from the main menu select File > Configured Devices.
2. Expand the Switch Only entry in the right pane (Available Media), drag and drop the Breakaway Device to the desired channel in the left pane. The entry BKWAY (breakaway device) is shown in the left pane.

![Configured Devices](image)

3. Repeat, creating a Breakaway Device for each Breakaway List.

**Note:** If a particular Breakaway List is not utilized, a Breakaway Device does not have to be created for it.

### Assign a Switch Only Breakaway Device to a Breakaway List

1. From the Config Tool select a Server, then from the main menu select File > List Configurations.
2. Expand the BKWAY (breakaway device) entry in the right pane (Available Media), then drag and drop a Breakaway Device to the desired channel in the left pane. The entry BKWAY (breakaway device) is shown in the left pane.

3. Repeat, assigning one Breakaway Device to each Breakaway List.

**Note:** If a particular Breakaway List is not utilized, a Breakaway Device does not have to be assigned to it. It is not necessary to assign a Breakaway List to every Breakaway List.

---

## Assigning a Protect Device

Stations that have purchased the Air and Protect option for their Automation system, may wish to assign a Protect device to a list to run in parallel with their primary Air playout device.

- If the automation system detects a failure in the Air device – for example, a tape or video server decoder port fails to cue – the automation system sends a command to your master control switcher to take the Protect device to air and switch away from the (now failed) Air device. The Air device and the Protect device run in parallel, synchronized to frame-accuracy, so the switch is not apparent on air.
- If the Air device fails due to an error not detectable by the automation system, such as a tape head clog or simply bad audio or video, operators may manually switch to the Protect device using a button on either the Air Client’s software or hardware control panels.

It is recommended that Air and Protect only be used with devices of a similar type. A cart machine may protect another cart machine, or a decoder port on one video server may protect a decoder port on another video server. A video server with multiple decoder ports sharing a common storage array may have decoders on the same device protecting one another, but is recommended that the Air decoder and Protect decoder be on separate I/O nodes.

**Note:** Both the Air and Protect devices must have exactly the same media available in storage.

## To Assign a Protect Device to a List

1. Select the Protect device from the right pane.
2. Drag and drop it on the Air device in the left pane.
   - Take care not to drop it on the list. This will assign this device to the list as a Protect device for the Air device.
List Assignments CHP-20

Configuring a GPI Trigger

Devices that cannot be controlled through a serial or Ethernet interface may be controlled using a General Purpose Interface (GPI) trigger. A GPI is a relay contact closure that provides either a high-to-low or a low-to-high transition to trigger devices that accept this type of control. A single Device Server can support up to 32 contact closures (four GPI cards), although the standard Device Server configuration includes two GPI cards. Additional GPI cards may be purchased separately.

GPI triggers are configured in the Configuration Manager Tool as Switch-Only devices.

**IMPORTANT RECOMMENDATION**: Wait at least one minute before applying power to the Device Server CHP after a shut-down. This allows sufficient time for the capacitor or capacitors to discharge, at which point the circuitry is inactive on restart, and prevents transient functions, such as GPI firing.

**To Configure a GPI Trigger**

1. After assigning a Switch-Only device to a device channel, double-click the entry in the Configured pane (Left pane) to open the configuration GUI.
2. Select the **General** tab. On this tab enter names for any Switch-Only GPI triggers being used. Up to eight GPI triggers may be configured for a Switch-Only device. While the names may use anything you want, these names are the IDs that must appear in the Transmission list to trigger the GPI.

![Switch Only Names](image)

3. Select the **GPI Sheet** tab.

![GPI Sheet](image)
Configure the following entries as required:

- **GPI Card**: Select which of the Device Server’s GPI cards contains the relay contact you wish to associate with this Switch-Only device.
- **Contact Number**: Select which of the eight contacts (bits) on the selected GPI card you wish to associate with this Switch-Only device.
- **Pulse Width**: For Primary GPI events, specify the length of the contact closure (in frames). See the Air Client Operator Guide for an explanation of Primary and Secondary GPI events.
- **Pulse Offset**: For Primary GPI events, specify any back-timed offset from the zero crossing for this contact closure (in frames). With a zero offset configured, Primary GPI events will trigger at the list pre-roll time.
- **Switch Only**: In this drop-down box, select which of the eight Switch-Only device media heads you wish to associate with the GPI trigger. The eight media heads correspond to the eight names configured on the General tab.

**Note**: Refer to the device manufacturer’s manual for information regarding GPI triggering requirements.

4. When finished click **Apply**, then click **OK**.
Configuring List Types

About Play lists and the Traffic Translator

Play list files are created from the traffic department’s daily programming log by processing them through the Traffic Translator software application (WinCMMS.exe). The rules that the Traffic Translator uses to parse the traffic log are customized to your specific requirements.

The traffic translator application is typically installed on the File Server, a seldom-used client PC, or may be installed and run on a PC in the traffic department. The input and output folders for the Traffic Translator are specified in the command line for the application. There are several other options that may be specified there as well. The command line for the Traffic Translator should be in the following format:

C:\WINCMMS\WinCMMS.exe <input directory/[input file]> or <input directory/[default extension]>
<output directory>
[-axy]
[<done directory>]

Where,

- <input directory>: Points to the default input directory (folder) where the traffic logs are located.
  - This may be accompanied by a [input file] name. This is useful when calling the translator from another application. The translator closes itself after the file is converted.
  - The input directory may also be accompanied by a [default extension] in "*.xxx" format.
- <output directory>: Points to the default output directory where the output play list file will be saved.
- [<done directory>]: Points to the directory where traffic logs will be moved after they have been translated. This option may be used in conjunction with the –a or –x switch.
- -a: Allows the application to run in Automatic Mode. The Traffic Translator will run minimized, converting all the files located in the <input directory>. After each log is translated, it is moved to the <done directory>. If there is no <done directory> specified, the traffic log will be moved to the <output directory>. The Traffic Translator will remain running in the background as a service (minimized in the Windows system tray) and translate any new files downloaded to the <input directory>. This switch should not to be used in conjunction with the –x switch.
- -x: Allows the application to run in Batch Mode. The Traffic Translator will convert all the files located in the <input directory>. It closes itself after the last file is converted. This switch should not to be used in conjunction with the –a switch.
- -y: Allows the translator to run without a prompt. The Traffic Translator will overwrite the output file, if it exists. This switch may be used in conjunction with the –a or –x switch.
Examples:

C:\WINCMMS\WinCMMS.exe A:\ E:\Playlist

This example will translate traffic logs on a floppy disk and place the translated play lists in the "E:\Playlist" folder. This option will require manual selection of the traffic log to be translated.

C:\WINCMMS\WinCMMS.exe E:\Traffic\today.txt E:\Playlist –γ

This example will translate a file named "today.txt" in the "E:\Traffic" folder and place the translated play list file in the "E:\Playlist" folder. It will overwrite any existing play lists without prompting the user.

C:\WINCMMS\WinCMMS.exe E:\Traffic\*.scd E:\Playlist –xy

This example will automatically translate any traffic logs with an "scd" extension in the "E:\Traffic" folder and place the translated play list files in the "E:\Playlist" folder. It will overwrite any existing play lists without prompting the user. The application will close after the last file has been translated.

C:\WINCMMS\WinCMMS.exe E:\Traffic E:\Playlist -ay E:\Traffic\done

This example will automatically translate any files that appear in the "E:\Traffic" folder and place the translated play list files in the "E:\Playlist" folder. It will overwrite any existing play lists without prompting the user. It will also move the original traffic log from the "E:\Traffic" folder to the "E:\Traffic\done" folder once it has been translated. The application will remain running (as a service, minimized in the Windows system tray) waiting for new traffic logs to appear in the "E:\Traffic" folder.

Depending on the custom features of your Traffic Translator, it may also be used to translate As-Run logs back into traffic reconciliation logs, combine As-Run and traffic logs for reconciliation, translate multiple traffic logs simultaneously for different Transmission lists. See your automation project manager for more information about the Traffic Translator.

About List Configuration

The automation server creates lists in the following order:

- Transmission Lists (Playlists) and record lists.
- Media Lists
- GMT Lists
- Compile Lists (see "Configuring Compile List Options" on page 426)

In the Configuration program the List Assignments window displays the list type next to the list name.

When a new list is added to the server configuration this can change the order of the lists. If a server originally had two playlists (lists one and two) and two media lists (lists three and four), then when a new playlist is added then list three now becomes a playlist and list five is the new media list.

When this new server is started the configuration data in the INI file is read in based on the old configuration. This means that the configuration data for the first media list (list three) is now being
used by the new list three, which is a playlist. This often created confusion for the users of the system as well as some on-air problems.

When installing a new version of the server with additional lists the user must always check the configuration. To ease the migration path and prevent some (but not all) configuration related issues:

- The lists when reading the configuration will make sure that what is read for the INI file is appropriate for the target list type being configured.
- Where possible the list will make sure setting options from the INI file that don’t apply to the list type will be corrected.

### Configuring Transmission List Options

Once a play list file has been translated from the traffic log, it may be loaded, pasted or appended into a Transmission window where it then becomes a Transmission List. A Transmission List is the main sequential list used by the Device Server to control the playout of media.

Transmission Lists are composed of primary and secondary events. Primary events may play out media from a physical media device, or may switch a crosspoint on a router or switcher using a Switch-Only device. Secondary events are "attached to" or associated with primary events to perform additional activities on the Transmission List. For example, a primary event may be playing out a clip from a video server’s decoder port while an attached secondary event, at some point during the primary event, may recall a page on a downstream keyer and key a graphic over the primary playout stream. Each primary event on a Transmission List plays out sequentially. When the full duration of a primary event has been reached, the next event will roll automatically. Operators may manually roll events before their full duration has been reached by using the Air Client’s control panel.

### Event Registration

When events are placed within the lookahead (see below) of a Transmission list, they are registered with the media devices assigned to that list. The system will query the storage collections of the devices, in the order of their assignment to device channels, and the first device that responds that it has the ID in its storage will register that event. This is indicated on the Transmission list by the event turning blue. If there are media heads available, the event will be threaded and cued. If there are no media devices assigned to the list that have the ID in their storage collections, the event will remain red on the Transmission list. The event will remain unregistered until a media device informs the system that the ID has been added to its storage collection.

Media devices are checked for media availability only under certain circumstances. Events are checked only when:

- A new event is inserted into the lookahead
- A new event enters the lookahead because another event has been deleted
- A "done" event is cleared within the lookahead
- The lookahead value is increased, and new events enter the lookahead
- The list "packs" – done events are removed from the top of the list and new events enter the lookahead
• An unregistered event is modified and the media is now available

Events are unregistered from devices only when:
• An event is deleted from the Transmission list
• A registered event is modified and the media is no longer available
• An event is marked "done"
• The lookahead is shortened, and previously registered events are now outside the lookahead
• An event is inserted into the lookahead, and previously registered events are now pushed outside the lookahead

Media devices inform the system when their storage collections have changed – when IDs have been either added or deleted. If a device informs the system that an ID has been added to its storage collection, lists that are assigned a media head of that device are rechecked to see if that ID is within the lookahead. If it is, then the event will be registered with that device. Pending record events (if the Transmission list is being used as a record list) will be rechecked to see if they should now be unregistered.

If a device informs the system that an ID has been removed from its storage collection, events registered with media heads of that device are re-checked to determine if the events should be unregistered. Pending unregistered record events are also rechecked to determine if they may now be registered.

In short, playout events will register with a media device if the ID exists within the device’s storage collection. Record events will register with a record device if the ID does not exist within the record device’s storage collection.

The Lookahead

The lookahead value, which may be configured in the list options configuration GUI (see below), represents the number of events at the top of the Transmission list that are checked for media availability. The lookahead may be a fixed number of events (default 50), or it may be a fixed time value based on the durations of the events. Events on the Transmission list beyond the lookahead are not checked and are not registered with devices.

• After events have run, they become part of the done count. The done count is a fixed number of "done" events held at the top of the Transmission list. The done count is configurable and may be set to a value between 1 and the lookahead value minus 1.
• As the Transmission list runs, the list "packs". Events at the top of the Transmission list's done count are removed and all remaining events on the list move up. Events just beyond the lookahead move up into the lookahead and are registered if possible.
• A duration-based lookahead, instead of looking ahead a fixed number of events, looks ahead a specified time value. The system will sum all of the event durations and keep an equivalent number of events in the lookahead. The actual number of events in the lookahead will vary, depending on the durations of events on the list.
Record Lists and GMT Push Lists

Transmission lists may be used for purposes other than playing out to air. Transmission lists may be used as Record lists for automated recording. A Record list is simply a Transmission list with record devices assigned to it. Record events are placed on the Record list either by manually entering them, by translating a record list provided by traffic with the Traffic Translator application (if so customized), or through the use of an automated recording client application like AutoSat.

Record events are timed events. They will roll at the time-of-day specified in the list’s Time column. Record lists have all the behaviors of a Transmission list with regard to event registration, A/V routing, threading, cueing and rolling events.

**Note:** For more information about creating and managing Record lists, reference the "Air Client Installation and Operations Reference".

Transmission lists may also be used as GMT Push lists. A Push list’s purpose is to move media from wherever it exists within the system to where it needs to be to play out ahead of time. Events may be placed on a Push list to populate a playout video server with media needed for tomorrow’s play list.

**Note:** For more information about GMT Push Lists see Global Media Transfer (on page 453).

To Configure Transmission List Options

A number of options may configured to control the behavior of Transmission Lists. These options are accessed from the Configuration Manager’s List Assignments window.

1. To access the Transmission List options configuration GUI, select a Transmission List (PlayList) in the Lists pane.

2. **Right-click** on the entry and then from the pop-up menu select **Properties**. The Configuration window opens with multiple tab selections. The options configured on these tabs apply to this list only. Configuration options for other lists must be configured separately.
3. Select the **Parameters** tab. This tab contains general configuration options for Transmission Lists. Some options are commonly used and enabled by default.

Configure the following options as required:

- **Name**: Enter a name for this List. List names are limited to 32 characters.

- **Options**:
  
  - **Auto Restart When Cued**: (Default: disabled) When enabled, this option causes events to automatically restart, without manual intervention, if the media has been recued. When this option is disabled, the automation system marks the event as missing and does not automatically cue the event when located.
  
  - **Recue On Media Changes**: (Default: enabled) When enabled, this option causes events to automatically recue if the event’s SOM (start-of-message time), DUR (duration), or New AFD is changed.

  **Note**: The ID Video ARC is reapplied if the event’s New AFD value is changed while the event is CUED.

  - **Rewind Compile Material**: (Default: disabled) When enabled, this option causes compile tapes to rewind to the head of the first spot when finished. The tape is rewound to the first commercial break (or "pod") minus the preroll.

  - **Rewind to First Program Segment**: (Default: enabled) When enabled, this option causes multi-segment programs played out from a VTR or cart machine to rewind to the head of the first program segment when finished. The tape is rewound to the SOM of the first segment minus the preroll.

  - **Update Cued Event on Media Change**: When this parameter is enabled (checked), all of the database derived metadata for any cued events is updated.

    - If ‘Recue on Media Changes’ parameter is enabled, then this parameter is also enabled.
If this parameter is enabled, but the ‘Recue on Media Change’ parameter is disabled, then although the event is updated, the device is not recued or otherwise updated.

**CAUTION:** This configuration scenario can cause unanticipated or invalid behaviors, such as the device and device driver’s head data to get out of sync. To avoid this ensure ‘Recue on Media Changes is also set.

- If this parameter is disabled, ‘Recue on Media Changes’ must also be disabled and no updates will be applied to cued events.
- If Auto Ripple is enabled, the start time of the event following the an updated event is also updated.

- **Update Playing Event on Media Change:** When this parameter is enabled (checked), the system partially updates the metadata of an event that is playing at the time of an update. **The device cannot be recued and the SOM of the event is not updated.**
  - If this parameter is enabled, then ‘Update Cued Event on Media Change’ must also be enabled.
  - If this parameter is enabled, the remaining duration of the event is recalculated on an update. Since the duration of an event decrements while it is playing, the duration is changed by an amount equal to the difference between the original duration and the updated duration.

**WARNING:** If the device is not updated- as in the case of a cued event because Recue on Media Changes is disabled, or in all cases for playing events- and the updated duration is longer than the duration used to initially cue the device, the device may cease playout at the end of the original duration, even if the event is updated. This typically causes a TapeEnd error and the list skips forward to the next event.

- **Block Recue Following an Upcount:** Enable (check) this option for the recue behavior to never allow recue following an upcount event. (See also ‘Always Allow Recue Following an Upcount’.)

**IMPORTANT:** While the configuration options **Always Allow Recue Following an Upcount** and **Block Recue Following an Upcount** are currently shown as available for Media List, GMT List, and Compile List types, they are not recommended for use with these lists.

**Note:** If both ‘Block Recue Following an Upcount’ or ‘Always Allow Recue Following an Upcount’ are DISABLED (unchecked), the recue behavior uses the upcount event’s reported duration to determine the downcount threshold after which the recue command will not be sent. This is illustrated in the following graphic:

![Diagram](image)

**Requirements for the setting of both options disabled:** The following List Option Parameter tab settings must also be set for this configuration setting:
- Enable Recue On Media Changes: Check to enable.
- "Update Cue Event on Media Change: Check to enable.
- The AO Event Thread Time must also be set and this parameter is used to determine the threshold mentioned above. (Note: The total time calculated = AO Event Thread Time: Cue Seconds + AO Event Thread Time: Cue Frames + Time Parameters: Preroll Seconds + Time Parameters: Preroll Frames + Time Parameters: Postroll Seconds + Time Parameters: Postroll Frames)

- **Always Allow Recue Following an Upcount**: Enable (check) this option for the recue behavior to always allow recue following an upcount event. (See also ‘Block Recue Following an Upcount’.)

**IMPORTANT**: While the configuration options **Always Allow Recue Following an Upcount** and **Block Recue Following an Upcount** are currently shown as available for Media List, GMT List, and Compile List types, they are not recommended for use with these lists.

**Requirements for this Setting**: The following List Option Parameter tab settings must also be set for this configuration setting:
- Enable Recue On Media Changes: Check to enable.
- "Update Cue Event on Media Change: Check to enable.

**Note**: If both ‘Block Recue Following an Upcount’ or ‘Always Allow Recue Following an Upcount’ are DISABLED (unchecked), the recue behavior uses the upcount event’s reported duration to determine the downcount threshold after which the recue command will not be sent. This is illustrated in the following graphic:

![Diagram of recue behavior](attachment://recue_behavior.png)

**Requirements for this Setting** (i.e. both options disabled): The following List Option Parameter tab settings must also be set for this configuration setting:
- Enable Recue On Media Changes: Check to enable.
- "Update Cue Event on Media Change: Check to enable.
- The AO Event Thread Time must also be set and this parameter is used to determine the threshold mentioned above. (Note: The total time calculated = AO Event Thread Time: Cue Seconds + AO Event Thread Time: Cue Frames + Time Parameters: Preroll Seconds + Time Parameters: Preroll Frames + Time Parameters: Postroll Seconds + Time Parameters: Postroll Frames)

- **Extended Time To Next**: (Default: enabled) When enabled, this option enhances the functionality of the time-to-next feature of the Transmission List. Time-to-next values are calculated correctly regardless of whether there is an intervening upcount event. Enhanced Functionality includes:
When the termination event is an O (hard start) event the Time To Next display includes the running short value.

Zero duration up counters do not stop the rippling.

When in an up counter, if an O event exists as the termination event, the Time Toext computation computes without any long or short value. It displays exactly how long until the hard timed start begins.

- **Release Tension On Record**: (Default: disabled) When enabled, this option, if VTRs or cart machines are assigned to this list as record devices, causes the VTR or cart machine to release tension on the tape when the record event has cued. The tape is re-tensioned at the "standby on" time (see below).

- **Rewind Spots**: (Default: enabled) When enabled, this option causes single-spot tapes played out from a VTR or cart machine to rewind to the head of the spot when finished. The tape is rewound to the SOM minus the preroll (on a multi-spot tape, the tape is rewound to the SOM minus the preroll of the last spot played).

- **Thread Limited**: (Default: disabled) When enabled, this option changes the cueing behavior of the Transmission List. Events are cued within the specified "thread time", taking into account the duration of events registered with the same media device that cannot be threaded due to a lack of available media heads. This means non-threaded but blue (registered) events count toward the total thread time as if they were threaded.

- **Time Parameters**: These options specify time values for this list.
  - **Preroll Seconds**: Define the number of preroll seconds to be used for the selected list. The valid range is 0-59 seconds. Default is 3 seconds.
  - **Preroll Frames**: Define the number of preroll frames to be used for the selected list. The valid range is 0-29 frames. Default is 0.

  All events on this list will preroll for the time (Seconds/Frames) specified here before switching. The list preroll should equal the preroll time required by the slowest device assigned to the list. For example, if a VTR assigned to this list takes 4 seconds to lock up, the list preroll should be no less than 4 seconds.

  **Note**: If a list preroll of less than 3 seconds is used, VTRs assigned to this list will not perform a tape speed override (TSO) when they roll.

Frame-accurate playout from tape cannot be guaranteed if a list preroll of less than 3 seconds is configured. Operators may manually override the list preroll by using the Roll Now button on the control panel. Only events registered with Switch-Only devices or video server decoder ports (if they are configured to support "instant prerolls") may be rolled using the Roll Now button.

- **Postroll Seconds**: Define a length of time, in seconds, the automation system plays the current event beyond its duration if it has not yet switched to the next event. The valid range is 0-59 seconds. Default is 1 second.

- **Postroll Frames**: Define a length of time, in frames, the automation system plays the current event beyond its duration if it has not yet switched to the next event. The valid range is 0-29 frames. Default is 0.

  All events on this list will postroll for the time (Seconds/Frames) specified here after their duration has expired. Events registered with video server decoder ports, if the port has been configured to support a "device postroll", may allow shorter postrolls that the list postroll.
• **StandbyOn Seconds**: This value determines when "standby on" commands are sent to VTRs by specifying the amount of time the automation system keeps the VTR in tension after cueing an event. The valid range is 10-59 seconds. Default is 30 seconds.

If a VTR assigned to this list is configured to perform a "standby off" when a tape has cued - spinning down the video heads and releasing tension on the tape - the tape will be re-tensioned and recued at the "standby on" time.

• **AO Event**: Hard start event (AO)

• **AO Event Thread Time**: Specify the following thread times:
  - **Cue Seconds**: Specify cue time seconds for the AO event.
  - **Cue Frames**: Specify cue time frames for the AO event.

• **Thrd AO evnt at last moment**: Check to enable threading of the AO event at the last moment.

  Checked: (Recommended): If another event occupies the same disk head, thread the disk hard start event when the current time is closer to its On Air time than AO Event Thread Time. Checking this box gives the maximum tolerance for the list events that in front of the AO events to do playout, and also allows the AO event to successfully register to a disk head to play on time.

  Unchecked: Thread disk hard start event based on thread time. If the disk head is occupied by another event, that event will be ejected.

• **Only Thread Next AO Event**: Enable / Disable threading of the next event. If multiple Hard-Start (AO) events are within the transmission list lookahead Window:

  Checked: Only thread the next Hard Start event without continuously rippling down to reach next AO event on the same list. Since playlist events often are without On-Air date information, this prevents the next day’s AO event (showing later in sequence on the playlist, but with an on-air time earlier than the today’s) being Cued first.

  Unchecked: if there are more than one AO event in the future, list will find the earliest timed one as the next AO event to start regardless its position in the list.

**Recommendation**: Uncheck only when there is a necessary for set AO event out of order.

4. Select the **Options** tab. This tab contains optional configuration settings for Transmission lists.
Note: All of the options on this tab may be configured in the Air Client application.

Enable (check)/ Disable (uncheck) and configure the following as required:

- **Options:**
  - **Auto A-B Routing:** (Default: disabled) Enabling this option causes devices to alternate between their primary and secondary audio/video routing paths as configured in this list’s A/V routing table (see below).
    When enabled this setting overrides an event’s channel settings (displayed in Transmission window’s CH column in Air Client). During transmission, successive primary events are routed alternatively through switching channels A and B. This function is useful to ensure that two successive events are not played through the same channel (which is needed when transition effects such as mixes are defined between events). Make sure both A and B channel A/V parameters are configured in all devices that are used.
    **Note:** When changing this configuration, existing events on the list, and in particular previously executed events recovered with 'Clear Done Events', may exhibit the previously configured switching behavior.

  - **Auto Ripple Times:** (Default: disabled) Enabling this option causes the time-of-day for events to update automatically, reflecting any changes to event durations made manually. The time "rippling" ends at hard start events. The calculation assumes that the Duration field for up-counting events is accurately set.

  - **Contact Start:** (Default: disabled) Enabling this option allows this list to be rolled via an external GPI contact-closure trigger. The GPI trigger duplicates the function of the Play button on the control panel.

  - **Play ID Title Mismatches:** (Default: disabled) This option only applies to systems that include a Sony LMS cart machine. The LMS will not register events if the ID and title on the tapes’ barcode labels do not match the ID and title of the events as they appear on the Transmission list. Enabling this option allows the LMS to register mismatched events.
Keep List Threaded: (Default: disabled) Enabling this option causes the Transmission list to thread and cue as many events as possible within the lookahead. If an event is inserted into the list to be played, the event is immediately cued and subsequent events unthreaded as necessary.

When enabled, thread time is not used. This option supersedes the Thread Time.
When disabled, the list only keeps events threaded within the Thread Time window (see below).

Logomotion Note: To ensure all available heads thread normally, enable ‘Keep List Threaded’.

Only Swap One Event in A-P: Enable / disable air protect switching for an event.
In an Air/Protect configuration, the playlist will play out an event simultaneously from both Air an Protect servers. If the Air Server has a failure or malfunction, the playout server switches event playout to the Protect server and stays there. In many situations, event interruption is only caused by one media, not the entire playout server or port. In this situation, some customers want the playlist to switch back to the previous Air server instead of keeping playout with the Protect server. Checking this option box will

Checked: Tells the playlist to switch back to the Air Server for normal playout, on conclusion
of this trouble event.
Unchecked: Treat Air and Protect disk equally, assign air or protect disk port to Air column whichever is ready first.

Recommendation: Uncheck when the disk port is the additional port of another video disk.

Play Hard Hits: (Default: disabled) Enabling this option allows an operator to manually override the start time of "hard start" or "hard hit time" events (timed events).

When disabled, "hard start" events only roll at the time specified in the Transmission list's Time column.

Release Tension When Cued: (Default: disabled) Enabling this option causes the system to send a "standby off" command to any VTRs when they have cued a tape. The tape is re-tensioned at the standby on time.

Skip Bad Events: (Default: enabled) When enabled this option the Transmission list to ignore and skip a single unregistered (bad) event. The list will continue playing out and mark the bad event as "missed".

When disabled, the Transmission list stops upon encountering any unregistered event and must be restarted manually.

Note: The Transmission list always stops upon encountering two or more consecutive bad events, whether this option is enabled or not.

Station ID On Skip: (Default: disabled) Enabling this option causes the switcher to switch to the Station ID source (configured in the master control switcher's configuration GUI) for the duration of the list preroll when an operator has manually skipped an event using the Skip button on the control panel.

Switch To Black: (Default: enabled) When enabled this option causes the master control switcher to take the Black source if the list stops. The Black source must be configured in the master control switcher's configuration GUI for this to occur.

When disabled (or the Black source not configured), the switcher will remain on the last source taken if the list stops.
- **Tension After Up Counter:** (Default: disabled) Enabling this option causes tape events following an upcount event to remain tensioned. Since the duration of upcount events is, by definition, indeterminate, there may not be time to re-tension a tape if an upcount event ends abruptly. This option allows events from tape to remain ready to roll immediately.

- **Thread After Break:** (Default: enabled) When enabled this option keeps the list threaded while the list has stopped due to encountering a Break event on the list. Break events are secondary events inserted in the list to cause the list to stop temporarily and wait for a Play command from either the control panel or an external GPI trigger.

- **Timed List:** (Default: enabled) When enabled this option allows the list to roll timed events – hard start or record events – at the time of day specified in the Transmission list’s Time column.
  
  When disabled, timed events will not roll.

- **Update On Air Time:** (Default: disabled) Enabling this option causes the on-air time for events to update to the actual time the event rolled. As-Run logs for the list are updated as well.
  
  When disabled, the As-Run logs reflect the time-of-day that appeared on the Transmission list, rather than the actual time the event rolled.

- **Update Final Upcount Durations:** Check to enable update of the final upcount event duration. This gives an actual duration of how long an event ran.

  An upcount event type(U) is used for an event of unknown duration, such as a sporting event or any other live broadcast. During playout, the event’s duration will count down to 00:00:00:00 and then will count back up.

  This repeats until terminated by either pressing Play or Skip on the control panel or a contact start is reached. The next event will play normally. Up counters only work on events played from Switch Only devices.

- **Done Count:** This value sets the number of "done" events that will be displayed at the top of the Transmission list. The Done Count may be set to any value between 1 and the lookahead value minus 1. Default is 4 events.

  **Note:** Never set the Done Count to a value equal to or greater than the lookahead value. Doing so causes the list to eventually run out of valid, registered events and stop.

- **Thread Time:** This time value determines the time "window" following the on-air event in which events will be threaded. The valid range is from 0 to 23:59:59:29 (23 hours, 59 minutes, 59 seconds, and 29 frames). Default is 2 minutes.

  - Any events within the Thread Time are threaded and cued.
  - If the list option "Keep List Threaded" is enabled, this value is ignored.

**IMPORTANT ICONSTATION XML VERSION NOTE:** The Transmission List Option: Thread Time value controls the length of back-time events on the Iconstation XML. For example, if the Thread Time is set to 2 minutes the max back-time value is also two minutes.

- **Match Primary Duration PT=EOM offset.** This option provides the ability to define an offset time (HH:MM:SS:FF) for the end point of a secondary event PT=, which should end with respect to the primary event. (i.e. The value of EOM offset is used for all PT= secondary events attached to the primary.)

  - This parameter affects the timing of every secondary event that uses the "=" modifier.
  - When defined the offset should be less than list preroll time.
• **Zero Upcount Durations**: Enable (check)/Disable (uncheck) the ability to zero the initial duration of upcount events
  - If Enabled (checked), the duration of Upcount event will setup to zero automatically before the event starts. The list will be rippled and timed as with estimated duration of this event.
  - If Disabled (unchecked), the behavior of the list will be as normal - upcount events would decrement from whatever duration is scheduled and then upcount from zero.

5. Select the **Lookahead** tab. This tab contains the configuration options for this Transmission list’s lookahead.

Configure the following options as required:

• **Duration Based Lookahead**: Enabling this option causes the Transmission list to keep a varying number of events in the lookahead, based on the sum of the durations of events on the list. A duration-based lookahead ignores the on-air event and Done Count, and calculates the lookahead from the sum of the durations of events following the on-air event.

The time values immediately below the checkbox (Hours, Minutes) specify the amount of time for the list to look ahead.

  - **Hours**: (Default: 4 hours) (Range: 0 to 23 hours) Specify a time duration, in hours, for the lookahead window to check. This option has no effect unless the Duration Based Lookahead box is enabled.
  - **Minutes**: (Default: 0) (Range: 0 to 59 minutes) Specify a time duration, in minutes, for the lookahead window to check. This option has no effect unless the Duration Based Lookahead box is enabled.
- **Count Lookahead:** (Default: 50 events.) If the Duration Based Lookahead checkbox is unchecked, the Transmission list will use a count-based (or event-based) lookahead. The list looks ahead a fixed number of events from the top of the list. This lookahead value includes the on-air event and the Done Count.
  - This value may be configured in the Air Client application also.

- **Duration Based Lookahead Toggle:** Enabling a duration-based lookahead allows an operator to toggle the lookahead value to either an alternate time value, or to include the all events on the Transmission list in the lookahead. An operator can select Toggle Lookahead from the Air Client’s popup menu (or hitting F8) to toggle the lookahead to its alternate value.
  - **Enable Toggle Lookahead checkbox:** (Default: disabled) Check to enable the duration-based lookahead toggle. This setting has no effect unless the Duration Based Lookahead box is enabled (above).
  - **Toggle To Full List:** Select to include all events in the Transmission list within the lookahead. Selecting this option causes the F8 key to toggle between the Duration Based Lookahead setting and the full list.
  - **Toggle To Alternate Time:** Select to enable the alternate time value configured here (Toggle Hours, Toggle Minutes). Selecting this option causes the F8 key to toggle between the Duration Based Lookahead setting and the alternate time set in the Toggle Hours and Toggle Minutes box to the right.
  - **Toggle Hours:** (Default: 4 hours) (Range: 0 to 23 hours) Set an alternate time for toggling back and forth from the default setting chosen above.
    An operator can use the F8 key to toggle back and forth between the default time setting and the alternate time chosen here.
  - **Toggle Minutes:** (Default: 0) (Range: 0 to 59 minutes) Set an alternate time for toggling back and forth from the default setting chosen above.
    An operator can use the F8 key to toggle back and forth between the default time setting and the alternate time chosen here.

- **Report Missing Media:**
  - **Report Missing Media Within LookAhead:** Enable (check) this option to allow sending missing media error message out on Automation LAN. If there an ADC SNMP-Agent client is running on the Automation LAN, it will detect these error messages, and forward them to remote SNMP Manager program for remote monitoring of playlist missing media alerts.
  - **Report GMT Requested Media:** (Active when ‘Report Missing Media Within LookAhead’ is selected.) If the Missing media is currently requested through ADC GMT system, enable (check) this box to allow the missing media error message to be correctly reported to the remote SNMP Manager program through ADC SNMP-Agent program.

6. Select the **Events to Log** tab. This tab contains configuration options for the As-Run logs created by the Air Client application.
  - By default, not all secondary event types are logged to the As-Run log. Checking the appropriate checkbox on this tab will enable logging of that secondary event type.
If this Transmission list is to be used as a record list and you require a log of what has been recorded, an As-Run log may be created that includes primary record events. Check the Log Record Events checkbox to enable this.

Secondary Events to Log:
Enable (check)/ Disable (uncheck) the secondary events to log in the As-run log. When all check-boxes are selected (checked), all secondary events associated with a primary are included in the As-Run log.

For Example: BREAK is disabled and others are enabled – all secondary events except BREAK secondary event are included in the As-run log.

Log Record Events: (Default: disabled) Check to enable logging of record events on normal completion.

7. Select the Mix/Wipe tab. This tab contains configuration options to play mix/wipes early. This allows dissolves (mixes) or wipes to be done between the source that is currently on-air and the next source. Events that include a mix or wipe transition are required to roll several frames early to allow the events to overlap.

Typical uses are to dissolve between VTRs inside an LMS, or when going from a station promo to a station ID. These promos and Station IDs always have extended vision on the videotape, i.e. the actual vision on the videotape have a longer duration, than what is shown in the Database.

About Extended Play Mix/Wipes Early:
These options allow playlist timing to be maintained by playing an event with a transition for an extended duration, so that it finishes at its scheduled time, leaving the list timing unchanged. The event is played early to provide overlap for the transition, but compensates for the changed
playlist time by playing the event for an extended time, which is equal to the mix or wipe transition duration.

The Extended Modes are only available when "Play Mix/wipes early" is enabled and "Enable Mode Selection" is checked.

**Note:** "Auto-Ripple List" must be enabled to maintain the playlist's timing.

### List Options

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Options</th>
<th>Lookahead</th>
<th>Events To Log</th>
<th>Mix/Wipe</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Enable Mix/Wipe Support**

- **Play Mixes/Wipes Early**: (Default: disabled) Check to enable the system to roll overlapping events early. It causes the list to pull back any events with the effect type of Mix, Wipe, or Mixed Transition.

**Note:** A Wipe effect requires a Wipe number. Each brand of Master Control Switcher may have it own set of Wipes. Each event can have its own wipe number. These are displayed and edited in Effect Number # field in the playlist editors of the windows client. When the event is played the Wipe number in the event is passed to the switcher when the Wipe transition is started. The Wipe number is solely dependent on the Master Control Switcher being used and is not interpreted by the automation as anything but a number.

- **Effect durations in frames**: Set the frame values for slow, medium, and fast effect durations. Effect durations are the amount of overlap time between the end of one spot and the beginning of the next spot.
  - **Slow**: Valid numbers are 0 to 999 frames. Default is 60 frames.
  - **Medium**: Valid numbers are 0 to 999 frames. Default is 30 frames.
  - **Fast**: Valid numbers are 0 to 999 frames. Default is 15 frames.

**Dwell**

- **Dwell event ID**: BLACK
- **Max Dwell duration (frames)**: 150

Configure the following options as required:

**CAUTION:** It must be understood that when an operator activates these features, recorded video beyond the database EOM exists for the material affected. This is an issue of Media Preparation.

- **Enable Mix/Wipe Support.**
  - **Play Mixes/Wipes Early**: (Default: disabled) Check to enable the system to roll overlapping events early. It causes the list to pull back any events with the effect type of Mix, Wipe, or Mixed Transition.

**Note:** A Wipe effect requires a Wipe number. Each brand of Master Control Switcher may have it own set of Wipes. Each event can have its own wipe number. These are displayed and edited in Effect Number # field in the playlist editors of the windows client. When the event is played the Wipe number in the event is passed to the switcher when the Wipe transition is started. The Wipe number is solely dependent on the Master Control Switcher being used and is not interpreted by the automation as anything but a number.

- **Effect durations in frames**: Set the frame values for slow, medium, and fast effect durations. Effect durations are the amount of overlap time between the end of one spot and the beginning of the next spot.
  - **Slow**: Valid numbers are 0 to 999 frames. Default is 60 frames.
- Medium: Valid numbers are 0 to 999 frames. Default is 30 frames.
- Fast: Valid numbers are 0 to 999 frames. Default is 15 frames.

**IMPORTANT:** These parameters must match the effects durations configured in your master control switcher. Failure to do so will result in mistimed effects.

- **Enable Mode Selection:** Check to enable Extended mode selection.
- **Mode Selection:** These options become available when Enable Mode Selection is checked. Select one of the following:
  - **Extend Old:** When this option is checked, the On-Air event is extended to provide overlap material for the transition (e.g. Dissolve or Mix). The list timing is maintained.
  - **Extend New:** When this option is checked, the Next event is played early and for an extended duration. The list timing is maintained.
  - **Extend Both:** When this option is checked, the On-Air event is extended by ½ the effect duration, the incoming event is played early by ½ the effect duration, and the new event is extended by ½ the effect duration.

  **Note:** Extend both is not fully implemented as described above, because currently the playlist always plays early by the full transition duration.

- **Dwell:** Support for a primary transition event that instructs the Versio Master Control Switcher to do a "U-fade". The event permits a variable duration, from 1 frame up to Output<x>_PostRoll for Native Driver (implemented on LLM 80.6.26.0 for Versio 2.2 and higher.)
  The duration value may come from traffic, or be manually entered or changed. The duration of the previous and following event in the list are unaffected.
  - **Dwell event ID:** This shows which event ID should be treated as the event for Dwell (should the default: BLACK not be convenient.)

  **IMPORTANT:** This ID must match on the switch-only event configuration and on the playlist event.

  **Note:** To disable this function delete the Dwell event ID
- **Max Dwell duration**: This is ADC's equivalent of Output<x>_PostRoll. If necessary, the system can automatically adjust duration of BLACK event if it exceeds the limit. The range is 0-150 (decimal) frames, with 150 as the default.

**About Output<x>_PostRoll:**
Set ADC's Max Dwell duration setting and Nexio PostRoll registry keys to the same value. Output<x>_PostRoll extends playback beyond the specified Cue duration. The range is 0-150 (decimal) frames, with 0 as the default. Output<x>_PostRoll will take effect before blanking specified above.

**Registry Location**: HKCU\Software\ASC Audio Video\LLM\Settings\Output<x>_PostRoll

**Prerequisite**: LLM 80.6.26.0

**Warning**: While Max Dwell time can be safely set to less than PostRoll, setting Max Dwell larger than PostRoll can result playback problems – this should not be done.

**About Dwell Operation:**
The dwell is called by a switch only in the playlist. A duration less than the Output<x>_PostRoll uses the dwell function. Durations greater than that setting can switch to the Black Source available.

**Requirement**: Configure the AV Tables (at least the drop down pointing to the VMCS) for the switch only event, even if the customer doesn’t expect it to be used with durations greater than the dwell setting.

**Note**: The real duration of the dwell is ultimately controlled by the switch only event in the list.

**CAUTION**: If the dwell duration exceeds the Output<x>_PostRoll, the LLM playback pipeline will stop, which could cause the next clip to fail to queue in time.

- The Dwell duration ("dwell time" for the transition) can be used in combination with cuts and fades on previous & next clip to create the following effects:
  - \_/ (fade down A, dwell black, fade up B)
  - \_/ (fade down A, dwell black, cut to B)
  - |_/ (cut to black, dwell black, fade up B)
  - |_/ (cut to black, dwell black, cut to B)

**Note**: The transition is programmed in the BLACK event. For example, if a Fade-Fade (V) is used, the previous clip will fade to black, and then next will fade up.

- The dwell (black) time can be specified with a primary event that is separate from events that are responsible for playing media.
- When the event begins, VMCS will output black from the Versio. When the event ends, VMCS will either output:
  - internal source "Clip A", if doing stacked playback
8. Select the **Device Owned** tab. Use this tab to define the relationship between the list and the specific switcher.

Configure the following options as required:

- **Channel Number**: Select from the drop down the channel number /switcher device the list will be using. This should be configured for normal operation of Manual Intervention.

**Note**: This solution doesn't require using a black source in VMCS directly. By specifying the dwell time, VMCS will output black.
9. Select the **Manual Intervention Options** tab. Use this tab to select the "list behavior" in case of manual intervention.

Configure the following options as required:

- **List Behavior**: From the available options, choose the "list behavior" to use when the Automation Interface is disabled (manual mode).
  - **List continues playing with switcher control**: When this option is selected the driver continues to send switch commands to the device.
  - **List continues without switcher control**: When this option is selected the driver stops sending switch commands to the device.
  - **List Stops**: When this option is selected the list stops playing.
10. Select the **Skip Secondary** tab.

![Configuring List Types](image)

Configure the following options to enable list linking as required:

- **Skip Secondary Event after Primary Event is Skipped**: Check to enable skip.
- **Secondary Events To Skip**: From the list, enable (check) the secondary events to skip. Uncheck to deselect.

11. Select the **Audio Routing** tab. *(NEXIO AMP only)*

The NEXIO AMP Track Router supports re-mapping audio tracks on playout and recording through use of an Output Audio Mask to identify which tracks should play on which audio channels and Input Mask to identify which input Audio should place on which audio track. These masks are used to set the output port configuration. Primary, secondary, and tertiary tracks may be specified for cases where a backup track should be played if the preferred track (e.g. language) is not present.

Configured options of audio routing are applied to all disk drivers which are assigned to this list. If a driver (of a Video Disk) does not support audio routing (currently audio routing is supported only for NEXIO driver), then audio routing settings does not affect on the driver. Basic operations on audio routing configuration performed by ADC List include:

- Exchange of data on audio masks and audio tags with the List Options configuration.
- Storing information about the current settings of audio routing during Device Server is running, saving the settings in the INI file when the Server is shut down, loading the settings from the INI file when the Server starts.
Transmission of audio routing settings to the driver, requesting the settings for the drivers.

To Configure Audio Routing:
- Select the Audio Routing tab. On this tab the operator can configure Output Masks (Primary, Secondary, Tertiary) and the Input Mask.
- Configure Tag descriptions for Output and Input Masks by selecting a Channel and from the enabled Tag Description drop down menu select from a list of available descriptions.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Tag Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pass-Thru</td>
</tr>
<tr>
<td>2</td>
<td>[PCM][und][LXF Track 5]</td>
</tr>
<tr>
<td>3</td>
<td>Pass-Thru</td>
</tr>
<tr>
<td>4</td>
<td>[PCM][und][LXF Track 5]</td>
</tr>
<tr>
<td>5</td>
<td>Pass-Thru</td>
</tr>
<tr>
<td>6</td>
<td>[PCM][und][LXF Track 1]</td>
</tr>
<tr>
<td>7</td>
<td>[PCM][und][LXF Track 2]</td>
</tr>
<tr>
<td>8</td>
<td>[PCM][und][LXF Track 3]</td>
</tr>
<tr>
<td>9</td>
<td>[PCM][und][LXF Track 4]</td>
</tr>
<tr>
<td>10</td>
<td>[PCM][und][LXF Track 5]</td>
</tr>
</tbody>
</table>

- Configure Type for Input Mask by selecting a Channel and from the enabled Type drop down menu select from a list of available descriptions.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Tag Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pass-Thru</td>
<td>PCM</td>
</tr>
<tr>
<td>2</td>
<td>Pass-Thru</td>
<td>PCM</td>
</tr>
<tr>
<td>3</td>
<td>Pass-Thru</td>
<td>Natural/OTC</td>
</tr>
<tr>
<td>4</td>
<td>Pass-Thru</td>
<td>Doby-Digital/AC3</td>
</tr>
<tr>
<td>5</td>
<td>Pass-Thru</td>
<td>Doby-E</td>
</tr>
<tr>
<td>6</td>
<td>Pass-Thru</td>
<td>MPEG1 Layer/II</td>
</tr>
</tbody>
</table>

**Configuration Notes:**

**Note:** While the following example screen shots are for Playlist, they reflect the same functionality across all other lists.

- No device, which supports Audio Routing, is assigned to a List. If no device can provide audio tag descriptions, Tags List will contain conditional strings defining the tag numbers.
An audio mask can be edited and will be automatically applied when a device with Audio Routing support is assigned to the list.

- One device (one IP) which supports Audio Routing is assigned to the List.
  - During initialization List reads saved Audio Routing settings from INI and sets up this settings to assigned device (to all their ports).
  - Every device which supports Audio Routing has to store list of descriptions of audio tags. When an operator opens the List Properties form, the List queries the list of descriptions from the device and passes it to the form to display.
  - If an operator changes primary, secondary, ternary, Input audio mask of tags and Input audio mask of types, then these changes are applied to the device. If the device isn’t connected, then the changes are applied after connect.

- Two or more devices (with different IP) which support Audio Routing are assigned to the List.
  - After reading Audio Routing settings from INI, the List will apply up these settings to all devices, assigned to this list.
  - List queries the list of descriptions from the first device which is assigned to this list.
  - If an operator changed primary, secondary, ternary, Input audio mask of tags and Input audio mask of types, then these changes are applied to the all devices assigned to this list.

- Stopping the server. On closing the Server, ADC list saves audio masks to the ADC INI. Tag descriptions aren’t saved.

Input Audio Masks include 2 masks: mask of tags and mask of audio types. The list of audio types retrieves from the device similarly audio tags list (FillAudioTypes function is used). NEXIO supports five audio types: PCM, Neutral/DTC, Dolby-Digital/AC3, Dolby-E, MPEG1 LayerI/II. Usually audio tags include an audio type name. In this case, after assigning some tag to audio channel, the audio type is set automatically for this channel, but this type is still available for editing.
Note: The audio type must meet the audio tag for similar audio channel.

12. Select the **Linking** tab. Use this tab to put software triggers from one list to another. This functionality provides an alternative to the GPI method; a software solution for triggering one list by another list. These triggers allow all of the same functions available via the GPI inputs - all of the control panel functions plus 'Skip to next N' (ER17504). Also, it is possible to issue a ganged command, and to issue triggers across connected Device Servers. Historically, in order to have one playlist control the start of another playlist on ADC a sGPI output is used on the Master playlist to send a GPI trigger to the Slave playlist(s)' GPI Input. The Slave playlists are then configured to accept a 'Contact Start'.
**Note:** This software trigger list Linking functionality only applies to playlists. Media, GMT, Compile and Record lists do not need to be linked to each other or playlists.

<table>
<thead>
<tr>
<th>List Options PlayList 1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip Secondary Audio Routing Linking</td>
<td></td>
</tr>
</tbody>
</table>

**Playlists triggered by current list**

<table>
<thead>
<tr>
<th>Linked</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>PlayList 2 - Server1</td>
<td>PlayList 2</td>
</tr>
<tr>
<td>PlayList 1 - Server2</td>
<td>PlayList 3</td>
</tr>
<tr>
<td></td>
<td>PlayList 4</td>
</tr>
<tr>
<td></td>
<td>PlayList 5</td>
</tr>
<tr>
<td></td>
<td>PlayList 6</td>
</tr>
<tr>
<td></td>
<td>PlayList 7</td>
</tr>
<tr>
<td></td>
<td>PlayList 8</td>
</tr>
<tr>
<td></td>
<td>PlayList 9</td>
</tr>
<tr>
<td></td>
<td>PlayList 10</td>
</tr>
<tr>
<td></td>
<td>PlayList 11</td>
</tr>
<tr>
<td></td>
<td>PlayList 12</td>
</tr>
<tr>
<td></td>
<td>PlayList 13</td>
</tr>
<tr>
<td></td>
<td>PlayList 14</td>
</tr>
<tr>
<td></td>
<td>PlayList 15</td>
</tr>
<tr>
<td></td>
<td>PlayList 16</td>
</tr>
</tbody>
</table>

Server2

**IMPORTANT.** When working with Linking options for a Playlist from Server1 and adding a Playlist from Server2 to Linked lists, proceed to Server2 list configuration in Config Tool and save its configuration manually. This is required because some parameters for the playlist from Server2 should be saved to its "ListConf.ini" file (see above), but it is impossible to save properties for Server2 while working with Server1 in Config Tool.

**About Device Server Functionality:**

- Each list of Device Server has information about its triggered lists (if it acts as Master list) and about list, which is Master for it (if it acts as triggered list). In both cases, info about each list consists of its global handle and its name.
• List global handle is equal to server handle, which is shifted left by 16 bits, plus (OR) list local handle.

• List name is an additional parameter, which is used to correctly display linked lists in the ConfigTool and the name of the Master list in the Transmission window in Air Client.

Data about linking / triggered playlists is saved in "ListConf.ini" file of Device Server. Example: Playlist1 on Server1 may have such data in "ListConf.ini":

```ini
[List1]
...
TriggeredLists=2;210833410;PlayList 2 - Server1;84480001;PlayList 1 - Server2
```

It is not enough to keep only an array of triggered lists for each playlist. A playlist also keeps information about the list which it is currently triggered by. This data (the exact list name) is used in the caption of a Transmission List in Air Client. The handle of Master list allows it to determine whether this list is triggered by any other list. It is used when creating Available column on "Linking" tab.

Example: List2 on Server1 may have such data in "ListConf.ini":

```ini
[List2]
...
MasterTrigListHandle=210833409
MasterTrigListName=Server1 - PlayList 1
```

Ability to send a command to a linked list if current event contains any action except No Action.

When an event has any selected Action except No Action (for example, Play), the appropriate command is sent to a linked list at the appropriate time to allow both lists to roll simultaneously (i.e. the events on the slave list(s) will typically play in conjunction with the triggering event on the master list.)

- Commands are divided into two groups:
  - Those which can be executed immediately as they are received (e.g. Hold, Freeze, and Skip). These commands are sent exactly when the event starts playing.
  - Those which require pre-roll before execution (i.e. Play, Play Secondary, Roll, Skip and Skip to Next). These commands are sent at the beginning of event's pre-roll.

**IMPORTANT.** Some commands can be executed only under certain conditions. For example, Play command can be executed on list which is already threaded. Play to Next and Skip to Next commands can be successfully performed only if list contains "N" event.

**Known Issues about Config Tool and Device Server Compatibility:**
The drop-down combo-box on Linking Tab in Config Tool, allows choosing a Device Server from the list of available servers. This combo-box contains all servers located in the network, regardless their versions.

If an earlier version of Device Server (pre 12.19) is selected from this drop-down list, the Available column will be empty. This occurs because the Config Tool sends a special object to the Device Server in order to get information about its playlists. Previous versions of Device Server can’t reply to this object, so the information is not provided.

13. Select the **Auto Ripple** tab. Use parameters on this tab to set an ripple time action to be performed automatically during live events at a user-defined interval.

**Note**: Auto ripple settings are available only for Transmission Lists. Other list types (GMT, Compile, Media, etc.) are not intended to support this feature.

Configure the following options as required:

- **Enable Auto Ripple on Upcount Events**: Check to enable auto ripple. By default, this option is disabled (unchecked).
- **Auto Ripple Frequency MM:SS**: Specify the auto ripple interval in format MM:SS. Default value is 03:00, minimum value 00:30
- **Events to Use**: Use radio buttons to select performing auto ripple on ‘All Upcount Events’ OR on ‘Upcount Events with the Follow IDs’.
  - **All Upcount Events**: Select this option to perform auto ripple upcount events with any ID.
  - **Upcount Events with the Following IDs**: When this option is selected, fill the list of valid IDs. Please split IDs with "enter". IDs are case-sensitive.

**Operation Considerations**
• Usually, upcount (AU) event counts down during its initial planning duration and then starts counting up. Auto-ripple will happen in both states – while AU is counting down and while AU is counting up.

• Next primary event on air time is calculated as: current time + list Preroll

• This time shows when next primary event will start if current AU is skipped right now.

• Usually, transmission list events are typically rippled in the following cases:
  o Operator invokes list control commands (run, play, skip, roll, +1/-1, etc.)
  o Operator modifies (inserts/deletes/edits) events in list

  If AU event is running and one of these actions happens, the list is rippled regardless of time passed since the last ripple. The list preserves the current timestamp and performs next auto ripple frequency seconds later if no operator intervention happens.

• Device Server performs ripple in zero frame of each second. If list preroll frames are zero, next event on air time will always have zero frames (or 02 frames in some cases for NTSC DF). This is expected behavior.

• Device Server ripples 200 events per pass (per second). If there are more than 200 events in lookahead, it will take "(amount of events in lookahead) / 200" seconds to ripple all events.

  For example, if list has 12500 events and lookahead is also set to 12500, it will take 63 seconds to ripple all list.

  Auto Ripple Frequency should be chosen considering the information. It is also necessary to take into account the fact that too frequent auto ripple may affect DS performance, especially if there are many Transmission Lists running.

14. When finished click **OK**, and then **Apply**.

### About Dynamic List Selection for API triggering

ADC v12.23 and higher supports Dynamic List Selection for API triggering. It incorporates a simple and dynamic means to alter the linked list associations from the Air Client and on an event-by-event bases.

**Storing selected lists within the event structure:**

Enabled triggered lists are configurable on an event basis; and information is stored within the event structure. Device Server and Air Client keep information about triggered lists in format "list handle" – "list name (including server name)".

- List handle is used as a destination for list trigger commands.
- list name is used in the UI.

A **bit-mask field** is used for keeping triggered lists state (enabled/disabled) within event structure. Each bit of this field equals 0 if the list is currently disabled and 1 if the list is currently enabled.
Example: In the following example a user selected 3 of 4 possible lists. Bit-mask is equal to $1101_2$ or to $13_{10}$. This method of data organization is invisible for user because it is only necessary for transferring information between Air Client and Device Server.

Bit Mask Field Method Restrictions:

This method imposes several user restrictions:

- A maximum 16 different lists can be triggered by one Transmission List. The Config Tool Linking tab will not allow more than 16 triggered lists to be added to one Transmission List.
- Since bit-mask addresses lists according only to their order (not names or handles), Triggered lists should not be changed from the Config Tool if triggers are already used in Transmission List.
  - Violation of this rule can result in triggered lists reordering; causing bits in bit-mask to correspond to wrong lists, and the server to send trigger commands to incorrect lists.
  - To prevent users from editing the triggered lists array, the Config Tool Linking tab becomes disabled if at least one event within the lookahead of the current Transmission List contains a non-empty trigger action.

Configuration:

1. Select the List Redundancy tab.
   This tab is available if the customer has purchased List Redundancy functionality.

   **Note:** Cloning and List Redundancy are considered mutually exclusive functionalities.
**Master List:** Enable Copy options are available on the Master list only.

Configure the following options to enable list linking as required:

- **Enable Auto ReSync Function:** Enable/Disable Auto Resync.  
  Checked: (Recommended) Enable auto re-sync function of List Redundancy.  
  Unchecked: Disable auto re-sync function of List Redundancy.  

  About the current Re-Sync mechanism of List Redundancy:  
  Users should send Mirror and Sync command manually from LRCC to start the Sync.

**Slave List:** To reduce the chance of errors the Enable Copy options are grayed out on the Slave list, so the user can enable/disable it only on the Master list.
When the Master List receives both the Mirror and Sync commands, the Auto Re-Sync mechanism is turned on, and users can disable Auto Re-Sync by sending one of the commands of Disable LR, Stop Sync, or Stop Mirror.

The Master List and Slave List exchanges the current playing event and frame every second.

- If the Events are different or the frames from two lists differ more than 3 frames, out of sync is considered to have happened once.
- If out of sync happens continuously, i.e. more than 20 times, the Auto Re-Sync function is triggered.

The auto re-sync function makes it possible to synchronize with all short events. When the Master List receives a 'Sync in 10 seconds' command from LRCC, it calculates the current event’s duration. If it is shorter than 10 seconds, it adds the next events duration, until there is enough time to put an AO flag (Audio Over) to an event in the Slave List.

If for any reason, the Sync operation fails, the Auto Re-Sync is triggered. So users only need to send the first Sync command from LRCC. The Auto Re-Sync mechanism will handle the rest until successfully Synchronized.

- **Enable Auto Swap Function**: Enable/Disable Auto Swap.
  - Checked: Enable Auto Swap Function.
  - Unchecked: (Recommended) Disable Auto Swap Function.

  If the master list is stopped and the slave list is still running, the Auto swap function automatically swaps the role of the master list with the slave list.

  **Note**: Currently, the Auto Swap Function cannot operate swap, so even if the master and slave list swap roles, the output stream will be still from the former master list’s device.

- **Enable Sync on Next Event During Upcounting**: Check to permit the system to partially synchronize lists on the current upcounting event.

  Usually, to sync on the next event, an AO must be put on the next event in both Master and Slave lists. But for an upcounting event, the start time of next event is unknown, so an AO cannot be put on the next event. This means we can never sync on an event next to an AO event.

  Partially synchronizing on the event overcomes this problem (i.e. On the current upcounting event, when operator skips to next event, both Master and Slave list roll together and keep synchronized on the next event.

- **Enable Copy Lookahead Value from Master List to Slave**: When using List Redundancy, enabling this option makes the Lookahead on the SLAVE list follow the value of the lookahead that is set on the MASTER list.

  - Check to enable this feature and copy the Lookahead Value from the Master List to the Slave List. The value of this option will be saved in INI-file.
  - Uncheck (Default) to disable this feature.

  **Note**: To reduce the chance of errors, this option can only be enabled/disabled on a Master list. This option is grayed out on a Slave list.

  This option only works if option "Enable Copy Lookahead Value from Master List to Slave" is enabled, a pair of lists (channel) is created in LRCC and their behavior is specified (Master/Slave). If the value of Lookahead is changed on the Master list, it is automatically copied to the Slave list. And on a Slave list the Lookahead spin-edit is grayed out.
**Note:** This enhancement involves only the value of Lookahead in events, which can be specified both in the Config Tool and Air Client, but not invoked duration-based Lookahead.

**Copy Lookahead Enabling Rules:**
- If option "Enable Copy Lookahead Value from Master List to Slave" is enabled/disabled on a Master list, it is automatically enabled/disabled on a Slave list (but on the Slave list it is always grayed-out).
- If the value of Lookahead on Master and Slave list is different and the user turns on option "Enable Copy Lookahead Value from Master List to Slave", the Lookahead value is automatically copied from the Master to Slave at this moment.

- **Enable Copy Done Count Value from Master List to Slave:** Enable (check) / Disable (uncheck) allowing the DONE Count to be mirrored to the Slave list.
  - The default value is false (not checked), so the customers who don’t need this feature will have no changes in their work.
  - Customers who want to copy done count value can enable this option. The value of this option is saved in INI-file.
  
  If option "Enable Copy Done Count Value from Master List to Slave" is...
  - Enabled/disabled on Master list, it will be automatically enabled/disabled on Slave list (but on Slave list it will be always grayed-out, like a read-only option).
  - Different and the user turns on option "Enable Copy Done Count Value from Master List to Slave", the Done Count value is automatically copied from Master to Slave at this moment.

  This feature will work only if....
  - The option "Enable Copy Done Count Value from Master List to Slave" is enabled,
  - A pair of lists (channel) is created in LRCC and their behavior is specified (Master/Slave).

  If the value of Done Count is changed on Master list, it is automatically copied to Slave list. And on Slave list Done Count spin-edit will be grayed out.

- **Meaning of the diagnostic information items:**
  - **Redundant Server:** The name of the server, which the redundant list of this list is in.
  - **Redundant Handle:** The server handle and list handle of the redundant list of this list.
  - **Redundant Latency:** When the master list receives a command, it sends the command to the slave list and executes the command on both sides after this latency time.
  - **Behavior:** Master or Slave or not decided
  - **Status:** LR link status
  - **RAN IP:** This is the server’s RAN network IP address.
  - **RAN Port:** This server’s RAN IP port
  - **RAN Latency:** If Master and Slave cannot get connected after this latency (default 20 seconds), they will give up and run separately.

2. When finished click **OK**, and then **Apply**.
Configuring Media List Options

Media lists are modified Transmission lists used exclusively by the Media Client application. They are not designed for use as Transmission lists. The Media Client application uses the media devices assigned to the Media lists for automated recording and copying activities. The Media Client application will place events on the Media list, run them and then remove them from the list. Media lists do not require any operator intervention and events generally should not be inserted into them or deleted from them. The A/V routing tables for devices assigned to Media lists may be configured as they are for Transmission lists to allow automatic routing of A/V streams.

**Note:** For more information about Media lists reference the "*Media Client Operator's Guide*".

To Configure Media List Options

A number of options may configured to control the behavior of Media Lists. These options are accessed from the Configuration Manager’s List Assignments window.

1. To access the Media List options configuration GUI, select a Media List in the Lists pane.

2. **Right-click** on the entry and then from the pop-up menu select **Properties**. The Configuration window opens with multiple tab selections. The options configured on these tabs apply to this list only. Configuration options for other lists must be configured separately.
3. Select the **Parameters** tab. This tab contains general configuration options for Media Lists. Some options are commonly used and enabled by default.

Configure the following options as required:

**IMPORTANT:** While the configuration options **Always Allow Recue Following an Upcount** and **Block Recue Following an Upcount** are currently shown as available for Media List, GMT List, and Compile List types, they are not recommended for use with these lists.

- **Name:** Enter a name for this List. List names are limited to 32 characters.
- **Options:**
  - **Auto Restart When Cued:** (Default: disabled) When enabled, this option causes events to automatically restart, without manual intervention, if the media has been recued. When this option is disabled, the automation system marks the event as missing and does not automatically cue the event when located.
  - **Recue On Media Changes:** (Default: enabled) When enabled, this option causes events to automatically recue if the event’s SOM (start-of-message time), DUR (duration), or New AFD is changed.
    - **Note:** The ID Video ARC is reapplied if the event’s New AFD value is changed while the event is CUED.
  - **Rewind Compile Material:** (Default: disabled) When enabled, this option causes compile tapes to rewind to the head of the first spot when finished. The tape is rewound to the first commercial break (or "pod") minus the preroll.
  - **Rewind to First Program Segment:** (Default: enabled) When enabled, this option causes multi-segment programs played out from a VTR or cart machine to rewind to the head of
the first program segment when finished. The tape is rewound to the SOM of the first segment minus the preroll.

- **Update Cued Event on Media Change**: When this parameter is enabled (checked), all of the database derived metadata for any cued events is updated.
  - If 'Recue on Media Changes' parameter is enabled, then this parameter is also enabled.
  - If this parameter is enabled, but the 'Recue on Media Change' parameter is disabled, then although the event is updated, the device is not recued or otherwise updated.
    - **CAUTION**: This configuration scenario can cause unanticipated or invalid behaviors, such as the device and device driver's head data to get out of sync. To avoid this ensure 'Recue on Media Changes is also set.
  - If this parameter is disabled, 'Recue on Media Changes' must also be disabled and no updates will be applied to cued events.
  - If Auto Ripple is enabled, the start time of the event following the an updated event is also updated.

- **Update Playing Event on Media Change**: When this parameter is enabled (checked), the system partially updates the metadata of an event that is playing at the time of an update. **The device cannot be recued and the SOM of the event is not updated.**
  - If this parameter is enabled, then 'Update Cued Event on Media Change' must also be enabled.
  - If this parameter is enabled, the remaining duration of the event is recalculated on an update. Since the duration of an event decrements while it is playing, the duration is changed by an amount equal to the difference between the original duration and the updated duration.
    - **WARNING**: If the device is not updated - as in the case of a cued event because Recue on Media Changes is disabled, or in all cases for playing events - and the updated duration is longer than the duration used to initially cue the device, the device may cease playout at the end of the original duration, even if the event is updated. This typically causes a TapeEnd error and the list skips forward to the next event.

- **Extended Time To Next**: (Default: enabled) When enabled, this option enhances the functionality of the time-to-next feature of the Transmission List. Time-to-next values are calculated correctly regardless of whether there is an intervening upcount event.
  - **Enhanced Functionality includes**:
    - When the termination event is an O (hard start) event the Time To Next display includes the running short value.
    - Zero duration up counters do not stop the rippling.
    - When in an up counter, if an O event exists as the termination event, the Time To ext computation computes without any long or short value. It displays exactly how long until the hard timed start begins.

- **Release Tension On Record**: (Default: disabled) When enabled, this option, if VTRs or cart machines are assigned to this list as record devices, causes the VTR or cart machine to release tension on the tape when the record event has cued. The tape is re-tensioned at the "standby on" time (see below).

- **Rewind Spots**: (Default: enabled) When enabled, this option causes single-spot tapes played out from a VTR or cart machine to rewind to the head of the spot when finished. The tape is...
rewound to the SOM minus the preroll (on a multi-spot tape, the tape is rewound to the
SOM minus the preroll of the last spot played).

- **Thread Limited**: (Default: disabled) When enabled, this option changes the cueing behavior
  of the Transmission List. Events are cued within the specified "thread time", taking into
  account the duration of events registered with the same media device that cannot be
  threaded due to a lack of available media heads. This means non-threaded but blue
  (registered) events count toward the total thread time as if they were threaded.

- **Time Parameters**: These options specify time values for this list.

  **IMPORTANT Preroll Note**: For Media Client, there is a dependency between the Preroll setting
  in the Configuration of a Prep Window (set in Configuration>"selected pre form">General>Time
  Parameters) and the Preroll of the Medialist (set in Config Tool -> Medialist
  Properties>Parameters >Time Parameters). The prep-form and Media list preroll values should
  match.

  - **Preroll Seconds**: Define the number of preroll seconds to be used for the selected list. The
    valid range is 0-59 seconds. Default is 3 seconds.
  
  - **Preroll Frames**: Define the number of preroll frames to be used for the selected list. The
    valid range is 0-29 frames. Default is 0.
    All events on this list will preroll for the time (Seconds/Frames) specified here before
    switching. The list preroll should equal the preroll time required by the slowest device
    assigned to the list. For example, if a VTR assigned to this list takes 4 seconds to lock up, the
    list preroll should be no less than 4 seconds.

  **Note**: If a list preroll of less than 3 seconds is used, VTRs assigned to this list will not perform
  a tape speed override (TSO) when they roll.

  Frame-accurate playout from tape cannot be guaranteed if a list preroll of less than 3
  seconds is configured. Operators may manually override the list preroll by using the Roll
  Now button on the control panel. Only events registered with Switch-Only devices or video
  server decoder ports (if they are configured to support "instant prerolls") may be rolled
  using the Roll Now button.

  - **Postroll Seconds**: Define a length of time, in seconds, the automation system plays the
    current event beyond its duration if it has not yet switched to the next event. The valid
    range is 0-59 seconds. Default is 1 second.
  
  - **Postroll Frames**: Define a length of time, in frames, the automation system plays the current
    event beyond its duration if it has not yet switched to the next event. The valid range is 0-29
    frames. Default is 0.
    All events on this list will postroll for the time (Seconds/Frames) specified here after their
    duration has expired. Events registered with video server decoder ports, if the port has been
    configured to support a "device postroll", may allow shorter postrolls that the list postroll.

  - **StandbyOn Seconds**: This value determines when "standby on" commands are sent to VTRs
    by specifying the amount of time the automation system keeps the VTR in tension after
    cueing an event. The valid range is 10-59 seconds. Default is 30 seconds
    If a VTR assigned to this list is configured to perform a "standby off" when a tape has cued -
    spinning down the video heads and releasing tension on the tape - the tape will be
    re-tensioned and recued at the "standby on" time.

- **AO Event**: Hard start event (AO)

- **AO Event Thread Time**: Specify the following thread times:
**Cue Seconds**: Specify cue time seconds for the AO event.

**Cue Frames**: Specify cue time frames for the AO event.

- **Thrd AO evnt at last moment**: Check to enable threading of the AO event at the last moment.
  
  Checked: (Recommended): If another event occupies the same disk head, thread the disk hard start event when the current time is closer to its On Air time than AO Event Thread Time. Checking this box gives the maximum tolerance for the list events that in front of the AO events to do playout, and also allows the AO event to successfully register to a disk head to play on time.
  
  Unchecked: Thread disk hard start event based on thread time. If the disk head is occupied by another event, that event will be ejected.

- **Only Thread Next AO Event**: Enable / Disable threading of the next event. If multiple Hard-Start (AO) events are within the transmission list lookahead Window:
  
  Checked: Only thread the next Hard Start event without continuously rippling down to reach next AO event on the same list. Since playlist events often are without On-Air date information, this prevents the next day's AO event (showing later in sequence on the playlist, but with an on-air time earlier than the today's) being Cued first.
  
  Unchecked: if there are more than one AO event in the future, list will find the earliest timed one as the next AO event to start regardless its position in the list.

  **Recommendation**: Uncheck only when there is a necessary for set AO event out of order.

4. Select the **Options** tab. This tab contains optional configuration settings for Media lists.

**Note**: All of the options on this tab may be configured in the Air Client application.
Enable (check)/ Disable (uncheck) and configure the following as required:

- **Options:**
  - **Auto A-B Routing:** (Default: disabled) Enabling this option causes devices to alternate between their primary and secondary audio/video routing paths as configured in this list’s A/V routing table (see below).

  When enabled this setting overrides an event’s channel settings (displayed in Transmission window’s CH column in Air Client). During transmission, successive primary events are routed alternatively through switching channels A and B. This function is useful to ensure that two successive events are not played through the same channel (which is needed when transition effects such as mixes are defined between events). Make sure both A and B channel A/V parameters are configured in all devices that are used.

  **Note:** When changing this configuration, existing events on the list, and in particular previously executed events recovered with ‘Clear Done Events’, may exhibit the previously configured switching behavior.

  - **Auto Ripple Times:** (Default: disabled) Enabling this option causes the time-of-day for events to update automatically, reflecting any changes to event durations made manually. The time "rippling" ends at hard start events. The calculation assumes that the Duration field for up-counting events is accurately set.

  - **Contact Start:** (Default: disabled) Enabling this option allows this list to be rolled via an external GPI contact-closure trigger. The GPI trigger duplicates the function of the Play button on the control panel.

  - **Play ID Title Mismatches:** (Default: disabled) This option only applies to systems that include a Sony LMS cart machine. The LMS will not register events if the ID and title on the tapes’ barcode labels do not match the ID and title of the events as they appear on the Transmission list. Enabling this option allows the LMS to register mismatched events.

  - **Keep List Threaded:** (Default: disabled) Enabling this option causes the Transmission list to thread and cue as many events as possible within the lookahead. If an event is inserted into the list to be played, the event is immediately cued and subsequent events unthreaded as necessary.

    When enabled, thread time is not used. This option supersedes the Thread Time. When disabled, the list only keeps events threaded within the Thread Time window (see below).

    **Logomotion Note:** To ensure all available heads thread normally, enable ‘Keep List Threaded’.

  - **Only Swap One Event in A-P:** Enable / disable air protect switching for an event.

    In an Air/Protect configuration, the playlist will play out an event simultaneously from both Air an Protect servers. If the Air Server has a failure or malfunction, the playout server switches event playout to the Protect server and stays there. In many situations, event interruption is only caused by one media, not the entire playout server or port. In this situation, some customers want the playlist to switch back to the previous Air server instead of keeping playout with the Protect server. Checking this option box will

    **Checked:** Tells the playlist to switch back to the Air Server for normal playout, on conclusion of this trouble event.

    **Unchecked:** Treat Air and Protect disk equally, assign air or protect disk port to Air column whichever is ready first.
**Recommendation:** Uncheck when the disk port is the additional port of another video disk.

- **Play Hard Hits:** (Default: disabled) Enabling this option allows an operator to manually override the start time of "hard start" or "hard hit time" events (timed events). When disabled, "hard start" events only roll at the time specified in the Transmission list’s Time column.

- **Release Tension When Cued:** (Default: disabled) Enabling this option causes the system to send a "standby off" command to any VTRs when they have cued a tape. The tape is re-tensioned at the standby on time.

- **Skip Bad Events:** (Default: enabled) When enabled this option the Transmission list to ignore and skip a single unregistered (bad) event. The list will continue playing out and mark the bad event as "missed". When disabled, the Transmission list stops upon encountering any unregistered event and must be restarted manually.

  **Note:** The Transmission list always stops upon encountering two or more consecutive bad events, whether this option is enabled or not.

- **Station ID On Skip:** (Default: disabled) Enabling this option causes the switcher to switch to the Station ID source (configured in the master control switcher’s configuration GUI) for the duration of the list preroll when an operator has manually skipped an event using the Skip button on the control panel.

- **Switch To Black:** (Default: enabled) When enabled this option causes the master control switcher to take the Black source if the list stops. The Black source must be configured in the master control switcher’s configuration GUI for this to occur. When disabled (or the Black source not configured), the switcher will remain on the last source taken if the list stops.

- **Tension After Up Counter:** (Default: disabled) Enabling this option causes tape events following an upcount event to remain tensioned. Since the duration of upcount events is, by definition, indeterminate, there may not be time to re-tension a tape if an upcount event ends abruptly. This option allows events from tape to remain ready to roll immediately.

- **Thread After Break:** (Default: enabled) When enabled this option keeps the list threaded while the list has stopped due to encountering a Break event on the list. Break events are secondary events inserted in the list to cause the list to stop temporarily and wait for a Play command from either the control panel or an external GPI trigger. When disabled, the list must be threaded manually before it can execute a Play command.

- **Timed List:** (Default: enabled) When enabled this option allows the list to roll timed events – hard start or record events – at the time of day specified in the Transmission list’s Time column. When disabled, timed events will not roll.

- **Update On Air Time:** (Default: disabled) Enabling this option causes the on-air time for events to update to the actual time the event rolled. As-Run logs for the list are updated as well. When disabled, the As-Run logs reflect the time-of-day that appeared on the Transmission list, rather than the actual time the event rolled.

- **Update Final Upcount Durations:** Check to enable update of the final upcount event duration. This gives an actual duration of how long an event ran.
00:00:00.00 and then will count back up.

This repeats until terminated by either pressing Play or Skip on the control panel or a contact start is reached. The next event will play normally. Up counters only work on events played from Switch Only devices.

- **Done Count**: This value sets the number of "done" events that will be displayed at the top of the Transmission list. The Done Count may be set to any value between 1 and the lookahead value minus 1. Default is 4 events. Maximum is 20.

  **Note**: Never set the Done Count to a value equal to or greater than the lookahead value. Doing so causes the list to eventually run out of valid, registered events and stop.

- **Thread Time**: This time value determines the time "window" following the on-air event in which events will be threaded. The valid range is from 0 to 23:59:59:29 (23 hours, 59 minutes, 59 seconds, and 29 frames). Default is 2 minutes.
  - Any events within the Thread Time are threaded and cued.
  - If the list option "Keep List Threaded" is enabled, this value is ignored.

- **Match Primary Duration PT=EOM offset**: This option provides the ability to define an offset time (HH:MM:SS:FF) for the end point of a secondary event PT=, which should end with respect to the primary event. (i.e. The value of EOM offset is used for all PT= secondary events attached to the primary.)
  - This parameter affects the timing of every secondary event that uses the "=" modifier.
  - When defined the offset should be less than list preroll time.

- **Zero Upcount Durations**: Enable (check)/Disable (uncheck) the ability to zero the initial duration of upcount events
  - If Enabled (checked), the duration of Upcount event will setup to zero automatically before the event starts. The list will be rippled and timed as with estimated duration of this event.
  - If Disabled (unchecked), the behavior of the list will be as normal - upcount events would decrement from whatever duration is scheduled and then upcount from zero.

5. Select the **Events to Log** tab. This tab contains configuration options for the As-Run logs created by the Air Client application.
By default, not all secondary event types are logged to the As-Run log. Checking the appropriate checkbox on this tab will enable logging of that secondary event type.

Enable (check)/ Disable (uncheck) the following as required:

- **Secondary Events to Log**:
  Enable (check)/ Disable (uncheck) the secondary events to log in the As-run log. When all check-boxes are selected (checked), all secondary events associated with a primary are included in the As-Run log.
  
  For Example: BREAK is disabled and others are enabled – all secondary events except BREAK secondary event are included in the As-run log.

- **Log Record Events**: (Default: disabled) Check to enable logging of record events on normal completion.
6. Select the **Skip Secondary** tab.

![List Options Media List 17 window]

Configure the following options to enable list linking as required:

- **Skip Secondary Event after Primary Event is Skipped**: Check to enable skip.
- **Secondary Events To Skip**: From the list, enable (check) the secondary events to skip.

7. Select the **Audio Routing** tab. (NEXIO AMP only)

The NEXIO AMP Track Router supports re-mapping audio tracks on playout and recording through use of an Output Audio Mask to identify which tracks should play on which audio channels and Input Mask to identify which input Audio should place on which audio track. These masks are used to set the output port configuration. Primary, secondary, and tertiary tracks may be specified for cases where a backup track should be played if the preferred track (e.g. language) is not present.

Configured options of audio routing are applied to all disk drivers which are assigned to this list. If a driver (of a Video Disk) does not support audio routing (currently audio routing is supported only for NEXIO driver), then audio routing settings does not affect on the driver. Basic operations on audio routing configuration performed by ADC List include:

- Exchange of data on audio masks and audio tags with the List Options configuration.
- Storing information about the current settings of audio routing during Device Server is running, saving the settings in the INI file when the Server is shut down, loading the settings from the INI file when the Server starts.
Transmission of audio routing settings to the driver, requesting the settings for the drivers.

To Configure Audio Routing:
- Select the Audio Routing tab. On this tab the operator can configure Output Masks (Primary, Secondary, Tertiary) and the Input Mask.
- Configure Tag descriptions for Output and Input Masks by selecting a Channel and from the enabled Tag Description drop down menu select from a list of available descriptions.
Configure Type for Input Mask by selecting a Channel and from the enabled Type drop down menu select from a list of available descriptions.

**Configuration Notes:**

**Note:** While the following example screen shots are for Playlist, they reflect the same functionality across all other lists.

- No device, which supports Audio Routing, is assigned to a List. If no device can provide audio tag descriptions, Tags List will contain conditional strings defining the tag numbers.
An audio mask can be edited and will be automatically applied when a device with Audio Routing support is assigned to the list.

- One device (one IP) which supports Audio Routing is assigned to the List.
  - During initialization List reads saved Audio Routing settings from INI and sets up this settings to assigned device (to all their ports).
  - Every device which supports Audio Routing has to store list of descriptions of audio tags. When an operator opens the List Properties form, the List queries the list of descriptions from the device and passes it to the form to display.
  - If an operator changes primary, secondary, ternary, Input audio mask of tags and Input audio mask of types, then these changes are applied to the device. If the device isn’t connected, then the changes are applied after connect.

- Two or more devices (with different IP) which support Audio Routing are assigned to the List.
  - After reading Audio Routing settings from INI, the List will set up these settings to all devices, assigned to this list.
  - List queries the list of descriptions from the first device which is assigned to this list.
  - If an operator changed primary, secondary, ternary, Input audio mask of tags and Input audio mask of types, then these changes are applied to the all devices, assigned to this list.

- Stopping the server. On closing the Server, ADC list saves audio masks to the ADC INI. Tag descriptions aren’t saved.

Input Audio Masks include 2 masks: mask of tags and mask of audio types. The list of audio types retrieves from the device similarly audio tags list (FillAudioTypes function is used). NEXIO supports five audio types: PCM, Neutral/DTC, Dolby-Digital/AC3, Dolby-E, MPEG1 LayerI/II. Usually audio tags include an audio type name. In this case, after assigning some tag to audio channel, the audio type is set automatically for this channel, but this type is still available for editing.
8. When finished click **OK**, and then **Apply**.

---

**Configuring GMT List Options**

GMT lists are modified Transmission lists used exclusively by the Global Media Transfer technology. They are not designed for use as Transmission lists. GMT uses the media devices assigned to the GMT lists for automated transfer of media from wherever it exists within the system to where it needs to be to play out. Generally, only GMT Distributors and certain baseband media devices are assigned to a GMT list. GMT lists do not require operator intervention, although events on a GMT list may be dragged and dropped to a new position to alter its transfer priority. The A/V routing tables for baseband devices assigned to GMT lists may be configured as they are for Transmission lists to allow automatic routing of A/V streams.

**Note:** For more information about GMT lists see Global Media Transfer (on page 453).

**To Configure GMT List Options**

A number of options may configured to control the behavior of Transmission Lists. These options are accessed from the Configuration Manager's List Assignments window.
1. To access the GMT List options configuration GUI, select a GMT List in the Lists pane.

2. Right-click on the entry and then from the pop-up menu select Properties. The Configuration window opens with multiple tab selections. The options configured on these tabs apply to this list only. Configuration options for other lists must be configured separately.

3. Select the Parameters tab. This tab contains general configuration options for GMT Lists. Some options are commonly used and enabled by default.

Configure the following options as required:
IMPORTANT: While the configuration options *Always Allow Recue Following an Upcount* and *Block Recue Following an Upcount* are currently shown as available for Media List, GMT List, and Compile List types, they are not recommended for use with these lists.

- **Name**: Enter a name for this List. List names are limited to 32 characters.
- **Options**:
  - **Auto Restart When Cued**: (Default: disabled) When enabled, this option causes events to automatically restart, without manual intervention, if the media has been recued.
    When this option is disabled, the automation system marks the event as missing and does not automatically cue the event when located.
  - **Recue On Media Changes**: (Default: enabled) When enabled, this option causes events to automatically recue if the event’s SOM (start-of-message time), DUR (duration), or New AFD is changed.
    **Note**: The ID Video ARC is reapplied if the event’s New AFD value is changed while the event is CUED.
  - **Rewind Compile Material**: (Default: disabled) When enabled, this option causes compile tapes to rewind to the head of the first spot when finished. The tape is rewound to the first commercial break (or "pod") minus the preroll.
  - **Rewind to First Program Segment**: (Default: enabled) When enabled, this option causes multi-segment programs played out from a VTR or cart machine to rewind to the head of the first program segment when finished. The tape is rewound to the SOM of the first segment minus the preroll.
  - **Update Cued Event on Media Change**: When this parameter is enabled (checked), all of the database derived metadata for any cued events is updated.
    - If ‘Recue on Media Changes’ parameter is enabled, then this parameter is also enabled.
    - If this parameter is enabled, but the ‘Recue on Media Change’ parameter is disabled, then although the event is updated, the device is not recued or otherwise updated.
    **CAUTION**: This configuration scenario can cause unanticipated or invalid behaviors, such as the device and device driver’s head data to get out of sync. To avoid this ensure ‘Recue on Media Changes is also set.
    - If this parameter is disabled, ‘Recue on Media Changes’ must also be disabled and no updates will be applied to cued events.
    - If Auto Ripple is enabled, the start time of the event following the an updated event is also updated.
  - **Update Playing Event on Media Change**: When this parameter is enabled (checked), the system partially updates the metadata of an event that is playing at the time of an update. **The device cannot be recued and the SOM of the event is not updated.**
    - If this parameter is enabled, then ‘Update Cued Event on Media Change’ must also be enabled.
    - If this parameter is enabled, the remaining duration of the event is recalculated on an update. Since the duration of an event decrements while it is playing, the duration is changed by an amount equal to the difference between the original duration and the updated duration.

**WARNING**: If the device is not updated - as in the case of a cued event because Recue on Media Changes is disabled, or in all cases for playing events - and the updated duration is
longer than the duration used to initially cue the device, the device may cease playout at the end of the original duration, even if the event is updated. This typically causes a TapeEnd error and the list skips forward to the next event.

**Extended Time To Next:** (Default: enabled) When enabled, this option enhances the functionality of the time-to-next feature of the Transmission List. Time-to-next values are calculated correctly regardless of whether there is an intervening upcount event.

Enhanced Functionality includes:
- When the termination event is an O (hard start) event the Time To Next display includes the running short value.
- Zero duration up counters do not stop the rippling.
- When in an up counter, if an O event exists as the termination event, the Time To Ext computation computes without any long or short value. It displays exactly how long until the hard timed start begins.

**Release Tension On Record:** (Default: disabled) When enabled, this option, if VTRs or cart machines are assigned to this list as record devices, causes the VTR or cart machine to release tension on the tape when the record event has cued. The tape is re-tensioned at the "standby on" time (see below).

**Rewind Spots:** (Default: enabled) When enabled, this option causes single-spot tapes played out from a VTR or cart machine to rewind to the head of the spot when finished. The tape is rewound to the SOM minus the preroll (on a multi-spot tape, the tape is rewound to the SOM minus the preroll of the last spot played).

**Thread Limited:** (Default: disabled) When enabled, this option changes the cueing behavior of the Transmission List. Events are cued within the specified "thread time", taking into account the duration of events registered with the same media device that cannot be threaded due to a lack of available media heads. This means non-threaded but blue (registered) events count toward the total thread time as if they were threaded.

### Time Parameters:

- **Preroll Seconds:** Define the number of preroll seconds to be used for the selected list. The valid range is 0-59 seconds. Default is 3 seconds.

- **Preroll Frames:** Define the number of preroll frames to be used for the selected list. The valid range is 0-29 frames. Default is 0.

All events on this list will preroll for the time (Seconds/Frames) specified here before switching. The list preroll should equal the preroll time required by the slowest device assigned to the list. For example, if a VTR assigned to this list takes 4 seconds to lock up, the list preroll should be no less than 4 seconds.

**Note:** If a list preroll of less than 3 seconds is used, VTRs assigned to this list will not perform a tape speed override (TSO) when they roll.

Frame-accurate playout from tape cannot be guaranteed if a list preroll of less than 3 seconds is configured. Operators may manually override the list preroll by using the Roll Now button on the control panel. Only events registered with Switch-Only devices or video server decoder ports (if they are configured to support "instant prerolls") may be rolled using the Roll Now button.

- **Postroll Seconds:** Define a length of time, in seconds, the automation system plays the current event beyond its duration if it has not yet switched to the next event. The valid range is 0-59 seconds. Default is 1 second.
- **Postroll Frames**: Define a length of time, in frames, the automation system plays the current event beyond its duration if it has not yet switched to the next event. The valid range is 0-29 frames. Default is 0.

  All events on this list will postroll for the time (Seconds/Frames) specified here after their duration has expired. Events registered with video server decoder ports, if the port has been configured to support a "device postroll", may allow shorter postrolls that the list postroll.

- **StandbyOn Seconds**: This value determines when "standby on" commands are sent to VTRs by specifying the amount of time the automation system keeps the VTR in tension after cueing an event. The valid range is 10-59 seconds. Default is 30 seconds

  If a VTR assigned to this list is configured to perform a "standby off" when a tape has cued - spinning down the video heads and releasing tension on the tape - the tape will be re-tensioned and recued at the "standby on" time.

- **AO Event**: Hard start event (AO)

  - **AO Event Thread Time**: Specify the following thread times:
    - **Cue Seconds**: Specify cue time seconds for the AO event.
    - **Cue Frames**: Specify cue time frames for the AO event.

  - **Thrd AO evnt at last moment**: Check to enable threading of the AO event at the last moment.

    Checked: (Recommended): If another event occupies the same disk head, thread the disk hard start event when the current time is closer to its On Air time than AO Event Thread Time. Checking this box give the maximum tolerance for the list events that in front of the AO events to do playout, and also allows the AO event to successfully register to a disk head to play on time.

    Unchecked: Thread disk hard start event based on thread time. If the disk head is occupied by another event, that event will be ejected.

  - **Only Thread Next AO Event**: Enable / Disable threading of the next event. If multiple Hard-Start (AO) events are within the transmission list lookahead Window:

    Checked: Only thread the next Hard Start event without continuously rippling down to reach next AO event on the same list. Since playlist events often are without On-Air date information, this prevents the next day's AO event (showing later in sequence on the playlist, but with an on-air time earlier than the today's) being Cued first.

    Unchecked: if there are more than one AO event in the future, list will find the earliest timed one as the next AO event to start regardless its position in the list.

    **Recommendation**: Uncheck only when there is a necessary for set AO event out of order.

4. Select the **Options** tab. This tab contains optional configuration settings for GMT lists.
Note: All of the options on this tab may be configured in the Air Client application.

Enable (check)/ Disable (uncheck) and configure the following as required:

- **Options:**
  - **Auto A-B Routing:** (Default: disabled) Enabling this option causes devices to alternate between their primary and secondary audio/video routing paths as configured in this list’s A/V routing table (see below).
    When enabled this setting overrides an event’s channel settings (displayed in Transmission window’s CH column in Air Client). During transmission, successive primary events are routed alternatively through switching channels A and B. This function is useful to ensure that two successive events are not played through the same channel (which is needed when transition effects such as mixes are defined between events). Make sure both A and B channel A/V parameters are configured in all devices that are used.
    
    **Note:** When changing this configuration, existing events on the list, and in particular previously executed events recovered with 'Clear Done Events', may exhibit the previously configured switching behavior.
  - **Auto Ripple Times:** (Default: disabled) Enabling this option causes the time-of-day for events to update automatically, reflecting any changes to event durations made manually. The time "rippling" ends at hard start events. The calculation assumes that the Duration field for up-counting events is accurately set.
  - **Contact Start:** (Default: disabled) Enabling this option allows this list to be rolled via an external GPI contact-closure trigger. The GPI trigger duplicates the function of the Play button on the control panel.
• **Play ID Title Mismatches:** (Default: disabled) This option only applies to systems that include a Sony LMS cart machine. The LMS will not register events if the ID and title on the tapes’ barcode labels do not match the ID and title of the events as they appear on the Transmission list. Enabling this option allows the LMS to register mismatched events.

• **Keep List Threaded:** (Default: disabled) Enabling this option causes the Transmission list to thread and cue as many events as possible within the lookahead. If an event is inserted into the list to be played, the event is immediately cued and subsequent events unthreaded as necessary.

  When enabled, thread time is not used. This option supersedes the Thread Time.

  When disabled, the list only keeps events threaded within the Thread Time window (see below).

  **Logomotion Note:** To ensure all available heads thread normally, enable ‘Keep List Threaded’.

• **Only Swap One Event in A-P:** Enable / disable air protect switching for an event.

  In an Air/Protect configuration, the playlist will play out an event simultaneously from both Air and Protect servers. If the Air Server has a failure or malfunction, the playout server switches event playout to the Protect server and stays there. In many situations, event interruption is only caused by one media, not the entire playout server or port. In this situation, some customers want the playlist to switch back to the previous Air server instead of keeping playout with the Protect server. Checking this option box will

  Checked: Tells the playlist to switch back to the Air Server for normal playout, on conclusion of this trouble event.

  Unchecked: Treat Air and Protect disk equally, assign air or protect disk port to Air column whichever is ready first.

  **Recommendation:** Uncheck when the disk port is the additional port of another video disk.

• **Play Hard Hits:** (Default: disabled) Enabling this option allows an operator to manually override the start time of "hard start" or "hard hit time" events (timed events).

  When disabled, "hard start" events only roll at the time specified in the Transmission list’s Time column.

• **Release Tension When Cued:** (Default: disabled) Enabling this option causes the system to send a "standby off" command to any VTRs when they have cued a tape. The tape is re-tensioned at the standby on time.

• **Skip Bad Events:** (Default: enabled) When enabled this option the Transmission list to ignore and skip a single unregistered (bad) event. The list will continue playing out and mark the bad event as "missed".

  When disabled, the Transmission list stops upon encountering any unregistered event and must be restarted manually.

  **Note:** The Transmission list always stops upon encountering two or more consecutive bad events, whether this option is enabled or not.

• **Station ID On Skip:** (Default: disabled) Enabling this option causes the switcher to switch to the Station ID source (configured in the master control switcher’s configuration GUI) for the duration of the list preroll when an operator has manually skipped an event using the Skip button on the control panel.
• **Switch To Black**: (Default: enabled) When enabled this option causes the master control switcher to take the Black source if the list stops. The Black source must be configured in the master control switcher’s configuration GUI for this to occur.
   
   When disabled (or the Black source not configured), the switcher will remain on the last source taken if the list stops.

• **Tension After Up Counter**: (Default: disabled) Enabling this option causes tape events following an upcount event to remain tensioned. Since the duration of upcount events is, by definition, indeterminate, there may not be time to re-tension a tape if an upcount event ends abruptly. This option allows events from tape to remain ready to roll immediately.

• **Thread After Break**: (Default: enabled) When enabled this option keeps the list threaded while the list has stopped due to encountering a Break event on the list. Break events are secondary events inserted in the list to cause the list to stop temporarily and wait for a Play command from either the control panel or an external GPI trigger.
   
   When disabled, the list must be threaded manually before it can execute a Play command.

• **Timed List**: (Default: enabled) When enabled this option allows the list to roll timed events – hard start or record events – at the time of day specified in the Transmission list’s Time column.
   
   When disabled, timed events will not roll.

• **Update On Air Time**: (Default: disabled) Enabling this option causes the on-air time for events to update to the actual time the event rolled. As-Run logs for the list are updated as well.
   
   When disabled, the As-Run logs reflect the time-of-day that appeared on the Transmission list, rather than the actual time the event rolled.

• **Update Final Upcount Durations**: Check to enable update of the final upcount event duration. This gives an actual duration of how long an event ran.
   
   An upcount event type(U) is used for an event of unknown duration, such as a sporting event or any other live broadcast. During playout, the event’s duration will count down to 00:00:00.00 and then will count back up.
   
   This repeats until terminated by either pressing Play or Skip on the control panel or a contact start is reached. The next event will play normally. Up counters only work on events played from Switch Only devices.

  ▪ **Done Count**: This value sets the number of "done" events that will be displayed at the top of the Transmission list. The Done Count may be set to any value between 1 and the lookahead value minus 1. Default is 4 events.

  **Note**: Never set the Done Count to a value equal to or greater than the lookahead value. Doing so causes the list to eventually run out of valid, registered events and stop.

  ▪ **Thread Time**: This time value determines the time "window" following the on-air event in which events will be threaded. The valid range is from 0 to 23:59:59:29 (23 hours, 59 minutes, 59 seconds, and 29 frames). Default is 2 minutes.

    ▪ Any events within the Thread Time are threaded and cued.

    ▪ If the list option "Keep List Threaded" is enabled, this value is ignored.

  ▪ **Match Primary Duration PT=EOM offset**: This option provides the ability to define an offset time (HH:MM:SS:FF) for the end point of a secondary event PT=, which should end with respect to the primary event. (i.e. The value of EOM offset is used for all PT= secondary events attached to the primary.)
• This parameter affects the timing of every secondary event that uses the "=" modifier.
• When defined the offset should be less than list preroll time.

- **Zero Upcount Durations**: Enable (check)/Disable (uncheck) the ability to zero the initial duration of upcount events
  • If Enabled (checked), the duration of Upcount event will setup to zero automatically before the event starts. The list will be rippled and timed as with estimated duration of this event.
  • If Disabled (unchecked), the behavior of the list will be as normal - upcount events would decrement from whatever duration is scheduled and then upcount from zero.

5. Select the **Events to Log** tab. This tab contains configuration options for the As-Run logs created by the Air Client application.

- By default, not all secondary event types are logged to the As-Run log. Checking the appropriate checkbox on this tab will enable logging of that secondary event type.
- If this Transmission list is to be used as a record list and you require a log of what has been recorded, an As-Run log may be created that includes primary record events. Check the Log Record Events checkbox to enable this.

---

Enable (check)/ Disable (uncheck) the following as required:

- **Secondary Events to Log**: Enable (check)/ Disable (uncheck) the secondary events to log in the As-run log. When all check-boxes are selected (checked), all secondary events associated with a primary are included in the As-Run log.

  For Example: BREAK is disabled and others are enabled – all secondary events except BREAK secondary event are included in the As-run log.
- **Log Record Events**: (Default: disabled) Check to enable logging of record events on normal completion.

6. Select the **GMT** tab.

Configure the following options to enable list linking as required:

- **Skip Events Not Cued**: This option is used for baseband transfer. When selected if the source event does not cue then the source and destination events are automatically marked missed and eventually removed from the GMT list. If the option is not selected then the events remain on the list allowing the operator to intervene in the GMT list and correct the source event so that it can be re-cued.

- **Allow Event Paste From Another GMT List**: Enable (check) / Disable (uncheck) pasting from another GMT list. (Default: Disabled (unchecked)).
  - Enabling (checking) this parameter allows the user to share GMT List load as described below.

In some situations, the user may want a GMT List to share the work of baseband transfers of another GMT List of the same device server.

**For example**: A Cart Machine port can be shared between two GMT Lists. Each GMT list has its own encoders on the same video disk. Event build on one GMT List may not get Cued for transfer because all encoders of this particular GMT List are busy. If the other GMT list has a spare encoder port that can share the baseband media transfer, the user may Cut-and-Paste these events from one busy GMT List to the GMT List that has an available encoder port. The waiting events immediately Cue and start transfer.
**CAUTION:** Event build on a GMT List is done by distributors owned by the GMT List. The transfer of an event on a GMT List often has hidden fields that do not show in the GMT list display window used for editing. Attempting to edit an event on a GMT List can be dangerous. It is not recommended, unless the user really knows what they are doing.

7. Select the **Skip Secondary** tab.

Configure the following options to enable list linking as required:

- **Secondary Events To Skip:** From the list, enable (check) the secondary events to skip. Uncheck to deselect.

8. Select the **Audio Routing** tab. (NEXIO AMP only)

The NEXIO AMP Track Router supports re-mapping audio tracks on playout and recording through use of an Output Audio Mask to identify which tracks should play on which audio channels and Input Mask to identify which input Audio should place on which audio track. These masks are used to set the output port configuration. Primary, secondary, and tertiary tracks may be specified for cases where a backup track should be played if the preferred track (e.g. language) is not present.

Configured options of audio routing are applied to all disk drivers which are assigned to this list. If a driver (of a Video Disk) does not support audio routing (currently audio routing is supported only for NEXIO driver), then audio routing settings does not affect on the driver. Basic operations on audio routing configuration performed by ADC List include:

- Exchange of data on audio masks and audio tags with the List Options configuration.
- Storing information about the current settings of audio routing during Device Server is running, saving the settings in the INI file when the Server is shut down, loading the settings from the INI file when the Server starts.
- Transmission of audio routing settings to the driver, requesting the settings for the drivers.

To Configure Audio Routing:

- Select the Audio Routing tab. On this tab the operator can configure Output Masks (Primary, Secondary, Tertiary) and the Input Mask.
Configure Tag descriptions for Output and Input Masks by selecting a Channel and from the enabled Tag Description drop down menu select from a list of available descriptions.
Configure Type for Input Mask by selecting a Channel and from the enabled Type drop down menu select from a list of available descriptions.

**Configuration Notes:**

**Note:** While the following example screen shots are for Playlist, they reflect the same functionality across all other lists.

- No device, which supports Audio Routing, is assigned to a List. If no device can provide audio tag descriptions, Tags List will contain conditional strings defining the tag numbers.
An audio mask can be edited and will be automatically applied when a device with Audio Routing support is assigned to the list.

- One device (one IP) which supports Audio Routing is assigned to the List.
  - During initialization List reads saved Audio Routing settings from INI and sets up this settings to assigned device (to all their ports).
  - Every device which supports Audio Routing has to store list of descriptions of audio tags. When an operator opens the List Properties form, the List queries the list of descriptions from the device and passes it to the form to display.
  - If an operator changes primary, secondary, ternary, Input audio mask of tags and Input audio mask of types, then these changes are applied to the device. If the device isn’t connected, then the changes are applied after connect.

- Two or more devices (with different IP) which support Audio Routing are assigned to the List.
  - The behavior in this scenario is similar to the One device (one IP) case, except:
    - After reading Audio Routing settings from INI, the List will set up these settings to all devices, assigned to this list.
    - List queries the list of descriptions from the first device which is assigned to this list.
    - If an operator changed primary, secondary, ternary, Input audio mask of tags and Input audio mask of types, then these changes are applied to the all devices, assigned to this list.

- Stopping the server. On closing the Server, ADC list saves audio masks to the ADC INI. Tag descriptions aren’t saved.

- Input Audio Masks include 2 masks: mask of tags and mask of audio types. The list of audio types retrieves from the device similarly audio tags list (FillAudioTypes function is used). NEXIO supports five audio types: PCM, Neutral/DTC, Dolby-Digital/AC3, Dolby-E, MPEG1 LayerI/II. Usually audio tags include an audio type name. In this case, after assigning some tag to audio channel, the audio type is set automatically for this channel, but this type is still available for editing.
Note: The audio type has to meet the audio tag for similar audio channel.

9. When finished click OK, and then Apply.

**Configuring Compile List Options**

Compile lists are used by the optional compiler function. The compiler allows operators to create compile reels or "spot reels" from play list files. Play list files, after some modification, may be loaded into the Compiler window and run in a similar way to a Transmission list. Only the source and destination devices for the compiler need be assigned to the Compile list.

**To Configure Compile List Options**

A number of options may configured to control the behavior of Compile Lists. These options are accessed from the Configuration Manager's List Assignments window.
1. To access the Compile List options configuration GUI, select a Compile List in the Lists pane.

2. Right-click on the entry and then from the pop-up menu select Properties. The Configuration window opens with multiple tab selections. The options configured on these tabs apply to this list only. Configuration options for other lists must be configured separately.

3. Select the Parameters tab. This tab contains general configuration options for Compile Lists. Some options are commonly used and enabled by default.

Configure the following options as required:
IMPORTANT: While the configuration options **Always Allow Recue Following an Upcount** and **Block Recue Following an Upcount** are currently shown as available for Media List, GMT List, and Compile List types, they are not recommended for use with these lists.

- **Name**: Enter a name for this List. List names are limited to 32 characters.
- **Options**:
  - **Auto Restart When Cued**: (Default: disabled) When enabled, this option causes events to automatically restart, without manual intervention, if the media has been recued. When this option is disabled, the automation system marks the event as missing and does not automatically cue the event when located.
  - **Recue On Media Changes**: (Default: enabled) When enabled, this option causes events to automatically recue if the event’s SOM (start-of-message time), DUR (duration), or New AFD is changed.

  **Note**: The ID Video ARC is reapplied if the event’s New AFD value is changed while the event is CUED.

  - **Rewind Compile Material**: (Default: disabled) When enabled, this option causes compile tapes to rewind to the head of the first spot when finished. The tape is rewound to the first commercial break (or "pod") minus the preroll.
  - **Rewind to First Program Segment**: (Default: enabled) When enabled, this option causes multi-segment programs played out from a VTR or cart machine to rewind to the head of the first program segment when finished. The tape is rewound to the SOM of the first segment minus the preroll.
  - **Update Cued Event on Media Change**: When this parameter is enabled (checked), all of the database derived metadata for any cued events is updated.
    - If ‘Recue on Media Changes’ parameter is enabled, then this parameter is also enabled.
    - If this parameter is enabled, but the ‘Recue on Media Change’ parameter is disabled, then although the event is updated, the device is not recued or otherwise updated.

  **CAUTION**: This configuration scenario can cause unanticipated or invalid behaviors, such as the device and device driver’s head data to get out of sync. To avoid this ensure ‘Recue on Media Changes is also set.
    - If this parameter is disabled, ‘Recue on Media Changes’ must also be disabled and no updates will be applied to cued events.
    - If Auto Ripple is enabled, the start time of the event following the an updated event is also updated.
  - **Update Playing Event on Media Change**: When this parameter is enabled (checked), the system partially updates the metadata of an event that is playing at the time of an update.
    - **The device cannot be recued and the SOM of the event is not updated.**
      - If this parameter is enabled, then ‘Update Cued Event on Media Change’ must also be enabled.
      - If this parameter is enabled, the remaining duration of the event is recalculated on an update. Since the duration of an event decrements while it is playing, the duration is changed by an amount equal to the difference between the original duration and the updated duration.

  **WARNING**: If the device is not updated - as in the case of a cued event because Recue on Media Changes is disabled, or in all cases for playing events - and the updated duration is
longer than the duration used to initially cue the device, the device may cease playout at the end of the original duration, even if the event is updated. This typically causes a TapeEnd error and the list skips forward to the next event.

**Extended Time To Next:** (Default: enabled) When enabled, this option enhances the functionality of the time-to-next feature of the Transmission List. Time-to-next values are calculated correctly regardless of whether there is an intervening upcount event.

Enhanced Functionality includes:
- When the termination event is an O (hard start) event the Time To Next display includes the running short value.
- Zero duration up counters do not stop the rippling.
- When in an up counter, if an O event exists as the termination event, the Time To Ext computation computes without any long or short value. It displays exactly how long until the hard timed start begins.

**Release Tension On Record:** (Default: disabled) When enabled, this option, if VTRs or cart machines are assigned to this list as record devices, causes the VTR or cart machine to release tension on the tape when the record event has cued. The tape is re-tensioned at the "standby on" time (see below).

**Rewind Spots:** (Default: enabled) When enabled, this option causes single-spot tapes played out from a VTR or cart machine to rewind to the head of the spot when finished. The tape is rewound to the SOM minus the preroll (on a multi-spot tape, the tape is rewound to the SOM minus the preroll of the last spot played).

**Thread Limited:** (Default: disabled) When enabled, this option changes the cueing behavior of the Transmission List. Events are cued within the specified "thread time", taking into account the duration of events registered with the same media device that cannot be threaded due to a lack of available media heads. This means non-threaded but blue (registered) events count toward the total thread time as if they were threaded.

### Time Parameters
- **Preroll Seconds:** Define the number of preroll seconds to be used for the selected list. The valid range is 0-59 seconds. Default is 3 seconds.
- **Preroll Frames:** Define the number of preroll frames to be used for the selected list. The valid range is 0-29 frames. Default is 0.

All events on this list will preroll for the time (Seconds/Frames) specified here before switching. The list preroll should equal the preroll time required by the slowest device assigned to the list. For example, if a VTR assigned to this list takes 4 seconds to lock up, the list preroll should be no less than 4 seconds.

**Note:** If a list preroll of less than 3 seconds is used, VTRs assigned to this list will not perform a tape speed override (TSO) when they roll.

Frame-accurate playout from tape cannot be guaranteed if a list preroll of less than 3 seconds is configured. Operators may manually override the list preroll by using the Roll Now button on the control panel. Only events registered with Switch-Only devices or video server decoder ports (if they are configured to support "instant prerolls") may be rolled using the Roll Now button.

**Postroll Seconds:** Define a length of time, in seconds, the automation system plays the current event beyond its duration if it has not yet switched to the next event. The valid range is 0-59 seconds. Default is 1 second.
- **Postroll Frames**: Define a length of time, in frames, the automation system plays the current event beyond its duration if it has not yet switched to the next event. The valid range is 0-29 frames. Default is 0.

  All events on this list will postroll for the time (Seconds/Frames) specified here after their duration has expired. Events registered with video server decoder ports, if the port has been configured to support a "device postroll", may allow shorter postrolls that the list postroll.

- **StandbyOn Seconds**: This value determines when "standby on" commands are sent to VTRs by specifying the amount of time the automation system keeps the VTR in tension after cueing an event. The valid range is 10-59 seconds. Default is 30 seconds.

  If a VTR assigned to this list is configured to perform a "standby off" when a tape has cued - spinning down the video heads and releasing tension on the tape - the tape will be re-tensioned and recued at the "standby on" time.

- **AO Event**: Hard start event (AO)

  - **AO Event Thread Time**: Specify the following thread times:
    - **Cue Seconds**: Specify cue time seconds for the AO event.
    - **Cue Frames**: Specify cue time frames for the AO event.

  - **Thrd AO evnt at last moment**: Check to enable threading of the AO event at the last moment.

    Checked: (Recommended): If another event occupies the same disk head, thread the disk hard start event when the current time is closer to its On Air time than AO Event Thread Time. Checking this box give the maximum tolerance for the list events that in front of the AO events to do playout, and also allows the AO event to successfully register to a disk head to play on time.

    Unchecked: Thread disk hard start event based on thread time. If the disk head is occupied by another event, that event will be ejected.

  - **Only Threa AO event**: Enable / Disable threading of the next event. If multiple Hard-Start (AO) events are within the transmission list lookahead Window:

    Checked: Only thread the next Hard Start event without continuously rippling down to reach next AO event on the same list. Since playlist events often are without On-Air date information, this prevents the next day’s AO event (showing later in sequence on the playlist, but with an on-air time earlier than the today’s) being Cued first.

    Unchecked: if there are more than one AO event in the future, list will find the earliest timed one as the next AO event to start regardless its position in the list.

    **Recommendation**: Uncheck only when there is a necessary for set AO event out of order.

4. Select the **Options** tab. This tab contains optional configuration settings for Compile lists.
Note: All of the options on this tab may be configured in the Air Client application.

Enable (check)/ Disable (uncheck) and configure the following as required:

- **Options:**
  - **Auto A-B Routing:** (Default: disabled) Enabling this option causes devices to alternate between their primary and secondary audio/video routing paths as configured in this list’s A/V routing table (see below).
    
    When enabled this setting overrides an event’s channel settings (displayed in Transmission window’s CH column in Air Client). During transmission, successive primary events are routed alternatively through switching channels A and B. This function is useful to ensure that two successive events are not played through the same channel (which is needed when transition effects such as mixes are defined between events). Make sure both A and B channel A/V parameters are configured in all devices that are used.

  **Note:** When changing this configuration, existing events on the list, and in particular previously executed events recovered with 'Clear Done Events', may exhibit the previously configured switching behavior.

  - **Auto Ripple Times:** (Default: disabled) Enabling this option causes the time-of-day for events to update automatically, reflecting any changes to event durations made manually. The time "rippling" ends at hard start events. The calculation assumes that the Duration field for up-counting events is accurately set.

  - **Contact Start:** (Default: disabled) Enabling this option allows this list to be rolled via an external GPI contact-closure trigger. The GPI trigger duplicates the function of the Play button on the control panel.
- **Play ID Title Mismatches**: (Default: disabled) This option only applies to systems that include a Sony LMS cart machine. The LMS will not register events if the ID and title on the tapes’ barcode labels do not match the ID and title of the events as they appear on the Transmission list. Enabling this option allows the LMS to register mismatched events.

- **Keep List Threaded**: (Default: disabled) Enabling this option causes the Transmission list to thread and cue as many events as possible within the lookahead. If an event is inserted into the list to be played, the event is immediately cued and subsequent events unthreaded as necessary.

  When enabled, thread time is not used. This option supersedes the Thread Time. When disabled, the list only keeps events threaded within the Thread Time window (see below).

  _Logomotion Note:_ To ensure all available heads thread normally, enable ‘Keep List Threaded’.

- **Only Swap One Event in A-P**: Enable / disable air protect switching for an event.

  In an Air/Protect configuration, the playlist will play out an event simultaneously from both Air and Protect servers. If the Air Server has a failure or malfunction, the playout server switches event playout to the Protect server and stays there. In many situations, event interruption is only caused by one media, not the entire playout server or port. In this situation, some customers want the playlist to switch back to the previous Air server instead of keeping playout with the Protect server. Checking this option box will

  Checked: Tells the playlist to switch back to the Air Server for normal playout, on conclusion of this trouble event.

  Unchecked: Treat Air and Protect disk equally, assign air or protect disk port to Air column whichever is ready first.

  _Recommendation:_ Uncheck when the disk port is the additional port of another video disk.

- **Play Hard Hits**: (Default: disabled) Enabling this option allows an operator to manually override the start time of "hard start" or "hard hit time" events (timed events).

  When disabled, "hard start" events only roll at the time specified in the Transmission list’s Time column.

- **Release Tension When Cued**: (Default: disabled) Enabling this option causes the system to send a "standby off" command to any VTRs when they have cued a tape. The tape is re-tensioned at the standby on time.

- **Skip Bad Events**: (Default: enabled) When enabled this option the Transmission list to ignore and skip a single unregistered (bad) event. The list will continue playing out and mark the bad event as "missed".

  When disabled, the Transmission list stops upon encountering any unregistered event and must be restarted manually.

  _Note:_ The Transmission list always stops upon encountering two or more consecutive bad events, whether this option is enabled or not.

- **Station ID On Skip**: (Default: disabled) Enabling this option causes the switcher to switch to the Station ID source (configured in the master control switcher’s configuration GUI) for the duration of the list preroll when an operator has manually skipped an event using the Skip button on the control panel.
• **Switch To Black**: (Default: enabled) When enabled this option causes the master control switcher to take the Black source if the list stops. The Black source must be configured in the master control switcher’s configuration GUI for this to occur.

When disabled (or the Black source not configured), the switcher will remain on the last source taken if the list stops.

• **Tension After Up Counter**: (Default: disabled) Enabling this option causes tape events following an upcount event to remain tensioned. Since the duration of upcount events is, by definition, indeterminate, there may not be time to re-tension a tape if an upcount event ends abruptly. This option allows events from tape to remain ready to roll immediately.

• **Thread After Break**: (Default: enabled) When enabled this option keeps the list threaded while the list has stopped due to encountering a Break event on the list. Break events are secondary events inserted in the list to cause the list to stop temporarily and wait for a Play command from either the control panel or an external GPI trigger.

• **Timed List**: (Default: enabled) When enabled this option allows the list to roll timed events — hard start or record events — at the time of day specified in the Transmission list’s Time column.

When disabled, timed events will not roll.

• **Update On Air Time**: (Default: disabled) Enabling this option causes the on-air time for events to update to the actual time the event rolled. As-Run logs for the list are updated as well.

When disabled, the As-Run logs reflect the time-of-day that appeared on the Transmission list, rather than the actual time the event rolled.

When disabled, the list must be threaded manually before it can execute a Play command.

• **Update Final Upcount Durations**: Check to enable update of the final upcount event duration. This gives an actual duration of how long an event ran.

An upcount event type(U) is used for an event of unknown duration, such as a sporting event or any other live broadcast. During playout, the event’s duration will count down to 00:00:00.00 and then will count back up.

This repeats until terminated by either pressing Play or Skip on the control panel or a contact start is reached. The next event will play normally. Up counters only work on events played from Switch Only devices.

- **Done Count**: (This option is grayed out) This value sets the number of "done" events that will be displayed at the top of the Transmission list. The Done Count may be set to any value between 1 and the lookahead value minus 1. Default is 4 events.

**Note:** Never set the Done Count to a value equal to or greater than the lookahead value. Doing so causes the list to eventually run out of valid, registered events and stop.

- **Thread Time**: This time value determines the time "window" following the on-air event in which events will be threaded. The valid range is from 0 to 23:59:59:29 (23 hours, 59 minutes, 59 seconds, and 29 frames). Default is 2 minutes.

  - Any events within the Thread Time are threaded and cued.
  - If the list option "Keep List Threaded" is enabled, this value is ignored.

- **Match Primary Duration PT=EOM offset**: This option provides the ability to define an offset time (HH:MM:SS:FF) for the end point of a secondary event PT=, which should end with respect to the primary event. (i.e. The value of EOM offset is used for all PT= secondary events attached to the primary.)
- This parameter affects the timing of every secondary event that uses the "=" modifier.
- When defined the offset should be less than list preroll time.

- **Zero Upcount Durations**: Enable (check)/Disable (uncheck) the ability to zero the initial duration of upcount events
  - If Enabled (checked), the duration of Upcount event will setup to zero automatically before the event starts. The list will be rippled and timed as with estimated duration of this event.
  - If Disabled (unchecked), the behavior of the list will be as normal - upcount events would decrement from whatever duration is scheduled and then upcount from zero.

5. Select the **Lookahead** tab. This tab contains the configuration options for this Transmission list’s lookahead.

![Configuration Options](image)

Configure the following options as required:

- **Count Lookahead**: (Default: 50 events.) If the Duration Based Lookahead checkbox is unchecked, the Transmission list will use a count-based (or event-based) lookahead. The list looks ahead a fixed number of events from the top of the list. This lookahead value includes the on-air event and the Done Count.
  - This value may be configured in the Air Client application also.

- **Report Missing Media**: Enable (check) this option to allow sending missing media error message out on Automation LAN. If there an ADC SNMP-Agent client is running on the Automation LAN, it will detect these error messages, and forward them to remote SNMP Manager program for remote monitoring of playlist missing media alerts.
Report GMT Requested Media: (Active when ‘Report Missing Media Within LookAhead’ is selected.) If the Missing media is currently requested through ADC GMT system, enable (check) this box to allow the missing media error message to be correctly reported to the remote SNMP Manager program through ADC SNMP-Agent program.

6. Select the Events to Log tab. This tab contains configuration options for the As-Run logs created by the Air Client application.
   - By default, not all secondary event types are logged to the As-Run log. Checking the appropriate checkbox on this tab will enable logging of that secondary event type.
   - If this Transmission list is to be used as a record list and you require a log of what has been recorded, an As-Run log may be created that includes primary record events. Check the Log Record Events checkbox to enable this.

   ![List Options CompileList 23](image)

   Enable (check)/ Disable (uncheck) the following as required:
   - Secondary Events to Log:
     - Enable (check)/ Disable (uncheck) the secondary events to log in the As-run log. When all check-boxes are selected (checked), all secondary events associated with a primary are included in the As-Run log.
     - For Example: BREAK is disabled and others are enabled – all secondary events except BREAK secondary event are included in the As-run log.
   - Log Record Events: (Default: disabled) Check to enable logging of record events on normal completion.

7. Select the Compiler tab. The Compiler function is an option that may be purchased separately for your Automation system.
IMPORTANT: This option is only available if the optional compiler function has been purchased.

Configure the following options as required:

- **Skip Missing Material**: (Default: disabled) The compiler leaves space for events in a pod that are not currently available to be compiled. It then continues to compile the pod around the missing material. If you enable this option and then later change the duration of any of the missing items of material you will have to recompile the remainder of the pod after the event whose duration changed.

- **Log Errors**: (Default: disabled) Check this box to cause all compile errors to be recorded into a logfile.

- **Time Parameters**:
  - **SOM**: Specify a Start Of Message (SOM) value for the compile tape. Default is 00:01:00:00.
  - **Tape Length**: This is the duration of the compile tape. Default is 01:30:00:00.
  - **Break Gap**: The distance between the end of black on one pod and the start of black on the next pod. Default is 00:30:00:00.
  - **Black In**: The amount of pre-black to record on the tape before recording the first compiled event. Default is 00:00:05:00.
  - **Black Out**: The amount of post-black to record on the tape after recording the last event in a compiled pod. Default is 00:00:05:00.
8. **Select the Skip Secondary tab.**

Configure the following options to enable list linking as required:

- **Skip Secondary Event after Primary Event is Skipped**: Check to enable skip.
- **Secondary Events To Skip**: From the list, enable (check) the secondary events to skip. Uncheck to deselect.

9. **Select the Audio Routing tab. (NEXIO AMP only)**

The NEXIO AMP Track Router supports re-mapping audio tracks on playout and recording through use of an Output Audio Mask to identify which tracks should play on which audio channels and Input Mask to identify which input audio should place on which audio track. These masks are used to set the output port configuration. Primary, secondary, and tertiary tracks may be specified for cases where a backup track should be played if the preferred track (e.g., language) is not present.

Configured options of audio routing are applied to all disk drivers which are assigned to this list. If a driver (of a Video Disk) does not support audio routing (currently audio routing is supported only for NEXIO driver), then audio routing settings does not affect on the driver. Basic operations on audio routing configuration performed by ADC List include:

- Exchange of data on audio masks and audio tags with the List Options configuration.
- Storing information about the current settings of audio routing during Device Server is running, saving the settings in the INI file when the Server is shut down, loading the settings from the INI file when the Server starts.
Transmission of audio routing settings to the driver, requesting the settings for the drivers.

To Configure Audio Routing:

- Select the Audio Routing tab. On this tab the operator can configure Output Masks (Primary, Secondary, Tertiary) and the Input Mask.
Configure Tag descriptions for Output and Input Masks by selecting a Channel and from the enabled Tag Description drop down menu select from a list of available descriptions.
Configure Type for Input Mask by selecting a Channel and from the enabled Type drop down menu select from a list of available descriptions.

- **Configuration Notes:**
  
  **Note:** While the following example screen shots are for Playlist, they reflect the same functionality across all other lists.

- No device, which supports Audio Routing, is assigned to a List. If no device can provide audio tag descriptions, Tags List will contain conditional strings defining the tag numbers.
An audio mask can be edited and will be automatically applied when a device with Audio Routing support is assigned to the list.

- One device (one IP) which supports Audio Routing is assigned to the List.
  - During initialization List reads saved Audio Routing settings from INI and sets up this settings to assigned device (to all their ports).
  - Every device which supports Audio Routing has to store list of descriptions of audio tags. When an operator opens the List Properties form, the List queries the list of descriptions from the device and passes it to the form to display.
  - If an operator changes primary, secondary, ternary, Input audio mask of tags and Input audio mask of types, then these changes are applied to the device. If the device isn’t connected, then the changes are applied after connect.
- Two or more devices (with different IP) which support Audio Routing are assigned to the List.
  - The behavior in this scenario is similar to the One device (one IP) case, except:
    - After reading Audio Routing settings from INI, the List will set up these settings to all devices, assigned to this list.
    - List queries the list of descriptions from the first device which is assigned to this list.
    - If an operator changed primary, secondary, ternary, Input audio mask of tags and Input audio mask of types, then these changes are applied to the all devices, assigned to this list.
- Stopping the server. On closing the Server, ADC list saves audio masks to the ADC INI. Tag descriptions aren’t saved.

Input Audio Masks include 2 masks: mask of tags and mask of audio types. The list of audio types retrieves from the device similarly audio tags list (FillAudioTypes function is used). NEXIO supports five audio types: PCM, Neutral/DTC, Dolby-Digital/AC3, Dolby-E, MPEG1 LayerI/Ii. Usually audio tags include an audio type name. In this case, after assigning some tag to audio channel, the audio type is set automatically for this channel, but this type is still available for editing.
**Note:** The audio type has to meet the audio tag for similar audio channel.

10. When finished click **OK**, and then **Apply**.

### About Breakaway Lists

A common requirement across the majority of the markets that ADC serves is to be able to break away from scheduled programming to an alternate source or material when required and subsequently continue the original schedule. Perhaps the most common example is a breaking news story, but there are other scenarios such as a live event running beyond its scheduled period.

The ADC AirFlex function makes use of ADC’s fundamental method of operation - a play list of sequential events loaded into a Transmission List, with devices assigned to the Transmission List - to provide an automated JIP process using a Break-away panel.

The ADC AirFlex function uses a breakaway list to manage the current schedule during the breakaway process. Associated with a Transmission List, the breakaway list operates as a background process for moving off the current scheduled programming while the breakaway sequence is in progress and then moving back onto the current schedule when rejoined.

**Note:** ADC AirFlex is provided as a standard feature of ADC and does not require purchase. However, prior to its use the correct number of Breakaway lists and Breakaway objects must be set for your implementation. If this is not done, the AirFlex functionality will not work. Contact Automation Support to ensure AirFlex functionality is correctly enabled for your system. If AirFlex is not enabled, the Breakaway panel will appear grayed out on the ribbon bar and there will be no operational impact on your system.

**Reference Note:** For details on ADC AirFlex overview, operations, and setup see the *ADC AirFlex Reference Guide*.  

© 2017 Imagine Communications Corp. Proprietary and Confidential.  
4/11/2017 | Page 442
To View Breakaway Lists in the Config Tool

The following information is provided for reference purposes. With the initial implementation of the AirFlex functionality, if ADC AirFlex functionality is enabled and properly set up on your system, Breakaway Lists are visible in the List Assignments window, but are not accessible as no configuration is necessary at this time.

**IMPORTANT:** Breakaway Lists and Breakaway Devices will not be added to Device Server configurations without prior consultation. Contact Automation Support for assistance.

**Note:** While Breakaway Lists do not count towards the maximum number of allowed lists, Breakaway Devices do occupy device channels and count towards the 128 device maximum. However, they do not require a serial port and do not count towards the limit of 64. Breakaway Devices require no configuration other than assignment to a Breakaway List.

**Reference Note:** For information on assigning a Breakaway Device to a Breakaway list, reference section: Configuring Device Assignments > Assigning a Breakaway Device to a Breakaway List (see "Assigning a Breakaway Device to a Breakaway List" on page 357).

1. To display available Breakaway Lists, from the main menu select **File > List Configurations** OR Right-click on the name of the Device Server and from the pop-up menu select "List Configurations.

2. In the List Assignments window scroll to the bottom of the Lists pane.

---

About Runway Lists

Runway lists are a special category list type used with the Protect Pool Devices.

**IMPORTANT:** Using Hold or Freeze while using Protect Pool is not supported.
**IMPORTANT:** Assigning a Media source to a runway list is not supported.

**Operation**

The maximum number of runway lists (4) is defined in "Userconc.inc" file as: MAXRUNWAYLISTS=4.

**Note:** See also N+1 Video Server Redundancy Configuration (Virtual Pool Driver).
1. Only runway lists are available on "Runway Lists" tab of Pool Driver properties dialog.

2. A runway list is available in Air Client as a generic transmission list. It is possible to watch events on it. However it is protected against an operator’s manual intervention. The following manual actions are prohibited on this list type:
   - insert, revise, edit, delete an event
   - load, insert, append a list
open the control panel
Configuring Audio / Video Routing Tables

About AV Routing Tables

One of the key features of the Automation system is its ability to automatically route audio and video streams for events on Transmission lists. Every media device assigned to a Transmission list may have an associated audio/video routing path specified.

- The A/V path is list-specific, so a device that is assigned to different lists for different purposes may have a different A/V path specified for each list.
- The A/V routing tables also contain alternate A/V paths for devices, and a Protect A/V path for use with Air and Protect.

The Audio/Video routing tables must be correctly configured for the automation to correctly route audio and video for devices. Each playlist (or media list or GMT list) may have designated routing paths for all devices in the system, including devices that may not be currently assigned to that list.

To Configure A/V Routing

1. To access the A/V routing tables, open the List Assignments window in the Configuration Manager Tool, and select a Transmission list (PlayList).

2. Right-click on the entry and then from the pop-up menu select Audio Video.

3. On the Audio Video tab configure the following as required:
   - **Device**: The Device drop-down list contains a list of all media devices configured in the automation system. Choose the device for which you wish to configure the A/V routing path for this Transmission list.
   - **Media Head**: The Media Head list will display all available media heads for the selected device. Single-stream devices, such as VTRs or video server ports, will display a single media head. A Multi-stream device, such as a cart machine, will display multiple media heads. The A/V routing path for each media head may be configured separately.
4. Edit the input to, or output from, the media device.
   Select the appropriate button. An easy way to remember which button to click is this:
   - If the device you are configuring is a playout device (an output device), click the **Edit Output** button.
   - If the device is a record device (an input device), click the **Edit Input** button.
   - If the device is to be used as both a playout and record device (such as a VTR), both the input A/V path and output A/V path may be configured.

5. The Crosspoints dialog that opens is the configuration GUI for this device’s A/V routing table for this Transmission list.

**Output Crosspoints Dialog:**

![Output Crosspoints Dialog](image.png)
Input Crosspoints Dialog:

Configure the following as required:

- **Device**: The Device drop-down list refers to the router or switcher device on which the crosspoint will be switched. Select the router or switcher device to which to send commands when this media device rolls an event on the Transmission list.

- **Input Cross Point**: The Input Cross Point field indicates the input on the router or switcher for this media device. For playout devices, this is the input on the router or switcher that receives audio and video from the device. For record devices, this is the input on the router or switcher that is the source for the recording.

- **Output Cross Point**: The Output Cross Point field indicates the output on the router or switcher for this media device. For playout devices, this is the destination on the router or switcher to which the A/V stream from the device will be routed. For record devices, this is the output on the switcher or router that feeds the A/V inputs to the record device.
  - The A path is the default A/V routing path for this device on this Transmission list.
  - The B and C paths are alternate A/V routing paths for this device on this Transmission list. The alternate routing paths are invoked by placing a "B" or "C" in the event’s Ch (channel) column in the Transmission list.

- **Protect**: The Protect path is used in an Air and Protect environment. When configured, this is the A/V routing path for this device when it is acting as a protect device. The output crosspoint is typically configured to feed a control room monitor. In the event of a failure of the Air device, the system will switch the Protect device to air, invoking it’s A path, and invoke the (now failed) Air device’s Protect A/V path, switching its output to a monitor. The Protect A/V path for the Protect device must be similarly configured to switch its output to a monitor under normal circumstances.

6. When finished click **OK**.

To Configure Preview A/V Routing

Use this procedure to review/configure the preview audio/video output for devices.

The preview audio/video configuration applies to a device regardless of which list it is running on. This means that there is only one preview audio/video configuration for device.
1. To access the A/V routing tables, open the List Assignments window in the Configuration Manager Tool, and select a Transmission list (PlayList).

2. From the List Assignments main menu select **File > Preview Audio Video**. The Preview Audio Video dialog is displayed.

3. On the **Preview Audio Video** tab you can review and/or edit the configuration as required:

4. Click the **Edit Output** button.
5. The Preview Audio Video Crosspoints dialog opens. This is the configuration GUI for this device’s preview A/V routing table for this Transmission list.

![Preview Audio Video Crosspoints dialog](image)

6. Configure the preview A/V routing table as required:
   - **Device**: The Device drop-down list refers to the router or switcher device on which the crosspoint will be switched. Select the router or switcher device to which to send commands when this media device rolls an event on the Transmission list.
   - **Input Cross Point**: The Input Cross Point field indicates the input on the router or switcher for this media device. For playout devices, this is the input on the router or switcher that receives audio and video from the device. For record devices, this is the input on the router or switcher that is the source for the recording.
   - **Output Cross Point**: The Output Cross Point field indicates the output on the router or switcher for this media device. For playout devices, this is the destination on the router or switcher to which the A/V stream from the device will be routed. For record devices, this is the output on the switcher or router that feeds the A/V inputs to the record device.
     - The A path is the default A/V routing path for this device on this Transmission list.
     - The B and C paths are alternate A/V routing paths for this device on this Transmission list. The alternate routing paths are invoked by placing a "B" or "C" in the event’s Ch (channel) column in the Transmission list.
   - **Protect**: The Protect path is used in an Air and Protect environment. When configured, this is the A/V routing path for this device when it is acting as a protect device. The output crosspoint is typically configured to feed a control room monitor. In the event of a failure of the Air device, the system will switch the Protect device to air, invoking its A path, and invoke the (now failed) Air device’s Protect A/V path, switching its output to a monitor. The Protect A/V path for the Protect device must be similarly configured to switch its output to a monitor under normal circumstances.

7. When finished click **OK**.
Global Media Transfer

Overview

Global Media Transfer (GMT) is Automation Solutions’ technology for automatically copying media among the devices controlled by the automation system, as it is needed for playout on a Transmission list. If a video server assigned to a Transmission list does not have a piece of media available in its storage collection, GMT will attempt to find the material in other media devices and copy it to the playout video server. This process occurs in the background and requires little or no operator intervention.

Purchase Note: GMT is a for-purchase option to ADC systems. Contact your Automation Sales representative for details.

Reference Note: For more information reference the ADC GMT Configuration and Operations Guide document.

GMT Transfer Modes

GMT supports four transfer modes or mechanisms for copying media: fibrechannel transfers, baseband transfers, archive transfers and wide-area network FTP transfers.

- Fibrechannel transfers – Media may be copied among video servers linked by a fibrechannel connection. Fibrechannel transfers are data transfers of compressed MPEG or JPEG files and occur faster than real time. Fibrechannel transfers may occur between devices controlled by multiple Device Servers.

- Archive transfers – Media may be copied to or from an archive device either by the normal background GMT process, or manually through the Media Client application. Archive transfers are data transfers of compressed MPEG or JPEG files and occur faster than real time. Archive transfers may be "single-hop" or "double-hop" transfers. Single-hop transfers copy the media from the archive directly to the requesting playout video server. Double-hop transfers copy the media from the archive to an intermediate video server, and then execute a fibrechannel transfer from the intermediate video server to the requesting playout video server. Archive transfers may occur between devices controlled by multiple Device Servers.

- Baseband transfers – Media may be copied from a baseband source device, such as a cart machine, VTR or a video server’s decoder port, to a video server’s encoder port. Baseband transfers are real-time transfers. Audio and video are automatically routed from the source device to the destination device according to the A/V routing tables configured for the GMT list. Baseband transfers may be "single-hop" or "double-hop" transfers. Single-hop transfers copy the media from the source device directly to the requesting playout video server. Double-hop transfers copy the media from the source device to an intermediate video server, and then execute a fibrechannel transfer from the intermediate video server to the requesting playout video server. Baseband transfers may only occur between devices controlled by a single Device Server. Only the fibrechannel "hop" of double-hop baseband transfers may occur between devices controlled by multiple Device Servers.
- **WAN FTP transfers** – Media may be copied among video servers using the video server’s native FTP transfer mechanism. This may be accomplished on a local-area or wide-area network. FTP transfers are data transfers of compressed MPEG or JPEG files and may occur faster than real time, depending on the bandwidth available on the wide-area network. Only the local video server, designated as the site manager, need be controlled by a Device Server.

### GMT Components

GMT consists of three fundamental components: Requesters, Distributors and GMT lists.

- **Requesters** – are virtual media devices assigned to a Transmission list and associated with destination devices (playout video servers). Media that is not available in the Requester’s destination device is requested from a Distributor (or Distributors) associated with source devices. Requests are made when events enter the lookahead of a Transmission list and cannot be registered with any of the physical media devices assigned to that list.

- **Distributors** – are virtual media devices assigned to a GMT list and associated with source devices. These source devices may be video server ports, cart machines, VTRs, archives or ProxyFTP devices. Distributors create and run events on the GMT list to accomplish the transfer of media to the requesting destination device. A single distributor can only support a single transfer mode, depending on the type of its associated source device, but may be "pointed to" or linked with other Distributors supporting other transfer modes. By "chaining" Distributors in this manner, search paths may be created to pass requests through a number of Distributors of different types. The first Distributor whose source device contains the requested media will execute a transfer - of that Distributor’s type - to the Requester’s destination device.

- **GMT Lists** – are modified Transmission lists used exclusively by GMT. Distributors assigned to the GMT list will create events to execute transfers of one type or another. Non-real-time transfers (fibrechannel, archive and WAN FTP) are executed by events registered and run by the Distributors. Baseband transfers are created by Distributors but run by the physical media devices assigned to the GMT list.

- **(OPTION) Push Lists** are simply Transmission Lists used for a specific purpose other than on-air playout. Push Lists are used to "push" media from a source device to a destination device ahead of time. Under normal circumstances, Requesters request missing media at roughly the same rate as events enter the lookahead of the requesting Transmission List. GMT is driven by the Transmission List and will fulfill requests for missing media as events undergo the registration process. A Push List allows GMT to move ("push") media in advance of the Transmission List. The traffic department may create a "push list" log consisting of spots needed for air tomorrow. The log file may then be translated into a playlist file by the Traffic Translator and loaded into the Push List.

### A Simple GMT System

The illustration below shows a simple fibrechannel GMT system.

- A Requester assigned to the Transmission List queries the destination device for availability of media. If an ID on the Transmission List cannot be registered by the destination device (because the ID does not exist in the destination device), the Requester passes a request to the Distributor.

- The Distributor is assigned to the GMT List and is in communication with a source device. If the Distributor, after querying its source device, finds that the media is available, it will create an event on the GMT List that will initiate a Fibrechannel transfer.
The Distributor will run the event on the GMT List and the media will be copied from the source device to the destination device. Once the copy process has begun, the source device will inform the system that the media is now available for registration on the Transmission List and playout.
Cloning

Introduction to ADC Cloning

The ADC Device Server v12 application runs on a Device Server chassis consisting of a personal computer installed with automation cards, connectors, network cards, and other peripherals. The operating systems can be Windows 7. Via 422 serial port connectors, the ADC Device Server communicates with and controls up to 68 broadcasting devices. In case of hardware failure, the automation stops functioning.

**Purchase Note:** Cloning is a for-purchase option to Device Server. Contact your Automation Sales representative for details.

**Reference Note:** For more information on Cloning operations reference the *ADC Cloning User Guide_Complete v8* document. For details on setting up the Cloning panel see the *ADC Hardware Control Panels Reference, Cloning panel section.*

For some mission critical TV channels, it is desirable to have a back up ADC Device Server to take over automation control when the main device server fails. For this purpose, in hardware, a relay is used to switch the connection between one of the device servers and the broadcasting devices. The device server pair are called A and B. When A is switched to communicate with the broadcasting devices, for instance, it is called the "Main" device server, and B is called "Clone" device server, and vice versa. The relay has an affiliated cloning control panel for user settings, as illustrated below:

In software, a cloning feature is added to the ADC Device Server application when the USECLONING compiler directive is defined. The feature has two basic functions.

- One is to copy the device status, device storage, list contents, list status, and other state machines from the main device server application to the clone device server application.
- The other is to dynamically maintain the synchronization by means of feedback close control looping.

With both hardware and software implementations, a seamless cloning with transparent switching between A and B device servers is achieved.

**Note:** The cloning feature software is only contained inside the device server application.

**IMPORTANT:** Cloning and List Redundancy are considered mutually exclusive functions.
List Redundancy

About List Redundancy

List Redundancy is an option of the ADC Device Server that is designed to add extra security to the automated broadcast system playout. Since this feature is only useful for the play out, the feature is only applied to transmission lists and not to media lists, GMT lists and so on...

**Purchase Note:** List Redundancy is a for-purchase option to Device Server. Contact your Automation Sales representative for details.

**Reference Note:** For more information reference the *ADC List Redundancy Control Client Reference* document.

**IMPORTANT:** Cloning and List Redundancy are considered mutually exclusive functions.

The List Redundancy Process

List Redundancy uses two Transmission Lists running the same programs in parallel, and independently, from distinct but similar devices (mostly videodisks) - if a problem occurs on one of the redundant lists, due to a device error for instance, the other redundant lists will keep on playing.

These lists can run on two Device Servers (MAIN & BACKUP) simultaneously. To achieve this, both lists must have the same event content, e.g. the lists are mirrored, and must be synchronized to play out events in a synchronous way. The List Redundancy gives a control on the Mirroring and on the Synchronization to the operator.

In order to have both redundant lists mirrored and synchronized, one redundant list has to provide all needed information to the other. So, the list providing information is called the ‘Master List’ and the list receiving information is called the ‘Slave List’. Editing the Air Client connected to the Master List will automatically make the same edits to the Slave list.

- Same program: The List Redundancy guaranties that the Master List is mirrored into the Slave List, and so that both lists have the same content.
- Same running point: The List Redundancy guaranties that Master List and Slave List are synchronized, and so that programs are running the same way.
- Overall control: The List Redundancy gives operators the ability to manually control the above functions.
The following graphic illustrates the List Redundancy process.

1. An operator inserts an event into the Master List.
2. The command is echoed to the related Slave List, if the list content or state has changed.
3. The Slave List refreshes its content.

**Functions**

The List Redundancy provides following major functions:

- **Master List / Slave List**: For a given transmission channel, Master and Slave Lists can use their own controlled devices to do play out, they can also share some of devices (normally assigned to the Master List).

  The Slave List handles the missing media, and keeps the synchronicity with the Master List when the Master List is malfunctioning, and allows the operator to use the Slave List to control program play out.

  **Note**: If an operator attempts to use the Control Panel to edit or control a slave playlist, a warning/error message is displayed indicating the "operation can't be applied to slave list."

- **List Mirroring**: The List Mirroring guaranties that both redundant transmission lists have the same content.

- **List Synchronization**: The List Synchronization guaranties that both redundant transmission lists have the same running point.
Diagnostics and Troubleshooting

Troubleshooting techniques

Once the automation system has been installed and commissioned, there should be very little regular maintenance or troubleshooting necessary to insure continued operation. Occasionally, if upgrades or changes are made to the system, problems can arise which require some investigation.

The automation system provides a number of troubleshooting tools, both as stand-alone applications and built into the Configuration Manager, to aid in troubleshooting problems with the system.

Generally, to diagnose and troubleshoot a problem, it is first necessary to isolate the problem. Is the problem with a component of the automation? Is the problem with the Device Server or one of the client applications? If the problem is with the Device Server, is it a specific component (physical device or device driver) that is the cause of the problem? Were any changes made to the system prior to the appearance of the problem? What did the operator do that preceded the appearance of the problem?

If all else fails, call Automation technical support. For customers who have a current service and support agreement with Imagine Communications, technical support is available 24 hours a day, 7 days a week. A call to technical support during business hours (6AM to 5PM Pacific Time) insures that you will speak to an Automation Solutions’ technical support representative. A call after business hours will be referred to a technical support representative on-call. If the problem is not critical (i.e. it does not affect on-air operations or revenue stream), it is best to postpone a call until business hours. By doing so, it will insure that the full resources of Automation technical support staff will be at your disposal.

Device Server Debugging Logs

To enable the device server debugging logs, you use the key combination of Control + Shift + Alt + Function. Each function key enable/disable a specific log: <Ctrl> + <Shift> + <Alt> + <Fn>

F2 = Enable cloning log

F4 = B: Background performance Log. It log how many times background come in each frame. Usually we don't leave it on in a long time period.

F5 = LR: List Redundancy log.

F6 = HAD: logs background timing and network timing.

F7 = DSK: Video disk log

F8 = API: API log

F9 = TLE: more detail API log, usually we don't leave it on in a long time period. And GMT log

F10 = LST: List log.
Configuration Manager tools

The Configuration Manager application provides a number of troubleshooting tools to diagnose problems with the automation system. All of them may be accessed from the Configured Devices window within the Configuration Manager.

Device Status window

The Device Status window may be accessed from the Configuration Manager or from the Air or Media Client applications. The Device Status window displays the current status of all of the devices configured in the automation system, and is updated dynamically by the Device Server. Of particular note is the status column. It will display a status message for each device in the list. Different devices will display different statuses:

1. In the Configured Devices window, select View > Device Status.

- Normal status: The normal status for an idle video server port is STANDBY. Both heads of a decoder port should display a STANDBY status. Encoder ports normally display a STANDBY status for head 1 and an OFFLINE status for head 2.
  - VTRs, both stand-alone and those within a cart machine, if there is no tape loaded, normally display a status of UNTHRD (unthreaded).
  - Other devices may display a status of STANDBY or may not display any status at all.
  - If the device is currently being used to play out media, a status of PLAY, REW, FFWD, JOG or STOP is normal.
- OFFLINE status: An OFFLINE status for a video server decoder port is usually caused by an incorrect configuration in the Device Server. Re-check the video server port device driver configuration and reinitialize the device if necessary. An OFFLINE status for head 2 of a video server encoder port is normal.
• BUSY status: Occasionally a video server port may display a status of BUSY. This means that the video server is currently performing some background operation and is not able to respond to commands from the automation system. The BUSY status is typically displayed for only a few seconds before it changes back to a STANDBY status. If the video server port remains in a BUSY state for an extended period of time, the port may have "hung" and may require reinitialization.

• NO DEV status: If a device displays a status of NO DEV, this means that there is no communication between the automation system and the device. A NO DEV status is typically caused by a faulty serial cable, or a serial cable that has been incorrectly pinned. Refer to the user notes for the device in question for the correct serial cable pinouts. Some devices require an RS232 to RS422 converter to connect the device to the automation system. This requirement, and the pinouts of the serial cables, will be noted in the user notes. If the serial cable is found to have been correctly made, then the device itself has stopped communicating with the automation system and may have failed.

• No Comm status: A status of No Comm indicates that a serial port on the Device Server has not yet been assigned for this device. Check the device configuration and assign a serial communications port for the device.

• Unknown status: If a device displays a status of Unknown, it is typically caused by a mismatch in the communication parameters for the serial port. Most device drivers in the automation system do not allow changes in the communication parameters (Baud rate, stop bits, data bits, parity). Check the communication parameters for the device’s serial port and ensure that they match the Device Server’s requirements. Again, this information may be found in the user notes for the device in question.

**GPI diagnostics**

The status and functionality of GPI cards installed in the Device Server may be checked from the Configuration Manager as well.

1. In the Configured Devices window, select View / GPI Card 1, 2, 3 or 4.
2. Clicking on one of the GPI Card menu items will open a diagnostic utility.

3. Placing a check mark in the appropriate check box will close the GPI contacts for the selected GPI card and relay. An ohmmeter connected to the NO or NC and COMMON pins on the GPI breakout panel may be used to check whether the relay is open or closed.

Real-time diagnostic traces

The Configuration Manager provides a means of capturing and displaying the data traffic to and from certain devices on a dynamic real-time basis. Devices that currently support this diagnostic feature include GMT Distributors, archive devices and ProxyFTP devices. The diagnostic windows for these devices may be opened in one of two states: modal and modeless. Select the device in question in the list of devices in the Configured Devices window. Right-click and select Properties. This opens the configuration GUI for the device. Click on the Diagnostics tab within the GUI. This displays the diagnostics window in modal state; only one modal-state diagnostic window may be displayed at a time.

Alternately, select the device in question in the Configured Devices window, right-click and select Diagnostics. This will open the diagnostics window for the device in modeless state. Several devices may be monitored simultaneously in modeless state, and the Configured Devices window may be minimized to reduce desktop clutter.

If a diagnostics window is opened in modeless state, a text log file will be created on the PC running the Configuration Manager in the C:\CONFIG\LOG folder. This log file may be emailed to automation technical support for assistance in diagnosing problems with your system.

Distributor diagnostics

1. To check the current status of a GMT Distributor, its diagnostics window may be opened in either modal or modeless state. In the Configured pane (Left pane) Right click on the Distributor and from the popup select Diagnostics.

Three options are available for tracing the status of a Distributor: Event Log, ID Trace and Buffer Dump.
2. Select **Event Log**: An event log is a real-time status display for the Distributor. As requests are processed by the Distributor, the RunState Status pane will update dynamically and display the current status of the operation.

This logs all internal ID events that occur in a Distributor. This event log provides information about how many events are holding in a Distributor and where they are internally. If the selected Distributor is currently transferring media, its ID name and its running states are recorded in the Run State Status. The user can check out what running state for an ID was last in if the Distributor doesn’t work.

- If the diagnostics window has been opened in modeless state, the data written to the RunState Status window will also be written to the text log file.
- A Reinitialize button is also available in Event Log mode. Clicking Reinitialize will clear the Distributor’s collection of pending requests and reset all of its internal variables to zero. Any pending requests on the Transmission List will be marked FAILED.
3. Select **ID Trace**. When selected, the diagnostics window will display an Input ID / Segment field. This logs a specified ID event and shows how it goes through a Distributor internally. It provides useful information for engineers to diagnose a troubled event and identify what states an ID has gone through within the Distributor.

- Enter an ID you wish to trace in the Input ID field (and a segment number if this is a multi-segment ID) and click Start Trace.
- The current status of the ID will be displayed in the RunState Status pane. If the diagnostics window has been opened in modeless state, the status will be written to the text log file as well.
4. Select **Buffer Dump**. This is used to dump out all event IDs that are currently holding in the internal buffer of a Distributor. If a Distributor is not working correctly, and it still holds some IDs within its internal buffer, this may prevent the same ID to be sent in. The user can use this function to dump out these IDs and analyze what caused this problem.

- Click the Start Dump button and the Distributor will write the contents of its buffer to the RunState Status pane.
- This action does not clear the contents of the Distributor’s buffer – that can only be accomplished by clicking the Reinitialize button. If the diagnostics window has been opened in modeless state, the buffer data will be written to the text log file as well.

5. When finished click **Close**.

**Diagnostic log file**

The diagnostic function generates log files as long as the Diagnostic tab sheet is displayed on the screen. This file is created on the same computer that is running the ADC1000NT Configuration Manager program. It is created under a "\log" sub-directory in the same directory, which contains ADCNTCFG.exe. The log file name has the following general structure:

```
Device name + Channel number + 'Diagnostics'+ Current Date + '.Log'
```

For example, a diagnostic log file with the following file name will be created for DISTR20, which is occupied channel 20:

```
DISTR20 - Channel 20 - Diagnostics 2002-07-29.log
```

Please contact your Automation Technical Support Representative for assistance in reading this log!!
Archive diagnostics

Archive devices’ configuration GUIs have a modal or modeless diagnostics window available as well.

1. Select the archive device in the Configured Devices pane (left pane).
2. Right-click and from the popup menu select **Diagnostics**. This opens the archive device’s diagnostics window in modeless state.

   - The diagnostics window displays the current real-time status of the archive device and log all communication between the Device Server and the archive manager.
   - If the diagnostics window is opened in modeless state, the contents of the diagnostics window are written to a text log file in the C:\CONFIG\LOG folder of the Configuration Manager PC.
3. When finished click **Close**.

ProxyFTP diagnostics

ProxyFTP devices’ configuration GUIs have a modal or modeless diagnostics window available as well.

1. Select the **ProxyFTP** device in the Configured Devices pane (left pane).
2. Right-click and from the popup menu select **Diagnostics**. This opens the ProxyFTP device’s diagnostics window in modeless state.

   - The diagnostics window displays the current real-time status of the ProxyFTP device and log all communication between the Device Server and the video server managing FTP transfers.
   - If the diagnostics window is opened in modeless state, the contents of the diagnostics window are written to a text log file in the C:\CONFIG\LOG folder of the Configuration Manager PC.
3. When finished click **Close**.
VDCP diagnostics

Tracing the port of a VDCP object through the Configuration Tool provides a simpler method of diagnostic tracing. Rather than using the Diagmon trace program used to generate traces, and the Trace Viewer to open them, the Configuration Tool has an additional control in its diagnostic mode to allow tracing of the VDCP communications. This gives more intelligent filtering of the data logged in order to limit the amount data produced in the log. VDCP devices’ configuration GUIs have a modal or modeless diagnostics window available as well.

Diagnostics tab

1. Select the VDCP device in the Configured Devices pane (left pane).
2. From the Configuration Manager main menu select File > Properties
3. Scroll right to select the Diagnostics tab.

![Diagnostics tab image]

4. When finished click Cancel.

Diagnostics Window

1. Select the VDCP device in the Configured Devices pane (left pane).
2. Right-click and from the popup menu select Diagnostics. This opens the device’s diagnostics window in modeless state.
The diagnostics window displays the current real-time status of the VDCP device and log all communication between the Device Server and the video server.

If the diagnostics window is opened in modeless state, the contents of the diagnostics window are written to a text log file in the C:\CONFIG\LOG folder of the Configuration Manager PC.

3. When finished click **Close**.

## Diagnostic Monitor

The Diagnostic Monitor is a client application available from Automation Technical Support. It will capture the data traffic to and from the Device Server on a specific serial port or multiple serial ports. When troubleshooting communications difficulties with a device, the Diagnostic Monitor is an invaluable tool for examining the data stream.

Each build of Device Server software contains a special session-layer login for the Diagnostic Monitor. The Diagnostic Monitor may only log into a single Device Server at a time.

The Diagnostic Monitor consists of three files:

- DIAGMON.EXE
- APILIB32.DLL
- NBIOS32.DLL

### To Set up Diagnostic Monitoring

1. Copy the three files into a folder on the Configuration Manager PC and create a desktop shortcut to the executable file. The Configuration Manager does not need to be running to run the Diagnostic Monitor.
2. Right-click on the desktop icon and select Properties. Select the Shortcut tab. In the Target field, place the cursor at the end of the path to the executable file, type a space, then type an application name for the Diagnostics Monitor. The name may be anything you wish (most people use DIAGMON). Type another space, then type the application name of the Device Server you wish the Diagnostic Monitor to log into (MAIN, MAIN_DS, BACKUP_DS, etc.). Click OK.

3. Start the Diagnostic Monitor by double-clicking the desktop icon.

4. From the Trace menu, select Ports. In the window that opens, select the Device Server serial port from which you wish to capture the data trace, then click Enable (ON/OFF). Multiple serial ports may be selected by holding down the CTRL key while clicking, but the trace files generated will contain data from all the serial ports selected. It is recommended that you capture the data traffic on a single serial port at a time.

   - Once a serial port has been selected, the Diagnostic Monitor will begin writing the data to a trace file. The naming convention for the trace files is mmddyy_nnnnnn.TRC, where nnnnnn represents a number from 000000 to 999999. By default, the trace files are stored in the same folder as the Diagnostic Monitor executable.

   - The Diagnostic Monitor will write to the current trace file until it reaches 1MB, at which point the Diagnostic Monitor will close the current trace file and begin writing to a new trace file. As long as the Diagnostic Monitor application is running, data will be written to trace files.

   - *Note: If the Diagnostic Monitor is left running unattended for a long period of time, it will eventually fill up the client PC’s hard drive with trace files. Another application called TraceFind (see below) can be provided to help manage the trace files generated by the Diagnostic Monitor."

5. To view the trace files that have been captured by the Diagnostic Monitor, Automation Technical Support can provide another application called TraceView (see below). The trace files are not ASCII text files and may only be viewed with TraceView.

6. TraceView cannot open a file to which the Diagnostic Monitor is currently writing. To force the Diagnostic Monitor to close the current trace file and open a new one, from the File menu select Force New File.

**TraceView**

To view the trace files generated by the Diagnostic Monitor, Automation Technical Support can provide an application called TraceView. TraceView is a stand-alone application and is not required to log into the Device Server. It may be run on a PC completely separate from the automation system.

- TraceView consists of a single file, TRACVIEW4.0.EXE, which may be copied into a folder on any PC. Create a desktop shortcut to the executable and double-click the icon to run the program.
- TraceView also allows you to save the trace files as text files.
- The trace files captured by the Diagnostic Monitor may be emailed to Automation Technical Support to aid in the troubleshooting and resolution of a problem.

*Note: The Traceview tool supports the Logomotion protocol. Recently, Field engineers have needed the Leitch Logomotion translated the communication byte stream into human readable form.

*Note: Please refer to the user notes for TraceView for more information.*
To view a trace file

1. To view a trace file, select the File menu, and then select one of the viewing options. TraceView can parse the trace files in a number of different formats. The choices are:
   - ASCII text
   - Sony VTR protocol
   - Sony Cart Machine protocol
   - GVG M2100 switcher protocol
   - VDCP (for video servers)
   - Sony M1000 switcher protocol

2. TraceView will open an Explorer window allowing you to find the trace find you wish to view. TraceView will open a new window displaying the data trace.

Example Data Trace

Below is a portion of a data trace captured by the Diagnostic Monitor from a Sony VTR. From left to right, the first column displays the serial port from which the data trace was taken – in this case, serial port 1. The next column displays either an O> or an I< indicating whether this is data going out from the Device Server or coming into the Device Server. The next column displays the time stamp for the data trace. The number in parentheses in the next column displays the number of bytes in the command. The next column displays the raw hexadecimal data, and the last column displays the command interpreted in the selected protocol.

10>14:33:15.15( 4)61 20 09 8ASense Status
1I<14:33:15.16( 12)79 20 00 A0 07 00 00 00 00 00 00 40VTR Status
1O>14:33:15.16( 4)61 0C 01 6EGet Timecode
1I<14:33:15.17( 7)74 04 42 57 00 00 11Timecode 00:00:57:02
1O>14:33:15.17( 4)61 20 09 8ASense Status
1I<14:33:15.18( 12)79 20 00 A0 07 00 00 00 00 00 00 40VTR Status
1O>14:33:15.18( 4)61 0C 01 6EGet Timecode
1I<14:33:15.19( 7)74 04 42 57 00 00 11Timecode 00:00:57:02
1O>14:33:15.19( 3)20 01 21Play
1I<14:33:15.20( 3)10 01 11Ack
1O>14:33:15.20( 4)61 20 09 8ASense Status
1<14:33:15.21( 12)79 20 00 81 04 00 00 00 00 00 00 1EVTR Status
Application and exception errors

The Device Server and Configuration Manager applications contain built-in error handling routines that will generate an exception error log file in the unlikely event of a software crash. By default, these log files are written to the same folder that contains the executable program that generated the error. The exception error logs are not text files and cannot be viewed in a text editor. It is strongly recommended that you email the exception error logs to Automation Technical Support as soon as possible after a software crash.

The ADC List Dump Tool

The ADC ListDump provides a quick means of generating a List Dump for troubleshooting purposes. The Dump tool can be used in two modes:

- GUI application
- Console application

GUI application

If tool is launched without command line arguments (e.g. ListDump.exe) it will show GUI. Tool GUI allows:

- View list of servers in a network
- View number and names of Lists on the selected server
- Create dump of multiple lists for selected server
• Create shortcut with required arguments

To use the GUI
1. Launch Device Server and Air Client
2. Load events on lists
3. Launch ListDump tool without arguments
4. Select server and lists
5. Press Dump selected button
6. Verify report files
   Report files are created for all selected lists and the Reports contain event information

Console application

If tool is launched with console line arguments, no GUI Command line is opened and the application automatically creates the dump according to arguments.

Format of arguments:  ListDump.exe [/NoPause] <ServerName> <List numbers>

Example:  ListDump.exe ALAZAREVICH 1 2 3 4 5

• It means the application should connect to server with name ALAZAREVICH and create dump of first five lists.
• /NoPause argument is optional. If this argument is added application will not wait for Enter key after dump of lists have been created.
• No client name argument is required. Client name is created automatically according to the following pattern: "DumpTool" + random number in range 1..10000.
To use the Console

1. Launch Device Server and Air Client
2. Create shortcut for ListDump tool (Manually or using Create Shortcut button in the GUI)
3. Launch tool with shortcut
   The Console window is opened and a Report file is created for all specified lists and contain event information.
Appendix A: Error Messages

Device Server Errors

Following is a list of Errors that can be generated by the ADC Device Server. Please note that the Time of Day the error occurred, the list name, as well as the Device Name precede errors. The quickest method to find your error in this document is to do a Find using only the text of the specific error message less the Time of Day, list name and if displayed, Device Name.

Note: This section does not cover all possible errors. Contact Automation Technical Support for assistance with any error: listed or not listed.

AIR COPY REMOVED FROM EVENT - The primary copy of the media was removed or ejected, and the backup (Protect) copy became the primary copy. The media was not on-air.

ANNOTATION CAUSED SHORT PROGRAM

ANNOTATION MEDIA WAS EJECTED - The secondary record event was deleted. No record.

ARM NOT Indexed - The arm of the TCS90 cart. Machine is not properly indexed (not initialized or problem).

ARM OFF LINE: <Error Code> - One or more cassette handler component not indexed.

AUDIO DATA ERROR LEVEL NO GOOD - ID: <ID> <Time Code> - In a Digital Sony deck the VTR protocol returned back an Audio Data error. The SOM of the error code will indicate where on the tape the error occurred.

AUDIO READ AFTER WRITE NO GOOD - ID: <ID> <Time Code> - In a Digital Sony deck the VTR protocol returned back an Audio Raw Verify error. The SOM of the error code will indicate where on the tape the error occurred.

AUDIOOVER NUMBER SWITCHED ON/OFF MANUALLY - Manual Intervention occurred on Audio Over.

AXIS OFF LINE - The arm cannot move in the axis (not initialized or problem).

BAD BARCODE READ ON BIN: <Bin Number> - The barcode reader in the cart machine has detected a label on the tape, but cannot properly read it.

BARCODE READ LOST - An unknown error occurred in a cart machine when trying to read the barcode label on a tape.

BARCODE READER ERROR - An error occurred with the barcode reader.

BIN: <Bin Number> IN USE BY VTR <Error Code> - BIN assigned to multiple tape.
CACHING FAILURE-CHECK EVENT:<ID> List <Error Code> - Impossible to make a cache request. The ID of the media seems bad.

CART COMMAND MALFUNCTION - C<ErrorCode> COMMAND FORMAT ERROR - Bad format of the command sent to the cart machine.

CART COMMAND MALFUNCTION - C<ErrorCode> ILLEGAL COMMAND ID - Unknown command ID.

CART COMMAND MALFUNCTION - C<ErrorCode> MARC BUFFER FULL - Cart machine buffer is full. Impossible to run the command.

CART COMMAND MALFUNCTION - C<ErrorCode> MARC BUSY - The cart machine is busy, the command will not run.

CART COMMAND MALFUNCTION - C<ErrorCode> MARC BUSY - The cart machine is busy.

CART COMMAND MALFUNCTION - INVALID PARAMETER - Cart command contained invalid parameters.

CART COMMAND MALFUNCTION - INVALID PARAMETER <ErrorCode> - Bad command parameters sent to the cart machine.

CART COMMAND MALFUNCTION - INVALID PARAMETER <ErrorCode> - Bad command parameters sent to the cart machine.

CART COMMAND MALFUNCTION - INVALID PARAMETER <ErrorCode> - Bad command parameters sent to the cart machine.

CART ERROR ON BARCODE READER COMMAND - Problem with a barcode reader command.

CART ERROR ON MISCELLANEOUS COMMAND - Message for every kind of errors (MISCELLANEOUS).

CART ERROR ON ROBOT COMMAND - Problem with a robot command.

CART ERROR ON VTR COMMAND - Problem with a VTR command.

CART JARRED - Attempted a movement command while the emergence stop switch is activated.

CART MALFUNCTION - <IDC_Format_OdeticCart> - General problem in the odetics carts.

CART OTHER MALFUNCTION - M<ErrorCode> NO TIMECODE - There is no timecode reference in the cart machine.

CART OTHER MALFUNCTION - M<ErrorCode> TIMECODE ERROR - Timecode error with the cart machine.

CART ROBOT MALFUNCTION - BAD BARCODE READ ON BIN: <ErrorCode> - The barcode reader in the cart machine has detected a label on the tape, but cannot properly read it.

CART ROBOT MALFUNCTION - R<ErrorCode> Abnormal End - The command was abnormally finished.

CART ROBOT MALFUNCTION - R<ErrorCode> Abnormal End - The command was abnormally finished.

CART ROBOT MALFUNCTION - R<ErrorCode> DEVICE OFF LINE - Device connected but offline.

CART ROBOT MALFUNCTION - R<ErrorCode> DEVICE RETURNED NAK, MINOR ERROR - The robot responded with a NAK, instead of an ACK.
CART ROBOT MALFUNCTION - R<ErrorCode> DEVICE RETURNED NAK, MINOR ERROR - The robot responded with a NAK, instead of an ACK.

CART ROBOT MALFUNCTION - R<ErrorCode> DEVICE RETURNED NAK, MINOR ERROR - The robot responded with a NAK, instead of an ACK.

CART ROBOT MALFUNCTION - R<ErrorCode> DEVICE RETURNED NAK, MINOR ERROR - The robot responded with a NAK, instead of an ACK.

CART ROBOT MALFUNCTION - R<ErrorCode> DOOR IS OPEN - The door of the robot is open.

CART ROBOT MALFUNCTION - R<ErrorCode> EJECT TIMEOUT - Eject command didn't run on time in a robot.

CART ROBOT MALFUNCTION - R<ErrorCode> EJECT TIMEOUT - Eject command didn't run on time in a robot.

CART ROBOT MALFUNCTION - R<ErrorCode> UNINITIALIZED - Robot not initialized.

CART ROBOT MALFUNCTION - R<ErrorCode> UNINITIALIZED - Robot not initialized.

CART ROBOT MALFUNCTION - R<ErrorCode> UNINITIALIZED - Robot not initialized.


CART VTR MALFUNCTION - V<ErrorCode> CAN NOT CANCEL - Impossible to cancel the VTR command.

CART VTR MALFUNCTION - V<ErrorCode> COMMAND CANCEL - Cancel of a VTR command.

CART VTR MALFUNCTION - V<ErrorCode> COMMAND CANCEL - Cancel of a VTR command.

CART VTR MALFUNCTION - V<ErrorCode> COMMAND CANCEL - VTR command was cancelled.

CART VTR MALFUNCTION - V<ErrorCode> COMMUNICATION ERROR - Communication error between the VTR and the Device server.

CART VTR MALFUNCTION - V<ErrorCode> COMMUNICATION ERROR - Communication error from a VTR in the cart machine.

CART VTR MALFUNCTION - V<ErrorCode> COMMUNICATION ERROR - Communication error from a VTR in the cart machine.

CART VTR MALFUNCTION - V<ErrorCode> COMMUNICATION ERROR - Communication error from a VTR in the cart machine.

CART VTR MALFUNCTION - V<ErrorCode> DEVICE OFF LINE - Device connected but offline.

CART VTR MALFUNCTION - V<ErrorCode> DEVICE OFF LINE - VTR connected but offline.

CART VTR MALFUNCTION - V<ErrorCode> DEVICE OFF LINE - VTR from a VTR in the cart machine is off line.

CART VTR MALFUNCTION - V<ErrorCode> DEVICE WENT INTO LOCAL - The remote control from the VTR in the cart machine is not able.
CART VTR MALFUNCTION - V<ErrorCode> HARDWARE ERROR - Hardware error for a VTR in the cart machine.

CART VTR MALFUNCTION - V<ErrorCode> HARDWARE ERROR - Hardware error for the cart machine.

CART VTR MALFUNCTION - V<ErrorCode> MARC BUSY - The cart machine is busy, the VTR command is not running.

CART VTR MALFUNCTION - V<ErrorCode> MARC SOFTWARE ERROR - VTR Cart machine software problem.

CART VTR MALFUNCTION - V<ErrorCode> MARC SOFTWARE ERROR - VTR Cart machine software problem.

CART VTR MALFUNCTION - V<ErrorCode> NO RESPONSE - No answer from a VTR in the cart machine.

CART VTR MALFUNCTION - V<ErrorCode> NO VTR - There is no VTR connected.

CART VTR MALFUNCTION - V<ErrorCode> REC INHIBIT - Recording impossible with a VTR in the cart machine.

CART VTR MALFUNCTION - V<ErrorCode> SERVO TROUBLE - Servo problem.

CART VTR MALFUNCTION - V<ErrorCode> TAPE TROUBLE - Problem with a tape in a VTR.

CART VTR MALFUNCTION - V<ErrorCode> UNDEFINED COMMAND - Undefined command sent to a VTR in the cart machine.

CASSETTE STUCK IN ELEVATOR - POSSIBLE VTR PROBLEM - The door on the cart machine is open.

CHC SLIDER NOT RETRACTED - Attempted a load port command before previous stall condition cleared.

COMMAND TIMED OUT, RECEIVED NO REPLY - Command got no reply.

COMMUNICATIONS LOST WITH CART - A Cart Machine stopped communicating over the RS422 connection.

COMMUNICATIONS LOST WITH DEVICE - The communication between the device server and the video server is lost.

COMMUNICATIONS LOST WITH DEVICE <Error Code> - A device stopped communicating over the RS422 connection.

COMMUNICATIONS RESTORED WITH DEVICE - The communication between the device server and the video server is restored.

COMPILE MEDIA NOT IN POSITION TO PLAY - Rollover between compile reels failed.


DEVICE - DIAGNOSTIC CODE:<Error Code> ID: <ID> - Specific error from the odetics cart. The errors have to be checked in the protocol of the device.

DEVICE - DIAGNOSTIC CODE:<Error Code> ID: <ID> - Used by video disk, do not use in diagnostic. The errors have to been checked in the protocol of the device.
DEVICE DELETED SPOT: <ID> - Spot deleted from the device. Impossible to play it.

DEVICE ERROR <Device Name> - INTERNAL ERROR - RESULT BUFFER OVERRUN - The buffer of the video server is full. The command won't be run.

DEVICE ERROR <Device Name> SWITCHPRESET - VID CROSSPOINT: <VideoInput> <-> AUD CROSSPOINT: <AudioInput> - From SwitchPreset.

DEVICE ERROR - PORT NOT VALID - Problem with a port of the video disk.

DEVICE ERROR - REPORTED FROM DEVICE: <Error Code> - Error code return for the video disk.

DEVICE ERROR - REPORTED FROM DEVICE: <ErrorCode> - Used by video disk, do not use in diagnostic. The errors have to been checked in the protocol of the device.

DEVICE NAME NOT VALID - The major device specified by the system resource event could not be found.

DEVICE NOT CUED IN TIME, HOLDING TIME:<ID> List <Error Code> - Media not cued in time in the video disk.

DEVICE NOT CUED IN TIME, HOLDING TIME:<ID> List <Error Code> - Media not cued in time.

DEVICE NOT IN EDIT ON - After a command to go into edit on mode, the device indicates that it is not in edit on mode.

DEVICE PLAY/RECORD STATUS LATE: <ID> - Problem with the time delay of the device.

DEVICE RECORDED SPOT: <ID> - Spot recorded in the device. Can be played.

DEVICE RETURNED ACK - Received unexpected ack.

DEVICE RETURNED NAK, MINOR ERROR <Error Code> - A device returned either a NAK through the protocol or a problem with communications existed.

DEVICE RETURNED UNEXPECTED NAK, MINOR ERROR <Error Code> - Received unexpected nak.

DEVICE SENT CUE CMD: <ID> - ID in copy queue is not in spot collection.

DEVICE SENT PROTECT CMD: <ID> - Record media, spot marked for cache.

DEVICE SERVER LOST BACKGROUND: <Error Code> - Event pointer nil when unregistered.

DEVICE SERVER REFERENCE VIDEO LOST

DEVICE SERVER TIMECODE LOST

DEVICE TIMEOUT - RETRYING COMMAND: <Error Code> - A timeout occurred when waiting for the response of a device.

DEVICE WENT INTO LOCAL - The device is no longer under automation control. Communications exist, but the device will not respond to commands.

DIAGNOSTIC STATUS ERROR <Error Code> - In a Digital Sony deck the VTR protocol returned the diagnostic status bit set in the extended status. The minor error code has the actual error code as defined by the Sony VTR Protocol.
DISK ERROR - AUDIO OVERLOAD - Problem with the configuration of the audio in the video server.

DISK ERROR - COMMAND NOT SUPPORTED - The video file server received a command not yet implemented.

DISK ERROR - COMMAND WHILE BUSY - The video server had an error while is busy.

DISK ERROR - CUE NOT DONE - The media was not cued on the right timecode.

DISK ERROR - DISK IS FULL, RECORD FAILED - The video disk server is full. No recording.


DISK ERROR - ID DELETE PROTECTED: <ID> - ID protected, do not delete from the video server.

DISK ERROR - ID NOT FOUND: <ID> - The media in the video server is not in the device storage.

DISK ERROR - ID STILL PLAYING: <ID> - Impossible to stop the media during a play.

DISK ERROR - ID STILL RECORDING: <ID> - Impossible to stop the media during a record.

DISK ERROR - ID TRANSFERRED: <ID> - Impossible to play an ID from the video server it was already transferred.

DISK ERROR - ILLEGAL VALUE - Bad value sent to the video server in a command.

DISK ERROR - INVALID ID: <ID> - The format of the ID is not correct.

DISK ERROR - INVALID PORT - Configuration conflict with port.

DISK ERROR - NO AUDIO INPUT - There's no input audio flow in the video server.

DISK ERROR - NO REFERENCE INPUT - The video file server has had the reference video removed.

DISK ERROR - NO VIDEO INPUT - No video input in the video disk.

DISK ERROR - NO VIDEO PORT OPEN - There's no port configured for the playout.

DISK ERROR - NOT IN CUED STATE - The state of the media in the device server is not already cued.

DISK ERROR - PORT NOT ACTIVE - The port of the video server is not active. The command won't be run.

DISK ERROR - PORT NOT IDLE - The port of the video server is not well reinitialized.

DISK ERROR - PORT PLAYING OR ACTIVE - The port is already used for a command. Impossible to use it for a new one.

DISK ERROR - SYSTEM ERROR - General problem in the video server.

DISK ERROR - VIDEO PORT DOWN - The playout port is down.

DISK ERROR - WRONG PORT TYPE - Wrong port assignment in the video server.

DISK ERROR-CUE OR OPERATION FAILED: <ID> - Impossible to cue an event in the video server. This message is used for another command.
DISK NAK - COMMUNICATIONS CHECKSUM ERROR - Time out between the device server and the video server. Problem with the checksum of the video server answer.

DISK NAK - COMMUNICATIONS FRAMING ERROR - Time out between the device server and the video server. Problem with the format of the video server answer.

DISK NAK - COMMUNICATIONS OVER FLOW - Time out between the device server and the video server. Problem with the format of the video server answer.

DISK NAK - COMMUNICATIONS PARITY ERROR - Time out between the device server and the video server. Problem with the parity bit of the video server answer.

DISK NAK - COMMUNICATIONS TIME OUT - Time out between the device server and the video server. No response from the video server.

DISK NAK - COMMUNICATIONS UNDEFINED ERROR - Undefined error from the video server.

DOOR OPEN TIMEOUT - The door stayed open too long.

DOS Server network error, obsolete error

DUPLICATE TAPE: <ID> In BIN: <Bin Number> - There are at least two identical ID in the bins of the cart Machine.

ELEVATOR OFF LINE - The robotic elevator is in an offline state.

ELEVATOR REPLY TIMEOUT - The elevator of the cart machine didn't move on time.

EMERGENCY STOP ACTIVE - Manual intervention has removed the device from service.

ERROR - DEVICE ACCESS ERROR - Access denied in the device.

ERROR - DEVICE OUT OF MEMORY - The memory of the device is full.

ERROR - DISK CACHE RECORDER FAILED ID: <ID> - Problem with the recording during the cache.

ERROR - DISK FAILED PLAY ID: <ID> - Problem to play a media from the video server.

ERROR - DISK FAILED RECORD ID: <ID> - Problem to record a media to the video server.

ERROR - LOST DISK REPLY(S) - Problem with the disk of the video server.

ERROR - RESENT LAST COMMAND - A command have not been executed and lost from the memory of the video server.

ERROR - UNKNOWN RESPONSE - The answer from the video server is wrong.

EVENT NOT PLAYED

EVENT NOT PLAYED

EVENT NOT PLAYED

EVENT NOT PLAYED
EVENT NOT PLAYED - INVALID OFFSET ON SECONDARY - A secondary GPI event that was to be run twice on the same primary event had an overlapping start time on the subsequent GPI event.

EVENT NOT PLAYED - SECONDARY MEDIA MISSING - GMT Error. A GMT transfer failed because the secondary events were not valid, such as in a baseband transfer.

EVENT SKIPPED - ABNORMAL END - An event encountered an end of media condition such as end of tape or end of recorded clip. The media stopped playing and the next event was run. (If a Protect copy exists this message is not generated)

EVENT UNABLE TO CUE - NO SOM - The Start of Message in the event is invalid for the material. Cannot cue the material to the specified location

EVENT UNABLE TO RECORD, REC INHIBIT ON - The device has recording disabled. Typically, a VTR with the rec inhibit tab set

FETCH OR INSERT TO EMPTY OR FULL LOCATION - Try to insert in full bin or try to take a tape from an empty bin.

GMT MEDIA TRANSFER FAILED, TIME = - A failure was reported back to the list for a media transfer by a requestor. The media was not transferred.

GMT-ABORT EVENT DUE TO ARCHIVE OR DISK TIME OUT - Abort event due to the archive manager or the video file server timeout.

GMT-BASEBAND DEVICE I/O FAILURE - A problem occurred during the baseband transfer.

GMT-EVENT ABORTED DURING RUNNING STATE - The running GMT event aborted during execution.

GMT-EVENT ID NOT FOUND IN SOURCE DEVICE - Event ID not found in the source device.

GMT-FOUND BUFFER FULL DURING GLOBAL DELETE - A buffer overflow error occurred during a global delete.

GMT-FOUND UNKNOWN/UNIMPLEMENTED DISK COMMAND - Found unknown / unimplemented VDCP command during transfer.

GMT-ID ALREADY EXISTED IN DESTINATION DEVICE - The media already exists in the device storage of the destination device.

GMT-LIST EVENT CUT OR RAN SHORT - An event on the GMT list was cut.

GMT-LISTED ID NOT FOUND IN DISTRIBUTOR COLLECTION - The media wasn't found by the distributor.

GMT-MISSING DISK HANDLE WHILE NEEDED - There is no disk handle parameter available for the activity.

GMT-NO FIBER DISTRIBUTOR TO DO THE MOV AFTER BB TRANSFER - No fibre distributor available to do the move after the baseband transfer has occurred.

GMT-NO FIBER DISTRIBUTOR TO DO THE MOV AFTER CFA - There is no fibre distributor to do a copy after the move from archive has occurred.
GMT-NO GLOBAL DELETE TARGETS CONFIGURED - No global delete targets are configured in the distributor.

GMT-REQUEST SUCCESS - The request succeeded.

GMT-REQUESTOR LOST COMMUNICATION WITH DISTRIBUTOR - The requestor lost communications with the distributor.

GMT-TRANSFER SUCCESS - Distributor transfer media in Fiber/Archive/WAN routing mode is successful.

GMT-VACP ERR COMM FAIL - VACP response from archive manager. Problem of communication.

GMT-VACP ERR ID EXISTS - VACP response from archive manager. The ID is already existing.

GMT-VACP ERR ID NOT FOUND - VACP response from archive manager. The ID was not in a device storage. The archive manager cannot find the specified ID.

GMT-VACP ERR INIT - VACP response from archive manager. Problem at the initialization.

GMT-VACP ERR INSUFF MEMORY - VACP response from archive manager. Problem of memory.

GMT-VACP ERR INSUFF SVCS - Insufficient services.

GMT-VACP ERR MACRO FAIL - The Archive manager reports (CFA/CTA) macro command is failed.

GMT-VACP ERR OP COMPLETED - Inverse of Incomplete Operation.

GMT-VACP ERR OPPERATION ABORTED - VACP response from archive manager. The command was aborted because of an unspecified error.

GMT-VACP ERR PARM INVALID - VACP response from archive manager. Bad parameters in the command.

GMT-VACP ERR PARTITION SMALL - The partition is too small to hold the material.

GMT-VACP ERR PORT_BUSY - VACP response from archive manager. The port is busy. Impossible to run the command.

GMT-VACP ERR RW FAILURE - VACP response from archive manager. Problem on read write mode.

GMT-VACP ERR SETUSERID - VACP Client is using wrong user ID to do the login.

GMT-VACP ERR TAPE UNAVAIL - VACP response from archive manager. No available tape to perform the operation.

GMT-VACP ERR TIMEOUT - VACP response from archive manager. Time out on a command.

GMT-VACP ERR UNKNOWN Command Received - VACP response from archive manager. The command is not a valid one.

GMT-VACP NAK_ERR_CHECKSUM - VACP response from archive manager. The checksum indicates an error in transmission.

GMT-VACP NAK_ERR_FRAMING - VACP response from archive manager. A framing error was detected in the message.
GMT-VACP NAK_ERR_ID_CONFLICT - VACP response from archive manager. The ID being sent to the archive already exists.

GMT-VACP NAK_ERR_ILLEGAL_VALUE - VACP response from archive manager. The response is a NAK, as a result of an illegal value being sent.

GMT-VACP NAK_ERR_OVERRUN - VACP response from archive manager. An over run condition was detected in the message.

GMT-VACP NAK_ERR_PARITY - VACP response from archive manager. A parity error was detected in the message.

GMT-VACP NAK_ERR_UNDEFINED - VACP response from archive manager. The response is a NAK, of undefined error type.

GMT-VACP NAK_ERR_UNSUPPORTED - VACP response from archive manager. The command is not supported by the archive manager.

GMT-VACP SUCCESS - VACP response from archive manager. Clip moved successfully.

GMT-VDCP Archive disk handle not configured - VDCP archive disk handle not configured.

GMT-VDCP_SUCCESS - VDCP response from archive manager. The command ran with success.

HARD ERROR - A Sony Protocol VTR returned back the Hard Error bit enabled indicating some physical problem with the VTR or Tape.

HARDWARE TROUBLE BUZZER ALARM - In a Digital Sony deck the VTR protocol returned the buzzer bit set in the extended status.

HEAD STILL IN PLAY - The system resource event attempted to assign a device that was in play. The assignment did not take place.

HUB OFF LINE - Attempted a load port command with no load port installed. Attempted a transfer command with no transfer mechanism installed.

ID DOES NOT MATCH, MACRO LSB <Error Code> - ID doesn’t match.

INCORRECT SIZE AT LOCATION - Insert command attempted to an incorrect size location.

INTERNAL ERROR - BAD COMMAND GENERATED - The format of the command is wrong.

INVALID EVENT COMMAND - The system resource event was not valid and could not be decoded by the list.

INVALID HEAD NUMBER - The minor device head specified by the system resource event was not a valid head number.

KEYER NUMBER SWITCHED ON/OFF MANUALLY - Manual Intervention occurred on Keyer.

KEYER NUMBER SWITCHED ON/OFF MANUALLY - Manual Intervention occurred on Keyer.

LIST WILL STOP ON NEXT EVENT - Manual intervention occurred, List will stop on next event, id field is empty.
LOAD PORT FULL - CANNOT UNLOAD VTR - Load port is full in the procart.

LOAD PORT INDEX, OPEN, CLOSED ARM IN FRONT ?? - Load port problem, it can be a bad reinitialization, or the load port is open or the arm is blocked just in front.

LOAD PORT NOT INDEXED - Bad load port initialization.

LOAD PORT STALL NOT CLEARED - Tape were not put out of the load port.

MACRO BUSY ERROR - A Sony Cart machine returned back a status of Macro Busy on a macro command. This error condition should never occur in a Sony Cart Machine.

MACRO DISTURBED - A Sony Cart machine returned back via the protocol that a Macro Command was either terminated or disturbed.

MACRO NOT FOUND, MACRO LSB <Error Code> - Couldn’t find macro.

MAIN ROBOT - General robot problem.

MAIN ROBOT, CLAW 1 - Problem with the gripper 1 of the robot.

MAIN ROBOT, CLAW 2 - Problem with the gripper 2 of the robot.

MAIN ROBOT, X AXIS - Problem with the X Axis arm robot.

MAIN ROBOT, Y AXIS - Problem with the Y Axis arm robot.

MANUAL INTERVENTION OF SYSTEM - Indicates Manual Intervention on the switcher.

MASTER MEDIA FAILURE - DURING PREROLL - A failure of the primary media occurred during pre-roll of the media. No switching to a protect copy could occur at this time.

MASTER MEDIA FAILURE - PROTECT COPY NOT PLAYING - A failure of the primary media occurred but the backup media was unable to be switched into the on-air video stream.

MASTER MEDIA FAILURE - PROTECT COPY SWITCHED - A failure of the primary media caused the backup media (Protect) to be switched into the on-air video stream.

MECHANICAL INTERFERENCE - Mechanical interference.

MEDIA DEVICE NOT PROPERLY INITIALIZED - The media wasn’t initialized properly.

MEDIA MISSING - NOT FOUND - The event was unable to play because the ID was not found in any device.

MEDIA NOT THREADED - The event was unable to play because the media was not threaded into a device.

MEDIA UNABLE TO CUE - ID: <ID> - Device is unable to cue.

MODE SET TO DISABLE MOVEMENT WHEN DOOR OPEN - In the Procart cart machine you can enable or not a sound indicating that the door in the Procart cart machine is open and that you have to close it.

MOVE WITH LIGHT CURTAIN ACTIVE - While moving the robotics, an interruption of the light curtain was detected.
MULTIPLE GRIPPER ERRORS

MULTIPLE GRIPPER ERRORS, ARM <Error Code> PLACED OUT OF SERVICE - Gripper is out of service.

NAK RETURNED FROM SWITCHER - The switcher responded with a NAK, instead of an ACK.

NO ANOTATION EVENTS TO RECORD - The secondary record event was not inserted. No record.

NO CASSETTE IN GRIPPER - Procart cart machine. No tape in the gripper.

NO MORE BINS TO STORE MEDIA - The bins in the cart machine are all full. There is no more room for tapes in the cart machine.

NO VTR AT LOCATION - There is no VTR installed at the physical location.

NOT CUED IN TIME - The event was unable to play because it was unable to cue.

ON AIR EVENT PACKED - LIST WILL STOP - The on-air event was playing, and the packing of the list forced the deletion of the event.

ON AIR EVENT WAS CUT - The on-air event was playing, and it was deleted from the playlist

ON AIR EVENT WAS EJECTED - Media was ejected during playout

ON AIR EVENT WAS RECUED - The event began to play, but the operator intervened by invoking the recue command.

OUTPORT IS FULL - PLEASE EMPTY IT - The I/O port of the cart machine is full. It must be emptied so that the current ejection process continues.

PGM CROSSPOINT NUMBER AUDIO SWITCHED MANUALLY - Manual Intervention occurred on Audio crosspoint number.

PGM CROSSPOINT NUMBER AUDIO SWITCHED MANUALLY - Manual Intervention occurred on Audio crosspoint number.

PGM CROSSPOINT NUMBER VIDEO SWITCHED MANUALLY - Manual Intervention occurred on video crosspoint number.

PGM CROSSPOINT NUMBER VIDEO SWITCHED MANUALLY - Manual Intervention occurred on video crosspoint number.

PLAY ISSUED - MEDIA IN LOCAL - The device received the play command, but the returned status indicates that it did not go into play mode.

PLAYOUT TIMES OVERLAP - Events overlapped in the transmission list.


PROGRAM/INTERFACE ERROR - SYSTEM ALARM - In a Digital Sony deck the VTR protocol returned the system alarm bit set in the extended status.
PROTECT COPY NOT USABLE – REMOVED - The protect copy of the media was removed or ejected, but the primary copy was not. The media was not on-air.

PROTECT MEDIA NOT PLAYED - NOT CUED - The secondary event was unable to play because the media was not cued in time.

PROTECT NAME NOT VALID - The major device to be used as a protect device, specified by the system resource event could not be found.

PUT TAPE FROM VTR: <Error Code> INTO BIN: <Bin Number> - Problem with an unthread tape for a VTR to a bin in the odetics cart.

PUT TAPE: <ID> FROM BIN: <Bin Number> INTO VTR: <Error Code> - Problem with a threading tape in a VTR of an odetics cart.

RECORD ENDED PREMATURELY - The event for a record operation terminated abnormally.

RECORD EVENT WAS CUT - The record event was recording, and it was deleted from the record list.

RECORD NOT STARTED - Event failed to start.

Reference Timecode missing. Shifting from timecode to reference video for clocking input

REFERENCE VIDEO MISSING - The VTR has lost the reference video signal.

Reference Video missing. Shifting to PC Clock for clocking input. (Timecode also missing)

REMOVE TAPE FROM VTR, INSERT VIA I/O PORT - Somebody put a tape manually into a VTR instead of the load port.

REMOVE TAPES FROM VTRS, INSERT VIA I/O PORT - Somebody put tapes manually into a VTR instead of the load port.

RESEAT CASSETTE IN BIN: <Bin Number> AND INIT ROBOT - Put the tape in its bin and reinitialize the robot.

RETURN TO AUTOMATED CONTROL OF SYSTEM - Indicates the switcher is back to the list control.

ROBOT WARNING number V<ErrorCode> VTR number <ID> - Problem with a VTR from the MARC cart machine.

SERIAL CONTROL WENT INTO AUTOMATION - The device is now under automation control. This is the reverse of AUTO_ENABLE_OFF.

SERIAL CONTROL WENT INTO LOCAL - The device is no longer under automation control. Communications exist, but the device will not respond to commands.


SKIP ISSUED - The event began to play, but the operator intervened by invoking the skip command.
STANDBYON ISSUED - MEDIA IN LOCAL - The device received the standby command, but the returned status indicates that it did not go into standby mode.

SWITCHER COMMAND QUEUE FULL <Error Number> - From PutQueue, when queue is full.

SWITCHER DID NOT RESPOND TO REQUEST - The switcher is no longer communicating.

SYSTEM ERROR: NO DATAGRAM NCBS

TAKE WAS SENT VID CROSSPOINT: <VideoInput> <-> AUD CROSSPOINT: <AudioInput> - From Background, just after sending take.

TAPE TROUBLE - A Sony Protocol VTR returned back the Tape Trouble bit enabled indicating some problem with the tape.

TARGETING OR DOOR OPEN - Procart cart machine. The door is either open or the tape could be put in the VTR.

THREAD FAILURE - DOOR OPEN OR SYSTEM DOWN - <Error Code> - The threading of a tape into the cart VTR has failed. The elevator may have become jammed or the VTR jammed.

TRANSITION - INPUT CROSSPOINT: <CrosspointInput> <-> OUTPUT CROSSPOINT: <CrosspointOutput> - From transition or/and control panel.

TRANSPORT MECHANISM MUST BE EMPTIED MANUALLY - Gripper has to be emptied manually.

TROUBLE IN DEVICE SERVO - In a Digital Sony deck the VTR protocol retunred the servo alarm bit set in the extended status.

TROUBLE WITH OUTPORT - PLEASE CHECK - On those cart machines that have an I/O port, attempting to put a tape into the I/O port failed because of a hardware problem with the I/O port.

UNABLE TO ASSIGN HEAD - Using the system resource assignment event, the device that was to be assigned to the list could not be assigned.

UNABLE TO RELEASE HEAD - Using the system resource assignment event, the device that was to be released from the list could not be released.

UNKNOWN MARC ERROR - Unknown MARC cart machine problem.

UNKNOWN RESPONSE FROM CART <Error Code> - Undefined problem from the LMS cart machine.

UNKNOWN THREAD ERROR - <Error Code> - A Sony Cart returned an unknown Macro completion code when the threading of a tape into a VTR failed.

USERBITS NOT VALID, DEVICE NOT SET TO EJECT - A VTR was set to keep the tape even if an eject was issued, but the userbit associated with the tape was not valid.

VENUS NOT LOCKED TO TIMECODE - Venus doesn't get any timecode.

VIDEO DATA ERROR LEVEL NO GOOD - ID: <ID> <Time Code> - In a Digital Sony deck the VTR protocol returned back an Video Data error. The SOM of the error code will indicate where on the tape the error occurred.
VIDEO READ AFTER WRITE NO GOOD - ID: <ID> <Time Code> - In a Digital Sony deck the VTR protocol returned back an Video Raw Verify error. The SOM of the error code will indicate where on the tape the error occurred.

VTR COMMAND TIMEOUT - The VTR command wasn’t made on time.

VTR EJECT FAILURE - CHECK FOR JAM - <Error Code> - The VTR did not eject the tape when requested.

VTR ERROR number<Bin Number> - Problem with a tape between the VTR and the bin of the cart.

VTR PROBLEM - CHECK FOR JAM - <Error Code> - A VTR in a cart machine had a failure and is off-line.

VTR STATUS : <Bin Number> - Status of the VTR returned to the device server.

WARNING-SPOT SHORTER THAN SCHEDULED: <ID> - The spot in the video server is too short to play well the next event.

---

**SQL Server Database Error Messages**

ADC applications have migrated to SQL Server. This section provides a reference to database errors that may be encountered.

- **Error Message Number**: Each error message displayed by SQL Server has an associated error message number that uniquely identifies the type of error.

- **State Number**: The error state number is an integer value between 1 and 127; it represents information about the source that issued the error (such as the error can be called from more than one place).

- **Error Severity**: The error severity levels provide a quick reference for you about the nature of the error. The severity levels range from 0 to 25.

<table>
<thead>
<tr>
<th>Severity Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 10</td>
<td>Messages with a severity level of 0 to 10 are informational messages and not actual errors.</td>
</tr>
<tr>
<td>11 to 16</td>
<td>Severity levels 11 to 16 are generated as a result of user problems and can be fixed by the user. For example, the error message returned in the invalid update query, used earlier, had a severity level of 16.</td>
</tr>
<tr>
<td>17</td>
<td>Severity level 17 indicates that SQL Server has run out of a configurable resource, such as locks. Severity error 17 can be corrected by the DBA, and in some cases, by the database owner.</td>
</tr>
<tr>
<td>18</td>
<td>Severity level 18 messages indicate nonfatal internal software problems.</td>
</tr>
</tbody>
</table>

**IMPORTANT**: Severity errors 19 through 25 are fatal errors and can only be used via RAISERROR by members of the fixed database role sysadmin with the with log option required. Severity 0 - 18 can be used by all users. When a fatal error occurs (20 - 25), the running process that generated the error is terminated (nonfatal errors continue processing). For error severity levels 20 and greater, the client connection to SQL Server is terminated.

19 | Severity level 19 indicates that a non-configurable resource limit has been
<table>
<thead>
<tr>
<th>Severity Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>exceeded.</td>
</tr>
<tr>
<td>20</td>
<td>Severity level 20 indicates a problem with a statement issued by the current process.</td>
</tr>
<tr>
<td>21</td>
<td>Severity level 21 indicates that SQL Server has encountered a problem that affects all the processes in a database.</td>
</tr>
<tr>
<td>22</td>
<td>Severity level 22 means a table or index has been damaged. To try to determine the extent of the problem, stop and restart SQL Server. If the problem is in the cache and not on the disk, the restart corrects the problem. Otherwise, use DBCC to determine the extent of the damage and the required action to take.</td>
</tr>
<tr>
<td>23</td>
<td>Severity level 23 indicates a suspect database. To determine the extent of the damage and the proper action to take, use the DBCC commands.</td>
</tr>
<tr>
<td>24</td>
<td>Severity level 24 indicates a hardware problem.</td>
</tr>
<tr>
<td>25</td>
<td>Severity level 25 indicates some type of system error.</td>
</tr>
</tbody>
</table>

**For SQL Server Error Definitions**

2. From the SQL Server Books Online dialog box, click the Search Tab.

3. The Search tab enables you to quickly search Books Online for specific information. For example, in the Query combo box, type the error message number: 208.
4. To run the search, click the search icon 🍃. Example: The query runs, searching for 208 in the title of any of the book topics. If one or more items are found, they are displayed in a Query Results frame in the SQL Server Books Online dialog box.

5. Under Refine Search choose the Source and Topics to additionally focus the search. (Example: Refined search to Library.)
6. To view the document(s) found in the search, click the item. (Example: click MSSQLSERVER_208)

7. The detailed information for the error message number, including a detailed explanation and the action to take, is displayed in the document.

   Also, the document can be printed ( ).

   When getting multiple documents back for an error message query, select the desired document title for the listed results. For example, the document title MSSQLSERVER_208 displays detailed information on error 208. After you have displayed the error number document, read through the document for an explanation of the error and then follow the directions in the Action section of the document to correct the error.